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1 Dokumentationshinweise
Diese Beschreibung wendet sich ausschließlich an ausgebildetes
Fachpersonal der Steuerungstechnik und Automatisierungstechnik,
das mit den geltenden nationalen Normen vertraut ist.
Zur Installation und Inbetriebnahme der Komponenten ist die Beach-
tung der Dokumentation und der nachfolgenden Hinweise und Er-
klärungen unbedingt notwendig.
Das Fachpersonal ist verpflichtet, stets die aktuell gültige Dokumen-
tation zu verwenden.
Das Fachpersonal muss sicherstellen, dass die Anwendung bzw.
der Einsatz der beschriebenen Produkte alle Sicherheitsanforderun-
gen, einschließlich sämtlicher anwendbarer Gesetze, Vorschriften,
Bestimmungen und Normen erfüllt.

1.1 Disclaimer
Beckhoff Produkte werden fortlaufend weiterentwickelt. Wir behalten
uns vor, die Dokumentation jederzeit und ohne Ankündigung zu
überarbeiten. Aus den Angaben, Abbildungen und Beschreibungen
in dieser Dokumentation können keine Ansprüche auf Änderung be-
reits gelieferter Produkte geltend gemacht werden.

1.1.1 Marken
Beckhoff®, TwinCAT®, TwinCAT/BSD®, TC/BSD®, EtherCAT®,
EtherCAT G®, EtherCAT G10®, EtherCAT P®, Safety over
EtherCAT®, TwinSAFE®, XFC®, XTS® und XPlanar® sind eingetrage-
ne und lizenzierte Marken der Beckhoff Automation GmbH.
Die Verwendung anderer in dieser Dokumentation enthaltenen Mar-
ken oder Kennzeichen durch Dritte kann zu einer Verletzung von
Rechten der Inhaber der entsprechenden Kennzeichen führen.

1.1.2 Patente
Die EtherCAT-Technologie ist patentrechtlich durch folgende An-
meldungen und Patente mit den entsprechenden Anmeldungen und
Eintragungen in verschiedenen anderen Ländern geschützt:

• EP1590927
• EP1789857
• EP1456722
• EP2137893
• DE102015105702

EtherCAT® ist eine eingetragene Marke und patentierte Technolo-
gie, lizenziert durch die Beckhoff Automation GmbH.
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1.1.3 Haftungsbeschränkungen
Die in dieser Bedienungsanleitung beschriebene Software wird je
nach Anwendungsbestimmungen mit einer bestimmten Konfigurati-
on von Hardwarekomponenten kombiniert. Umbauten und Änderun-
gen der Konfiguration von Hardware oder Software, die über die do-
kumentierten Möglichkeiten hinausgehen, sind verboten und führen
zum Haftungsausschluss der Beckhoff Automation GmbH & Co. KG.

Folgendes wird aus der Haftung ausgeschlossen:
• Nichtbeachtung dieser Betriebsanleitung
• Nichtbestimmungsgemäße Verwendung
• Einsatz von nicht ausgebildetem Fachpersonal
• Verwendung nicht zugelassener Ersatzteile

1.1.4 Copyright
© Beckhoff Automation GmbH & Co. KG, Deutschland
Die Weitergabe sowie Vervielfältigung dieses Dokuments, Verwer-
tung und Mitteilung seines Inhalts sind verboten, soweit nicht aus-
drücklich gestattet. Zuwiderhandlungen verpflichten zu Schadener-
satz. 
Wir behalten uns alle Rechte für den Fall der Eintragung der Paten-
te, Gebrauchsmuster und Geschmacksmuster vor.
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1.2 Ausgabestände

Bereitstellung Ausgabestände
Auf Anfrage erhalten Sie eine Auflistung der Ausgabestände zu Än-
derungen in der Dokumentation.
• Anfrage senden an: motion-documentation@beckhoff.de
Dokumentenursprung
Diese Dokumentation ist in deutscher Sprache verfasst. Alle weite-
ren Sprachen werden von dem deutschen Original abgeleitet.

Produkteigenschaften
Gültig sind immer die Produkteigenschaften, die in der aktuellen Do-
kumentation angegeben sind. Weitere Informationen, die auf den
Produktseiten der Beckhoff Homepage, in E-Mails oder sonstigen
Publikationen angegeben werden, sind nicht maßgeblich.

1.3 Dokumentationsumfang
Neben dieser Dokumentation sind folgende Dokumente Bestandteil
der Gesamtdokumentation:

Handbuch | TF5410
Beschreibung des optionalen Pakets zur Kollisionsvermeidung beim
Betreiben mehrerer Achsen.

Direktlink zur Dokumentation TF5410 | TwinCAT 3 Motion
Collision Avoidance

Original-Betriebsanleitung | XTS
Beschreibung der mechanischen und elektrischen Kenngrößen so-
wie aller notwendigen Informationen für die Montage des XTS Sys-
tems.

https://www.beckhoff.com/en-en/support/download-finder/search-result/?download_group=339413613
https://www.beckhoff.com/en-en/support/download-finder/search-result/?download_group=339413613
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1.4 Symbolerklärung
Für eine übersichtliche Gestaltung werden verschiedene Symbole
verwendet:

► Das Dreieck zeigt eine Handlungsanweisung, die Sie ausfüh-
ren sollen

 • Der Punkt zeigt eine Aufzählung

1.4.1 Piktogramme

HINWEIS
Hinweise
Für wichtige Informationen zu dem Produkt werden Hinweise ver-
wendet. Werden diese nicht beachtet, sind mögliche Folgen:
• Funktionsfehler an dem Produkt
• Schäden an dem Produkt
• Schäden an der Umwelt

Informationen
Dieses Zeichen zeigt Informationen, Tipps und Hinweise für den
Umgang mit dem Produkt oder der Software.

Beispiele
Dieses Zeichen zeigt Beispiele für den Umgang mit dem Produkt
oder der Software.
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1.5 Beckhoff Services
Beckhoff und die weltweiten Partnerfirmen bieten einen umfassen-
den Support und Service.

1.5.1 Support
Der Beckhoff-Support bietet Ihnen technische Beratung bei dem
Einsatz einzelner Beckhoff-Produkte und Systemplanungen. Die
Mitarbeiter unterstützen Sie bei der Programmierung und Inbetrieb-
nahme komplexer Automatisierungssysteme.

Hotline: +49(0)5246/963-157
Fax: +49(0)5246/963-199
E-Mail: support@beckhoff.com
Web: www.beckhoff.de/support

1.5.2 Training
Schulungen in Deutschland finden in dem Schulungszentrum der
Unternehmenszentrale in Verl, den Niederlassungen oder nach Ab-
sprache bei den Kunden vor Ort statt.

Hotline: +49(0)5246/963-5000
Fax: +49(0)5246/963-95000
E-Mail: training@beckhoff.com
Web: www.beckhoff.de/training

1.5.3 Service
Das Beckhoff Service-Center unterstützt Sie rund um den After-Sa-
les-Service wie Vor-Ort-Service, Reparaturen oder Ersatzteilservice.

Hotline: +49(0)5246/963-460
Fax: +49(0)5246/963-479
E-Mail: service@beckhoff.com
Web: www.beckhoff.de/service

1.5.4 Downloadbereich
Im Downloadbereich erhalten Sie Produktinformationen, Software-
Updates, die Software TwinCAT, Dokumentationen und vieles mehr.

Web: www.beckhoff.de/download

1.5.5 Firmenzentrale
Beckhoff Automation GmbH & Co. KG
Hülshorstweg 20
33415 Verl
Deutschland

Telefon: +49(0)5246/963-0
Fax: +49(0)5246/963-198
E-Mail: info@beckhoff.com
Web: www.beckhoff.de

Die Adressen der weltweiten Beckhoff Niederlassungen entnehmen
Sie der Internetseite: http://www.beckhoff.de

http://www.beckhoff.de
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2 Zu Ihrer Sicherheit
Lesen Sie dieses Kapitel mit den allgemeinen Sicherheitshinweisen.
Beachten Sie in jedem Fall die Sicherheitshinweise für Ihre eigene
Sicherheit, die Sicherheit anderer Personen und die Sicherheit des
Produktes.
Bei der Arbeit mit Produkten in der Steuerungstechnik und Automa-
tisierung können aus unachtsamer und falscher Anwendung viele
Gefahren resultieren. Arbeiten Sie besonders sorgfältig, nicht unter
Zeitdruck und verantwortungsbewusst gegenüber anderen Perso-
nen.

2.1 Allgemeine Sicherheitshinweise
In diesem Kapitel erhalten Sie Hinweise zur Sicherheit für den Um-
gang mit der Software und den damit verbundenen und eingesetz-
ten Produkten. Lesen Sie auch die Original-Betriebsanleitung zu
den von Ihnen verwendeten Hardwarekomponenten.

2.1.1 Vor dem Betrieb
Gefahr durch magnetische Felder
Durch magnetische Felder an einzelnen Komponenten des XTS be-
steht Gefahr für:
• Personen mit Herzschrittmachern
• Personen mit magnetisch leitenden Implantaten
• Implantierte und externe Defibrillatoren
• Magnetische Datenträger, Chipkarten mit Magnetstreifen und

andere elektronische Geräte

Gewährleisten Sie einen Sicherheitsabstand zu allen magnetischen
Teilen und verhindern Sie direkten Kontakt zwischen magnetischen
und störungsempfindlichen Teilen.
Beachten Sie die Anforderungen der BGV B 11 für elektromagneti-
sche Felder und geltende, nationale Bestimmungen in anderen Län-
dern.

Ausgangsspannungen SELV / PELV verwenden
Betreiben Sie alle Elektronikbaugruppen und Komponenten im An-
triebssystem nur mit einer Ausgangsspannung SELV, Safety Extra
Low Voltage, oder PELV, Protective Extra Low Voltage.

Näheres Umfeld sauber halten
Halten Sie Ihren Arbeitsplatz und das nähere Umfeld sauber. Ge-
währleisten Sie ein sicheres Arbeiten.

Maschine oder Anlage stillsetzen und sichern
Setzen Sie die Maschine oder Anlage still. Sichern Sie die Maschine
oder Anlage gegen eine versehentliche Inbetriebnahme.
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Keine beschädigten Komponenten verwenden
Halten Sie bei Lagerung, Transport und Betrieb die Vorgaben aus
den Technischen Daten ein. Verwenden Sie keine beschädigten
Komponenten.

Verletzungsgefahr beim Umgang mit Schneidwerkzeugen
Beim unachtsamen Arbeiten mit Schneidwerkzeugen können Sie
sich durch Schnitte oder Stiche verletzen.
Gewährleisten Sie sicheres Arbeiten. Wenn nötig, tragen Sie
Schutzhandschuhe.

Verletzungsgefahr beim Umgang mit Klebstoff
Klebstoff kann die Augen, die Atmungsorgane und die Haut reizen.
Atmen Sie den Dampf nicht ein. Vermeiden Sie die Berührung des
Klebstoffs mit den Augen und der Haut. Sollte dennoch Klebstoff in
die Augen gelangen, waschen Sie die Augen sofort gründlich mit
Wasser aus und suchen Sie einen Arzt auf.
Beachten Sie beim Umgang mit Klebstoff die Dokumentation des
Herstellers. Wenn nötig, Schutzhandschuhe und Schutzbrille tragen.

Sicherheitsbildzeichen prüfen
Prüfen Sie, ob sich die Bildzeichen am Produkt befinden. Ersetzen
Sie fehlende oder unleserliche Aufkleber.

Anzugsdrehmomente beachten
Montieren und überprüfen Sie wiederkehrend Anschlüsse und Kom-
ponenten unter Einhaltung der vorgeschriebenen Anzugsdrehmo-
mente.

Elektrische Komponenten oder Baugruppen richtig erden
Vermeiden Sie Stromschläge durch eine nicht ordnungsgemäße Er-
dung von elektrischen Komponenten oder Baugruppen. Erden Sie
alle leitfähigen Komponenten nach den Vorgaben aus den Kapiteln:
„Elektrische Installation“ und „Mechanische Installation“.

Nur Original-Verpackung nutzen
Verwenden Sie beim Versenden, Transportieren, Lagern und Verpa-
cken die Original-Verpackung oder nicht leitfähige Materialien.

2.1.2 Im Betrieb
Erdungskonzept beachten
Bei der Erdung des XTS beachten Sie besondere Bedingungen. Le-
sen Sie dazu in jedem Fall das Kapitel: „Erdung der Einspeisung“.

Nicht an elektrischen Teilen unter Spannung arbeiten
Stellen Sie einen ordnungsgemäßen Anschluss des Schutzleiters si-
cher. Lösen Sie elektrische Anschlüsse nie unter Spannung. Arbei-
ten Sie erst am XTS, wenn die Spannung auf < 10 V abgesunken
ist. Trennen Sie alle Komponenten vom Netz und sichern Sie diese
gegen Wiedereinschalten.

Heiße Oberflächen nicht berühren
Kontrollieren Sie die Abkühlung der Oberflächen mit einem Thermo-
meter. Berühren Sie nicht die Komponenten während und direkt
nach dem Betrieb. Lassen Sie die Komponenten nach dem Abschal-
ten ausreichend abkühlen.
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Überhitzung vermeiden
Betreiben Sie die Komponenten unter den technisch vorgesehenen
Spezifikationen. Beachten Sie hierzu das Kapitel: „Technische Da-
ten“. Stellen Sie eine ausreichende Kühlung her. Schalten Sie die
Komponenten bei zu hoher Temperatur sofort ab.

Keine Komponenten in Bewegung oder Rotation berühren
Berühren Sie keine Teile in Bewegung oder Rotation. Stellen Sie
einen festen Sitz aller an der Maschine oder Anlage befindlichen
Bauteile oder Komponenten her.

2.1.3 Nach dem Betrieb
Vor Arbeiten an Komponenten den energielosen und span-
nungsfreien Zustand herstellen
Prüfen Sie alle sicherheitsrelevanten Einrichtungen auf die Funktio-
nalität. Sichern Sie die Arbeitsumgebung. Sichern Sie die Maschine
oder Anlage gegen eine versehentliche Inbetriebnahme. Beachten
Sie das Kapitel: „Außerbetriebnahme“.
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3 Hinweise zur Informationssicherheit
Die Produkte der Beckhoff Automation GmbH & Co. KG sind, sofern
sie online zu erreichen sind, mit Security-Funktionen ausgestattet,
die den sicheren Betrieb von Anlagen, Systemen, Maschinen und
Netzwerken unterstützen. Trotz der Security-Funktionen sind die Er-
stellung, Implementierung und ständige Aktualisierung eines ganz-
heitlichen Security-Konzepts für den Betrieb notwendig, um die je-
weilige Anlage, das System, die Maschine und die Netzwerke gegen
Cyber-Bedrohungen zu schützen. Die von Beckhoff verkauften Pro-
dukte bilden dabei nur einen Teil des gesamtheitlichen Security-
Konzepts. Der Kunde ist dafür verantwortlich, dass unbefugte Zu-
griffe durch Dritte auf seine Anlagen, Systeme, Maschinen und
Netzwerke verhindert werden. Letztere sollten nur mit dem Unter-
nehmensnetzwerk oder dem Internet verbunden werden, wenn ent-
sprechende Schutzmaßnahmen eingerichtet wurden.
Beckhoff empfiehlt folgende Schutzmaßnahmen zur Informationssi-
cherheit und Industrial Security:

www.infosys.beckhoff.com

Die Produkte und Lösungen von Beckhoff werden ständig weiterent-
wickelt. Dies betrifft auch die Security-Funktionen. Aufgrund der ste-
tigen Weiterentwicklung empfiehlt Beckhoff ausdrücklich, die Pro-
dukte ständig auf dem aktuellen Stand zu halten und nach Bereit-
stellung von Updates diese auf die Produkte aufzuspielen. Die Ver-
wendung veralteter oder nicht mehr unterstützter Produktversionen
kann das Risiko von Cyber-Bedrohungen erhöhen. Um stets über
Hinweise zur Informationssicherheit zu Produkten von Beckhoff in-
formiert zu sein, abonnieren Sie den RSS Feed. Weitere Informatio-
nen dazu finden Sie unter:

www.infosys.beckhoff.com

https://infosys.beckhoff.com/content/1031/ipc_security/976055435.html
https://infosys.beckhoff.com/content/1031/ipc_security/976057355.html
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4 Allgemeine Informationen
Die vorliegende Bedienungsanleitung hilft Ihnen bei der Inbetrieb-
nahme und Programmierung eines XTS Systems.
Die folgenden Kapitel leiten Sie durch die Basiskonfiguration der
XTS Hardwarekomponenten in TwinCAT 3, sodass Sie die XTS Mo-
ver über die grundlegende NC Schnittstelle fahren und in der PLC
programmieren können. Das Ziel ist das erste Verfahren der XTS
Mover und die Überprüfung des Systemkonzepts. Des Weiteren er-
halten Sie einen ersten Überblick über alle XTS Funktionalitäten der
TF5850 TC3 XTS Extension.

Die Dokumentation der TF5850 TC3 XTS Extension befindet sich
derzeit noch im Aufbau und wird laufend erweitert. Die aktuelle Ver-
sion dieser Bedienungsanleitung finden Sie unter:

www.beckhoff.com/de-de/support/downloadfinder/

4.1 Kompatibilität
Diese Dokumentation bezieht sich auf folgende Softwareversionen
der TF5850 TC3 XTS Extension, TF5400 TC3 Advanced Motion
Pack Extension und TwinCAT 3:

Software Version
TF5850 3.21.703.0 oder höher
TF5400 3.1.10.52 oder höher
TC3 3.1.4024.22 oder höher

Zur Inbetriebnahme von XTS Systemen mit älteren Softwareversio-
nen ist diese Dokumentation nur bedingt geeignet. Bei Fragen kon-
taktieren Sie den für Ihre Region zuständigen Produktspezialisten.

4.2 Darstellung der Screenshots
Für diese Dokumentation wurde die Spracheinstellung Englisch in
TwinCAT verwendet. Sämtliche Screenshots werden in dieser Do-
kumentation exemplarisch in englischer Sprache dargestellt. In den
dazugehörigen Handlungsanweisungen werden die Begriffe aus den
Screenshots verwendet.
Sämtliche Funktionen und Einstellungen sind unabhängig von der
eingestellten Sprache auf Ihrem PC an derselben Stelle in der Soft-
ware zu finden.

https://www.beckhoff.com/de-de/support/downloadfinder/suchergebnis/?c-1=26779659
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4.3 Übersicht Benutzeroberfläche
Die Benutzeroberfläche von TwinCAT ist in folgende Bereiche auf-
geteilt:

1 2 3 4 5 6

7 8

Position Erläuterung
1 Solution Explorer
2 Menüleiste
3 Projektfenster
4 Symbolleiste
5 XTS Tool Window
6 Toolbox oder Properties Window
7 Meldungsfenster Error List und Output
8 Informationsleiste und Statusleiste
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5 Installation und Software-Update
Bevor Sie ein XTS System in Betrieb nehmen können, müssen Sie
zunächst die Software TF5850 | TwinCAT 3 XTS Extension installie-
ren. Die folgenden Schritte sind auch bei einem Update auf die
neueste Version von TF5850 | TwinCAT 3 XTS Extension erforder-
lich.
Wenn Sie bereits eine Softwareversion installiert haben, überprüfen
Sie, ob Sie die neueste Version installiert haben. Weitere Informatio-
nen dazu finden Sie im Kapitel „Versionsstand überprüfen“, [Seite
 22].

Als Voraussetzung für die Installation muss auf Ihrem System be-
reits eine Version von TwinCAT 3 XAE (TcXaeShell oder höher) vor-
handen sein.

Die jeweils aktuelle Version der Software finden Sie im Downloadfin-
der:

www.beckhoff.com/de-de/support/downloadfinder/

► Software TF5850 | TwinCAT 3 XTS Extension herunterladen
und speichern

► Doppelklick auf das Symbol TF5850-XTS-Technology auf Ihrem
Desktop

Die Installation wird gestartet.

► Auf Yes klicken, um Änderungen an dem Gerät zuzulassen

► Die gewünschte Installationssprache im Dropdown-Menü aus-
wählen

► Auswahl mit OK bestätigen

https://www.beckhoff.com/de-de/support/downloadfinder/suchergebnis/?c-1=26782567
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Die Installation wird vorbereitet.

► Auf Next > klicken, um mit der Installation fortzufahren
► Auf Next > klicken, um mit der Installation fortzufahren

► Den Lizenzvereinbarungen zustimmen
► Bei Bedarf auf Print klicken, um die Lizenzvereinbarungen aus-

zudrucken
► Auf Next > klicken, um mit der Installation fortzufahren

► In das Eingabefeld User Name den Benutzernamen eingeben
► In das Eingabefeld Organization den Firmennamen eingeben
► Auf Next > klicken, um mit der Installation fortzufahren

► Setup Type Complete auswählen
► Auf Next > klicken, um mit der Installation fortzufahren
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► Mit Install bestätigen

Das Programm wird installiert.

► Auf Finish klicken

► Auf Yes klicken, um das Gerät neu zu starten und die Änderun-
gen zu übernehmen

Wenn Sie ein Update der Software TF5850 | TwinCAT 3 XTS Exten-
sion durchgeführt haben, müssen Sie die TcCom-Objekte neu la-
den. Weitere Informationen dazu finden Sie im Kapitel „TcCom-Ob-
jekte neu laden“, [Seite 23].
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5.1 Versionsstand überprüfen

Betriebssystem beachten
Das Aufrufen des Versionsstandes ist abhängig vom installierten
Betriebssystem auf Ihrem Gerät und kann von der hier beschriebe-
nen Variante abweichen.

► Auf Start klicken
► Die Systemsteuerung aufrufen

Das Fenster Control Panel öffnet sich.
► Auf Programs klicken

Das Fenster Programs öffnet sich.
► Auf Programs and Features klicken

Das Fenster Programs und Features öffnet sich.
► Den Versionsstand von Beckhoff TF5850 TC3 XTS Technolo-

gy überprüfen
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5.2 TcCom-Objekte neu laden
Wenn Sie ein Update der Software TF5850 | TwinCAT 3 XTS Exten-
sion durchgeführt haben, müssen Sie die TcCom-Objekte neu la-
den.

► Solution Explorer > TwinCAT Project > SYSTEM ausklappen
► Doppelklick auf TcCOM Objects

► Im Projektfenster den Reiter Project Objects anklicken
► Alle Objekte markieren
► Mit der rechten Maustaste auf die ausgewählten Objekte klicken,

um das Kontextmenü aufzurufen
► Im Kontextmenü auf Reload TMI/TMC Description(s) klicken
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6 Funktionen des Treibers

6.1 XTS Konfiguration
Das XTS System besteht aus Hardwarekomponenten und Software-
komponenten, die miteinander kommunizieren und zusammen funk-
tionieren müssen. Damit sich das System wie erwartet verhält, müs-
sen Sie die generellen Prozesse und die Kommunikationswege zwi-
schen Software und Hardware verstehen.
Ein XTS System besteht aus den Modulen, Führungsschienen und
Movern sowie einigen Softwarekomponenten, die auf einem IPC
laufen.

Kommunikationsebenen

SPS-ProgrammSPS

NC
TF5410* 

MC KommandosNC Daten

SoftDrive

XTS Treiber
(XTS Processing Unit / XTS IO Driver)

XTS Modul

XTS
TF5850 

IO 

Mover 
Strom-Sollwerte

Spulen 
Sollstrom

 Feedback 
Senso werter

Mover 
Position-Istwerte

Sollwerte
(Pos., Vel., Acc.)

Istwerte
(Pos., Vel., Acc.)

NC Achse
Collision 

Avoidance Group*

CA-Group 
Daten

CA-Group 
Kommandos

AXES_GROUP_REF*AXIS_REF

CoE 
Status/Control

CoE 
Status/Control

CoE 
Status/Control

NC-Daten

CA Bewegungsprofil

* Optional
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Die Grundlage der Kommunikation bildet die Hardware, bestehend
aus den Modulen. Die Module übermitteln Sensorwerte an den Trei-
ber.
Der Treiber benutzt die Sensorwerte der Module zur Positionsbe-
stimmung der Mover und übermittelt die Positionswerte jedes einzel-
nen Movers an den jeweiligen SoftDrive.
Der SoftDrive übermittelt die aktuellen Positionswerte und Ge-
schwindigkeitswerte an die NC-Achsen. Die NC-Achsen erzeugen
Bewegungsprofile auf Basis der erhaltenen Werte und übermitteln
Sollwerte für die Position und die Geschwindigkeit zurück an den
SoftDrive.
Der SoftDrive interpoliert die Werte und führt einen Soll-Ist-Wertab-
gleich durch und übermittelt die sich aus der Regelstruktur ergebe-
nen Stromwerte des Movers zurück an den Treiber. Der Treiber be-
rechnet und übermittelt die Stromsollwerte an die 15 Spulen der Mo-
dule.
Wenn die NC-Achsen in eine Collision Avoidance-Gruppe eingebun-
den sind, erhalten die NC-Achsen externe Sollwerte zurück, die das
Bewegungsprofil jedes einzelnen Movers darstellen.
Fahrkommandos und administrative Kommandos werden vom An-
wender aus der SPS-Applikation über Bibliotheken direkt an die NC-
Achsen oder die Collision Avoidance-Gruppe übergeben.
Die Kommunikation des XTS basiert auf und erfolgt über die
CANopen-Kommunikationsstruktur. Zusätzliche Daten werden zwi-
schen den Objekten übertragen, um den Spulenstrom, die Kommu-
tation, die Dynamik und die Bewegungsprofile zu berechnen.
Weitere Informationen zu den einzelnen Objekten finden Sie in den
jeweiligen Dokumentationen.

6.1.1 Integration des XTS Treibers
Das XTS System besteht softwareseitig aus mehreren Komponen-
ten, die als TwinCAT Component-Objekt, kurz TcCom-Objekt, in ein
TwinCAT-Projekt eingefügt werden. Jedes Modul und jeder Mover
benötigt ein entsprechendes Treiber TcCom-Objekt, über dessen
Schnittstellen Daten mit anderen Komponenten ausgetauscht wer-
den:
• Das TcCom-Objekt Modul verfügt über Data Pointers. Diese Da-

ta Pointers sind Schnittstellen, die mit den Prozessdaten der
XTS IO Module verknüpft werden. Über die Data Pointers erhält
das TcCom-Objekt Modul die Sensorwerte des Moduls.

• Das TcCom-Objekt Mover verfügt über Data Areas. Diese Data
Areas sind Schnittstellen zu dem entsprechenden SoftDrive-Ob-
jekt, das unter jeder NC-Achse angelegt ist. Über die Data Areas
erhält das TcCom-Objekt Mover neue Stromsollwerte und liefert
die aktuelle Position über den SoftDrive an die NC-Achse.

Neben den TcCom-Objekten Modul und Mover benötigt das System
noch weitere TcCom-Objekte, um allgemeine Systemberechnungen
durchzuführen und um grundlegende Systemparameter zu verwal-
ten. Weitere Informationen dazu finden Sie in den Kapiteln „Konfigu-
rationsaufbau“, [Seite  29] und „Neues XTS System manuell anle-
gen“, [Seite 39].
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6.1.2 Grundlagen
Die Bedienoberfläche der XTS Software vereinfacht die Arbeit und
den Umgang mit den immer größeren und komplexeren Systemen,
die mit XTS umgesetzt werden. Der einfache bildliche Aufbau trägt
entscheidend zu einer schnellen Inbetriebnahme und einer intuitiven
Arbeitsweise bei. Eine große Anzahl an XTS Systemen kann nun
unabhängig von der Länge, der Form oder der Variante sehr einfach
eingerichtet werden.
Ein Hauptziel der XTS Software ist die Unterstützung der verschie-
denen Softwarefunktionalitäten wie beispielsweise Track Manage-
ment oder Leave and Arrive:
• Mithilfe der Track Management-Funktion können Sie das XTS

System in einzelne Abschnitte aufteilen, die Sie dann zu fortlau-
fenden Strecken zusammenfügen können. Das gibt Ihnen die
Möglichkeit einzelne Abschnitte auf unterschiedliche Weise me-
chanisch auszurichten und somit die Mover flexibler auf dem
System einzusetzen.

• Mithilfe der Leave and Arrive-Funktion können Sie im laufenden
System Mover herausnehmen oder weitere Mover hinzufügen.

6.1.2.1 Beispielkonfigurationen für XTS Systeme
Die beiden Beispielkonfigurationen zeigen, wie unterschiedlich ein
XTS System aufgebaut werden kann.

Geschlossenes XTS System

Ein geschlossenes System mit 180° Kurven und zehn Movern, ent-
sprechend der Konfiguration eines 3 m XTS Starterkits.
Weitere Informationen dazu finden Sie im Kapitel „System konfigu-
rieren“, [Seite 263].

XTS System mit Track Management

Ein XTS System mit Track Management mit vier XTS Parts und
sechs Movern. Dieser Aufbau wird meistens als Weiche oder Auf-
zug bezeichnet.
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Der Unterschied zwischen diesen beiden Systemkonfigurationen be-
steht darin, dass bei einem geschlossenem XTS System die Rei-
henfolge der Module und Mover immer konstant bleibt. Die Mover
haben somit nur einen möglichen XTS Track, auf dem sie sich be-
wegen können.
Bei einem XTS System mit Track Management können die Module
ihre Position verändern und sich an anderen Modulen ausrichten.
Somit ist die Reihenfolge der Module und Mover veränderbar, da
neue Strecken gebildet werden können. Um den Überblick über die-
se neuen Funktionen behalten zu können, wurden die Funktionen
XTS Parts und XTS Tracks eingeführt.

Part 1

Part 1

Track 1 

6

1
2

3 4
11 10 9

8
7

5

Der XTS Part ist im Prinzip die physische Hardwarekomponente auf
der der Mover fährt, vergleichbar mit einem Straßenabschnitt für ein
Auto. Der XTS Track hingegen ist die tatsächliche Strecke, die der
Mover nimmt. Die Strecke entsteht, indem die einzelnen Hardware-
komponenten zusammengefügt werden. Im Vergleich mit dem Auto
wird sozusagen eine mögliche Strecke mit verschiedenen Straßen-
abschnitten erschaffen.
XTS Parts und XTS Tracks sind Objekte, die mithilfe des XTS Confi-
gurators im TwinCAT-Projekt angelegt werden können. Ein einfa-
ches System kann dabei mit nur einem XTS Part und einem XTS
Track für alle Mover angelegt werden.

16

Part 5
Track 2

Part 1

Track 1
Part 3

Part 2
Part 4

P

5
8

9

12

7 6
11

1
2 10

3 4

Komplexere XTS Systeme können aus mehreren XTS Parts beste-
hen, die zu verschiedenen XTS Tracks zusammengefügt werden.
Im Vergleich mit dem Auto wird zwischen zwei möglichen Strecken
eine Autofähre eingesetzt.



Funktionen des Treibers

28 ─── Version: 1.1.1TF5850
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LAGERXTS System

Mit der Leave and Arrive-Funktion ist es möglich, dass einzelne Mo-
ver vom System genommen oder weitere Mover auf das System ge-
bracht werden können. Im Vergleich mit dem Auto dient der zusätzli-
che Straßenabschnitt dabei als Einfahrt und Ausfahrt. Außerhalb der
XTS Parts gibt es Parkplätze für nicht genutzte Autos, Neuwagen-
händler mit zusätzlichen Autos und Werkstätten für defekte Autos.
Übertragen auf das XTS System bedeutet es, dass Sie beispielswei-
se:
• Mover für Wartungsarbeiten entnehmen können,
• bei Bedarf neue Mover hinzufügen können,
• nicht mehr benötigte Mover entnehmen können.
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6.1.3 Konfigurationsaufbau

Manuelles Anlegen oder Verwendung von TwinCAT Tools
Sie haben die Möglichkeit die Hardwarekomponenten und die
IO‑Komponenten manuell oder schnell und einfach über die
TwinCAT Tools XTS Configurator und XTS Simulation Builder anzu-
legen. Weitere Informationen dazu den TwinCAT Tools finden Sie in
den Kapiteln „XTS Configurator“, [Seite  260] und „XTS Simulation
Builder“, [Seite 231].
Konfigurator ersetzt den XTS Manager
Der Konfigurator ersetzt den XTS Manager, der in den Softwarever-
sionen, bis Version 3.18.715.0, im XTS IO  Driver-Objekt integriert
war. Weitere Informationen dazu finden Sie im Kapitel „Kompatibili-
tätsmodus“, [Seite 71].

Bevor Sie ein XTS System nutzen können, muss es zunächst mit al-
len IO-Komponenten und allen Einstellungen von Real Time und
Distributed Clock vollständig konfiguriert werden.
Die wichtigsten Schritte bei der Konfiguration eines Systems sind
folgende:
• XTS Processing Units
• XTS Parts
• XTS Modules
• XTS Tracks
• XTS Movers
• XTS Stations
• NC-Achse
• SoftDrive
• IO-Terminal
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6.1.3.1 XTS Processing Units
Die Processing Unit ist das Zentrum eines XTS Systems. In der Pro-
cessing Unit laufen alle erforderlichen Objekte zusammen und wer-
den logisch miteinander verknüpft.

Die XTS Processing Unit ersetzt das XTS IO Driver-Objekt der frü-
heren Softwareversion.

Sie können eine oder mehrere Processing Units anlegen, je nach
Anzahl der einzelnen Systeme, die in der Maschine verwendet wer-
den. Jede Processing Unit benötigt mindestens eine Task, die nicht
in anderen Processing Units verwendet wird.

Part

Processing Unit

Track Mover

Benötigte Einstellungen:
• Task
• OperationMode
• MoverType
• MagnetPlateType
• IdDetectionMode
• IsTeachingEnabled

Optionale Einstellungen:
• MoverSortOrder
• MinMechanicalMoverDistance
• alle weiteren Parameter
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6.1.3.2 XTS Parts
Ein Part ist die mindestens erforderliche Komponente eines XTS
Systems. Der kleinste mögliche Part ist ein einzelnes Modul. Nor-
malerweise besteht ein Part aus einem Einspeisestrang, aber auch
mehrere Einspeisungen innerhalb eines Parts sind möglich.
Während des manuellen Anlegens in der korrekten Reihenfolge,
wird festgelegt, welche IO Devices enthalten sind und zu welcher
Processing Unit der Part gehört.
Die optionalen Einstellungen dienen dazu, die Ansicht im XTS Sys-
tem View so realistisch wie möglich darzustellen.

Motormodul

Part

Modul

Modul

...

Modul

...

Modul

Modul
mit Einspeisung

Modul
mit Einspeisung

 
 3 

m
≤

 
 3 

m
≤

...

Benötigte Einstellungen:
• keine

Optionale Einstellungen:
• TaskOID
• ModuleSide
• OriginTransform
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6.1.3.3 XTS Modules
Ein Modul entspricht einem physischen Modul AT2xxx‑0xxx und ist
immer ein untergeordnetes Objekt eines Parts.
Jedem Modul muss im Reiter Context eine Task zugewiesen wer-
den, um aktive Berechnungen ausführen zu können. Nur Module mit
Einspeisung und Module mit Steckverbinder verfügen über
EtherCAT-Kommunikationsschnittstellen. Mithilfe von Connector-
Karten wird die EtherCAT-Kommunikation zu anderen Modulen her-
gestellt.

Simulationsbetrieb oder Maschinenbetrieb
Für den Simulationsbetrieb des Treibers wird keine Hardware benö-
tigt.
Für den realen Maschinenbetrieb muss jedem Modul ein physisches
Modul AT2xxx-0xxx zugeordnet werden.

Jedem Modul muss eine entsprechende Hardwarekomponente zu-
geordnet werden.

Data Pointer

Modul

Data Pointer

Modul
mit Einspeisung

Benötigte Einstellungen:
• Task
• PositionIndex
• MotorTerminalOid
• SensorTerminalOid
• Verlinkung mit IO-Objekten

Optionale Einstellungen:
• Gap
• Offset
• ScalingFactor
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6.1.3.4 XTS Tracks
Ein Track ist eine mit Movern befahrbare Strecke, die aus einem
oder mehreren Parts besteht. Dabei kann ein Part auch mehr als
einmal in einem bestimmten XTS Track vorkommen oder auch in
mehrere unterschiedliche Tracks eingefügt werden. Sie können be-
liebig viele Tracks anlegen.
Um einen Track anzulegen, müssen Sie festlegen, welche Parts in
diesem Track enthalten sind und in welcher Reihenfolge die Parts
vorkommen.
Eine wichtige Einstellmöglichkeit ist die Angabe, ob der Track ge-
schlossen ist. Mit dieser Angabe legen Sie fest, ob die Mover die
Möglichkeit haben endlos im Kreis zu fahren oder ob das System
über Endpunkte verfügt.

HINWEIS
Schäden am Produkt und Funktionsfehler vermeiden
Achten Sie auf die korrekte Angabe, ob Sie ein geschlossenes
System oder ein System mit definierten Endpunkten konfigurie-
ren.
Ist die Angabe fehlerhaft, können bei einem offenen System die
Mover das System verlassen. Bei einem geschlossenen System
mit falscher Angabe können die Mover nicht wie gewohnt im
Kreis fahren.

Um beim Start des Systems die korrekte Anzahl an Movern festzu-
stellen, müssen Sie definieren, welche Tracks die Erkennung durch-
führen. Dabei ist es wichtig, dass jeder Part innerhalb eines Tracks
nur einmal im Erkennungsprozess vorkommt, da ansonsten mögli-
cherweise zu viele Mover angezeigt werden. Nutzen Sie am besten
alle Tracks zur Erkennung der Mover, die in Ihrer aktuellen Hardwa-
rekonfiguration aktiv sind. Das Einstellen der Erkennungsparameter
können Sie auch über die PLC vornehmen.

Benötigte Einstellungen:
• IsClosed
• IsIncludedInDetection
• PartConfigItems
• ObjectID

Optionale Einstellungen:
• Polarity
• Offset
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6.1.3.5 XTS Movers
Die Mover sind zusammen mit den Modulen die Hauptkomponenten
des XTS Systems. Die Mover fahren auf den Parts im System, in-
dem die entsprechenden Tracks mit Hilfe von NC-Funktionalitäten
von TwinCAT 3 aktiviert werden. Derzeit können 250 Mover mit Kol-
lisionsvermeidungsfunktion innerhalb eines Projektes gleichzeitig
gesteuert werden.
Jeder Mover ist mit einer NC‑Achse über den SoftDrive verbunden
und hat sein eigenes SoftDrive-Objekt, um mit der NC zu kommuni-
zieren und die Kompatibilität mit den grundlegenden Steuerbefehlen
herzustellen. Der SoftDrive ist ein Softwarecontroller für die Achsen,
der die Mover der untersten Ebene steuert. Das bedeutet, dass der
SoftDrive die Regelung der Mover an unterschiedliche Beladungen
anpassen kann.

Benötigte Einstellungen:
• Task
• Verlinkung mit dem SoftDrive der NC-Achsen
• SimulatedStartUpPart
• SimulatedStartUpPosition
• SimulatedStartUpId

Optionale Einstellungen:
• keine
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6.1.3.6 XTS Stations, Beta

Die Funktion XTS Stations befindet sich momentan noch in der Be-
taphase. Zukünftig werden noch mehr Funktionen und Informationen
verfügbar sein und auch das aktuelle Interface kann sich noch än-
dern.

Die Stations sind sehr nützlich, um das System und dazugehörige
Applikationen zu verwalten. Eine Station liefert Informationen dar-
über, wo einzelne Prozesse innerhalb des Systems stattfinden, um
so den Aufbau der gesamten Applikation zu veranschaulichen. Die
Informationen können auch mit Hilfe der XTS Utility in der PLC aus-
gelesen werden.
Jede Station hat ihre eigenen Kenndaten: ID, Farbe, Name und Be-
schreibung. Unabhängig von dem Auswahlfeld Is Enabled hat jede
Station eine definierte Startposition und Endposition. Diese Positio-
nen bilden den Rahmen der Station und können sich über mehrere
Parts erstrecken.
Innerhalb der Station können Sie Stopppositionen konfigurieren, die
anzeigen, an welcher Stelle die Mover stoppen sollen oder wo eine
bestimmte Aufgabe erfüllt wird.

Benötigte Einstellungen:
• Part
• Startposition
• Endposition

Optionale Einstellungen:
• alle weiteren Parameter
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6.1.3.7 NC-Achse
Jeder Mover ist mit einer NC-Achse verbunden, die das Sollwertpro-
fil für die Fahrbewegung des jeweiligen Movers erzeugt. Die NC-
Achse wird im Projekt unter MOTION angelegt und über ein Soft-
Drive-Objekt mit einem Mover verknüpft.
Über Bibliotheken mit PLC-open-konformen Bausteinen lassen sich
die NC-Achsen direkt über das TwinCAT NC-Interface oder über die
SPS bedienen.

Benötigte Einstellungen:
• Link to I/O
• Axis Type
• Maximal-Dynamiken und Default-Dynamiken
• Modulo Factor
• Tolerance Window for Modulo Start

Optionale Einstellungen:
• Invertierung von Drive-Laufrichtung und Encoder-Laufrichtung
• Schleppabstandsüberwachung
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6.1.3.8 SoftDrive
Der SoftDrive verbindet jeden Mover mit einer NC-Achse. Über das
NC-Sollwertprofil regelt der SoftDrive die Position, die Geschwindig-
keit und den Strom für das Verfahren der Mover und erzeugt die da-
für benötigte Stromgröße und Stromrichtung.
Der SoftDrive stellt der NC-Achse die benötigten Ist-Daten zur Er-
zeugung der NC-Profile bereit. Die Verbindung zwischen dem Soft-
Drive und dem jeweiligen Mover erfolgt über DataPointer.

Weitere Informationen zum SoftDrive finden Sie in der XTS Soft-
Drive Dokumentation oder kontaktieren Sie den für Ihre Region zu-
ständigen Produktspezialisten.

Benötigte Einstellungen:
• Task
• Verlinkung mit TcCom-Objekt Mover
• Hardware-Modulo

Optionale Einstellungen:
• Regelparameter für Geschwindigkeitsregler und Positionsregler
• Regelparameter für Beschleunigungsvorsteuerung
• Filter
• Einstellungen für das Verhalten des Encoders
• Umschalten von Regelmodi
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6.1.3.9 IO-Terminal
Jedes Modul wird über EtherCAT mit dem IPC verbunden, diese
Verbindung wird durch das IO-Terminal dargestellt. Jedem IO-Ter-
minal wird ein physikalisches Modul eines Einspeisestrangs zuge-
ordnet. Jeder Einspeisestrang wird als EtherCAT-Master in der IO-
Übersicht dargestellt.
Nach dem Einscannen lassen sich der Status der EtherCAT-Verbin-
dung sowie die einzelnen Sensordaten und Statusdaten der Hard-
ware in der IO-Übersicht aufrufen. Die Verbindung des IO-Terminals
mit dem Modul des Treibers erfolgt über DataPointer.

 IO-Terminal

Modul

Benötigte Einstellungen:
• Verlinkung zu TcCom-Objekten XTS Module

Optionale Einstellungen:
• Zugriff auf CoE-Daten
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6.1.4 Neues XTS System manuell anlegen

Manuelles Anlegen oder Verwendung von TwinCAT Tools
Sie haben die Möglichkeit die Hardwarekomponenten und die
TcCom-Objekte manuell oder schnell und einfach über die TwinCAT
Tools XTS Configurator und XTS Simulation Builder anzulegen.
Weitere Informationen dazu Sie in den Kapiteln „XTS Configurator“,
[Seite 260] und „XTS Simulation Builder“, [Seite 231].

In diesem Kapitel wird beschrieben, wie Sie Hardwarekomponenten
und TcCom-Objekte manuell und ohne die Hilfe von XTS Tools an-
legen.

6.1.4.1 TcCom-Objekte hinzufügen
Die TcCom-Objekte müssen in der folgenden Reihenfolge angelegt
werden:
• Processing Unit
• Part
• Module
• Track
• Mover

Beispielkonfiguration
Das Anlegen der XTS TcCom-Objekte wird beispielhaft für jedes
Objekt einmalig dargestellt. Wiederholen Sie die entsprechenden
Schritte so oft, bis die Sie Ihre gewünschte Konfiguration erstellt ha-
ben.
Achten Sie darauf, dass Sie zu jeder erstellten Processing Unit im-
mer alle weiteren TcCom-Objekte hinzufügen.

Processing Unit
► Solution-Explorer > TwinCAT Project > SYSTEM ausklappen
► Mit der rechten Maustaste auf TcCOM Objects klicken, um das

Kontextmenü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert TcCOM Object öffnet sich.
► Beckhoff Automation GmbH > XTS Modules ausklappen
► XtsProcessingUnit [Module] auswählen
► Doppelklick auf die Auswahl oder mit OK bestätigen
Eine Processing Unit wird zu den TcCom-Objekten hinzugefügt.
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Part
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCom Ob-

jects ausklappen
► Mit der rechten Maustaste auf Object (XtsProcessingUnit) kli-

cken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert TcCOM Object öffnet sich.
► Beckhoff Automation GmbH > XTS Modules ausklappen
► XtsPart [Module] auswählen
► In das Eingabefeld Multiple die Anzahl der benötigten Parts ein-

geben
► Doppelklick auf die Auswahl oder mit OK bestätigen
Ein oder mehrere Parts werden zur Processing Unit hinzugefügt.

Module
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (XtsProcessingUnit) ausklappen
► Mit der rechten Maustaste auf Object (XtsPart) klicken, um das

Kontextmenü aufzurufen
► Im Kontextmenü auf Add New Item… klicken
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Das Dialogfenster Insert TcCOM Object öffnet sich.
► Beckhoff Automation GmbH > XTS Modules ausklappen
► AT2xxx-0xxx [Module] auswählen
► In das Eingabefeld Multiple die Anzahl der benötigten Module

eingeben
► Doppelklick auf die Auswahl oder mit OK bestätigen
Ein oder mehrere Module werden zum Object (XtsPart) hinzugefügt.

Track
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCom Ob-

jects ausklappen
► Mit der rechten Maustaste auf Object (XtsProcessingUnit) kli-

cken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert TcCOM Object öffnet sich.
► Beckhoff Automation GmbH > XTS Modules ausklappen
► XtsTrack [Module] auswählen
► In das Eingabefeld Multiple die Anzahl der benötigten Tracks

eingeben
► Doppelklick auf die Auswahl oder mit OK bestätigen
Ein oder mehrere Tracks werden zur Processing Unit hinzugefügt.
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Mover
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCom Ob-

jects ausklappen
► Mit der rechten Maustaste auf Object (XtsProcessingUnit) kli-

cken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert TcCOM Object öffnet sich.
► Beckhoff Automation GmbH > XTS Modules ausklappen
► XtsMover [Module] auswählen
► In das Eingabefeld Multiple die Anzahl der benötigten Mover ein-

geben
► Doppelklick auf die Auswahl
ODER
► Mit OK bestätigen
Ein oder mehrere Mover werden zur Processing Unit hinzugefügt.
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InfoServer
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCom Ob-

jects ausklappen
► Mit der rechten Maustaste auf Object (XtsProcessingUnit) kli-

cken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert TcCOM Object öffnet sich.
► Beckhoff Automation GmbH > XTS Modules ausklappen
► XtsInfoServer [Module] auswählen
► In das Eingabefeld Multiple die Anzahl der benötigten InfoServer

eingeben
► Doppelklick auf die Auswahl oder mit OK bestätigen
Ein oder mehrere InfoServer werden zur Processing Unit hinzuge-
fügt.
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Stations
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCom Ob-

jects ausklappen
► Mit der rechten Maustaste auf Object (XtsProcessingUnit) kli-

cken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert TcCOM Object öffnet sich.
► Beckhoff Automation GmbH > XTS Modules ausklappen
► XtsStationInfo [Module] auswählen
► In das Eingabefeld Multiple die Anzahl der benötigten StationInfo

eingeben
► Doppelklick auf die Auswahl oder mit OK bestätigen
Ein oder mehrere StationInfos werden zur Processing Unit hinzuge-
fügt.
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6.1.4.2 Motion-Objekte hinzufügen
Die Motion-Objekte müssen in der folgenden Reihenfolge angelegt
werden:
• NC-Task
• NC-Achse
• SoftDrive

Beispielkonfiguration
Das Anlegen der Motion-Objekte wird beispielhaft für jedes Objekt
einmalig dargestellt. Wiederholen Sie die entsprechenden Schritte
so oft, bis Sie Ihre gewünschte Konfiguration erstellt haben.

NC-Task
► Solution-Explorer > TwinCAT Project ausklappen
► Mit der rechten Maustaste auf MOTION klicken, um das Kontext-

menü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert Motion Configuration öffnet sich.
► NC/PTP NCI Configuration auswählen
► Mit OK bestätigen
Eine NC-Task SAF wird hinzugefügt.

NC-Achse
► Solution-Explorer > TwinCAT Project > MOTION >

NC‑Task 1 SAF ausklappen
► Mit der rechten Maustaste auf Axes klicken, um das Kontextme-

nü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert NC Axis öffnet sich.
► Continuous Axis im Dropdown-Menü Type auswählen
► Mit OK bestätigen
Eine NC-Achse wird hinzugefügt.
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SoftDrive
► Solution-Explorer > TwinCAT Project > MOTION > NC‑Task SAF

> Axes ausklappen
► Mit der rechten Maustaste auf Axis klicken, um das Kontextme-

nü aufzurufen
► Im Kontextmenü auf Add klicken
► Im Untermenü auf Add Object(s)… klicken

Das Dialogfenster Insert TcCom Object öffnet sich.
► Beckhoff Automation GmbH > SoftDrive Modules ausklappen
► CTcSoftDrive [Module] auswählen
► Mit OK bestätigen
Ein SoftDrive-Objekt wird hinzugefügt.
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6.1.4.3 IO-Objekte hinzufügen

HINWEIS
Vorhandene XTS Hardware scannen
Wenn Sie Ihre vorhandene XTS Hardware verwenden möchten,
nutzen Sie die Scan-Funktion von TwinCAT, um Fehler bei der
Konfiguration zu vermeiden und um Zeit zu sparen. Weitere Infor-
mationen dazu finden Sie im Kapitel „XTS Configurator“, [Seite
 260].

XTS Simulation Builder verwenden
Mit dem XTS Simulation Builder haben Sie die Möglichkeit
IO‑Objekte anzulegen, um Zeit zu sparen. Weitere Informationen
finden Sie im Kapitel „XTS Simulation Builder“, [Seite 231]. 

Manuell konfigurieren
Wenn Sie die IO-Objekte manuell konfigurieren möchten, müs-
sen Sie darauf achten, dass Sie genau die Komponenten anle-
gen, die in Ihrem XTS System verbaut sind.

Die IO‑Objekte müssen in der folgenden Reihenfolge angelegt wer-
den:
• Real-Time Ethernet-Adapter
• EtherCAT Master
• CU2508 Ethernet Port
• XTS Modul
• XTS Sensorkanal

Real-Time Ethernet-Adapter
Mit dem Real-Time Ethernet-Adapter wird die physikalische Verbin-
dung zwischen den XTS Ethernet-Leitungen und dem IPC herge-
stellt.

Beispiel CU2508 Real-Time-Ethernet-Adapter
Das Hinzufügen eines Real-Time Ethernet-Adapters wird beispiel-
haft an einen CU2508 Adapter dargestellt. Zu dem CU2508 Adapter
können Sie vier EtherCAT Master hinzufügen. Je nach Anzahl der
EtherCAT Master müssen entsprechend viele Real-Time Ethernet-
Adapter hinzugefügt werden.
Sie haben die Möglichkeit andere Adapter hinzuzufügen. Beachten
Sie, dass sich diese Adapter in der Darstellungsform unterscheiden
und über weniger Anschlüsse verfügen.
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► Solution Explorer > TwinCAT Project > I/O ausklappen
► Mit der rechten Maustaste auf Devices klicken, um das Kontext-

menü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert Device öffnet sich.
► Ethernet ausklappen
► Real-Time Ethernet Adapter (Multiple Protocol Handler) aus-

wählen
► Bei Bedarf in das Eingabefeld Name einen Namen für den Real-

Time Ethernet-Adapter eingeben
► Mit OK bestätigen
Ein Device (RT-Ethernet Adapter) wird zu den I/O Devices hinzuge-
fügt.

EtherCAT Master
Für jeden Einspeisestrang wird ein EtherCAT Master unter den
IO‑Objekten benötigt. Sie können vier EtherCAT Master unter einem
Real-Time Ethernet-Adapter verwenden. Wenn Sie mehr als vier
EtherCAT Master verwenden, müssen Sie einen weiteren Real-Ti-
me Ethernet-Adapter zu den IO‑Objekten hinzufügen.

► Solution Explorer > TwinCAT Project > I/O ausklappen
► Mit der rechten Maustaste auf Devices klicken, um das Kontext-

menü aufzurufen
► Im Kontextmenü auf Add New Item… klicken
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Das Dialogfenster Insert Device öffnet sich.
► EtherCAT ausklappen
► EtherCAT Master auswählen
► Bei Bedarf in das Eingabefeld Name einen Namen für den

EtherCAT Master eingeben
► Mit OK bestätigen
Ein Device (EtherCAT) wird zu den IO-Objekten hinzugefügt.
Zu dem EtherCAT Master müssen ein CU2508 Ethernet Port und
die Module eines Einspeisestrangs hinzugefügt werden.

CU2508 Ethernet Port
Zu dem EtherCAT Master muss ein CU2508 Ethernet Port hinzuge-
fügt werden, bevor die Module hinzugefügt werden.

► Solution Explorer > TwinCAT Project > I/O > Devices ausklap-
pen

► Mit der rechten Maustaste auf Device (EtherCAT) klicken, um
das Kontextmenü aufzurufen

► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert Device öffnet sich.
► Beckhoff Automation GmbH & Co. KG > Ethernet Port Multiplier

(CU25xx) ausklappen
► CU2508 Ethernet Port auswählen
► Bei Bedarf in das Eingabefeld Name einen Namen für den

CU2508 Ethernet Port eingeben
► Mit OK bestätigen
Eine Box (CU2508) wird zu dem EtherCAT Master hinzugefügt.
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XTS Modul
Nachdem der CU2508 Ethernet Port zum EtherCAT Master hinzu-
gefügt wurde, müssen die Module des Einspeisestrangs hinzugefügt
werden.

Beispiel Modul mit Einspeisung
Da zunächst ein Modul mit Einspeisung zu dem EtherCAT Master
hinzugefügt werden muss, wird das Hinzufügen eines Moduls be-
spielhaft an einem Modul mit Einspeisung AT2001-0250 gezeigt.

Module mit Einspeisung sind mit with feed in der Auswahlliste ge-
kennzeichnet.

► Solution Explorer > TwinCAT Project > I/O > Devices ausklap-
pen

► Mit der rechten Maustaste auf Device (EtherCAT) klicken, um
das Kontextmenü aufzurufen

► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert Device öffnet sich.
► Beckhoff Automation GmbH & Co. KG > XTS ausklappen
► AT2001-0250 Motor module with feed 250 mm, 48 V auswäh-

len
► Bei Bedarf in das Eingabefeld Name einen Namen für das Modul

eingeben
► Mit OK bestätigen
Ein Term (AT2001-0250) wird zum EtherCAT Master hinzugefügt.
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XTS Sensorkanal
Zu jedem Modul muss ein Sensorkanal hinzugefügt werden.

Beispiel Sensorkanal für Modul mit Einspeisung
Das Hinzufügen eines Sensorkanals wird bespielhaft an einem
AT0250-5250 gezeigt, der zu einem Modul mit Einspeisung
AT2001-0250 gehört.

► Solution Explorer > TwinCAT Project > I/O > Devices > Device
(EtherCAT) ausklappen

► Mit der rechten Maustaste auf Term (AT2001-0250) klicken, um
das Kontextmenü aufzurufen

► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert Device öffnet sich.
► Beckhoff Automation GmbH & Co. KG > XTS ausklappen
► AT2001-5250 Sensor line with feed auswählen
► Bei Bedarf in das Eingabefeld Name einen Namen für den Sen-

sorkanal eingeben
► Mit OK bestätigen
Ein Term (AT2001-5250) wird zu dem Modul Term (AT2001-0250)
hinzugefügt.

Nachdem der Sensorkanal zu dem Modul mit Einspeisung hinzuge-
fügt wurde, können alle weiteren Module des Einspeisestrangs zu
dem EtherCAT Master hinzugefügt werden.
► Alle weiteren Module des Einspeisestrangs mit einem entspre-

chenden Sensorkanal auf die gleiche Weise hinzufügen
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6.1.4.4 TcCom-Objekte verlinken
Nachdem alle Objekte angelegt wurden, müssen noch einige Verlin-
kungen erstellt werden, um Daten zwischen den Objekten austau-
schen zu können.

Module und IO-Objekte
Die Module müssen mit den entsprechenden IO-Objekten verlinkt
werden.

HINWEIS
Sorgfältiges Verlinken
Damit sich das System problemlos starten lässt, gehen Sie bei
der Verlinkung der Module mit den IO-Objekten sorgfältig und der
Reihe nach vor.
Eine fehlerhafte Verlinkung kann zu Problemen beim Aufstarten
des Systems führen.

Control
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (XtsProcessingUnit) > Object (XtsPart) > Object
(AT2001-0250) > Data Pointer ausklappen

► Mit der rechten Maustaste auf Control klicken, um das Kontext-
menü aufzurufen

► Im Kontextmenü auf Change Link… klicken

Das Dialogfenster Attach Variable Control öffnet sich.
► Solution-Explorer > TwinCAT Project > I/O > Devices > Devices

(EtherCAT) > Term 2 (AT2001-0250) ausklappen
► Control auswählen
► Mit OK bestätigen

Ein grauer Pfeil an der Variablen zeigt die erfolgreiche Verlinkung
an.
Weitere Informationen dazu finden Sie im Kapitel „Verlinkungsde-
tails“, [Seite 57].
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CurrentSetpointValues
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (XtsProcessingUnit) > Object (XtsPart) > Objekt
(AT2001-0250) > Data Pointer ausklappen

► CurrentSetpointValues[0] bis CurrentSetpointValues[14] von
oben nach unten auswählen

► Mit der rechten Maustaste auf die oberste Variable der Markie-
rung klicken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Change Multi Link… klicken

Das Dialogfenster Attach Variable 30.0 Byte(s) öffnet sich.
► Solution-Explorer > TwinCAT Project > I/O > Devices > Devices

(EtherCAT) > Term 2 (AT2001-0250) ausklappen
► Kontrollkästchen All Types aktivieren
► Current setpoint value Ch.1 bis Current setpoint value Ch.15

auswählen
► Mit OK bestätigen

Ein grauer Pfeil an der Variablen zeigt die erfolgreiche Verlinkung
an.
Weitere Informationen dazu finden Sie im Kapitel „Verlinkungsde-
tails“, [Seite 57].
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Status
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (XtsProcessingUnit) > Object (XtsPart) > Object
(AT2001-0250) > Data Pointer ausklappen

► Mit der rechten Maustaste auf Status klicken, um das Kontext-
menü aufzurufen

► Im Kontextmenü auf Change Link… klicken

Das Dialogfenster Attach Variable Status öffnet sich.
► Solution-Explorer > TwinCAT Project > I/O > Devices > Devices

(EtherCAT) > Term 2 (AT2001-0250) ausklappen
► Status auswählen
► Mit OK bestätigen

Ein grauer Pfeil an der Variablen zeigt die erfolgreiche Verlinkung
an.
Weitere Informationen dazu finden Sie im Kapitel „Verlinkungsde-
tails“, [Seite 57].

CurrentActualValues
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (XtsProcessingUnit) > Object (XtsPart) > Objekt
(AT2001-0250) > Data Pointer ausklappen

► CurrentActualValues[0] bis CurrentActualValues[14] von
oben nach unten auswählen

► Mit der rechten Maustaste auf die oberste Variable der Markie-
rung klicken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Change Multi Link… klicken



Funktionen des Treibers

Version: 1.1.1 ─── 55TF5850

Das Dialogfenster Attach Variable 30.0 Byte(s) öffnet sich.
► Solution-Explorer > TwinCAT Project > I/O > Devices > Devices

(EtherCAT) > Term 2 (AT2001-0250) ausklappen
► Kontrollkästchen All Types aktivieren
► Current actual value Ch.1 bis Current actual value Ch.15 aus-

wählen
► Mit OK bestätigen

Ein grauer Pfeil an der Variablen zeigt die erfolgreiche Verlinkung
an.
Weitere Informationen dazu finden Sie im Kapitel „Verlinkungsde-
tails“, [Seite 57].

RawPositionValues
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (XtsProcessingUnit) > Object (XtsPart) > Objekt
(AT2001-0250) > Data Pointer ausklappen

► RawPositionValues[0] bis RawPositionValues[31] von oben
nach unten auswählen

► Mit der rechten Maustaste auf die oberste Variable der Markie-
rung klicken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Change Multi Link… klicken
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Die entsprechenden Value Channels zu den RawPositionValues be-
finden sich im hinzugefügten Term des XTS Sensorkanals. Achten
Sie darauf, dass Sie den korrekten Term beim Verlinken auswählen.

Das Dialogfenster Attach Variable 64.0 Byte(s) öffnet sich.
► Solution-Explorer > TwinCAT Project > I/O > Devices > Devices

(EtherCAT) > Term 3 (AT2001-0250) ausklappen
► Kontrollkästchen All Types aktivieren
► Value Channel 01 bis Value Channel 32 auswählen
► Mit OK bestätigen

Ein grauer Pfeil an der Variablen zeigt die erfolgreiche Verlinkung
an.
Weitere Informationen dazu finden Sie im Kapitel „Verlinkungsde-
tails“, [Seite 57].
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Verlinkungsdetails
Nach einer erfolgreichen Verlinkung der Module TcCom-Objekte mit
den physischen Modulen der I/O wird die Verlinkung durch graue
Pfeile an den einzelnen Data Pointer-Variablen der TcCom-Objekte
angezeigt. Sie haben nun die Möglichkeit, sich weitere Details zu
der Verlinkung anzeigen zu lassen.

Verlinkungsbeispiel
In diesem Kapitel wird an einer erfolgreichen Control-Verlinkung bei-
spielhaft gezeigt, wie Sie sich die Details zu der Verlinkung anzei-
gen lassen können.

► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects > Object (XtsProcessingUnit) > Object (XtsPart) > Objekt
(AT2001-0250) > Data Pointer ausklappen

► Doppelklick auf Control

► Im Projektfenster auf den Reiter Variable klicken
Details der Verlinkung werden unter Linked to… angezeigt.
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TcCom-Objekte Mover und Motion
Um die Mover steuern zu können, müssen die Sollwerte der Mover
berechnet werden. Dazu muss jedes TcCOM-Objekt Mover mit ei-
ner NC-Achse verlinkt werden.

Entsprechende TcCom-Objekte Mover mit TC1250 und TF5020
anlegen
Um die TcCom-Objekte mit den NC-Achsen zu verlinken, müssen
entsprechende XTS Mover Software-Objekte mit der Software
TC1250 | TwinCAT 3 PLC/NC PTP 10 und TF5020 | TwinCAT 3 NC
PTP Axes Pack unlimited angelegt werden. Weitere Informationen
finden Sie unter folgenden Links:

Direktlink zur Dokumentation TC1250 | TwinCAT 3 PLC/NC
PTP 10

Direktlink zur Dokumentation TF50x0 | TwinCAT 3 | NC PTP

HINWEIS
Sorgfältiges Verlinken
Damit sich das System problemlos starten lässt, gehen Sie bei
der Verlinkung der Mover mit den Motion-Objekten sorgfältig und
der Reihe nach vor.
Eine fehlerhafte Verlinkung kann zu Problemen beim Aufstarten
des Systems führen.

SoftDrive Input
Die Positionssollwerte und Dynamiksollwerte für den Mover werden
für die Berechnung bereitgestellt.

► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects > Object (XtsProcessingUnit) > Object (XtsMover) > Inputs
ausklappen

► Mit der rechten Maustaste auf SoftDriveInput klicken, um das
Kontextmenü aufzurufen

► Im Kontextmenü auf Change Link… klicken

https://infosys.beckhoff.com/content/1031/tc1250_tc3_plc_ncptp/index.html?id=4414599728561591270
https://infosys.beckhoff.com/content/1031/tc1250_tc3_plc_ncptp/index.html?id=4414599728561591270
https://download.beckhoff.com/download/Document/automation/twincat3/TF50x0_TC3_NC_PTP_DE.pdf
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Das Dialogfenster Attach Variable SoftDriveInput (Output) öffnet
sich.
► MOTION > NC-Task 1 SAF > Axes > Axis 1 > Axis 1_Obj (CTc-

SoftDrive) ausklappen
► InputPointer auswählen
► Mit OK bestätigen

Ein grauer Pfeil an der Variablen zeigt die erfolgreiche Verlinkung
an.

Verlinkungsdetails
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (XtsProcessingUnit) > Object (XtsMover) > Inputs
ausklappen

► Doppelklick auf SoftDriveInput

► Im Projektfenster auf den Reiter Variable klicken
Die Details der Verlinkung werden unter Linked to… angezeigt.
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SoftDrive Output
Die Ist-Werte für die Position und Dynamik des Movers werden für
die Anwendung bereitgestellt.

► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects > Object (XtsProcessingUnit) > Object (XtsMover) > Out-
puts ausklappen

► Mit der rechten Maustaste auf SoftDriveOutput klicken, um das
Kontextmenü aufzurufen

► Im Kontextmenü auf Change Link… klicken

HINWEIS
Achten Sie bei Verlinkung des der SoftDrive Outputs darauf, dass
Sie denselben Mover auswählen, den Sie bei der Verlinkung des
SoftDrive Inputs verwendet haben.

Das Dialogfenster Attach Variable SoftDriveOutput (Input) öffnet
sich.
► MOTION > NC-Task 1 SAF > Axes > Axis 1 > Axis 1_Obj (CTc-

SoftDrive) ausklappen
► OutputPointer auswählen
► Mit OK bestätigen

Ein grauer Pfeil an der Variablen zeigt die erfolgreiche Verlinkung
an.
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Verlinkungsdetails
► Solution-Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (XtsProcessingUnit) > Object (XtsMover) > Out-
puts ausklappen

► Doppelklick auf SoftDriveOutput

► Im Projektfenster auf den Reiter Variable klicken
Die Details der Verlinkung werden unter Linked to… angezeigt.
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6.1.4.5 Benötigte Einstellungen
Nach der erfolgten Verlinkung werden weitere Einstellungen für die
TcCom-Objekte, Motion-Objekte und IO-Objekte benötigt, bevor das
XTS System in Betrieb genommen werden kann.
Wenn der XTS Configurator zum Erstellen des XTS Systems ver-
wendet wurde, sind die benötigten Einstellungen automatisch er-
stellt worden.

Processing Unit
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects ausklappen
► Doppelklick auf Object (XtsProcessingUnit)

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General ausklappen
► Normal oder Simulation im Dropdown-Menü OperationMode

auswählen

► Mover ausklappen
► Den entsprechenden Mover im Dropdown-Menü MoverType

auswählen

► Das entsprechende Magnetplattenset des Movers im Dropdown-
Menü MagnetPlateType auswählen

► Mover ID Detection ausklappen
► Im Dropdown-Menü IdDetectionMode auswählen, ob auf dem

XTS System kein, ein oder mehrere Mover 1 verwendet werden
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► Teaching ausklappen
► TRUE im Dropdown-Menü IsTeachingEnabled auswählen
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Module
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (ProcessingUnit) ausklappen
► Doppelklick auf Object (AT2xxx-0xxx)

► Im Projektfenster auf den Reiter Context klicken
► Die entsprechende Task im Dropdown-Menü Task auswählen

Der Positionsindex definiert die Position des Moduls im XTS Sys-
tem. Das erste Modul hat die Hardwareposition  0, die weiteren
Module werden aufsteigend gezählt. Die Anzahl der Module mi-
nus eins ergibt die Hardwareposition für das letzte Modul.

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General auskappen
► In das Eingabefeld PositionIndex einen fortlaufenden Wert ein-

geben, beginnend bei dem ersten Modul mit 0
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► Das verwendete Modul im Dropdown-Menü MotorTerminalOID
auswählen

► Den Sensorkanal im Dropdown-Menü SensorTerminalOID aus-
wählen
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Track
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > Object (ProcessingUnit) ausklappen
► Doppelklick auf Object (XtsTrack)

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General ausklappen
► TRUE im Dropdown-Menü IsClosed auswählen, wenn das Sys-

tem geschlossen ist
ODER
► FALSE im Dropdown-Menü IsClosed auswählen, wenn das Sys-

tem offen ist

► TRUE im Dropdown-Menü IsIncludedInDetection auswählen,
wenn der Track in die Mover ID-Erkennung einbezogen wird

ODER
► FALSE im Dropdown-Menü IsIncludedInDetection auswählen,

wenn der Track aus der Mover ID-Erkennung ausgeschlossen
wird

► Im Dropdown-Menü in der Spalte Units die Anzahl der Parts aus-
wählen, die im Track enthalten sind

► PartConfigItems ausklappen
► Den Part oder die Parts im Dropdown-Menü ObjectId auswäh-

len, die zu dem Track gehören
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Mover
Bei dem manuellen Anlegen von Movern wird standardmäßig ein
universelles Mover-Objekt eingefügt. Neben der Auswahl des Mo-
vertyps muss auch die Startposition des Movers bestimmt werden.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects > Object (XtsProcessingUnit) ausklappen

► Doppelklick auf Object (XtsMover)

► Im Projektfenster auf den Reiter Context klicken
► Die Task im Dropdown-Menü Task auswählen

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Simulation ausklappen
► Einen Part im Dropdown-Menü SimulatedStartUpPart auswäh-

len, auf dem der Mover starten soll

► In das Eingabefeld SimulatedStartUpPosition die genaue Positi-
on des Movers auf dem Part eingeben



Funktionen des Treibers

68 ─── Version: 1.1.1TF5850

NC-Achse
► Solution Explorer > TwinCAT Project > MOTION > NC-SAF 1

Task > Axes ausklappen
► Doppelklick auf Axis 1

► Im Projektfenster auf den Reiter Settings klicken
► Auf Link To I/O… klicken

Das Dialogfenster Select I/O Box/Terminal öffnet sich.
► In der Liste das entsprechende SoftDrive (Object) auswählen
► Auswahl mit OK bestätigen

Mit der Auswahl des SoftDrives ändert sich automatisch der Axis
Type zu SoftDrive (Object).

► Im Projektfenster auf den Reiter Parameter klicken
► Maximum Dynamics ausklappen
► In das Eingabefeld Reference Velocity den Wert 4200.0 einge-

ben
► In das Eingabefeld Maximum Velocity den Wert 4000.0 eingeben
► In die Eingabefeld Maximum Acceleration und Maximum Decele-

ration die Werte 80000.0 eingeben
► Default Dynamics ausklappen
► In das Eingabefeld Deafult Acceleration und Default Decelerati-

on den Wert 20000.0 eingeben
► In das Eingabefeld Default Jerk den Wert 200000.0 eingeben
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► Solution Explorer > TwinCAT Project > MOTION > NC-Task 1
SAF > Axes > Axis 1 ausklappen

► Doppelklick auf Enc

► Im Projektfenster auf den Reiter Parameter klicken
► Encoder Evaluation ausklappen
► In das Eingabefeld Modulo Factor den Wert 3000 eingeben
► In das Eingabefeld Tolerance Window for Modulo Start den Wert

0.2 eingeben
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SoftDrive
► Solution Explorer > TwinCAT Project > MOTION > NC-Task 1

SAF > Axes > Axis ausklappen
► Doppelklick auf Axis 1_Obj1 (CTcSoftDrive)

► Im Projektfenster auf den Reiter Context klicken
► Die entsprechende Task im Dropdown-Menü Task auswählen

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General ausklappen
► In das Eingabefeld Hardware Modulo den Wert 3000.0 eingeben

HINWEIS
Vorhandene Hardware-Komponenten konfigurieren
Alle Objekte müssen den vorhandenen Hardware-Komponenten
entsprechen, damit die Konfiguration in der Simulation und im
Betrieb verwendet werden kann.

Sobald alle Objekte dem gewünschten XTS System entsprechen,
kann die Konfiguration in der Simulation verwendet werden. Bei Be-
darf können Module und Objekte für ein reines Simulationsprojekt
ohne vorhandene Hardware hinzugefügt oder entfernt werden.
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6.1.5 Kompatibilitätsmodus
Der Kompatibilitätsmodus ermöglicht Ihnen den Wechsel vom bishe-
rigen XTS Manager der Softwareversionen bis Version 3.18.715.0
zur TF5850 | TwinCAT 3 XTS Extension ohne das XTS System neu
konfigurieren zu müssen. Der alte XTS Manager kann immer noch
mit allen Funktionen genutzt werden. Alte Versionen der XTS Utility
Library, die XTS Tools sowie der XTS Viewer und der XTS Support
Assistant funktionieren auch nach dem Update.

Beachten Sie, dass während der Verwendung des Kompatibilitäts-
modus die neuen Funktionen, beispielsweise das XTS Track Mana-
gement sowie die Leave and Arrive-Funktionalität, oder einige neue
Funktionen zur Simulation und Visualisierung nicht verfügbar sind.
Um Ihr XTS System zu erweitern und die neuen Funktionen nutzen
zu können, müssen Sie Ihre aktuelle Konfiguration der XTS Objekte
in ein neues Projekt konvertieren. Weitere Informationen finden Sie
im Kapitel „Altes XTS System konvertieren“, [Seite 72].

Alte Konfiguration Neue Konfiguration

Um die neue XTS Software nach dem Wechsel zu aktivieren, müs-
sen Sie lediglich die XTS TcCOM-Objekte neu laden. Die alte Konfi-
guration und das XTS System funktionieren ohne Anpassung des
Projektes wie gewohnt. Weitere Informationen dazu finden Sie im
Kapitel „TcCom-Objekte neu laden“, [Seite 23].
Während des Betriebs wird im Hintergrund mit Hilfe der neuen Ob-
jektstruktur XTS Parts und XTS Tracks eine versteckte neue Konfi-
guration erzeugt, die intern mit den alten Objekten verlinkt ist. Zu se-
hen ist diese Konfiguration im Reiter Online Objects.



Funktionen des Treibers

72 ─── Version: 1.1.1TF5850

6.1.6 Altes XTS System konvertieren

Beachten Sie, dass während der Verwendung des Kompatibilitäts-
modus die neuen Funktionen des XTS Track Managements sowie
die Leave and Arrive-Funktionalität oder einige neue Funktionen zur
Simulation und Visualisierung nicht verfügbar sind. Um Ihr XTS Sys-
tem zu erweitern und die neuen Funktionen nutzen zu können, müs-
sen Sie Ihre aktuelle Konfiguration der XTS Objekte in ein neues
Projekt konvertieren.

Bei der Konvertierung eines alten XTS Systems bis Softwareversion
3.18.715.0 müssen folgende Bereiche angepasst und genau über-
prüft werden, da nur kleine Änderungen in diesen Bereichen große
Effekte im gesamten Projekt erzielen:
• XTS TcCOM-Objekte
• NC-Achsen und SoftDrives
• XTS Utility Library

Beispielkonfiguration
Die Konvertierung eines alten Systems und des dazu gehörigen
Projekts wird beispielhaft an einem geschlossenen System mit 180°
Kurven und vier Movern beschrieben.

Erstellen Sie vor dem Start der Konvertierung zur Sicherheit eine
Kopie Ihres Projekts. Es kann nicht garantiert werden, dass die fol-
genden Schritte zu hundert Prozent auf jedes Projekt übertragen
werden können. Sollten Sie Schwierigkeiten bei der Konvertierung
haben, kontaktieren Sie den für Ihre Region zuständigen Produkt-
spezialisten.
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6.1.6.1 Alte XTS Task und TcCOM-Objekt XtsIoDriver entfernen
Zunächst müssen die XTS Task und die Struktur des TcCOM-Ob-
jekts XtsIoDriver aus dem alten Projekt entfernt werden.

Legen Sie sich bei Bedarf eine Liste der wichtigsten Einstellungen
des TcCOM-Objekts XtsIoDriver an, damit Sie diese später für das
XTS Processing Unit-Objekt übernehmen können.

XTS Task
► Solution Explorer > TwinCAT Project > SYSTEM > Tasks aus-

klappen
► Mit der rechten Maustaste auf XTS Task klicken, um das Kon-

textmenü aufzurufen
► Im Kontextmenü auf Remove klicken

XtsIoDriver TcCOM-Objekt
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects ausklappen
► Mit der rechten Maustaste auf Object (XtsIoDriver) klicken, um

das Kontextmenü aufzurufen
► Im Kontextmenü auf Remove klicken
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TMC Reload ausführen

Falls noch nicht erfolgt, muss ein TMC Reload durchgeführt werden.
Weitere Informationen dazu finden Sie im Kapitel „Kompatibilitäts-
modus“, [Seite 71].

► Im Projektfenster auf den Reiter Project Objects klicken
► Alle Objekte markieren
► Mit der rechten Maustaste auf die ausgewählten Objekte klicken,

um das Kontextmenü aufzurufen
► Im Kontextmenü auf Reload TMI/TMC Description(s) klicken

Neue XTS TcCom-Struktur anlegen
Um ein altes XTS System zu konvertieren, muss zunächst ein neu-
es XTS System konfiguriert werden. Aktivieren Sie dazu das XTS
Tool Window. Weitere Informationen dazu finden Sie im Kapitel
„XTS Tool Window aktivieren“, [Seite 226].
Starten Sie mit der Konfiguration des Systems. Weitere Informatio-
nen dazu finden Sie im Kapitel XTS System konfigurieren. Bei Be-
darf können Sie bereits während der Konfiguration neue Parameter
wie Stations oder Simulationsparameter für die Mover einstellen.
Bei der Konfiguration der Mover können Sie entweder die vorhande-
nen NC-Achsen und SoftDrives übernehmen oder neue anlegen.
Die vorhandenen NC-Achsen zu übernehmen, bietet den Vorteil,
dass Sie keine neuen Links zur PLC setzen müssen. Des Weiteren
werden alle Tuningparameter und Einstellungen der NC-Achsen
übernommen.

Wiederverwendung von NC-Achsen

Das Dialogfenster Add Movers for existing Axes öffnet sich nur,
wenn im neuen Projekt weniger Mover als alte NC-Achsen vorhan-
den sind.

Das Dialogfenster Add Movers for existing Axes? öffnet sich.
► Alle NC-Achsen auswählen, für die Mover angelegt werden sol-

len
► Mit OK bestätigen
Beachten Sie, dass die Reihenfolge in der die Mover ausgewählt
werden, einen Einfluss darauf hat, welcher Mover mit welcher
NC‑Achse verlinkt wird.
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Nachdem die Konfiguration abgeschlossen wurde, werden alle kon-
figurierten TcCOM-Objekte im Projektbaum des Solution Explorers
angezeigt.
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6.1.6.2 XtsIoDriver-Parameter wiederverwenden
Spezielle Parameter, wie die Mover  1-Funktionalität, die Sie unter
dem alten XtsIoDriver-Objekt festgelegt haben, können Sie im XTS
Processing Unit-Objekt einstellen. Im XTS Processing Unit-Objekt
finden Sie die Einstellmöglichkeiten für alle alten Parameter.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects ausklappen

► Doppelklick auf XtsProcessingUnit
► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Einstellungen überprüfen
► Bei Bedarf die Einstellungen des alten XTS Projekts eintragen
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6.1.6.3 Zykluszeit der XTS Task anpassen

Die Zykluszeit der neuen XTS Task muss auf 250 µs eingestellt wer-
den.

► Solution Explorer > TwinCAT Project > SYSTEM ausklappen
► Doppelklick auf Real-Time 

► Im Projektfenster auf den Reiter Settings klicken
► Darauf achten, dass die XTS Task auf dem richtigen RT-Core

läuft
► Bei Bedarf RT-Core über das Dropdown Menü ändern
► Darauf achten, dass die Base Time auf 250 µs eingestellt ist
► Bei Bedarf Base Time Wert über das Dropdown-Menü auf

250 µs einstellen
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► Solution Explorer > TwinCAT Project > SYSTEM > Tasks aus-
klappen

► Doppelklick auf die neue XTS Task 

► Im Projektfenster auf den Reiter Task klicken
► In das Eingabefeld Cycle ticks den Wert 1 eingeben oder mithilfe

der Pfeiltasten einstellen

Weitere Informationen zu den benötigten Real-Time-Einstellungen
finden Sie in der entsprechenden Dokumentation oder kontaktieren
Sie den für Ihre Region zuständigen Produktspezialisten.
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6.1.6.4 NC‑Achsen und SoftDrive-Parameter überprüfen
Neue NC‑Achsen Wenn Sie neue NC-Achsen verwenden, müssen alle vorherigen Pa-

rameter aus dem alten XTS Projekt übernommen werden. Die Para-
meter können entweder manuell hinzugefügt oder im XTS Configu-
rator als Parameterset der Mover importiert werden. Weitere Infor-
mationen zu allen verfügbaren Parametern für die NC‑Achsen und
den SoftDrive finden Sie in der SoftDrive-Dokumentation.

Die neuen NC‑Achsen müssen mit der PLC verlinkt werden:

► Solution Explorer > TwinCAT Project > MOTION > NC SAF aus-
klappen

► Doppelklick auf Axes

► Im Projektfenster alle Achsen auswählen, die mit der PLC ver-
linkt werden sollen

► Mit der rechten Maustaste auf die ausgewählten Achsen klicken,
um das Kontextmenü aufzurufen

► Im Kontextmenü auf Change Axis PLC Links… klicken

Das Dialogfenster Select Axis PLC Reference öffnet sich.
► Die PLC auswählen, mit der die Achsen verlinkt werden sollen
► Mit OK bestätigen

Der Modulo Factor für die NC-Achsen und den SoftDrive muss auf
die korrekte Länge des Systems eingestellt werden:

► Solution Explorer > TwinCAT Project > MOTION > NC SAF >
Axes ausklappen

► Die Achse ausklappen, deren Einstellungen angepasst werden
sollen

► Doppelklick auf Enc
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► Im Projektfenster auf den Reiter Parameter klicken
► Encoder Evaluation ausklappen
► Darauf achten, dass der Modulo Factor auf die Länge des aktu-

ellen Systems eingestellt ist
► Bei Bedarf in das Eingabefeld Modulo Factor die Länge des ak-

tuellen Systems eingeben

► Solution Explorer > TwinCAT Project > MOTION > NC SAF >
Axes ausklappen

► Die Achse ausklappen, deren Einstellungen angepasst werden
sollen

► Doppelklick auf SoftDrive

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General ausklappen
► Darauf achten, dass der Wert HardwareModulo auf die Länge

des aktuellen XTS Systems eingestellt ist
► Bei Bedarf in das Eingabefeld HardwareModulo die Länge des

aktuellen Systems eingeben
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Vorhandene NC‑Achsen

Wenn Sie vorhandene NC‑Achsen aus Ihrem alten Projekt verwen-
den, müssen Sie den Parameter PositionFeedbackMode des ent-
sprechenden SoftDrive-Objekts überprüfen. Fehlerhafte Einstellun-
gen können ein verändertes Verhalten der NC-Position zur Folge
haben.

► Solution Explorer > TwinCAT Project > MOTION > NC SAF >
Axes ausklappen

► Die Achse ausklappen, deren Einstellungen angepasst werden
sollen

► SoftDrive ausklappen
► Doppelklick auf SoftDriveEncoder

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General ausklappen
► Darauf achten, dass der PositionFeedbackMode auf

MODULO_START eingestellt ist
► Bei Bedarf MODULO_START im Dropdown-Menü PositionFeed-

backMode auswählen
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6.1.6.5 Alte XTS Utility-Aufrufe ersetzen
Da sich bei der Konvertierung die Struktur der XTS Objekte im Pro-
jekt grundlegend geändert hat, wurde auch die Struktur der XTS Uti-
lity geändert. In der neuen Konfiguration funktionieren die alten Auf-
rufe der Funktionsblöcke FB_XtsUnit und der FB_XtsVisuDiag nicht
mehr korrekt.
Weil die ADS Lesekommandos und Schreibkommandos im Hinter-
grund auf andere Objekt-IDs verweisen, ist es nicht möglich Daten
vom XtsIoDriver-Objekt zu lesen oder auf das XtsIoDriver-Objekt zu
schreiben. Die XtsUnit-Struktur erlaubt keinen Zugriff auf die Daten
der entsprechenden XTS Objekte, wie beispielsweise der Module
CoE-Daten.
Jeder XTS Utility-Aufruf der PLC muss geprüft und mit einer neuen
Funktion ersetzt werden, um die gewünschten Werte zu erhalten. Es
ist erforderlich, alle Stellen zu finden, an denen die alte XtsUnit-
Struktur zum Einsatz kam und die Werte zu ermitteln, die dort ge-
schrieben oder gelesen wurden.
Viele der alten Aufrufe der XtsUnit-Struktur können mit dem Verfah-
ren der XTS Environment-Struktur ersetzt werden.
Ein grundlegendes Beispiel dafür, was in der Struktur geändert wer-
den muss, ist das Vorgehen bei der Mover ID-Erkennung:

//MoverId Functionality
//check whether the position detection of the Movers has been completed.
IF fbXtsUnit.stXtsUnit.stTcIoXtsDrv.stParameter.bAreAllMoverPositionsValid THEN

    //Check if “MoverIdDetectionMode” has been activated under the XtsIoDriver object
    IF fbXtsUnit.stXtsUnit.stTcIoXtsDrv.stParameter.eMoverIdDetectionMode =
E_MoverIdDetectionMode.Mover1
        //and that we are not running in simulation.
        AND NOT bSimulation
        THEN
            //Check whether the “MoverIdDetection” has already been started or the Mover1 was found.
            IF NOT (bMoverIdDetectionStarted OR bMoverIdDetected)
            THEN
                //Trigger the “MoverIdDetection”.
                fbXtsUnit.stXtsUnit.stTcIoXtsDrv.ipTcXtsIo.TriggerMoverIdDetection();
                // “bMoverIdDetectionStarted” is set to “True” after a single initiation.
                bMoverIdDetectionStarted := TRUE;
            END_IF

//Check for error or success of “MoverIdDetection”.
bMoverIdDetectionError := fbXtsUnit.stXtsUnit.stTcIoXtsDrv.stParameter.bHasMoverIdDetectionError;
bMoverIdDetected := fbXtsUnit.stXtsUnit.stTcIoXtsDrv.stParameter.bIsMoverIdDetectionValid;

//Do not process any further until the “MoverId” was detected.
IF NOT bMoverIdDetected THEN
RETURN;
END_IF
// If the “MoverIdDetection” was not activated in the XtsIoDriver object or running in simulation,
// then the activation of the “MoverIdDetection” and the search of Moer1 is skipped.
ELSE
;
END_IF

//If not all Mover positions are valid, do not process any further.
ELSE
RETURN;
END_IF
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In der alten Konfiguration bekamen einige Aufrufe der Mover ID-Er-
kennung die Informationen des XtsIoDriver-Objekts mithilfe der Xts-
Unit-Struktur:

Da das XtsIoDriver-Objekt in der neuen Konfiguration nicht vorhan-
den ist, müssen die Aufrufe so angepasst werden, dass die XtsEnvi-
ronment-Struktur die Informationen des XtsProcessingUnit-Objekts
für die Aufrufe liefern:

Auf diese Weise können viele der Aufrufe ersetzt werden. Dabei ist
zu beachten, dass sich die XtsEnvironment-Struktur von der alten
XTS Struktur im Hinblick auf die Initialisierung und das Sammeln der
Zyklusdaten unterscheidet. Weitere Informationen dazu finden Sie
im Kapitel „Bibliothek hinzufügen“, [Seite 430].
Nachdem alle XtsUnit-Aufrufe aus dem Projekt entfernt wurden,
kann die Konfiguration aktiviert werden.
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6.1.6.6 Konfiguration aktivieren
Wenn Sie alle Änderungen im Projekt vorgenommen haben, können
Sie die Konfiguration aktivieren, in den Betriebsmodus wechseln
und die PLC starten. Sollten Sie Schwierigkeiten bei der Aktivierung
haben, kontaktieren Sie den für Ihre Region zuständigen Produkt-
spezialisten.
Wenn alle Aufrufe korrekt ersetzt wurden, gibt es im Betrieb des
XTS Systems keine Unterschiede zu der alten Konfiguration. Zu-
sätzlich sind nun alle neuen Funktionen zur Simulation und Visuali-
sierung nutzbar und das Projekt ist bereit für zukünftige Updates
des XTS Treibers.
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6.2 XTS Simulation-Funktionalität
Die Simulation-Funktionalität ermöglicht es Ihnen, ein System zu
testen, ohne reale Hardware zu verwenden. Weitere Informationen
dazu finden Sie im Kapitel „XTS Simulation Builder“, [Seite 231].

6.2.1 Simulationsmodus aktivieren
Wenn Sie ein System mit dem XTS Simulation Builder konfigurieren,
wird der Simulationsmodus automatisch aktiviert und es ist nicht er-
forderlich den Simulationsmodus zu aktivieren.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects ausklappen

► Doppelklick auf XtsProcessingUnit

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General ausklappen
► Simulation im Dropdown-Menü OperationMode auswählen
► Alle weiteren XTS Processing Units, die im Simulationsmodus

laufen sollen, auf die gleiche Weise in den Simulationsmodus
setzen

Beckhoff empfiehlt die entsprechende Hardware des XTS Systems
in der IO-Konfiguration zu deaktivieren, um ein versehentliches Akti-
vieren zu vermeiden. Um eine IO-Konfiguration ohne vorhandene
Hardware zu aktivieren, müssen alle virtuellen Devices deaktiviert
werden.
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6.2.1.1 Devices deaktivieren
► Solution Explorer > TwinCAT Project > I/O > Devices ausklap-

pen
► Mit der rechten Maustaste auf ein Device klicken, um das Kon-

textmenü aufzurufen
► Im Kontextmenü auf Disable klicken
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6.2.2 Wichtige Simulationseinstellungen
Es gibt wichtige Parameter, die unter den TcCOM-Objekten einge-
stellt werden, um festzulegen, wie sich die Simulation beim Starten
des XTS Systems verhält. Standardmäßig verhält sich die Simulati-
on wie ein reales System. Beispielsweise werden keine XTS Mover
gefunden, wenn keine XTS Tracks im Erkennungsprozess vorhan-
den sind, oder es können keine Achsen aktiviert werden, wenn die
Mover ID-Erkennung nicht gestartet worden ist.

6.2.2.1 XTS Mover Simulation Parameter
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects > XtsProcessingUnit ausklappen
► Doppelklick auf Mover 1

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Simulation ausklappen
► Den Part im Dropdown-Menü SimulatedStartUpPart auswählen,

auf dem der Mover starten soll
► In das Eingabefeld SimulatedStartUpPosition den Wert für die

Startposition des Movers eingeben
► In das Eingabefeld SimulatedStartUpId den Wert 1 eingeben,

damit der Mover beim Starten als Mover 1 erkannt wird
ODER
► In das Eingabefeld SimulatedStartUpId keinen Wert eingeben,

damit der Mover als Standard Mover erkannt wird
Diese Eingaben können auch im XTS Configurator und im XTS Si-
mulation Builder auf der Seite Movers getätigt werden. Weitere In-
formationen dazu finden Sie in den Kapiteln „XTS Configurator“,
[Seite 260] und „XTS Simulation Builder“, [Seite 231].
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XTS Simulation Builder
► Die Seitenleiste ausklappen und auf Configure klicken

► Auf den Reiter Movers klicken
► Den Mover auswählen, für den die Einstellungen angepasst wer-

den sollen

► Details ausklappen
► In das Eingabefeld Start-Up Position die Startposition des Mo-

vers eingeben
► Den Part im Dropdown-Menü Start-Up Part auswählen, auf dem

der Mover starten soll
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XTS Configurator
► Die Seitenleiste ausklappen und auf Movers klicken

► Mover List ausklappen
► Den Mover auswählen, für den die Einstellungen angepasst wer-

den sollen
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► Mover Details ausklappen, um die Simulation Start-Up Settings
einzublenden

► Den Part im Dropdown-Menü Part auswählen, auf dem der Mo-
ver starten soll

► In das Eingabefeld Position die Startposition des Movers einge-
ben

► 1 in das Eingabefeld ID eingeben, damit der Mover beim Starten
als Mover 1 erkannt wird

ODER
► Keinen Wert in das Eingabefeld ID eingeben, damit der Mover

als Standard Mover erkannt wird

Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
SimulatedStartUpPart Simulation OTCID 0x03080278 Bestimmt auf welchem Part

der Mover im Simulations-
modus startet.

SimulatedStartUpPositi-
on

Simulation LREAL 0x03080279 Bestimmt an welcher Stelle
des ausgewählten Parts sich
der Mover im Simulations-
modus befindet.
Jede Position zwischen 0
und der Länge des Parts ist
möglich. Bei Verwendung
anderer Werte, wird der Mo-
ver nicht gefunden.
Einheit: mm

SimulatedId Simulation STRING(3) 0x0308027E Bestimmt, welche ID der Mo-
ver haben soll, wenn sich
das XTS System im Simulati-
onsmodus befindet und eine
Mover ID-Erkennung gestar-
tet wird.

• 1 Der Mover wird als Mover 1
in der Simulation erkannt.

• - Der Mover wird als Standard
Mover in der Simulation er-
kannt.
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6.2.2.2 XTS Processing Unit Parameter
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects ausklappen
► Doppelklick auf XtsProcessingUnit

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Simulation ausklappen
► TRUE oder FALSE im Dropdown-Menü IsPositionNoiseEnabled

und IsRandomStartUpEnabled auswählen
► In die Eingabefelder MoverDistance, PositionOffset, PositionNoi-

seBandwidth und RandomStartUpBandwidth einen Wert einge-
ben

► Parameter für die Startposition der Mover im Dropdown-Menü
PositionStartUpSimulationMode auswählen

► Parameter für die Mover ID im Dropdown-Menü MoverIdStartUp-
SimulationMode auswählen

► Art der Zufallsverteilung im Dropdown-Menü RandomInitMode
auswählen

► In das Eingabefeld RandomInitMode einen Wert eingeben
Weitere Informationen dazu finden Sie im Kapitel „Parameter (Init)“,
[Seite 91].

6.2.2.2.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
MoverDistance Simulation LREAL 0x0308022E Bestimmt den Abstand zwi-

schen den Movern, wenn der
PositionStartUpSimulation-
Mode UseOffsetAndDistance
ausgewählt ist.
Bei zu großem Abstand pas-
sen die Mover nicht auf das
XTS System und werden da-
her nicht gefunden.
Einheit: mm

PositionOffset Simulation LREAL 0x0308022D Bestimmt die Position des
ersten Movers, wenn der Po-
sitionStartUpSimulationMode
UseOffsetAndDistance aus-
gewählt ist.
Bei zu großem Offset passen
die Mover nicht auf das XTS
System und werden daher
nicht gefunden.
Einheit: mm
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Parameter Gruppe Typ PTCID Erläuterung
PositionNoiseBandwidth Simulation LREAL 0x03080231 Bestimmt die maximale Ab-

weichung der simulierten Po-
sitionsverzögerung der Mo-
ver, wenn das Positionsrau-
schen in der Simulation akti-
viert ist.
Einheit: mm

RandomStartUpBand-
width

Simulation LREAL 0x03080232 Bestimmt die maximale Ab-
weichung der Startposition
zwischen den Movern, wenn
der PositionStartUp-
SimulationMode UseOffset-
AndDistance ausgewählt ist.
Bei zu großer Bandbreite
passen die Mover nicht auf
das XTS System und werden
daher nicht gefunden.
Einheit: mm

PositionStartUpSimula-
tionMode

Simulation XTS.PositionStartUp-
SimulationMode

0x03080230 Bestimmt welcher Parameter
die Startposition des Movers
in der Simulation liefert.

• UseOffsetAndDistance – – – Der Parameter des TcCOM-
Objekts ProcessingUnit wird
verwendet

• UseMoverParameters – – – Der Parameter des TcCOM-
Objekts Mover wird verwen-
det

• UseRandomDistributi-
on

– – – Die Mover werden zufällig
verteilt.

MoverIdStartUpSimula-
tionMode

Simulation XTS.MoverIdStartUp-
SimulationMode

0x0308027D Bestimmt welcher Parameter
die Mover ID in der Simulati-
on liefert.

• UseRandomDistributi-
on

– – – Die Mover erhalten ihre ID
zufällig nach den Einstellun-
gen der Parameter IdDetec-
tionMode und ExpectedMo-
verIds.

• UseMoverParameters – – – Der Parameter des TcCOM-
Objekts Mover wird verwen-
det.

• UseAlternation – – – Die Mover erhalten nachein-
ander ihre ID, beginnend bei
1.

RandomInitMode Simulation XTS.RandomInitMo-
de

0x0308027F Bestimmt, wie die Zufallsver-
teilung angewendet wird.

• UseSystemTime – – – Erzeugt einen Wert, basie-
rend auf der Systemzeit.

• UseInitSeed – – – Verwendung des Werts bei
Parameter RandomInitSeed.

RandomInitSeed Simulation DINT 0x03080280 Bestimmt die Zahl für die Zu-
fallsverteilung, wenn der
RandomInitMode UseInit-
Seed ausgewählt ist.
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6.3 Mover 1-Funktionalität
Der Mover 1 dient als Referenzmover des XTS Systems. Er ist mit
einem speziellen Magnetplattenset ausgestattet. Das spezielle Ma-
gnetplattenset Mover 1 ist äußerlich erkennbar durch die Gravur auf
dem Magnetplattenset sowie durch den Aufdruck auf der Geberfah-
ne.

6.3.1 Mover ID-Erkennung
Bei der Mover ID-Erkennung werden alle Mover kaum sichtbar in
Bewegung versetzt und vom System neu sortiert. Da der Mover  1
durch sein spezielles Magnetplattenset ein anderes Verhalten zeigt
als die übrigen Mover, wird er automatisch vom System erkannt. Auf
diese Weise ist eine eindeutige Zuordnung der Moverhardware zur
NC-Achse möglich.
Wenn beim Parameter MoverPositionAssignment die Einstellung
StartAtFirstMover ausgewählt ist, hat der Mover 1 immer entweder
die größte oder die kleinste Position aller NC-Achsen. Ist dies nach
Aufstarten, standardgemäßer Erkennung und erfolgreicher Mover
ID-Erkennung noch nicht der Fall, wird die komplette Systemlänge
zur Position einzelner Mover hinzuaddiert. 

Beispielhafte Positionsberechnung

Geplante Mover 1
Position

Parameter Mover-
SortOrder

Mover 1 Mover 6

Positionen in den NC-Achsen vor der Mover ID-Erkennung [mm]
Kleinste Position Ascending 360 27
Größte Position Descending 40 280
Positionen in den NC-Achsen während der Mover ID-Erkennung [mm]
Kleinste Position Ascending - 27 + 3000 Systemlänge
Größte Position Descending 40 + 3000 Systemlänge -
Positionen in den NC-Achsen nach der Mover ID-Erkennung [mm]
Kleinste Position Ascending 360 3027
Größte Position Descending 3040 280

Geplante Mover 1
Position

Parameter Mover-
SortOrder

Positionen in den NC-Achsen [mm] Mover 1 Mover 6

Kleinste Position Ascending Vor der Mover ID-Erkennung 360 27
Während der Mover ID-Erkennung – 27 + 3000

Systemlänge
Nach der Mover ID-Erkennung 360 3027

Größte Position Descending Vor der Mover ID-Erkennung 40 + 3000
Systemlänge

280

Während der Mover ID-Erkennung 360 3027
Nach der Mover ID-Erkennung 3040 280
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Geplante Mo-
ver 1 Position

Parameter
MoverSort-
Order

Positionen in den NC-
Achsen vor der Mover
ID-Erkennung

Positionen in den NC-
Achsen während der
Mover ID-Erkennung

Positionen in den NC-
Achsen nach der Mover
ID-Erkennung

Mover 1 Mover 6 Mover 1 Mover 6 Mover 1 Mover 6
Kleinste Position Ascending 360 mm 27 mm – 27 mm +

3000 mm
System-
länge

360 mm 3027 mm

Größte Position Descending 40 mm 280 mm 40 mm +
3000 mm
System-
länge

– 3040 mm 280 mm

48 V Spannungsversorgung notwendig
Zur Durchführung der Mover ID-Erkennung wird die 48  V Span-
nungsversorgung benötigt.
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6.3.2 Anwendung im XTS Processing Unit-Objekt

6.3.2.1 Parameter

Wenn Sie den Kompatibilitätsmodus nutzen, können Sie die Mover
ID-Erkennung wie gewohnt über das TcIoXtsDrv-Objekt steuern.
Richten Sie sich hierfür nach den folgenden Beschreibungen für die
Anwendung im XTS Processing Unit Objekt. Bei Abweichungen zwi-
schen beiden Objekten wird separat darauf hingewiesen.

Über das XTS Processing Unit-Objekt wird die Mover ID-Erkennung
gesteuert. Sie haben die Möglichkeit, über allgemeine Parameter 
Einstellungen vorzunehmen und die Mover ID-Erkennung manuell
auszulösen ohne ein PLC-Projekt hinzufügen zu müssen.
Folgende Parameter stehen für Einstellungen und zur Überprüfung
im XTS Processing Unit-Objekt beziehungsweise im TcIoXtsDrv-Ob-
jekt zur Verfügung:

XTS Processing Unit-Objekt
Parameter Erläuterung
IdDetectionMode Einstellung, ob ein oder mehrere Mo-

ver 1 im System vorhanden sind.
MoverPositionAssignment Einstellung, dass der Mover 1 abhängig

von der Sortierreihenfolge die größte
oder kleinste Position der NC-Achsen
auf dem System erhält.

ExpectedMoverIds
[0].Id Erwartete Mover IDs für die Multiple-

Mover 1 ID-Erkennung.
• 1 Mover mit Magnetplattenset Mover 1.
• 0 Mover mit Magnetplattenset Mover

Standard.
[0].Count Anzahl der erwarteten Mover 1.
TriggerMoverIdDetection Manueller Start der Mover ID-Erken-

nung.
HasIdDetectionError Anzeige, ob ein Fehler bei der Mover

ID-Erkennung aufgetreten ist.
IsIdDetectionValid Anzeige, ob Mover 1 erkannt wurde.
IsIdDetectionActive Anzeige, ob die Mover ID-Erkennung

läuft.

TcIoXtsDrv-Objekt
Parameter Erläuterung
MoverIdDetectionMode Einstellung, ob ein Mover 1 im System

vorhanden ist.
MoverPositionAssignment Einstellung, dass der Mover 1 abhängig

von der Sortierreihenfolge die größte
oder kleinste Position der NC-Achsen
auf dem System erhält.

TriggerMoverIdDetection Manueller Start der Mover ID-Erken-
nung.

IsMoverIdDetectionValid Anzeige, ob Mover 1 erkannt wurde.
HasMoverIdDetectionEr-
ror

Anzeige, ob ein Fehler bei der Mover
ID-Erkennung aufgetreten ist.
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MoverIdDetection
► Solution Explorer > XtsProject > SYSTEM > TcCOM Objects

ausklappen
► Doppelklick auf XtsProcessingUnit

Parameter (Init)
► Im Projektfenster auf den Reiter Parameter (Init) klicken
► MoverIdDetection ausklappen

 WARNUNG
Verletzungsgefahr durch unvorhersehbare Bewegungen
Wenn Sie keinen Parameter auswählen, obwohl es einen oder
mehrere Mover mit den speziellen Mover  1-Magnetplattensets
auf dem System gibt, werden die Mover falsch bestromt und die
Mover können sich unvorhersehbar bewegen.
Unvorhersehbare Bewegungen der Mover können zu schweren
Verletzungen an den Fingern durch Quetschungen und zu Be-
schädigungen an Werkzeugen und der Maschine führen.
• Wählen Sie den Parameter Mover1 oder MultipleMover1 aus.

► Mover1 oder MultipleMover1 im Dropdown-Menü IdDetection-
Mode auswählen

Zur Übernahme der Einstellungen muss die Konfiguration neu akti-
viert und das TwinCAT System muss neu gestartet werden.
► TwinCAT neu starten

► StartAtFirstMover im Dropdown-Menü MoverPositionAssign-
ment auswählen

Zur Übernahme der Einstellungen muss die Konfiguration neu akti-
viert und das TwinCAT System muss neu gestartet werden.
► TwinCAT neu starten
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► ExpectedMoverIds ausklappen
► 1 (Array Elements) oder 2 (Array Elements) im Dropdown-Me-

nü ExpectedMoverIds in der Spalte Unit auswählen
► In das Eingabefeld [0].Id den Mover ID-Typ eingeben
► In das Eingabefeld [0].Count die Anzahl der erwarteten Mover 1

eingeben

► Mit der rechten Maustaste in das Eingabefeld TriggerMoverIdDe-
tection klicken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Download klicken
Die Mover ID-Erkennung wird jetzt manuell ausgelöst. Alle Mover
starten die Bewegung.

Parameter (Online)
► Im Projektfenster auf den Reiter Parameter (Online) klicken

► Ergebnis bei HasIdDetectionError prüfen:

TRUE
Mover 1 wurde nicht erkannt. Mögliche Urachen:
• Mover ID-Erkennung wurde nicht gestartet
• IsIdDetectionValid zeigt FALSE an

FALSE
Mover 1 wurde erkannt. Es sind keine Fehler aufgetreten.

► Ergebnis bei IsIdDetectionValid prüfen:

TRUE
Mover 1 wurde erkannt. Es sind keine Fehler aufgetreten.

FALSE
Mover 1 wurde nicht erkannt. Mögliche Urachen:
• Mover ID-Erkennung wurde nicht gestartet
• HasIdDetectionValid zeigt TRUE an
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Wenn die Mover ID-Erkennung fehlgeschlagen ist:
► Benachrichtigungen in den Meldungsfenstern Error List und Out-

put prüfen
► Hidden Parameter „DetectionInfoMessage“, [Seite 110] aktivie-

ren
► Parameter im „TcSoftDrive-Objekt“, [Seite 107] anpassen
► Hidden Parameter der XTS Processing Unit anpassen
► Mover ID-Erkennung erneut ausführen

► Ergebnis bei IsIdDetectionActive prüfen

TRUE
Mover ID-Erkennung ist aktiv. Es sind keine Fehler aufgetreten.

FALSE
Mover ID-Erkennung ist nicht aktiv. Mögliche Ursache:
• Mover ID-Erkennung ist nicht aktiv

Mover IDs prüfen
Nachdem die Mover IDs erkannt wurden, können Sie diese über die
Processing Unit oder das Mover-Objekt aufrufen und prüfen:
Unter der Processing Unit finden Sie die Mover IDs für alle Mover
unter folgendem Pfad:
Parameter (Online) > Mover ID Detection > MoverIds

Unter dem Mover-Objekt finden Sie die Mover IDs für jeden Mover
einzeln unter folgendem Pfad:
Parameter (Online) > Mover ID Detection > Id
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6.3.2.2 Hidden Parameter
Für die erweiterte Bedienung der Mover ID-Erkennung haben Sie
die Möglichkeit, Hidden Parameter zu verwenden. Sie können zum
Beispiel die Zeitverzögerung verändern, mit der die Mover innerhalb
eines Pakets bewegt werden und die Abstände definieren, in denen
Mover als ein Paket erkannt werden. In der Regel stimmen jedoch
die Standardparameter mit Ihrem XTS System überein. Die Mover
ID-Erkennung kann sofort gestartet werden. Die Suche dauert weni-
ge Sekunden und ist abhängig von der Anzahl der Mover und den
jeweiligen Einstellungen.
Folgende Hidden Parameter stehen für Einstellungen zur Verfü-
gung:

IdDiagConfiguration Berechnungsparameter der Mover ID-Erkennung. Nicht ändern!

DelayBetweenMoversInPack Zeitverzögerung in der Mover ID-Erkennung zwischen Movern im
selben Paket. Einheit: s.

DelayBetweenMoverPacks Zeitverzögerung in der Mover ID-Erkennung zwischen Movern in
verschiedenen Paketen. Einheit: s

GapToDefineMoverPack Abstand zwischen Movern, innerhalb dessen Mover als ein Paket
erkannt werden. Einheit: mm

CompleteCriteria Einstellung, ab wann eine Suche als erfolgreich gewertet werden
soll.

► Kontrollkästchen Show Hidden Parameter aktivieren, um die
Hidden Parameter einzublenden

In einem Mover-Paket wird die Bewegung zeitgleich nur für einen
Mover ausgelöst, um eine mechanische Beeinflussung unter den
Movern zu verhindern. Nach Ablauf der Suche eines vorangegange-
nen Movers in einem Paket und nach Ablauf der Zeit DelayBetween-
MoversInPack wird die Suche für den nächsten Mover im Paket ge-
startet.
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6.3.3 Anwendung in der PLC

6.3.3.1 Varianten
Über die PLC haben Sie die Möglichkeit, die Mover ID-Erkennung 
auszulösen, indem Sie den Programmcode verwenden. Hierzu ste-
hen Ihnen zwei Varianten zur Verfügung:

PLC Variante I (Trigger via XtsUtility)
Start der Mover ID-Erkennung durch den Aufruf der Methode Trig-
gerMoverIdDetection.

PLC Variante II (Trigger via ADS-Write)
Start der Mover ID-Erkennung durch einen ADSWRITE-Befehl auf
den Parameter TriggerMoverIdDetection im XTS Processing Unit-
Objekt.

Rechenzeit beachten
Der Aufruf der PLC Variante I benötigt mehr Rechenzeit. Sollte die
Rechenzeit für die Anwendung ein Problem darstellen, nutzen Sie
die PLC Variante II.

Bibliothek hinzufügen
Für die Anwendung der PLC Variante I (Trigger via XtsUtility) muss
die passende Bibliothek hinzugefügt werden:

Name für Dateipfad abweichend
Beim Anlegen der Bibliothek unter PLC muss ein Name vergeben
werden. Im folgenden Beispiel wurde kein Name vergeben, sodass
der Dateipfad mit Untitled dargestellt wird. Beachten Sie, dass Ihr
Dateipfad entsprechend anders aussieht.

► Solution Explorer > TwinCAT Project > PLC > Untitled1 > Untit-
led Project ausklappen

► Mit der rechten Maustaste auf References klicken, um das Kon-
textmenü aufzurufen

► Im Kontextmenü auf Add library … klicken

Das Dialogfenster Add Library öffnet sich.
► (Miscellaneous) ausklappen
► Auf Tc3_XTS_Utility klicken
► Mit OK bestätigen
Die Bibliothek wird zum Projekt hinzugefügt.
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► Solution Explorer > TwinCAT Project > PLC > PLC1 > PLC Pro-
ject > References ausklappen

► Überprüfen, ob die Tc3_XTS_Utility-Bibliothek zu dem Projekt
hinzugefügt wurde

Je nachdem ob das Processing Unit-Objekt oder das TcIoXtsDrv-
Objekt verwendet wird, unterscheiden sich die Funktionen in der Bi-
bliothek.
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PLC Variante I (Trigger via XtsUtility)
Sie haben die Möglichkeit, die Mover ID-Erkennung über die PLC
Variante I auszulösen. Um die Suche automatisch anzusteuern,
können Sie die folgenden Beispiel-Codes für das Processing Unit-
Objekt und das TcIoXtsDrv-Objekt nutzen:

XTS Processing Unit-Objekt

// Declaration Part
PROGRAM MAIN
VAR
     stMoverRef                       : ARRAY [1..cAxcnt] OF AXIS_REF;

     fbXtsUnit                        : FB_XtsUnit;

     eMoverIdDetectionMode            : MoverIdDetectionMode:= MoverIdDetectionMode.Mover1; 
                                        //Should be the same as shown in the TcIoXtsDrv object
     bStartMoverIdDetection           : BOOL := TRUE; //Can also be written to trigger the process
                                        manually after start up

     bMoverIdDetectionError           : BOOL;
     bMoverIdDetected                 : BOOL;
     bMoverIdDetectionActive          : BOOL;
END_VAR

VAR CONSTANT
     cAxcnt                           : INT:=10; // Example
END_VAR

//----------------------------------------------------------------------------------------------------

// Programm Part
// Cyclic call of the main block of the XtsUtility Library.
fbXtsUnit(Axis := stMoverRef);

// Check if the position detection of the Movers has been completed.
IF NOT fbXtsUnit.stXtsUnit.stTcIoXtsDrv.stParameter.bAreAllMoverPositionsValid THEN
     // If not all Mover positions are valid, do not process any further.
     RETURN;
END_IF

// Mover1 Functionality
// Check if "MoverIdDetectionMode" has been activated.
IF eMoverIdDetectionMode = E_MoverIdDetectionMode.Mover1 THEN

     // Check if the "MoverIdDetection" has already been started or the Mover1 was found.
     IF bStartMoverIdDetection AND NOT (bMoverIdDetectionActive OR bMoverIdDetected) THEN
          bStartMoverIdDetection:=FALSE;

          // Trigger the "MoverIdDetection".
          fbXtsUnit.stXtsUnit.stTcIoXtsDrv.ipTcXtsIo.TriggerMoverIdDetection();
          bMoverIdDetectionActive:=TRUE;
     END_IF

     // Check for error or success of "MoverIdDetection".
     bMoverIdDetectionError := fbXtsUnit.stXtsUnit.stTcIoXtsDrv.stParameter.bHasMoverIdDetectionError;
     bMoverIdDetected       := fbXtsUnit.stXtsUnit.stTcIoXtsDrv.stParameter.bIsMoverIdDetectionValid;

     // If the detection has an error, check for errors in output and try again.
     IF bMoverIdDetectionError THEN
          bMoverIdDetectionActive:=FALSE;
          RETURN;
     END_IF

     // Do not process any further until the "MoverId" was deteced.
     IF NOT bMoverIdDetected THEN
          RETURN;
     END_IF
     bMoverIdDetectionActive:=FALSE;

// If the "MoverIdDetection" was not activated,
// then the start of the "MoverIdDetection" and the search of Mover1 is skipped.
ELSE
     ;
END_IF
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TcIoXtsDrv-Objekt

// Declaration Part
PROGRAM MAIN
VAR
     fbXtsEnvironment                 : FB_TcIoXtsEnvironment;
     bInit                            : BOOL;

     bStartMoverIdDetection           : BOOL:=TRUE; // Can also be written to trigger the process
                                        manually after start up

     bMoverIdDetectionError           : BOOL;
     bMoverIdDetected                 : BOOL;
     bMoverIdDetectionActive          : BOOL;
END_VAR

//----------------------------------------------------------------------------------------------------

// Programm part
//Trigger only once in init.
IF NOT bInit THEN
     IF fbXtsEnvironment.Init(TRUE) THEN
          fbXtsEnvironment.Init(FALSE);
          bInit:=TRUE;
     END_IF
     RETURN;
END_IF

// Check if the position detection of the Movers has been completed.
IF NOT fbXtsEnvironment.XpuTcIo(1).GetAreAllPositionsValid() THEN
     // If not all Mover positions are valid, do not process any further.
     RETURN;
END_IF

// Mover1 Functionality
// Check if "MoverIdDetectionMode" has been activated under the XtsProcessingUnit object.
IF fbXtsEnvironment.XpuTcIo(1).GetMoverIdDetectionMode() = MoverIdDetectionMode.Mover1 THEN

     // Check if the "MoverIdDetection" has already been started or the Mover1 was found.
     IF bStartMoverIdDetection AND NOT (bMoverIdDetectionActive OR bMoverIdDetected) THEN
          bStartMoverIdDetection:=FALSE;

          // Trigger the "MoverIdDetection".
          fbXtsEnvironment.XpuTcIo(1).TriggerMoverIdDetection();
     END_IF

     // Check for error or success of "MoverIdDetection".
     bMoverIdDetectionError := fbXtsEnvironment.XpuTcIo(1).GetHasMoverIdDetectionError();
     bMoverIdDetected := fbXtsEnvironment.XpuTcIo(1).GetIsMoverIdDetectionValid();
     bMoverIdDetectionActive := fbXtsEnvironment.XpuTcIo(1).GetIsMoverIdDetectionActive();

     // If the detection has an error, check for errors in output and try again.
     IF bMoverIdDetectionError THEN
          RETURN;
     END_IF

     // Do not process any further until the "MoverId" was deteced.
     IF NOT bMoverIdDetected THEN
          RETURN;
     END_IF

     // Do not process any further until the "MoverId" was deteced.
     IF NOT bMoverIdDetected THEN
          RETURN;
     END_IF

// If the "MoverIdDetection" was not activated in the XtsProcessingUnit object,
// then the activation of the "MoverIdDetection" and the search of Mover1 is skipped.
ELSE
     ;
END_IF
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PLC Variante II (Trigger via ADS-Write)
Sie haben die Möglichkeit, die Mover ID-Erkennung über die PLC
Variante II auszulösen. Der Zugriff auf Parameter des XTS Proces-
sing Unit-Objekts kann über ADSREAD-Befehle und ADSWRITE-
Befehle erfolgen.
Weitere Informationen dazu finden Sie unter folgenden Links:

Direktlink zum Handbuch TE1000 TwinCAT 3 | PLC-Biblio-
thek: Tc2_System

Direktlink zu den Funktionsbausteinen

Für die Parametrierung benötigen Sie folgende XTS spezifische An-
gaben:

Parameter Codeblock Erläuterung
Task Port PORT : T_AmsPort; Task Port der XTS Task.
Object Id IDXGRP : UDINT; Object ID aus dem XTS

Processing Unit-Objekt.
PTCID IDXOFFS : UDINT; PTCID des Parameters.

► Solution Explorer > TwinCAT Project > SYSTEM > Tasks aus-
klappen

► Doppelklick auf XTS Task

► Im Projektfenster auf den Reiter Task klicken
► Wert bei Port ablesen
Standardmäßig ist der Wert 350 voreingestellt.

https://download.beckhoff.com/download/Document/automation/twincat3/TwinCAT_3_PLC_Lib_Tc2_System_DE.pdf
https://download.beckhoff.com/download/Document/automation/twincat3/TwinCAT_3_PLC_Lib_Tc2_System_DE.pdf
https://infosys.beckhoff.com/content/1031/tcplclib_tc2_system/4566798475.html
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Object Id
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects ausklappen
► Doppelklick auf XTS Processing Unit

► Im Projektfenster auf den Reiter Object klicken
► Wert bei Object Id ablesen

PTCID
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-

jects ausklappen
► Doppelklick auf XTS Processing Unit
Die angezeigten Werte des XTS Processing Unit-Objekts und des
TcIoXtsDrv-Objekts unterscheiden sich voneinander.

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Wert bei TriggerMoverIdDetection ablesen
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Beispiel TriggerMoverIdDetection
Im Folgenden sehen Sie Beispiel-Codes für eine TriggerMoverIdDe-
tection:

ADSWRITE

// Declaration part
PROGRAM MAIN
VAR
     fbAdsWrite     : ADSWRITE;
END_VAR

//----------------------------------------------------------------------------------------------------

// Programm part
fbAdsWrite(
     NETID      := ´´,
     PORT       := 350,               // Taskport of the XTS-Task
     IDXGRP     := 16#01010010,       // Object Id of the driver object
     IDXOFFS    := 16#205,            // PTDCID of TriggerMoverIdDetection
     WRITE      := TRUE);             // Trigger

ADSREAD

// Declaration part
PROGRAM MAIN
VAR
     fbAdsRead     : ADSREAD;
     TempData      : BOOL; // Needs to be the data type that is read
END_VAR

//----------------------------------------------------------------------------------------------------

// Programm part
fbAdsRead(
     NETID      := ´´,
     PORT       := 350,               // Taskport of the XTS-Task
     IDXGRP     := 16#01010010,       // Object Id of the driver object
     IDXOFFS    := 16#251,            // PTDCID of IsIdDetectionValid
     LEN        := SIZEOF(TempData),  // Size of the read out data
     DESTADDR   := ADR(TempData),     // Address to which the data should be written to
     READ       := TRUE);             // Trigger
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6.3.4 Erweiterte Bedienung im TcSoftDrive-Objekt

6.3.4.1 Parameter
Über das Processing Unit-Objekt wird die Mover ID-Erkennung je
Mover-Achse gesteuert und ausgeführt. Sie haben die Möglichkeit
den Ablauf der Suche anzupassen, indem Sie einige Parameter ein-
stellen sowie das Erkennungsverfahren über die Mover-Achse konfi-
gurieren. In der Regel stimmen jedoch die Standardparameter mit
Ihrem XTS System überein.
Die folgenden Tabellen zeigen die Standardparameter für die
Beckhoff Mover:

Parameter Default Min Max Unit Tab
DetectionMinMovement 0,1 0,01 2,0 mm Init
DetectionFilter 250 0 5000 Hz Init
DetectionCurrentRamp 25 10 1000 mA/ms Init
DetectionMaxCurrent 12 0,5 13 A Init

Anpassung der Standardparameter bei kundenspezifischen Mo-
vern
Bei kundenspezifischen Movern, die sich in der Steifigkeit, der Mas-
se oder anderem abweichenden mechanischen Verhalten von den
Beckhoff Movern unterscheiden, kann es notwendig sein, die Stan-
dardparameter anzupassen, um die Mover ID-Erkennung zu opti-
mieren.

DetectionMinMovement Positionsänderung, die der Mover während der Mover ID-Erkennung
mindestens erfahren muss, damit die Erkennung erfolgreich durch-
geführt werden kann.

DetectionFilter Filter für die Stromänderung.

DetectionCurrentRamp Steigung des Stroms der Mover ID-Erkennung.

DetectionMaxCurrent Maximalwert des Stroms der Mover ID-Erkennung.

DetectionStatus Status der Mover ID-Erkennung.
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► Solution Explorer > TwinCAT Project > MOTION > NC SAF >
Axes > Mover Axis > SoftDrive > Data Pointer ausklappen

► Doppelklick auf FeedForward_Obj6 (CTcSdFeedForward)

Parameter (Init)
► Im Projektfenster auf den Reiter Parameter (Init) klicken
► MoverIdDetection ausklappen

► Bei Bedarf den Wert für die minimale Positionsänderung wäh-
rend der Mover ID-Erkennung im Eingabefeld DetectionMinMo-
vement verkleinern, um die Positionsänderung der Mover zu ver-
ringern

ODER
► Bei Bedarf den Wert für die minimale Positionsänderung wäh-

rend der Mover ID-Erkennung im Eingabefeld DetectionMinMo-
vement erhöhen, um die Positionsänderung der Mover zu ver-
größern

► Bei Bedarf den Wert für den Filter der Stromänderung im Einga-
befeld DetectionFilter verkleinern, um den Strom langsamer auf-
zubauen und die Mover ID-Erkennung sanfter erfolgen zu lassen

ODER
► Bei Bedarf den Wert für den Filter der Stromänderung im Einga-

befeld DetectionFilter erhöhen, um den Strom schneller aufzu-
bauen und die Mover ID-Erkennung ruckartiger erfolgen zu las-
sen

► Bei Bedarf den Wert für die Steigung des Stroms der Mover ID-
Erkennung im Eingabefeld DetectionCurrentRamp ändern
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► Bei Bedarf den Wert für Grenze des Stroms der Mover ID-Erken-
nung im Eingabefeld DetectionMaxCurrent ändern

Parameter (Online)
► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Ergebnis bei DetectionStatus prüfen:

OFF
Mover ID-Erkennung wird nicht genutzt.

ACTIVE
Mover ID-Erkennung läuft.

ERROR
Mover ID-Erkennung ist fehlgeschlagen.

FOUND_Standard
Für einen bestimmten Mover wurde das Magnetplatttenset Standard
gefunden.

FOUND_Mover1
Für einen bestimmten Mover wurde das Magnetplattenset Mover 1
gefunden.
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6.3.4.2 Hidden Parameter
Für die erweiterte Bedienung und Konfiguration der Mover ID-Erken-
nung haben Sie die Möglichkeit Hidden Parameter zu verwenden.
Sie können zum Beispiel verschiedene Wartezeiten der Mover an-
passen.
Die folgende Tabelle zeigt die Standardparameter:

Hidden Parameter Default Min Max Unit Tab
DetectionStandstillVelocityLimit 15 1 1000 mm/s Init
DetectionStandstillSwitchTime 0,015 0,00 1,0 s Init
DetectionTimeOut 2 0 10 s Init
DetectionInfoMessage FALSE FALSE TRUE -- Init

► Kontrollkästchen Show Hidden Parameter aktivieren, um die
Hidden Parameter einzublenden

DetectionStandstillVelocityLi-
mit

Festlegung der maximalen Geschwindigkeit für die Stillstandsüber-
wachung.
Wert < Standardparameter:
Die Suche wechselt später in die nächste Phase.
Wert > Standardparameter:
Die Suche wechselt früher in die nächste Phase.

DetectionStandstillSwitchTime Zeit, in der der Mover mit der Geschwindigkeit unter dem Wert des
Parameters DetectionStandstillVelocityLimit liegen muss.
Wert < Standardparameter:
Die Suche wird beschleunigt.
Wert > Standardparameter:
Die Suche wird verlangsamt.

DetectionTimeOut Gesamtzeitüberschreitung für die Mover ID-Erkennung. Wenn diese
Zeit erreicht wird, tritt ein Fehler auf. Mögliche Ursachen:
• zu wenig Bewegung durch einen zu geringen Wert im Eingabe-

feld DetectionMaxCurrent
• fehlende 48 V Spannungsversorgung
• zu großer Wert im Eingabefeld DetectionMaxMovement
• zu geringer Wert im Eingabefeld DetectionMinCurrent

Mit dem Standardparameter DetectionMaxCurrent sollten Sie immer
die DetectionMinMovement-Bewegung erreichen können.

DetectionInfoMessage Meldungen werden im TwinCAT-Ausgabefenster angezeigt.



Funktionen des Treibers

Version: 1.1.1 ─── 111TF5850

6.3.5 Erkennungsphasen der Mover ID-Erkennung
In den folgenden Abbildungen werden die Auswirkungen der Para-
meter einer Mover ID-Erkennung dargestellt. Die Phasen 1 bis 4
werden beispielhaft mit den Standardparametern abgebildet.

6.3.5.1 Phase 1
► Ersten Stromvektor einstellen

Position Erläuterung
1 Der Absolutwert des Stromvektors wird entsprechend dem Parameter DetectionCurrentRamp er-

höht.
2 Die Bewegung wird überwacht, bis der Wert des Parameters DetectionMinMovement erreicht ist.
3 Der Strom wird über einen Filter abgesenkt, definiert durch den Parameter DetectionFilter.
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6.3.5.2 Phase 2
► Warten, bis der Mover wieder stillsteht

Position Erläuterung
1 Warten bis die Geschwindigkeit kleiner als der mit dem Parameter DetectionStandstillVelocityLimit

eingestellte Grenzwert ist.
2 Die Geschwindigkeit muss für eine mit dem Parameter DetectionStandstillSwitchTime eingestellte

Zeit kontinuierlich unter der Grenzgeschwindigkeit liegen.
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6.3.5.3 Phase 3
► Zweiten Stromvektor in entgegengesetzte Richtung setzen

Position Erläuterung
1 Der Absolutwert des aktuellen Vektors wird entsprechend dem Parameter DetectionCurrentRamp

erhöht.
2 Die Bewegung wird überwacht, bis der Wert des Parameters DetectionMinMovement erreicht ist.
3 Der Strom wird über einen Filter abgesenkt, definiert durch den Parameter DetectionFilter.
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6.3.5.4 Phase 4
► Warten, bis der Mover wieder stillsteht

Position Erläuterung
1 Warten bis die Geschwindigkeit unter dem eingestellten Grenzwert des Parameters Detection-

StandstillVelocityLimit ist.
2 Die Geschwindigkeit muss für eine mit dem Parameter DetectionStandstillSwitchTime eingestellte

Zeit kontinuierlich unter der Grenzgeschwindigkeit liegen.
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6.4 Teaching-Funktionalität

6.4.1 Teaching im Stillstand
Das Teaching im Stillstand ist eine zusätzliche Funktion, die zur Ka-
librierung des Nullwert-Signals von Sensoren an XTS Modulen ver-
wendet werden kann.
Es werden alle Sensorwerte von Modulen erfasst, auf denen sich
kein Mover befindet, der die Sensoren beeinflussen kann. Die er-
fassten Werte werden in einer speziellen Teaching-Datei gespei-
chert, die dazu benutzt wird, die realen Werte auf 0 zu setzen. Gibt
ein Sensor von einem Modul, auf dem sich kein Mover befindet, bei-
spielsweise 500 zurück, wird der Wert erfasst und gespeichert, so-
dass das Offset -500 sein muss, um den Nullwert zu erreichen.
Ein Teaching im Stillstand kann durchgeführt werden, um Störeffek-
te auf das Modul zu beseitigen, eine verbesserte Genauigkeit und
eine verbesserte Erkennung der Mover zu erhalten.

HINWEIS
Revisionsnummer beachten
Module mit einem Sensor-Revisionsstand ≥ 18 werden bereits in
der Produktion abgeglichen. Ein zusätzliches Teaching ist nur er-
forderlich, wenn die Genauigkeit verbessert werden muss oder
Probleme bei der Erkennung der Mover auftreten.
Module mit einem Sensor-Revisionsstand ≤ 17 müssen manuell
abgeglichen werden, um das System zu starten und die Mover zu
erkennen.

Systemart beachten
Das Teaching im Stillstand ist nur beim XTS Standard System an-
wendbar und nicht für das XTS Hygienic System verfügbar.

6.4.1.1 Teaching aktivieren
► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Teaching ausklappen
► TRUE im Dropdown-Menü IsTeachingEnabled auswählen, um

das Teaching zu aktivieren
Sie haben zudem die Möglichkeit das Teaching im XTS Configurator
zu aktivieren. Weitere Informationen dazu finden Sie im Kapitel „Te-
aching“, [Seite 267].
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6.4.1.2 Nummer der Teaching-Datei eingeben
Zur Eingabe der Nummer der Teaching-Datei muss das Teaching
aktiviert sein.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects ausklappen

► Doppelklick auf XtsProcessingUnit

Teaching File Number ändern
Ändern Sie die Nummer der Teaching-Datei immer bevor Sie mit
einem neuen Teaching beginnen. Wenn die Nummer der Tea-
ching-Datei nicht geändert wird oder die Konfiguration nicht gela-
den wird, wird die alte Datei verwendet und überschrieben.
Beckhoff empfiehlt für die Nummer der Teaching-Datei das aktu-
elle Datum zu verwenden. Für das erste Teaching am
03. April 2021 können beispielsweise die Ziffern 202104031 ver-
wendet werden und für das zweite Teaching am selben Tag die
Ziffern 202104032 und so weiter.

► Im Projektfenster auf den Reiter Parameter (init) klicken
► Teaching ausklappen
► In das Eingabefeld TeachingFileNumber die Nummer der Tea-

ching-Datei eingeben
Sie haben zudem die Möglichkeit die TeachingFileNumber im XTS
Configurator zu ändern. Weitere Informationen dazu finden Sie im
Kapitel „Teaching“, [Seite 267].

► Auf die Schaltfläche ActivateConfiguration klicken, um die
Konfiguration zu aktivieren und die Nummer der Teaching-Datei
zu laden
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6.4.1.3 Teaching-Modus auswählen
Vor dem Teaching im Stillstand muss festgelegt werden, mit wel-
chem teachingSelection-Parameter das Teaching durchgeführt wer-
den soll. Die Auswahl des Parameters entscheidet, welche Module
in das Eingabefeld .selectionString eingegeben werden müssen.

ExcludeSpecifiedItems Module, auf denen sich Mover befinden, werden vom Teaching aus-
geschlossen. Die entsprechenden Modulnummern müssen im Ein-
gabefeld .selectionString eingegeben werden.

IncludeSpecifiedItems Module, auf denen sich keine Mover befinden, werden in das Tea-
ching einbezogen. Die entsprechenden Modulnummern müssen im
Eingabefeld .selectionString eingegeben werden.

► StartStandStillTeaching ausklappen
► ExcludeSpecifiedItems im Dropdown-Menü .teachingSelection

auswählen, um Module mit Movern vom Teaching auszuschlie-
ßen

ODER
► IncludeSpecifiedItems im Dropdown-Menü .teachingSelection

auswählen, um Module ohne Mover ins Teaching zu integrieren

Abstände beachten
Das Teaching eines Moduls, auf dem sich ein Mover befindet,
kann zu einem falschen Abgleich eines benachbarten Moduls
führen, wenn der Abstand des Movers zum Rand zu gering ist.

► Darauf achten, dass die Geberfahne eines Movers das Teaching
eines leeren Moduls nicht beeinflusst

2020

1 2

Für die Auswahl des Parameters teachingSelection ist es wichtig,
dass der Abstand zwischen der Geberfahne  [1] eines Movers und
der Außenkante [2] eines leeren Moduls mindestens 20 mm beträgt.
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6.4.1.4 Module eingeben

Die Modulnummer finden Sie unter Solution Explorer > TwinCAT
Project > SYSTEM > TcCOM Objects > XtsProcessingUnit > Part >
Module.

► In das Eingabefeld .selectionString die Modulnummern eingeben
Die Modulnummern können mit den Zeichen ‑ und , oder einer Kom-
bination aus beiden Zeichen eingegeben werden, beispielsweise
1‑4, 1,2,3,4 oder 1‑3,4.

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► In das Eingabefeld PositionIndex die Hardwareposition eingeben
Das erste Modul hat die Hardwareposition 0.

6.4.1.5 Teaching starten
Nach der Auswahl des Teaching-Modus und nach Eingabe der ent-
sprechenden Module, kann das Teaching gestartet werden.

► Mit der rechten Maustaste in das Eingabefeld StartStandStillTea-
ching klicken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Download klicken
Das Teaching wird gestartet und dauert wenige Sekunden.
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Im Meldungsfenster Error List erscheinen die Meldungen Teaching
is started und Teaching is stopped.

Wenn die Meldung […] are not in the expected range
(-600.000000, 600.000000) erscheint, sind die Module nicht abgegli-
chen und verfügen über einen Sensor-Revisionsstand ≤ 17.
Wenn die Meldung Mover lost errors erscheint:
► Überprüfen, ob der richtige Teaching-Modus im Dropdown-Menü

teachingSelection eingegeben ist
► Überprüfen, ob im Eingabefeld .selectionString die richtigen Mo-

dule eingegeben sind
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Wenn Warnungen in den Meldungsfenstern Error List oder Output
angezeigt werden, gibt es möglicherweise ein Problem mit dem En-
coder Ihres Moduls. Kontaktieren Sie den für Ihre Region zuständi-
gen Produktspezialisten.

Das Teaching ist abgeschlossen, sobald alle leeren Module abgegli-
chen wurden. Abhängig von der Anzahl der Module, der Mover und
dem Teaching-Modus muss das Teaching mehrmals wiederholt
werden, bis jedes Modul leer abgeglichen wurde. Überprüfen Sie,
dass sich im Modus IncludedSpecifiedItems keine Mover auf den
Modulen befinden, die im Eingabefeld selectionString eingetragen
wurden.
Nach der Überprüfung und Korrektur der Eingaben, muss die Konfi-
guration erneut aktiviert werden.

► Auf die Schaltfläche ActivateConfiguration klicken, um die
Konfiguration zu aktivieren

Im Meldungsfenster Error List erscheinen Meldungen, dass die Tea-
ching-Datei geladen wurde und der Plausibility Check erfolgreich
war.

Wenn die Teaching-Datei nicht geladen wurde und der Plausibility
Check nicht erfolgreich war:
► Überprüfen, welche Meldungen unter Output angezeigt werden

Wenn Warnungen in den Meldungsfenstern Error List oder Output
angezeigt werden, gibt es möglicherweise ein Problem mit dem En-
coder Ihres Moduls. Kontaktieren Sie den für Ihre Region zuständi-
gen Produktspezialisten.
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Wenn sich TwinCAT im Run-Modus befindet, lässt sich das Ergeb-
nis des Teachings auch im Projektfenster unter dem Reiter Parame-
ter (Online) überprüfen.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects ausklappen

► Doppelklick auf XtsProcessingUnit

► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Teaching ausklappen
Wenn die Teaching-Datei überschrieben wurde, zeigt der Parameter
IsTeachingChanged TRUE an.
Wenn das Teaching gültig ist und die Teaching-Datei richtig geladen
wurde, zeigt der Parameter IsTeachingValid TRUE an.
Wenn die Teaching-Datei die neueste Version verwendet, zeigt der
Parameter IsTeachingFileUpToDate TRUE an.

6.4.1.6 Teaching-Datei Update
Ein bereits gespeichertes Teaching, das mit einer älteren Software-
version erstellt wurde, kann von der neuesten Softwareversion ver-
wendet werden.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects ausklappen

► Doppelklick auf XtsProcessingUnit

► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Teaching ausklappen
► Online-Status von Parameter IsTeachingFileFormatUpToDate

prüfen
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Wenn der Parameters IsTeachingFileFormatUpToDate den Online-
Status FALSE anzeigt:

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Teaching ausklappen
► Mit der rechten Maustaste in das Eingabefeld TriggerTeaching-

FileFormatUpdate klicken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Download klicken

Wenn der Download erfolgreich war, zeigen die Parameter
IsTeachingValid und IsTeachingFileFormateUpToDate TRUE an.
Wenn der Download nicht erfolgreich war, zeigen die Parameter
IsTeachingValid und IsTeachingFileFormateUpToDate FALSE an
und im Meldungsfenster Error List wird eine Fehlermeldung ausge-
geben.
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6.5 Track Management-Funktionalität
Mit der Track Management-Funktionalität kann ein XTS System in
einzelne, räumlich getrennte Streckenabschnitte unterteilt werden.
Bewegte Streckenabschnitte ermöglichen den Movern beispielswei-
se einen Wechsel zwischen zwei festen, aber räumlich getrennten
Streckenabschnitten. Auf den bewegten Streckenabschnitten verfü-
gen sowohl die Mover als auch die Module über ihre volle Funkti-
onsfähigkeit und bleiben als volle Fahrstrecke erhalten.
Ein XTS System mit Track Management erfordert eine erweiterte
Programmierung zum Verfahren der Mover und zur Positionsüber-
wachung als ein geschlossenes XTS System, da die Mover nicht
mehr konstant auf einem einzigen geschlossenen Track fahren und
sich ihre Reihenfolge durch den Wechsel auf andere Tracks ändert.

6.5.1 Geschlossenes XTS System

Bei einem geschlossenen XTS System bleibt die Reihenfolge der
Module und Mover immer konstant. Die Mover haben somit nur
einen möglichen Track, auf dem sie sich bewegen können.

6.5.2 XTS System mit Track Management

Bei einem XTS System mit Track Management können die Module
ihre Position verändern und sich an anderen Modulen ausrichten.
Auf diese Weise entstehen neue Tracks und die Reihenfolge der
Mover verändert sich.
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6.5.3 Voraussetzungen
Um ein XTS System mit Track Management nutzen zu können,
müssen einige Anforderungen an Software und Hardware erfüllt
sein.

6.5.3.1 Software
Folgende Softwareversionen müssen auf Ihrem System vorhanden
sein:

Software Version
TwinCAT 3 3.1.4024.0 oder höher
TF5850 | TwinCAT 3 XTS Extension 3.20.700.0 oder höher
TF5400 TwinCAT 3 Advanced Motion Pack 3.1.10.14 oder höher

6.5.3.2 Hardware
Für die Umsetzung des XTS Track Managements benötigen Sie ne-
ben mehreren Modulen mindestens ein Modul mit Steckverbinder
AT2002‑0249, um einen Luftspalt zwischen den Modulen für den
bewegten Streckenabschnitt zu ermöglichen. Außerdem werden ein
oder mehrere Mover und eine geeignete Mechanik für den beweg-
ten Streckenabschnitt, beispielsweise eine Spindelachse oder einen
Linearmotor, benötigt.
Folgende Komponenten müssen für die Nutzung von Track Mana-
gement in Ihrem XTS System vorhanden sein:
• Mindestens ein verkürztes Modul mit Steckverbinder

AT2002‑0249
• Leitungen mit Steckverbinder
• Mover: AT9011-0x70, AT9014-0x70 oder externe Mover

Weitere Informationen dazu finden Sie im Kapitel „Konfigurations-
aufbau“, [Seite 125] und in der XTS Original-Betriebsanleitung:

Direktlink zur XTS Original-Betriebsanleitung

https://download.beckhoff.com/download/document/motion/xts_ba_de.pdf
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6.5.4 Konfigurationsaufbau
Im Gegensatz zu einem geschlossenen XTS System unterscheidet
sich ein XTS System mit Track Management durch seinen Aufbau
mit festen und bewegten Streckenabschnitten deutlich. Damit ein
Streckabschnitt bewegt werden kann, ist ein Luftspalt zwischen be-
wegtem und festem Streckenabschnitt erforderlich. Der erforderliche
Luftspalt lässt sich durch die Verwendung von verkürzten Modulen
und entsprechenden Führungsschienen realisieren.

6.5.4.1 Verfahrachsen für bewegte Streckenabschnitte

Das Ineinandergreifen der Beckhoff Führungsschienen ermöglicht
ein Bewegen eines Streckenabschnitts in X-Richtung und Y-Rich-
tung. Eine Bewegung in Z-Richtung ist durch das Ineinandergreifen
der Führungsschienen nicht möglich.
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Für die Bewegung eines Streckenabschnitts in X-Richtung und
Y‑Richtung oder in Z-Richtung müssen parallele Führungsschienen
von Drittherstellern verwendet werden, die nicht ineinandergreifen.
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6.5.4.2 Luftspalt
Der erforderliche Luftspalt lässt sich mit einem oder zwei Modulen
AT2002-0249 realisieren. Dieses Modul ist 1  mm kürzer als ein
Standard XTS Modul und ermöglicht einen beidseitigen Luftspalt
von 0,5 mm oder 1 mm.

Für ein XTS System mit Track Management mit Beckhoff Führungs-
schienen werden zwei Module AT2002‑0249 als Module mit
250 mm Länge verwendet. Daraus ergibt sich ein Spalt von 1 mm
auf beiden Seiten des bewegten Streckenabschnitts.
Durch das Ineinandergreifen der Beckhoff Führungsschienen ist die-
ser Luftspalt groß genug, um den Streckenabschnitt zu bewegen,
und klein genug, um die Mover problemlos zu verfahren.
Der Luftspalt muss in den Parametern eingetragen werden. Weitere
Informationen dazu finden Sie im Kapitel „Luftspalt eingeben“, [Seite
 135].

Für ein Track Management System ohne Beckhoff Führungsschie-
nen wird ein Modul AT2002‑0249 als Modul mit 250 mm Länge ver-
wendet. Daraus ergibt sich ein Spalt von 0,5 mm auf beiden Seiten
des bewegten Streckenabschnitts.
Der Luftspalt muss in den Parametern eingetragen werden. Weitere
Informationen dazu finden Sie im Kapitel „Luftspalt eingeben“, [Seite
 135].

HINWEIS
Nur ein Modul AT2002-0249 bei externen Führungsschienen
Externe Führungsschienen dürfen nur mit einem einzigen Modul
AT2002-0249 verwendet werden, da die Toleranzen geringer
sind. Schienen, die nicht ineinandergreifen, führen zu einer höhe-
ren Reibung beim Überfahren des physikalischen Luftspalts.

Kontaktieren Sie den Hersteller der externen Führungsschiene, um
zu klären, ob die Führungsschiene für das XTS Track Management
genutzt werden kann.
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6.5.4.3 Mover

Nur Beckhoff 70 mm Mover oder externe Mover verwenden
Für das Track Management dürfen nur Beckhoff-Mover mit 70 mm
Länge und externe Mover verwendet werden, die die vorgegebenen
Toleranzen einhalten.

Es sind nur folgende Mover für das Track Management zugelassen:
• AT9011-0070
• AT9014-0070
• Externe Mover

Kontaktieren Sie den Hersteller des externen Movers, um zu klären,
ob der Mover für das Track Management genutzt werden kann und
ob der Mover und das Führungssystem geeignet sind.

6.5.4.4 Verkabelung
Im Vergleich zu einem geschlossenen XTS System werden bei ei-
nem XTS System mit Track Management mehr Module mit Einspei-
sung verwendet, da jeder bewegliche Streckenabschnitt eine eigene
Einspeisung benötigt.
Für Applikationen mit mehr als 32 Modulen mit Einspeisung kontak-
tieren Sie den für Ihre Region zuständigen Produktspezialisten.
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6.5.4.5 Tracks
Auf Grundlage von Parts wird die genaue Position des Movers und
sein Fahrtweg ermittelt. Die unterschiedlichen Parts setzen sich zu
Tracks zusammen, auf denen die Mover fahren.

Beispiel mit vier Parts
Die Zusammensetzung der Parts zu Tracks wird beispielhaft an ei-
nem XTS System mit vier Parts dargestellt

Weitere Informationen dazu finden Sie im Kapitel „XTS Konfigurati-
on“, [Seite 24].
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6.5.4.6 Varianten für die Mover-Organisation
Die bewegten Streckenabschnitte sorgen dafür, dass sich die Rei-
henfolge der Mover permanent ändert. Daher ist es erforderlich eine
objektorientierte Programmierung zu verwenden, um die Mover in-
nerhalb des Systems zu organisieren.
Die Mover-Organisation kann beispielsweise mit einem lokalen oder
einem globalen Ansatz erfolgen. Des Weiteren lassen sich diese
Ansätze miteinander kombinieren und die Vorteile beider Ansätze
optimal nutzen.

Lokaler Ansatz
Der lokale Ansatz ist geeignet für ein XTS System mit:
• vielen Movern
• vielen bewegten Parts

Dieser Ansatz gibt Ihnen die Möglichkeit mit einer geringen Anzahl
von Tracks zu arbeiten. In diesem Beispiel verfügt das XTS System
über zehn mögliche Tracks, von denen aber nur zwei Tracks ver-
wendet werden. In virtuellen Stationen wechseln Mover von einem
Track auf den nächsten Track.

Entscheidend bei Verwendung des lokalen Ansatzes ist, dass die
Kollisionsvermeidung manuell erfolgen muss. Bei einem Wechsel ei-
nes Movers von einem zum anderen Track erkennen die verbliebe-
nen Mover den Mover auf dem bewegten Streckenabschnitt nicht
mehr, da die Kollisionsvermeidung Track-basierend funktioniert. Der
Programmierer muss sicherstellen, dass sich die Mover auf dem
richtigen Track befinden und nicht miteinander kollidieren.
Weitere Informationen zur Kollisionsvermeidung finden Sie im Kapi-
tel „Collision Avoidance-Funktionalität“, [Seite 140].
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Globaler Ansatz
Der globale Ansatz ist geeignet für ein XTS System mit:
• wenigen Movern
• wenigen bewegten Parts

Dieser Ansatz gibt Ihnen die Möglichkeit ohne virtuelle Stationen
und nur mit Tracks zu arbeiten. In diesem Beispiel verfügt das XTS
System über zehn mögliche Tracks, die nicht gleichzeitig für die Mo-
ver aktiviert sind. Die Mover werden bei diesem Ansatz auf den rich-
tigen Track geschaltet, basierend auf der Position der bewegten
Streckenabschnitte.

Während sich die beiden äußeren Streckabschnitte bewegen, sind
in dieser Konfiguration alle Parts eigenständige Tracks. Sobald ein
bewegter Streckabschnitt mit dem oberen Modul übereinstimmt,
wird ein neue Konfiguration mit einem neuen Track gebildet. In die-
sem Beispiel bilden Part 2, Part  3 und Part 4 zusammen Track 5
und die Mover wechseln automatisch auf diesen neuen Track.
Dieser globale Ansatz eignet sich für eine überschaubare Anzahl
von Movern und Tracks. Je mehr bewegte Streckenabschnitte in Ih-
rem XTS System vorhanden sind, desto mehr mögliche Tracks gibt
es. Das exponentielle Wachstum führt dazu, dass ab einem gewis-
sen Punkt die Anzahl an möglichen Konfigurationen zu groß ist und
der globale Ansatz für dieses System ungeeignet ist.
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Die Kollisionsvermeidung der Mover findet ohne manuelle Prüfung
und korrekt statt.

Aktivierung eines neuen Tracks stoppt aktive Fahrbefehle
Der MC_ActivateTrack bricht momentan den aktiven Fahrbefehl al-
ler Mover ab, sobald ein neuer Track aktiviert wird. Der Fahrbefehl
muss anschließend manuell neu aktiviert werden. Sie müssen prü-
fen, ob es möglich ist, die neuen Tracks für alle Mover zu aktivieren,
da sonst ein Fehler am Baustein ausgeworfen wird.

Gemischter Ansatz
Der gemischte Ansatz vereint die jeweiligen Vorteile des lokalen und
globalen Ansatzes. Das XTS System wird in Abschnitte unterteilt, in
denen die Tracks die Mover global verwalten. Jeder dieser Ab-
schnitte verfügt über eine begrenzte Anzahl von möglichen Konfigu-
rationen, die einfach zu konfigurieren sind. Die Kollisionsvermeidung
kann dabei in vollem Umfang verwendet werden.
Zwei global organisierte Abschnitte werden anschließend mit einer
virtuellen Station über den lokalen Ansatz miteinander verbunden,
sodass die Mover von einem zum anderen globalen System wech-
seln können.
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6.5.5 Programmierung eines XTS Systems mit Track Management
Da die Mover nicht mehr konstant auf einem einzigen geschlosse-
nen Track fahren, verändert sich ihre kontinuierliche Position, die
von der NC vorgegeben wird. Durch die bewegten Streckenab-
schnitte ist es möglich, dass sich Mover überholen. Das führt dazu,
dass sich die Ausgangspositionen der Mover verändern und Mover
gegebenenfalls die gleiche kontinuierliche Position aufweisen kön-
nen.
Es ist erforderlich, dass ein XTS System mit Track Management ei-
ne erweiterte Programmierung zum Verfahren und zur Positions-
überwachung der Mover nutzt.

Standard XTS System

Bei einem geschlossenen XTS System gibt es jede Position nur ein
einziges Mal. Die maximale Position entspricht der Länge des Sys-
tems. Nachdem der Mover einmal die gesamte Länge gefahren ist,
wird wieder bei Position 0 begonnen.
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XTS System mit Track Management
Für die Positionsermittlung der Mover auf einem XTS System mit
Track Management sind die Positionen und die Objekt IDs aller
Parts oder aller Tracks erforderlich, um doppelte Positionen von Mo-
vern zu vermeiden.

Wenn die Positionsermittlung nur auf Basis der Position auf einem
Part erfolgt, haben die Mover 1, Mover 2, Mover 3, Mover 4 und Mo-
ver  5 in diesem Beispiel alle dieselbe Position von 190  mm. Erst
durch die Kombination von PartPosition und PartId ist eine einzige
exakte Positionsermittlung für jeden Mover möglich. Alternativ kann
auch die Kombination von TrackPosition und TrackId zu einer exak-
ten Positionsermittlung der Mover verwendet werden, da es auch
diese Kombination nur ein einziges Mal im System gibt.
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6.5.5.1 Luftspalt eingeben
Der mit einem verkürzten Modul AT2002-0249 realisierte Luftspalt
für bewegte Streckenabschnitte muss in TwinCAT eingegeben wer-
den. Bei der Eingabe ist zu beachten, von welcher Seite ihr System
in TwinCAT dargestellt wird.

Wenn das XTS System in der Ansicht Front dargestellt wird, befin-
det sich der Luftspalt [1] auf der linken Seite von dem Modul [2].
Wenn das XTS System in der Ansicht Back dargestellt wird, befindet
sich der Luftspalt [1] auf der rechten Seite des Typenschilds [3] von
dem Modul [2].

Manuelles Eingeben oder Verwendung von TwinCAT Tools
Sie haben die Möglichkeit den Luftspalt manuell oder schnell und
einfach über die TwinCAT Tools XTS Configurator und XTS Simula-
tion Builder einzugeben.
Weitere Informationen dazu finden Sie in den Kapiteln „XTS Confi-
gurator“, [Seite 260] und „XTS Simulation Builder“, [Seite 231].

Manuell eingeben
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM

Object > Object (XtsProcessingUnit) ausklappen
► Doppelklick auf Object (AT2002_0249)

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General ausklappen
► In das Eingabefeld Gap einen Wert für den Abstand zwischen

den Modulen eingeben



Funktionen des Treibers

136 ─── Version: 1.1.1TF5850

Im XTS Configurator eingeben
► Seite Parts öffnen
► Auf den Reiter Modules klicken
► Auf ein Modul klicken
► In das Eingabefeld Gap einen Wert für den Abstand zwischen

den Modulen eingeben

Im XTS Simulation Builder eingeben
► XtsProcessingUnit > Parts > Part 1 > Modules ausklappen
► Auf ein Modul klicken
► In das Eingabefeld Gap einen Wert für den Abstand zwischen

den Modulen eingeben
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6.5.5.2 Track aktivieren
Die Mover benötigen aktivierte Tracks, damit der XTS Treiber die In-
formation bekommt, welche Spulen zum Verfahren der Mover akti-
viert werden müssen. Nach dem Start haben alle Mover ihren akti-
ven Track, auf dem sie gefunden werden. Sie haben die Möglichkeit
Tracks manuell zu aktivieren, indem Sie die jeweiligen Parameter
mit der Track ID herunterladen. Um einen weiteren Track für einen
Mover zu aktivieren, muss sich der Mover auf einem Part befinden,
der Teil des XTS Tracks ist, der aktiviert werden soll.

Mit XTS Utility Bibliothek oder ADS lesen
Die Ist-Werte für die Position können mithilfe der XTS Utility Biblio-
thek oder ADS gelesen werden.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM
Objects > XTSProcessingUnit ausklappen

► Doppelklick auf Object (XtsMover)

► Im Projektfenster auf den Reiter Parameter (Online) klicken
► General ausklappen
► Mit der rechten Maustaste in das Eingabefeld ActiveTrackOb-

jectId klicken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Download klicken
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In SPS auslesen
Funktionsbaustein MC_ActivateTrack
Der Funktionsbaustein MC_ActivateTrack wird zur Aktivierung eines
Tracks verwendet. Der Execute-Befehl löst ein Ereignis aus und
Statusbits können ausgelesen werden, um eine Rückmeldung des
Funktionsbausteins zu bekommen.
Der Funktionsbaustein kann in der SPS verwendet werden und
übernimmt die Track-Objekt ID aus dem Track-Objekt. Wenn die
Track-Objekt ID auf 0 gesetzt ist, kann das absolute Referenzsys-
tem, das standardmäßig verwendet wird, für die NC-Achse erneut
aktiviert werden.
Während der Track für den Mover im XTS Treiber aktiviert wird, um
über die Module fahren zu können, wird der Track auch als Refe-
renzsystem in der NC aktiviert. Das Referenzsystem kann dann in
verschiedenen Bewegungsfunktionen zur Positionierung verwendet
werden, beispielsweise MoveAbsoluteCA, HaltCA, GearInPosCA.
Die Achse muss Teil einer CA-Gruppe sein, damit der Funktions-
baustein funktioniert. Der Funktionsbaustein MC_ActivateTrack
bricht andere Bewegungsbefehle automatisch ab, wenn sie ausge-
löst werden.
Weitere Informationen dazu finden Sie in der Dokumentation
TF5410 TwinCAT 3 | Collision Avoidance:

Direktlink zur Dokumentation TF5410 | TwinCAT 3 | Motion
Collision Avoidance

6.5.5.3 Track Positionen ermitteln
Die Positionsermittlung der Mover anhand von Parts eines umlau-
fenden Tracks funktioniert bei einem XTS System mit Track Mana-
gement nicht, da die Parts Teile von unterschiedlichen Tracks sein
können. Mit der MC_ReadTrackPositions-Funktion werden die Posi-
tion und die Objekt ID aller Parts und aller Tracks ermittelt. Mit die-
sen Informationen kann die exakte Position eines Movers im System
ermittelt werden.

Mit XTS Utility Bibliothek oder ADS lesen
Die Ist-Werte für die Position können mithilfe der XTS Utility Biblio-
thek oder ADS gelesen werden.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects > XTSProcessingUnit ausklappen

► Doppelklick auf Object (XtsMover)

https://download.beckhoff.com/download/document/automation/twincat3/tf5410_tc3_collision_avoidance_DE.pdf
https://download.beckhoff.com/download/document/automation/twincat3/tf5410_tc3_collision_avoidance_DE.pdf
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► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Mover Detection > PositionInfo ausklappen
► Werte für .partPosition, .trackPosition, .partObjectId

und .trackObjectId ablesen

In SPS auslesen
Mit dem Funktionsbaustein MC_ReadTrackPosition lassen sich Soll-
werte von der NC zur SPS übertragen.

Funktionsbaustein MC_ReadTrackPositions
Dieser Funktionsbaustein unterscheidet sich von den anderen Moti-
on-Funktionsbausteinen. Durch Enable wird der Funktionsbaustein
aktiviert und ermöglicht einen zyklischen Leseprozess der Positio-
nen. Statussignale werden ausgelesen, um eine Rückmeldung des
Funktionsbausteins zu bekommen.
Der Funktionsbaustein gibt die aktuellen Sollpositionen der Parts
und Tracks und die zugehörigen Objekt IDs zurück. Die Achse der
Mover, die sich auf den Parts und Tracks befinden, muss Teil einer
CA-Gruppe sein, damit der Funktionsbaustein gültige Werte liefert.
Wenn für die Achse kein Track aktiviert ist, werden die absoluten
Sollwerte, der Track und die Part ID mit 0 zurückgegeben.
Weitere Informationen dazu finden Sie in der Dokumentation
TF5410 TwinCAT 3 | Collision Avoidance:

Direktlink zur Dokumentation TF5410 | TwinCAT 3 | Motion
Collision Avoidance

https://download.beckhoff.com/download/document/automation/twincat3/tf5410_tc3_collision_avoidance_DE.pdf
https://download.beckhoff.com/download/document/automation/twincat3/tf5410_tc3_collision_avoidance_DE.pdf
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6.5.5.4 Zu einer absoluten Position verfahren
In den Optionen des Motion-Befehls MC_MoveAbsoluteCA gibt es
ein Position Reference System und ein Dynamic Reference System
bei denen der Track angegeben werden muss, auf dem sich der
Mover befindet. Durch die Eingabe des Tracks wird das Bewe-
gungsprofil korrekt berechnet und bei Bedarf abgelehnt, wenn sich
das Bewegungsprofil außerhalb der Grenzwerte des Tracks befin-
det. Wenn die Eingabe des Tracks fehlt, wird gegen das absolute
System berechnet. Wenn der Part statt des Tracks eingegeben wird,
wird gegen den Part berechnet.

In SPS auslesen
Funktionsbaustein MC_MoveAbsoluteCA
Dieser Funktionsbaustein befiehlt einer einzelnen Achse, sich mit
Collision Avoidance an die im Funktionsbaustein festgelegte absolu-
te Position zu verfahren. Die Collision  Avoidance hat eine höhere
Priorität als das Bewegungskommando. Daher kann die Achse wäh-
rend der Ausführung des Bewegungskommandos langsamer wer-
den oder warten, um eine Kollision zu vermeiden. Der Funktions-
baustein gibt das Signal Done jedoch erst dann aus, wenn die Ach-
se ihre Zielposition erreicht hat.
Weitere Informationen dazu finden Sie in der Dokumentation
TF5410 TwinCAT 3 | Collision Avoidance:

Direktlink zur Dokumentation TF5410 | TwinCAT 3 | Motion
Collision Avoidance

6.5.5.5 Collision Avoidance-Funktionalität
Das Track Management unterstützt die Collision Avoidance-Funktio-
nalität. Die Kollisionsvermeidung funktioniert wie bei einem ge-
schlossenen XTS System, jedoch gibt es einige Besonderheiten zu
beachten.
Für ein XTS System ist nur eine CA-Gruppe erforderlich. Unter der
CA-Gruppe gibt es eine versteckte Domain-Verwaltung, die die Kol-
lisionsvermeidung für die unterschiedlichen Track-Kombinationen
verwaltet. Jeder Track wird durch eine Domaine dargestellt und die
Mover dieser Domain können untereinander eine Kollision vermei-
den. Das heißt, dass die Kollisionsvermeidung ausschließlich auf
Basis von Tracks funktioniert.
Wenn die Mover auf demselben Track fahren, erkennen sie sich ge-
genseitig und können automatisch eine Kollision vermeiden. Wenn
die Mover auf unterschiedlichen Tracks aber auf demselben Part
fahren, erkennen sie sich nicht gegenseitig und können ohne manu-
elle Steuerung miteinander kollidieren.

Track-basierte Kollisionsvermeidung
Momentan steht nur eine Track-basierte Berechnung der Kollisions-
vermeidung zur Verfügung. Eine auf Parts basierende Kollisionsver-
meidung befindet sich noch in der Entwicklung.

https://download.beckhoff.com/download/document/automation/twincat3/tf5410_tc3_collision_avoidance_DE.pdf
https://download.beckhoff.com/download/document/automation/twincat3/tf5410_tc3_collision_avoidance_DE.pdf
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6.6 Leave and Arrive-Funktionalität
Die Leave and Arrive-Funktionalität ermöglicht eine dynamische An-
passung der Mover-Anzahl eines XTS Systems während des laufen-
den Betriebs. Mover können beispielsweise für Servicearbeiten vom
System entnommen werden oder nach Bedarf vom System entnom-
men und wieder hinzugefügt werden.

Momentane Taktrate von 60 Movern pro Minute
Das Hinzufügen und Entfernen von Movern ist momentan auf eine
Taktrate von 60 Movern pro Minute begrenzt.

6.6.1 Beispiele

Service

Mit der Leave and Arrive-Funktionalität können Mover zur Wartung
vom System entnommen werden, während das restliche System in
Betrieb bleibt.

Mover können vom System entnommen werden, wenn sie beispiels-
weise bei einem Produktwechsel vorübergehend nicht benötigt wer-
den. Entnommene Mover lassen sich bei Bedarf wieder zum System
hinzufügen.
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Mover können das System verlassen, auf einen Streckenabschnitt
ohne XTS Funktionalität wechseln und an anderer Stelle wieder
zum System hinzugefügt werden.
Beckhoff empfiehlt den Transport mithilfe einfacher Fördertechnik
nur für Systeme mit einer Länge von mindestens 30 Metern.
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6.6.2 Voraussetzung
Es ist erforderlich eine zusätzliche Task hinzuzufügen, damit die
Mover-Erkennung parallel zum Betrieb der anderen Module und Mo-
ver erfolgen kann.
Die zusätzliche Task wird bei der Konfiguration mit dem XTS Confi-
gurator hinzugefügt. Die zusätzliche Task kann auch bei Bedarf ma-
nuell hinzugefügt werden. Weitere Informationen dazu finden Sie im
Kapitel „AUX Task für die Leave and Arrive-Funktionalität“, [Seite
 312].

6.6.2.1 Zusätzliche Task manuell hinzufügen
► Solution Explorer > TwinCAT Project > SYSTEM ausklappen
► Mit der rechten Maustaste auf Tasks klicken, um das Kontext-

menü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Insert Task öffnet sich.
► In das Eingabefeld Name einen Namen für die Task eingeben
► Mit OK bestätigen

► Solution Explorer > TwinCAT Project > SYSTEM > Tasks aus-
klappen

► Doppelklick auf XTS Aux Task
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► Im Projektfenster auf den Reiter Task klicken
► Darauf achten, dass die Cycle ticks auf 0.250 ms eingestellt

sind
Weitere Informationen dazu finden Sie im Kapitel „Real-Time“,
[Seite 307].

► Solution Explorer > TwinCAT Project > SYSTEM > TcCom Ob-
jects ausklappen

► Doppelklick auf XTSProcessingUnit

► Im Projektfenster auf den Reiter Context klicken
► XTS Aux Task im Dropdown-Menü Results ID 2 auswählen

Nachdem eine Task für die Mover-Erkennung hinzugefügt wurde,
können Mover mit der Leave-Funktion entnommen oder mit der
Arrive-Funktion wieder hinzugefügt werden.
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6.6.3 Systemstart
Nach dem Systemstart und der ersten Mover-Erkennung werden al-
le erkannten Mover auf aktiv geschaltet. Die erste Mover-Erkennung
ist erforderlich und erfolgt automatisch. Nach der ersten Mover-Er-
kennung haben Sie die Möglichkeit die Einstellungen für weitere
Mover-Erkennungen anzupassen.

6.6.4 Leave-Funktion
Die Regler eines aktiven Movers sind eingeschaltet und der Mover
ist eventuell in einen CA- Bewegungsbefehl eingebunden, beispiels-
weise MC_MoveAbsoluteCA. Der Mover muss zunächst angehalten
und aus der Regelung entfernt werden, bevor er vom System ent-
nommen werden kann.
Für die Entnahme des Movers wird für das TcCOM-Objekt Mover
mithilfe der SPS und des AXIS_REF-Interface die Regelung abge-
schaltet. Sobald der Mover über die XTS Utility passiv ist, seine In-
formationen auf die Standardeinstellungen zurückgesetzt wurden
und seine Position 0 beträgt, kann er vom System entnommen wer-
den, ohne dass der Mover einen Fehler auslöst. Die Verlinkungen
des Movers zu seinem entsprechenden SoftDrive-Objekt und zu sei-
ner NC-Achse bleiben weiterhin bestehen.
Die Abbildung zeigt den Aufbau der erforderlichen Leave-Sequenz,
um einen Mover vom System zu entfernen.
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6.6.4.1 Mover entfernen

HINWEIS
Fehler in der Steuerung und Beschädigungen an Movern
und Modulen durch falsch entnommene Mover
Werden aktive Mover entnommen, die nicht in Regelung sind,
kann es zu Problemen mit der Steuerung führen und das gesam-
te System kann in einen Fehler versetzt werden.
• Entfernen Sie vom System nur passive Mover, die sich nicht

in Regelung befinden und aus der CA-Gruppe entfernt wur-
den.

Mover deaktivieren
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM

Objects > XtsProcessingUnit ausklappen
► Doppelklick auf den Mover, der vom System entfernt werden soll

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Mover Detection ausklappen
► Mit der rechten Maustaste in das Eingabefeld TriggerLeave kli-

cken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Download klicken

Ergebnis prüfen
Nach dem Download können Sie überprüfen, ob der Mover erfolg-
reich deaktiviert wurde und sich die Gesamtzahl der Mover verrin-
gert hat.

► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Mover Detection ausklappen
► Überprüfen, ob der Parameter IsActive FALSE anzeigt
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► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM
Objects ausklappen

► Doppelklick auf XtsProcessingUnit

► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Mover Detection ausklappen
► Überprüfen, ob sich die Anzahl der Mover bei ActiveMover-

Count verringert hat
Wenn der Mover passiv ist und sich die Anzahl der Mover verringert
hat, kann der Mover vom System entnommen werden.
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6.6.5 Arrive-Funktion

Arrive-Funktion nur zum Hinzufügen von Movern nutzen
Mit der Arrive-Funktion lassen sich nur Mover zu einem XTS System
hinzufügen, die zuvor mit der Leave-Funktion entnommen wurden
oder bereits beim Aufstarten des Systems passiv waren. Es ist nicht
möglich die Konfiguration eines XTS Systems mit der Arrive-Funkti-
on zu ändern.

Ein oder mehrere passive Mover müssen aktiviert, in Regelung ver-
setzt und zu einer Gruppe hinzugefügt werden, bevor sie über einen
CA-Bewegungsbefehl verfahren werden können.
Die Verlinkungen des Movers zu seinem entsprechenden SoftDrive-
Objekt und zu seiner NC-Achse bestehen bereits. Der Mover muss
aktiv sein, zu einer Gruppe hinzugefügt werden und sich auf dem
richtigen Track befinden, damit er mithilfe der SPS und des
AXIS_REF-Interface eingeschaltet und dem System verfahren wer-
den kann.

6.6.5.1 Aufbau
Das Hinzufügen von Movern kann auf zwei unterschiedliche Weisen
erfolgen:
• mehrere Mover
• einzelnen Mover

Die beiden Arrive-Sequenzen unterscheiden sich in ihrem Aufbau
voneinander. Die entsprechenden Sequenzen finden Sie auf den
folgenden Seiten.
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Mehrere Mover
Die Abbildung zeigt den Aufbau der erforderlichen Arrive-Sequenz
an, um mehrere passive Mover zum System hinzuzufügen.

* Erforderlich, wenn nicht alle Mover zu dem System zurückkehren und/oder ein separater Track für die Mo-
ver-Erkennung genutzt wird.
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Einzelner Mover
Die Abbildung zeigt den Aufbau der erforderlichen Arrive-Sequenz
an, um einen Mover zum System hinzuzufügen.
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6.6.5.2 Mover hinzufügen
Sie haben die Möglichkeit mehrere Mover gleichzeitig mit einer Mo-
ver-Erkennung wieder zum System hinzuzufügen. Auf diese Weise
lässt sich auch ein einziger Mover hinzufügen oder Sie verwenden
dazu die Variante zum Hinzufügen eines einzelnen Movers. Mit der
zweiten Variante lässt sich immer nur ein einzelner Mover hinzufü-
gen und nicht mehrere Mover gleichzeitig. Weitere Informationen
zum Hinzufügen eines einzelnen Movers finden Sie im Kapitel „Ein-
zelner Mover“, [Seite 154].

HINWEIS
Fehler in der Steuerung und Beschädigungen an Movern
und Modulen durch andere Mover
Es dürfen nur Mover hinzugefügt werden, die der Konfiguration
entsprechen. Es ist nicht möglich zusätzliche Mover, einen ande-
ren Movertyp oder Mover mit einem anderen Magnetplattenset
hinzuzufügen, da ein Verfahren von diesen Movern nicht möglich
ist.
• Achten Sie darauf, dass nur Mover hinzugefügt werden, die

der Konfiguration Ihres Systems entsprechen.

Mehrere Mover
Wenn ein oder mehrere Mover hinzugefügt werden, muss eine neue
Mover-Erkennung gestartet werden, um die Mover zu finden. Nach-
dem Sie festgelegt haben, wie viele Mover auf welchen Tracks er-
kannt werden sollen, kann die Mover-Erkennung gestartet werden.
Im Gegensatz zu der initialen Mover-Erkennung wird eine Mover-Er-
kennung zum Hinzufügen von Movern nur einmal durchgeführt und
nicht zyklisch wiederholt. Eine zyklische Wiederholung erfolgt nur,
wenn der entsprechende Parameter für die Wiederholung ange-
passt wurde.

Mover aktivieren

HINWEIS
Fehler in der Steuerung und Beschädigungen an Movern
und Modulen durch Mover, die bereits in Regelung sind
Auf dem Track, auf dem die Mover-Erkennung weiterer Mover
ausgeführt werden soll, dürfen sich keine Mover befinden, die be-
reits in Regelung sind. Mover, die bereits in Regelung sind, kön-
nen bei einer Mover-Erkennung unkontrolliert reagieren und zu
Schäden an Movern und Modulen führen.
• Achten Sie darauf, dass sich keine Mover auf dem Track für

die Mover-Erkennung neuer Mover befinden, die bereits in
Regelung sind.
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► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM
Objects ausklappen

► Doppelklick auf XtsProcessingUnit

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Mover Detection ausklappen
► In das Eingabefeld ConfiguredDetectionCount die Anzahl der zu

erkennenden Mover eingeben
► Darauf achten, dass sich keine Mover, die in Regelung sind, auf

dem Track befinden, der für die Mover-Erkennung genutzt wer-
den soll

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM
Objects > XtsProcessingUnit ausklappen

► Auf den Track klicken, der für die Mover-Erkennung genutzt
werden soll

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► General ausklappen
► TRUE im Dropdown-Menü IsIncludedInDetection auswählen

► Doppelklick auf XtsProcessingUnit
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► Mit der rechten Maustaste in das Eingabefeld TriggerDetection
klicken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Download klicken

Ergebnis prüfen
Nach dem Download können Sie überprüfen, ob die Mover-Erken-
nung erfolgreich war oder ob sich die Anzahl passiver und erkannter
Mover unterscheidet.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM
Objects ausklappen

► Doppelklick auf XtsProcessingUnit

► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Mover Detection ausklappen
► Überprüfen, ob die Anzahl der aktiven Mover bei ActiveMover-

Count korrekt ist
► Überprüfen, wie viele Mover-Erkennungen bei DetectionCycle-

Count angezeigt werden
► Überprüfen, ob der Parameter DetectionState Succeeded an-

zeigt

Für jeden Mover lässt sich überprüfen, ob dieser aktiv oder passiv
ist. In der XTS View werden ausschließlich aktive Mover dargestellt.
Passive Mover werden in der XTS View nicht dargestellt, da passive
Mover vom System unerkannt bleiben.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM
Objects > XtsProcessingUnit ausklappen

► Auf den Mover klicken, dessen Status überprüft werden soll



Funktionen des Treibers

154 ─── Version: 1.1.1TF5850

► Überprüfen, ob der Parameter IsActive TRUE anzeigt

Einzelner Mover

Gleichzeitiges Hinzufügen mehrerer Mover nicht möglich
Mit dieser Variante lässt sich nur ein einzelner Mover zu dem Sys-
tem hinzufügen. Wenn Sie mehrere Mover hinzufügen möchten,
müssen Sie die Handlungsschritte für jeden Mover wiederholen oder
Sie nutzen die Variante zum Hinzufügen mehrerer Mover. Weitere
Informationen dazu finden Sie im Kapitel „Mehrere Mover“, [Seite
 151].

Eine Mover-Erkennung wird benötigt, um einen einzelnen Mover zu
finden und ihn zum System hinzuzufügen. Im Gegensatz zu der in-
itialen Mover-Erkennung nach dem Systemstart, wird eine Mover-
Erkennung zum Hinzufügen von Movern nur einmal durchgeführt
und nicht zyklisch wiederholt. Eine zyklische Wiederholung erfolgt
nur, wenn der entsprechende Parameter für die Wiederholung ange-
passt wurde.

Mover aktivieren
► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM

Objects > XtsProcessingUnit ausklappen
► Auf den Mover klicken, der aktiviert werden soll

► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Mover Detection ausklappen
► Den Track im Dropdown-Menü ConfiguredDetectionTrackObjec-

tId auswählen, auf dem sich der Mover befindet
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► Mit der rechten Maustaste in das Eingabefeld TriggerArrive kli-
cken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Download klicken

Ergebnis prüfen
► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Mover Detection ausklappen
► Überprüfen, ob der Parameter IsActive TRUE anzeigt
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6.6.6 Parameter
Für die Leave and Arrive-Funktionalität lassen sich spezielle Para-
meter des XTS Systems einstellen. Die folgenden Tabellen enthal-
ten alle Parameter, die der Leave and Arrive-Funktionalität zugeord-
net werden können.

6.6.6.1 Processing Unit

6.6.6.1.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
ConfiguredDetection-
Count

Mover Detection UDINT 0x030802B4 Legt die Anzahl der Mover
für die Mover-Erkennung
fest.

ConfiguredRetryCount Mover Detection UDINT 0x030802F1 Legt die Anzahl an Wieder-
holungen für die Mover-Er-
kennung fest, wenn nicht alle
konfigurierten Mover erkannt
werden.

TriggerDetection Mover Detection TriggerDetection 0x030802B5 Wenn die TriggerDetection
heruntergeladen wird, wird
eine Mover-Erkennung für
die Anzahl an konfigurierten
Movern auf den konfigurier-
ten Tracks durchgeführt.
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6.6.6.1.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
ActiveMoverCount Mover Detection UDINT 0x030802B7 Gibt die Anzahl an aktiven

Movern zurück.
AreAllPositionsValid Mover Detection BOOL 0x03080256 Gibt TRUE zurück, wenn die

Positionen aller Mover kor-
rekt sind.

DetectionCycleCount Mover Detection UDINT 0x03080259 Gibt die Anzahl der Mover-
Erkennungen zurück.

DetectionCycleCountTo-
tal

Mover Detection UDINT 0x030802EC Gibt die Anzahl der Mover-
Erkennungen zurück, seit-
dem der Treiber gestartet
wurde.

DetectionState Mover Detection XTS.DetectionS-
tateEnum

0x030802ED Gibt den Status der Mover-
Erkennung zurück.

DetectedMoverCount Mover Detection UDINT 0x0308033E Gibt die Anzahl der erkann-
ten Mover zurück, die sich
momentan auf dem System
befinden.

DetectedMoverCount Mover Detection UDINT 0x03080257 Gibt die Anzahl der erkann-
ten Mover zurück, die wäh-
rend der letzten Mover-Er-
kennung erkannt wurden.

ExpectedMoverCount Mover Detection UDINT 0x03080258 Gibt die Anzahl der erwarte-
ten Mover zurück, entspre-
chend der Anzahl der erstell-
ten TcCOM-Objekte Mover.

ScannedModuleCount Mover Detection UDINT 0x03080225 Gibt die Anzahl der Module
zurück, die während einer
Mover-Erkennung gefunden
wurden.
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6.6.6.2 Mover

6.6.6.2.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
ConfiguredDetection-
TrackObjectId

Mover Detection UDINT 0x030802F0 Legt die Objekt ID des
Tracks auf dem die Mover-
Erkennung ausgeführt wird
fest, wenn TriggerArrive aus-
gelöst wird.

TriggerArrive Mover Detection TriggerArrive 0x030802EE Wenn TriggerArrive herun-
tergeladen wird, wird eine
Mover-Erkennung für einen
Mover auf dem konfigurier-
ten Track durchgeführt. Nach
erfolgreicher Mover-Erken-
nung wird der Mover aktiv.

TriggerLeave Mover Detection TriggerLeave 0x030802EF Wenn TriggerLeave herun-
tergeladen wird, wird der ak-
tive Mover aus der Regelung
entfernt. Der Mover kann
nicht mehr verwendet wer-
den und kann, ohne einen
Fehler auszulösen, vom Sys-
tem entnommen werden.

6.6.6.2.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
IsActive Mover Detection BOOL 0x030802B6 Ermittelt den Wert, der an-

gibt, ob der Mover aktiv ver-
wendet wird oder derzeit
passiv ist. Ein aktiver Mover
kann aus der Regelung ent-
fernt werden, wenn man
plant, ihn aus dem System
zu entfernen.
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6.7 Parameter
Mit TwinCAT lassen sich zahlreiche Parameter des XTS Systems
einstellen. Die folgenden Tabellen enthalten alle Parameter, die den
TcCOM-Objekten zugeordnet werden können.

6.7.1 Processing Unit

6.7.1.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
OperationMode General OperationMode 0x0308022C Auswahl der Betriebsart. Si-

mulationsmodus oder Ver-
wendung der Hardware.
Weitere Informationen dazu
finden Sie unter „Operation-
Mode“, [Seite 190].

MoverType Mover MoverType 0x00000090 Auswahl des Movertyps.
Weitere Informationen dazu
finden Sie unter „MoverTy-
pe“, [Seite 190].

MagnetPlateType Mover MagnetPlateType 0x00000091 Auswahl des Magnetplatten-
sets.
Achtung! Richtiges Magnet-
plattentset auswählen. Bei
falscher Auswahl kann der
Mover unerwartet reagieren.
Weitere Informationen dazu
finden Sie unter „MagnetPla-
teType“, [Seite 190].

MoverSortOrder Mover SetOrderEnum 0x00000048 Auswahl der Sortierreihenfol-
ge der Mover.
Weitere Informationen dazu
finden Sie unter „MoverSor-
tOrder“, [Seite 190].

MinMechanicalMover-
Distance

Mover LREAL 0x0308027A Ermittelt/bestimmt den mini-
malen Positionsabstand zwi-
schen den Movern, der in
der Kurve gemessen werden
muss. Als Vorgabe wird der
zum Movertyp gehörende
Abstand verwendet.

IdDetectionMode MoverIdDetection MoverIdDetection-
Mode

0x03080246 Auswahl des Modus für die
ID-Erkennung, um Mover 1
zu erkennen.
Weitere Informationen dazu
finden Sie unter „IdDetec-
tionMode“, [Seite 191].

MoverPositionAssign-
ment

MoverIdDetection MoverPosition-
Assignment

0x03080253 Bestimmt die niedrigste/
höchste Position
Weitere Informationen dazu
finden Sie unter „MoverPosi-
tionAssignment“, [Seite 191].
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Parameter Gruppe Typ PTCID Erläuterung
ExpectedMoverIds MoverIdDetection – 0x03080267 Erwartete Mover IDs für die

MultipleMover 1 ID-Erken-
nung.
Weitere Informationen dazu
finden Sie unter „Expected-
MoverIds“, [Seite 191].

TriggerMoverIdDetection MoverIdDetection TriggerMoverIdDe-
tection

0x03080250 Löst die Mover ID-Erken-
nung aus.
Achtung! Die Steuerung der
Achsen wird kurzzeitig akti-
viert.

TeachingFileNumber Teaching UDINT 0x0308022A Die Nummer wird an den Na-
men der Teaching-Datei an-
gefügt – beispielsweise „TcI-
oXts.TeachingData.0.boot-
data“.
Weitere Informationen dazu
finden Sie unter „Nummer
der Teaching-Datei einge-
ben“, [Seite 116].

StartStandStillTeaching Teaching – 0x03080228 Beim Download wird das
Teaching auf den angegebe-
nen Modulen gestartet und
automatisch gestoppt.
Weitere Informationen dazu
finden Sie unter „StartStand-
StillTeaching“, [Seite 191].

StartMovementTeaching Teaching – 0x03080269 Beim Download wird das
Teaching gestartet. Danach
bewegen sich die Mover
über jedes Modul.
Weitere Informationen dazu
finden Sie unter „StartMove-
mentTeaching“, [Seite 192].

StopMovementTeaching Teaching StopMovementTea-
ching

0x03080270 Nach dem Download wird
das Teaching sofort ange-
wendet.

IsAbortOnTeachingWar-
ningsEnabled

Teaching BOOL 0x00000057 Bei TRUE wird eine Tea-
ching Warnung ausgegeben,
dass der Treiber nicht star-
tet.
Weitere Informationen dazu
finden Sie unter „IsAbortOn-
TeachingWarningsEnabled“,
[Seite 192].

IsTeachingCheckSum-
CheckEnabled

Teaching BOOL 0x00000055 Bei TRUE wird die eingetra-
gene Summe zum Überprü-
fen verwendet, ob die richti-
ge Teaching-Datei geladen
und unbeschädigt ist.
Weitere Informationen dazu
finden Sie unter „IsTeaching-
CheckSumCheckEnabled“,
[Seite 192].
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Parameter Gruppe Typ PTCID Erläuterung
TeachingCheckSum Teaching – 0x00000054 Prüfsumme des Teachings,

um die Datei zu validieren.
Nach einem erneuten Tea-
ching kann die Prüfsumme
aus dem Treiber gelesen
werden.
Weitere Informationen dazu
finden Sie unter „Teaching-
CheckSum“, [Seite 192].

TeachingWarningLevel Teaching TeachingWarningLe-
vel

0x0308028C Bestimmt den Wert, ab dem
der InputCheck und das Tea-
ching Warnungen ausgeben.
Weitere Informationen dazu
finden Sie unter „Teaching-
WarningLevel“, [Seite 193].
Level_1: sehr genau
Level_3: gering

TriggerTeachingFileFor-
matUpdate

Teaching TriggerTeachingFile-
FormatUpdate

0x000000A9 Veranlasst das System, das
Format der angegebenen
Teaching-Datei zu aktualisie-
ren, wenn es in den Konfigu-
rationsmodus zurückwech-
selt.
Die alte Datei wird über-
schrieben.

IsAutoDumpWriting-
Enabled

Diagnostics BOOL 0x00000049 Bei TRUE schreibt der Trei-
ber automatisch Dump-Da-
teien in bestimmten Situatio-
nen, z. B. beim Starten oder
im Falle eines Fehlers.
Weitere Informationen dazu
finden Sie unter „IsAu-
toDumpWritingEnabled“,
[Seite 193].

IsInputCheckEnabled Diagnostics BOOL 0x03080283 Aktiviert die Nachvollziehbar-
keitsprüfung aller Eingangs-
daten des Systems.
Weitere Informationen dazu
finden Sie unter „IsInputChe-
ckEnabled“, [Seite 193].

WriteDump Diagnostics WriteDump 0x00000044 Beim manuellen Download
schreibt der Treiber eine
Dump-Datei.

UsedEventLogger Diagnostics EventMessenger 0x000000A4 Gibt an, wie Ereignisse vom
Treiber übermittelt werden.
Weitere Informationen dazu
finden Sie unter „UsedEvent-
Logger“, [Seite 193].

EtherCatMasterSync-
TaskObjectId

Advanced OTCID 0x03080233 Objekt ID der Task einstel-
len, die für das Triggern des
EtherCAT-Masters zuständig
ist, der auf unabhängige DC-
Zeit eingestellt ist.
Empfohlen bei Verwendung
der 16-Port-EtherCAT-Netz-
werkkarte.
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Parameter Gruppe Typ PTCID Erläuterung
IsCycleTimeWarning-
Suppressed

Advanced BOOL 0x00000046 Bei TRUE wird die Warnung,
dass der Treiber bei 250 us
nicht läuft, deaktiviert.

IsMoverFrozenErrorActi-
vated

Advanced BOOL 0x00000097 Bei TRUE wird die Position
des Movers überwacht.
Wenn sich die Position über
mehrere Zyklen nicht ändert,
wird ein Fehler ausgegeben.
Weitere Informationen dazu
finden Sie unter „IsMover-
FrozenErrorActivated“, [Seite
 194].

IsPositionBasedError-
ForwardingEnabled

Advanced BOOL 0x00000092 Bei TRUE wird auf Grund-
lage der Position der Mover,
die sich auf fehlerhaften Mo-
dulen befinden, ein Hardwa-
refehler ausgegeben.
Weitere Informationen dazu
finden Sie unter „IsPosition-
BasedErrorForwardingEnab-
led“, [Seite 194].

Optimization Advanced OptimizationEnum 0x00000047 Auswahl verfügbarer Opti-
mierungen oder Deaktivie-
rung aller Optimierungen.
Weitere Informationen dazu
finden Sie unter „Optimizati-
on“, [Seite 194].

TriggerRedetection Advanced TriggerRedetection 0x00000098 Wenn es heruntergeladen
wird, verlieren alle Mover ih-
re Position und es wird eine
neue Erkennung durchge-
führt. Die Reihenfolge der
Mover kann sich ändern.

CalculateNormAmplitude Advanced BOOL 0x030802B1 Bei TRUE wird die Schwin-
gung des Movers neutrali-
siert.

IsPositionNoiseEnabled Simulation BOOL 0x0308022F Bei TRUE wird ein Zufalls-
rauschen mit der angegebe-
nen Bandbreite zu den Posi-
tionen der Mover hinzuge-
fügt.

IsRandomStartUp-
Enabled

Simulation BOOL 0x03080285 Bei TRUE und aktiviertem
UseOffsetAndDistance Mo-
dus, werden die Startpositio-
nen der Mover unter Ver-
wendung der angegebenen
Bandbreite zufällig bestimmt.

MoverDistance Simulation LREAL 0x0308022E Ermittelt/bestimmt den Ab-
stand zwischen den simulier-
ten Movern beim Start.

PositionOffset Simulation LREAL 0x0308022D Ermittelt/bestimmt die Positi-
on, an der der erste simulier-
te Mover erkannt werden
soll.

PositionNoiseBandwidth Simulation LREAL 0x03080231 Ermittelt/bestimmt die Band-
breite, die beschreibt, wie
stark eine Position wechseln
soll.
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Parameter Gruppe Typ PTCID Erläuterung
RandomStartUpBand-
width

Simulation LREAL 0x03080232 Ermittelt/bestimmt die Band-
breite, mit der die Startposi-
tionen der Mover geändert
werden können. Die Band-
breite wird zusätzlich zu Po-
sitionOffset und MoverDi-
stance angewendet.

PositionStartUpSimula-
tionMode

Simulation PositionStartUpSimu-
lationMode

0x03080230 Legt fest, wie die Startposi-
tionen für die Mover erzeugt
werden sollen.
Weitere Informationen dazu
finden Sie unter „Positi-
onStartUpSimulationMode“,
[Seite 195].

MoverIdStartUpSimula-
tionMode

Simulation MoverIdStartUpSi-
mulationMode

0x0308027D Legt fest, wie die Mover IDs
beim Starten erzeugt wer-
den.
Weitere Informationen dazu
finden Sie unter „MoverId-
StartUpSimulationMode“,
[Seite 195].

RandomInitMode Simulation RandomInitMode 0x0308027F Legt den Modus für die Initia-
lisierung der Zufallsauswahl
fest.
Weitere Informationen dazu
finden Sie unter „RandomI-
nitMode“, [Seite 195].

RandomInitSeed Simulation DINT 0x03080280 Ermittelt/bestimmt den Wert,
der zur Erzeugung von zufäl-
ligen Zahlen für die Positio-
nen und IDs verwendet wird.
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6.7.1.2 Hidden Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
IdDiagConfiguration MoverIdDetection – 0x03080100 Berechnungsparameter der

Mover ID-Erkennung.
Achtung! Nicht ändern.
Weitere Informationen dazu
finden Sie unter „IdDiagCon-
figuration“, [Seite 195].

DelayBetweenMoversIn-
Pack

MoverIdDetection LREAL 0x03080247 Zeitverzögerung in der Mo-
ver ID-Erkennung zwischen
Movern im selben Paket.
Einheit: s

DelayBetweenMover-
Packs

MoverIdDetection LREAL 0x03080248 Zeitverzögerung in der Mo-
ver ID-Erkennung zwischen
Movern in verschiedenen
Paketen.
Einheit: s

GapToDefineMoverPack MoverIdDetection LREAL 0x03080249 Abstand zwischen Movern,
innerhalb dessen Mover als
ein Paket erkannt werden.
Einheit: mm

CompletionCriteria MoverIdDetection MoverIdDetection-
CompletionCriteria

0x0308027B Definiert die Kriterien zur
Vervollständigung der ID-Er-
kennung.
Weitere Informationen dazu
finden Sie unter „Comple-
tionCriteria“, [Seite 196].

DumpWriterFallback-
Mode

Diagnostics DumpWriterFallback-
Mode

0x030802B2 Ermittelt/bestimmt den Mo-
dus, ob zusätzlicher Spei-
cherplatz für das Schreiben
einer Dump-Datei verwendet
werden kann oder nicht. Die-
ser zusätzliche Speicherplatz
kann verwendet werden,
wenn der normale Speicher-
platz für die Dump-Datei zu
klein ist.

IsPartBasedHandling-
Activated

Advanced BOOL 0x03080284 Wenn TRUE, wird der Status
und die Steuerung aller
Klemmen anhand von Parts
überprüft.
Achtung! Beta-Funktion.

IncludedTrackCheck-
Timeout

Advanced UDINT 0x03080293 Ermittelt/bestimmt die Zeit-
überschreitung, nach der ei-
ne Warnung ausgegeben
wird, wenn keine Tracks in
die Erkennung einbezogen
werden.
Einheit: s



Funktionen des Treibers

Version: 1.1.1 ─── 165TF5850

6.7.1.3 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
AreAllPositionsValid MoverDetection BOOL 0x03080256 Gibt TRUE zurück, wenn alle

Mover Positionen richtig
sind.

DetectionCycleCount MoverDetection UDINT 0x03080259 Gibt die Anzahl an Erken-
nungen zurück.

DetectedMoverCount MoverDetection UDINT 0x03080257 Gibt die Anzahl der erkann-
ten Mover zurück, die wäh-
rend der letzten Erkennung
erkannt wurden.

ExpectedMoverCount MoverDetection UDINT 0x03080258 Gibt die Anzahl der erwarte-
ten Mover zurück, entspre-
chend der Anzahl der erstell-
ten TcCOM-Objekte Mover.

ScannedModuleCount MoverDetection UDINT 0x03080225 Gibt die Anzahl der Module
zurück, die während einer
Erkennung gefunden wur-
den.

MoverPositions MoverDetection – 0x0308020D Gibt den Bereich mit den ak-
tuellen Positionen aller Mo-
ver zurück.

HasIdDetectionError MoverIdDetection BOOL 0x03080252 Gibt TRUE zurück, wenn die
Mover ID-Erkennung fehler-
haft ist.

IsIdDetectionValid MoverIdDetection BOOL 0x03080251 Gibt TRUE zurück, wenn die
Mover IDs erkannt wurden.

IsIdDetectionActive MoverIdDetection BOOL 0x03080268 Gibt TRUE zurück, wenn die
Mover ID-Erkennung läuft.

MoverIds MoverIdDetection – 0x0308027C Gibt den Bereich mit den IDs
aller Mover zurück.

IsTeachingChanged Teaching BOOL 0x0308022B Gibt TRUE zurück, wenn die
Teaching-Datei überschrie-
ben wurde.

IsTeachingValid Teaching BOOL 0x03080255 Gibt TRUE zurück, wenn das
Teaching gültig und die Tea-
ching-Datei richtig geladen
wurde.

IsTeachingFileForma-
tUpToDate

Teaching BOOL 0x03080290 Gibt TRUE zurück, wenn das
Teaching das neueste Versi-
on verwendet.

HasInputCheckError Diagnostics BOOL 0x0308028F Gibt das Ergebnis der Einga-
beprüfung zurück.

DriveState Info DriveState 0x000000A0 Gibt den Status des Treibers
zurück.

PartOrigins Info – 0x03080261 Gibt den Bereich mit allen
Ursprüngen der Parts zu-
rück.

VersionString Info STRING(31) 0x03080287 Gibt den Versionsnamen des
Treibers zurück.

MoverCount Structure UDINT 0x0308020A Gibt die Anzahl der Mover
zurück.

MoverObjectIDs Structure – 0x0308020B Gibt den Bereich zurück, der
die Objekt IDs aller Mover
beinhaltet.
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Parameter Gruppe Typ PTCID Erläuterung
PartCount Structure UDINT 0x03080203 Gibt die Anzahl der Parts zu-

rück.
PartObjectIDs Structure – 0x03080224 Gibt den Bereich zurück, der

die Objekt IDs aller Parts
enthält.

TaskCount Structure UDINT 0x0000009C Gibt die Anzahl der Tasks
zurück.

TaskObjectIDs Structure – 0x0000009D Gibt den Bereich zurück, der
die Task-Objekt IDs enthält.

TrackCount Structure UDINT 0x0308020E Gibt die Anzahl der Tracks
zurück.

TrackObjectsIDs Structure – 0x0308020F Gibt den Bereich zurück, der
die Objekt IDs aller Tracks
enthält.
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6.7.2 Mover

6.7.2.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
AdsPort General WORD 0x03002090 Ermittelt/bestimmt den ADS-

Port.
Der Port sollte zum Lesen/
Schreiben von Parametern
über ADS verwendet wer-
den.

ActiveTrackObjectId General OTCID 0x03080209 Ermittelt/bestimmt die Track-
Objekt ID, der für den Mover
gerade aktiv ist oder aktiv
sein sollte.

TaskOID General OTCID 0x03002060 Ermittelt/bestimmt die XTS-
Task, die für die Berechnun-
gen der Mover verwendet
wird.

SimulatedStartUpPart Simulation OTCID 0x03080278 Ermittelt/bestimmt den Part,
auf dem der Mover während
der Simulation erkannt wird.

SimulatedStartUpPositi-
on

Simulation LREAL 0x03080279 Ermittelt/bestimmt die Part
Position, an der der Mover
während der Simulation er-
kannt wird.

SimulatedStartUpId Simulation STRING(3) 0x0308027E Ermittelt/bestimmt die Mo-
ver ID, die während der Si-
mulation verwendet wird.
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6.7.2.2 Hidden Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
IsCommutationInverted General BOOL 0x03080200 Wenn die Kommutation ver-

tauscht ist und das Magnet-
plattenset nicht passt, kann
der Mover nicht sicher ge-
steuert werden.
Achtung! Beta-Funktion.
Weitere Informationen dazu
finden Sie unter „IsCommu-
tationInverted“, [Seite 196].

6.7.2.3 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
Id MoverIdDetection STRING(3) 0x03080266 Gibt die Mover ID zurück.
AxisId Info UDINT 0x03080288 Ruft die ID der zugehörigen

NC-Achse ab.
AxisObjectId Info OTCID 0x0308028A Ruft die Objekt ID der zuge-

hörigen NC-Achse ab.
DistanceDriven Info LREAL 0x00000050 Gibt den Wert der absoluten

Strecke zurück, die der Mo-
ver gefahren ist.
Einheit: mm

DistanceDrivenInKm Info LREAL 0x00000051 Gibt den Wert der absoluten
Strecke zurück, die der Mo-
ver gefahren ist.
Einheit: km

DriveAddress Info UINT 0x00000087 Gibt die Adresse der An-
triebsklemme zurück, auf der
der Mover momentan einge-
schaltet ist.

DriveModuleNumber Info UDINT 0x00000066 Wenn HasDriveError TRUE
ist, wird unter der Treiber-
nummer die erste Modul-
nummer eingetragen, die
einen Fehler meldet.

DriveTerminalOid Info OTCID 0x00000070 Wenn HasDriveError TRUE
ist, wird die Objekt ID der
Antriebsklemme eingetra-
gen.

EncoderAddress Info UINT 0x00000088 Gibt die Adresse der Enco-
derklemme zurück, auf der
sich der Mover momentan
befindet.

EncoderModuleNumber Info UDINT 0x00000067 Wenn HasEncoderError
TRUE ist, wird unter der En-
codernummer die erste Mo-
dulnummer eingetragen, die
einen Fehler meldet.

EncoderTerminalOid Info OTCID 0x00000071 Wenn HasEncoderError
TRUE ist, wird die Objekt ID
des Encoders eingetragen.
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Parameter Gruppe Typ PTCID Erläuterung
HasDriveError Info BOOL32 0x00000068 Gibt TRUE zurück, wenn das

Modul, das von einem Mover
verwendet wird, einen Fehler
meldet.

HasEncoderError Info BOOL32 0x00000069 Gibt TRUE zurück, wenn das
Encoder-Modul, das von ei-
nem Mover verwendet wird,
einen Fehler meldet.

MasterNetId Info AMSNETID 0x00000089 Gibt die Netz ID des
EtherCAT-Masters zurück,
zu dem der Treiber/Encoder
gehört.

PositionInfo Info – 0x03080286 Gibt die Position des Parts
und des Tracks sowie deren
Objekt IDs zurück.

SoftDriverOid Info OTCID 0x03080289 Ruft die Objekt ID des Soft-
drives ab.
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6.7.2.4 Data Area

Inputs
Parameter Typ Größe Offset Erläuterung
SoftDriveInput SoftDriveInput 104 0 Zyklische Datenstruktur für

die Kommunikation vom Mo-
ver-Objekt zum SoftDrive-
Objekt der Achse.

Outputs
Parameter Typ Größe Offset Erläuterung
SoftDriveOutput SoftDriveOutput 96 0 Zyklische Datenstruktur für

die Kommunikation vom
SoftDrive-Objekt zum Mover-
Objekt der Achse.
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6.7.3 Part

6.7.3.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
TaskOID General OTCID 0x03002060 Ermittelt/bestimmt die XTS-

Task, die für die Berechnun-
gen für den Part verwendet
wird.

ModuleSide General ModuleSide 0x03080262 Modulseite des Parts, der im
XTS Tool Window und im
XTS Viewer angezeigt wird.
Weitere Informationen dazu
finden Sie unter „ModuleSi-
de“, [Seite 196].

OriginTransform General – 0x03080260 Ermittelt/bestimmt einen Be-
reich aus X‑Koordinaten und
Y‑Koordinaten und dem
Drehwinkel Alpha für die
Darstellung des Parts im
XTS Live View.

6.7.3.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
DriveState Info DriveState 0x000000A0 Gibt den Status des Treibers

zurück.
GlobalNumber Info UDINT 0x03080227 Die GlobalNumber wird be-

nötigt, um alle Parts zu un-
terscheiden, die über die
XPU verwaltet werden.

Length Info LREAL 0x03080206 Gibt die Länge des Parts zu-
rück.

AreaCount Structure UDINT 0x03080234 Gibt die Anzahl der Areas
zurück.

AreaObjectIDs Structure – 0x03080235 Gibt einen Bereich zurück,
der die Objekt IDs aller Are-
as enthält.

ModuleCount Structure UDINT 0x03080207 Gibt die Anzahl der Module
zurück.

ModuleObjectIDs Structure – 0x03080208 Gibt einen Bereich zurück,
der die Objekt IDs aller Mo-
dule enthält.
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6.7.4 Info Server

6.7.4.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
AdsPort General WORD 0x03002090 Ermittelt/bestimmt den ADS

Port.
Der Port sollte zum Lesen/
Schreiben von Parametern
über ADS verwendet wer-
den.

6.7.4.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
StationInfoCount Structure UDINT 0x03080275 Gibt die Anzahl der Mover

zurück.
StationInfoObjectIds Structure – 0x03080276 Gibt einen Bereich zurück,

der die Objekt IDs aller Stati-
on-Infos enthält.
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6.7.5 Station Info

6.7.5.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
AdsPort General WORD 0x03002090 Definiert den ADS-Port.

Der Port sollte zum Lesen/
Schreiben von Parametern
über ADS verwendet wer-
den.

StationId General UDINT 0x03080271 Definiert die Station ID.
StationColor General UDINT 0x03080277 Definiert die Farbe der Stati-

on.
Einheit: ARGB.

StartPositionOnPart General LREAL 0x03080272 Definiert die Startposition auf
dem ersten Part.

EndPositionOnPart General LREAL 0x03080273 Definiert die Endposition auf
dem letzten Part.

StopPositions General LREAL 0x03080274 Definiert einen Bereich für
Stopppositionen. Der gültige
Bereich reicht von 0 mm bis
zur Gesamtlänge aller konfi-
gurierten Parts.

PartObjectIds General – 0x03080224 Definiert die Parts, die zur
Station gehören.

IsEnabled General BOOL 0x0308023C Definiert, ob der Part aktiviert
oder deaktiviert ist.
Weitere Informationen dazu
finden Sie unter „IsEnabled“,
[Seite 196].

Description General STRING(1023) 0x0308023A Beschreibung der Station.
Achtung! Die Eingabe einer
Beschreibung ist optional.

6.7.5.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
PartCount Structure UDINT 0x03080203 Gibt die Anzahl der Parts zu-

rück.
StopPositionCount Structure UDINT 0x0308028E Gibt die Anzahl der Stopppo-

sitionen zurück.



Funktionen des Treibers

174 ─── Version: 1.1.1TF5850

6.7.6 Io Driver

6.7.6.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
AdsPort General WORD 0x03002090 Definiert den ADS-Port.

Der Port sollte zum Lesen/
Schreiben von Parametern
über ADS verwendet wer-
den.

MoverType General MoverType 0x00000090 Auswahl des Movertyps.
Weitere Informationen dazu
finden Sie unter „MoverTy-
pe“, [Seite 190].

MagnetPlateType General MagnetPlateType 0x00000091 Auswahl des Magnetplatten-
sets.
Achtung! Richtiges Magnet-
plattentset auswählen. Bei
falscher Auswahl kann der
Mover unerwartet reagieren.
Weitere Informationen dazu
finden Sie unter „MagnetPla-
teType“, [Seite 190].

MoverSortOrder General SortOrderNum 0x00000048 Auswahl der Sortierreihenfol-
ge der Mover.
Weitere Informationen dazu
finden Sie unter „MoverSor-
tOrder“, [Seite 190].

MinMechanicalMover-
Distance

General LREAL 0x0308027A Ermittelt/bestimmt den ge-
ringsten Abstand, der in den
Kurven zwischen Movern ge-
messen wird.
Standardmäßig wird der zum
Movertyp gehörende Ab-
stand verwendet.

PermanentDataConfigu-
ration

Teaching – 0x00000020 Ermittelt/bestimmt eine
Struktur, die die Nummer
derTeaching-Datei enthält.

StartStandStillTeaching-
Parameter

Teaching – 0x00000010 Ermittelt/bestimmt einen Be-
reich, der die Module enthält,
die vom Teaching ausge-
schlossen werden.

StopStandStillTeaching-
Parameter

Teaching – 0x00000011 Ermittelt/bestimmt die Struk-
tur, die das Ergebnis des
Teachings enthält.

IsAbortOnTeachingWar-
ningsEnabled

Teaching BOOL 0x00000057 Wenn TRUE und Warnun-
gen des Teachings vorlie-
gen, wird der Start des Trei-
bers abgebrochen.
Weitere Informationen dazu
finden Sie unter „IsAbortOn-
TeachingWarningsEnabled“,
[Seite 192].
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Parameter Gruppe Typ PTCID Erläuterung
IsTeachingCheckSum-
CheckEnabled

Teaching BOOL 0x00000055 Wenn TRUE, wird beim Start
eine Prüfung der Teaching
Kontrollsumme durchgeführt.
Weitere Informationen dazu
finden Sie unter „IsTeaching-
CheckSumCheckEnabled“,
[Seite 192].

TeachingCheckSum Teaching – 0x00000054 Prüfsumme des Teachings,
um die Datei zu validieren.
Nach einem erneuten Tea-
ching kann die Prüfsumme
aus dem Treiber gelesen
werden.

TeachingWarningLevel Teaching TeachingWar-
ningLevel

0x0308028C Bestimmt den Wert ab dem
der InputCheck und das
Teaching Warnungen ausge-
ben.
Level_1: sehr genau
Level_3: gering

TriggerTeachingFileFor-
matUpdate

Teaching TriggerTeachingFi-
leFormatUpdate

0x03080291 Das Format der Teaching-
Datei wird aktualisiert, wenn
das System in den Konfigu-
rationsmodus zurückwech-
selt.
Die alte Datei wird über-
schrieben.

MoverIdDetectionMode MoverIdDetection MoverIdDetection-
Mode

0x00000201 Auswahl des Mover 1-Erken-
nungsmodus. Bei Standard
ist der Erkennungsmodus
ausgeschaltet.
Weitere Informationen dazu
finden Sie unter „MoverIdDe-
tectionMode“, [Seite 196].

MoverPositionAssign-
ment

MoverIdDetection MoverPosition-
Assignment

0x00000208 Bestimmt die höchste und
die niedrigste Position.
Weitere Informationen dazu
finden Sie unter „MoverPosi-
tionAssignment“, [Seite 197].

TriggerMoverIdDetection MoverIdDetection TriggerMoverIdDe-
tection

0x00000205 Löst die Mover ID-Erken-
nung aus.
Achtung! Die Steuerung der
Achsen wird kurzzeitig akti-
viert.

IsAutoDumpWriting-
Enabled

Diagnostics BOOL 0x00000049 Bei TRUE schreibt der Trei-
ber automatisch Dump-Da-
teien in bestimmten Situatio-
nen, z. B. beim Starten oder
im Falle eines Fehlers.
Weitere Informationen dazu
finden Sie unter „IsAu-
toDumpWritingEnabled“,
[Seite 193].
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Parameter Gruppe Typ PTCID Erläuterung
IsInputCheckEnabled Diagnostics BOOL 0x03080283 Aktiviert die Nachvollziehbar-

keitsprüfung aller Eingangs-
daten des Systems.
Weitere Informationen dazu
finden Sie unter „IsInputChe-
ckEnabled“, [Seite 193].

WriteDump Diagnostics WriteDump 0x00000044 Beim manuellen Download
schreibt der Treiber eine
Dump-Datei.

UsedEventLogger Diagnostics EventMessenger 0x03080292 Gibt an, wie Ereignisse vom
Treiber übermittelt werden.
Weitere Informationen dazu
finden Sie unter „UsedEvent-
Logger“, [Seite 193].

IncludeModuleAreasIn-
Record

Diagnostics BOOL 0x00000095 Achtung! Nicht verändern!
Veralteter Parameter.
Weitere Informationen dazu
finden Sie unter „IncludeMo-
duleAreasInRecord“, [Seite
 197].

IncludeMoverAreasInRe-
cord

Diagnostics BOOL 0x00000096 Achtung! Nicht verändern!
Veralteter Parameter.
Weitere Informationen dazu
finden Sie unter „IncludeMo-
verAreasInRecord“, [Seite
 197].

DumpWriterFallbackMo-
de

Diagnostics DumpWriterFall-
backMode

0x030802B2 Ermittelt/bestimmt welcher
zusätzliche Speicher zum
Schreiben der Dump-Datei
genutzt werden kann, falls
es der Treiber die Dump-Da-
tei beim ersten Mal nicht
schreiben kann.

IsCycleTimeWarning-
Suppressed

Advanced BOOL 0x00000046 Bei TRUE wird die Warnung,
dass der Treiber bei 250 us
nicht läuft, deaktiviert

IsMoverFrozenErrorActi-
vated

Advanced BOOL 0x00000097 Wenn TRUE, wird ein Fehler
statt einer Warnung heraus-
gegeben, wenn die Position
eines Movers eingefroren ist.
Weitere Informationen dazu
finden Sie unter „IsMover-
FrozenErrorActivated“, [Seite
 194].

IsPositionBasedError-
ForwardingEnabled

Advanced BOOL 0x00000092 Wenn TRUE, können einzel-
ne Parts statt des gesamten
Systems hochgefahren oder
heruntergefahren werden.
Achtung! Beta Funktion.
Weitere Informationen dazu
finden Sie unter „IsPosition-
BasedErrorForwardingEnab-
led“, [Seite 194].
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Parameter Gruppe Typ PTCID Erläuterung
Optimization Advanced OptimaizationEnum 0x00000047 Auswahl verfügbarer Opti-

mierungen oder Deaktivie-
rung aller Optimierungen.
Weitere Informationen dazu
finden Sie unter „Optimizati-
on“, [Seite 194].

TriggerRedetection Advanced TriggerRedetection 0x00000098 Löst eine neue Mover-Erken-
nung aus.

TriggerResort Advanced BOOL 0x00000061 Löst eine Sortierung der Mo-
ver Positionen aus. Basie-
rend auf dem Parameter Mo-
verSortOrder erhält der erste
Mover die niedrigeste oder
höchste Position.

6.7.6.2 Hidden Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
DelayBetweenMoversIn-
Pack

MoverIdDetection LREAL 0x00000202 Zeitverzögerung in der Mo-
ver ID-Erkennung zwischen
Movern im selben Paket.
Einheit: s

DelayBetweenMover-
Packs

MoverIdDetection LREAL 0x00000203 Zeitverzögerung in der Mo-
ver ID-Erkennung zwischen
Movern in verschiedenen
Paketen.
Einheit: s

GapToDefineMoverPack MoverIdDetection LREAL 0x00000204 Abstand zwischen Movern,
innerhalb dessen Mover als
ein Paket erkannt werden.
Einheit: mm

IncludedTrackCheck-
Timeout

Advanced UDINT 0x000000A5 Ermittelt/bestimmt die Zeit-
überschreitung, nach der ei-
ne Warnung ausgegeben
wird, wenn keine Tracks in
die Erkennung einbezogen
werden.
Einheit: s

6.7.6.3 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
IsTeachingFileForma-
tUpToDate

Miscellaneous BOOL 0x000000A8 Ermittelt, ob das Format der
aktuell geladenen Teaching-
Datei für die verwendete
Treiberversion gültig ist.

AreAllMoverPositionVa-
lid

Miscellaneous BOOL32 0x00000072 Gibt TRUE zurück, wenn alle
Mover erkannt wurden.

IsTeachingValid Miscellaneous BOOL32 0x00000073 Gibt TRUE zurück, wenn die
Teaching-Daten gültig sind.

DetectedMoverCount Miscellaneous DINT 0x00000074 Gibt die Anzahl der erkann-
ten Mover zurück.

ExpectedMoverCount Miscellaneous DINT 0x00000075 Gibt die Anzahl der erwarte-
ten Mover zurück.
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Parameter Gruppe Typ PTCID Erläuterung
ModuleCount Miscellaneous DINT 0x00000078 Gibt die Anzahl der Module

zurück.
ModuleObjectIDs Miscellaneous – 0x00000079 Gibt den Bereich zurück, der

die Objekt IDs aller Module
enthält.

MoverCount Miscellaneous DINT 0x00000080 Gibt die Anzahl der Mover
zurück.

MoverObjectIDs Miscellaneous – 0x00000081 Gibt den Bereich zurück, der
die Objekt IDs aller Mover
beinhaltet.

MoverPositions Miscellaneous – 0x0000008A Gibt den Bereich zurück, der
die aktuellen Positionen aller
Mover beinhaltet.

IsMoverIdDetectionValid Miscellaneous BOOL32 0x00000206 Gibt TRUE zurück, wenn
Mover ID-Erkennung durch-
geführt wurde.

HasMoverIdDetection-
Error

Miscellaneous BOOL32 0x00000207 Gibt TRUE zurück, wenn die
Mover ID-Erkennung fehler-
haft war.
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6.7.6.4 Data Area

Info
Parameter Typ Größe Offset Erläuterung
AreAllMoverPositionsVa-
lid

BOOL32 4.0 0 Gibt TRUE zurück, wenn alle
Mover erkannt wurden.

IsTeachingValid BOOL32 4.0 4 Gibt TRUE zurück, wenn die
Teaching-Daten gültig sind.

DetectedMoverCount DINT 4.0 8 Gibt die Anzahl der erkann-
ten Mover zurück.

ExpectedMoverCount DINT 4.0 12 Gibt die Anzahl der erwarte-
ten Mover zurück.
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6.7.7 Track

6.7.7.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
TaskOID General OTCID 0x03002060 Ermittelt/bestimmt die XTS-

Task, die für die Berechnun-
gen der Mover verwendet
wird.

IsClosed General BOOL 0x0308021D Ermittelt/bestimmt ob der
Track als Kreis geschlossen
ist oder ein offenes Ende
hat.

IsIncludedInDetection General BOOL 0x03080226 Ermittelt/bestimmt ob der
Track in die Mover-Erken-
nung und die Mover ID-Er-
kennung einbezogen wird.

Polarity General Polarity 0x03080201 Ermittelt/bestimmt welche
Richtung der Track im globa-
len Kontext hat.
Achtung! Zurzeit wird nur
Positive unterstützt.

Offset General LREAL 0x03080202 Ermittelt/bestimmt den Ver-
satz für den Track.

PartConfigItems General – 0x03080204 Ruft einen Bereich von Part-
Konfigurationsobjekten ab,
der die Part Objekt ID und
die Polarität des Parts inner-
halb des Tracks enthält.
Achtung! Zurzeit wird nur
Postive unterstützt.

6.7.7.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
Length Info LREAL 0x03080206 Ermittelt die aktuelle Länge

des Parts.
ModuleCount Info UDINT 0x03080207 Ermittelt die Anzahl der im

Track enthaltenen Module.
PartCount Structure UDINT 0x03080203 Ermittelt die Anzahl der im

Part enthaltenen Module.
PartInfoItems Structure – 0x03080205 Ermittelt den Bereich des

Parts, der die Informations-
elemente zu der Part-Objekt
ID, der Polarität des Parts in-
nerhalb des Tracks, dem
Versatz des Parts im Track
und der aktuellen Länge des
Parts enthält.
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6.7.8 Control Area

6.7.8.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
Name General STRING(1023) 0x03080239 Name der Control Area.

Achtung! Die Eingabe eines
Namens ist optional.

Description General STRING(1023) 0x0308023A Beschreibung der Control
Area.
Achtung! Die Eingabe einer
Beschreibung ist optional.

StartPosition General LREAL 0x03080236 Startposition der Control
Area auf dem Part.
Einheit: mm

EndPosition General LREAL 0x03080237 Endposition der Control Area
auf dem Part.
Einheit: mm

BlendInLength General LREAL 0x0308023E Einblendbereich: Länge vom
Beginn der Control Area bis
neue Parameter vollständig
verwendet werden.

BlendOutLength General LREAL 0x0308023F Ausblendbereich: Länge bis
zum Ende der Control Area
bis der zuvor verwendete
Parameter wiederverwendet
wird.

IsEnabled General BOOL 0x0308023C Ermittelt/bestimmt ob die ak-
tuellen Control Areas akti-
viert oder deaktiviert sind.
Weitere Informationen dazu
finden Sie unter „IsEnabled“,
[Seite 196].

6.7.8.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
Length Info LREAL 0x03080238 Länge der Control Area.

Von der Endposition bis zur
Startposition.

IsValid Info BOOL 0x0308023D Gibt TRUE zurück, wenn alle
Einstellungen gültig sind und
die Control Area verwendet
werden kann.
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6.7.9 AT20xx_0xxx

6.7.9.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
AdsPort General WORD 0X03002090 Ermittelt/bestimmt den ADS-

Port.
Der Port sollte zum Lesen/
Schreiben von Parametern
über ADS verwendet wer-
den.

TaskOID General OTCID 0X03002060 Ermittelt/bestimmt die XTS-
Task, die für die Berechnun-
gen für den Mover verwen-
det wird.

MotorTerminalOID General OTCID 0x00000009 Bestimmt die Objekt ID der
entsprechenden Motorklem-
me.

SensorTerminalOID General OTCID 0x0000000A Bestimmt die Objekt ID der
entsprechenden Sensor-
klemme.

PositionIndex General UDINT 0x00000006 Definiert die Position des
Moduls im System.
Das erste Modul hat die
Hardwareposition 0, die wei-
teren Module werden auf-
steigend gezählt.
Die Anzahl der Module mi-
nus eins ergibt die Hard-
wareposition für das letzte
Modul.

Gap General LREAL 0x0308028B Bestimmt den Abstand des
Moduls zu dem vorherigen
Modul.

Offset General LREAL 0x00000007 Bestimmt einen Versatz des
Moduls, um mechanische
Toleranzen bei der Modul-
produktion auszugleichen.

ScalingFactor General LREAL 0x00000008 Bestimmt einen Skalierungs-
faktor für das Modul, um me-
chanische Toleranzen bei
der Modulproduktion auszu-
gleichen.
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6.7.9.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
Angle Info LREAL 0x00000083 Gibt den Winkel des Moduls

zurück.
Einheit: mm

GlobalNumber Info UDINT 0x03080227 Globale Nummer, um alle
Module zu unterscheiden,
die von einer XPU verwaltet
werden.

Length Info LREAL 0x00000082 Gibt die Länge des Moduls
zurück. Die Länge wird ent-
lang der Mitte der Spulen ge-
messen.
Einheit: mm

MasterNetId Info AMSNETID 0x00000086 Gibt die Netz ID des
EtherCAT Masters zurück,
der zu der Klemme gehört

DriveAddress Drive Info UINT 0x00000084 Gibt die Adresse der An-
triebsklemme zurück

DriveConfigIdentity Drive Info – 0x00000062 Ermittelt die Struktur der
konfigurierten Antriebsklem-
men ID.
Weitere Informationen dazu
finden Sie unter „DriveConfi-
gIdentity“, [Seite 198].

DriveOnlineIdentity Drive Info – 0x00000063 Ermittelt die Struktur der On-
line Antriebsklemmen ID.
Weitere Informationen dazu
finden Sie unter „DriveOnlin-
eIdentity“, [Seite 198].

DriveState Drive Info DriveState 0x000000A0 Gibt den Status der Antriebs-
klemme zurück.

EncoderAdress Encoder Info UINT 0x00000085 Gibt die Adresse der Enco-
derklemme (Sensor) zurück.

EncoderConfigIdentity Encoder Info – 0x00000064 Ermittelt die Struktur der
konfigurierten Encoderklem-
men ID.
Weitere Informationen dazu
finden Sie unter „Encoder-
ConfigIdentity“, [Seite 198].

EncoderOnlineIdentity Encoder Info – 0x00000065 Ermittelt die Struktur der On-
line Encoderklemmen ID.
Weitere Informationen dazu
finden Sie unter „Encode-
rOnlineIdentity“, [Seite 198].

EncoderSensorValues Encoder Info – 0x00000093 Ermittelt den Bereich der En-
codersensorwerte.
Weitere Informationen dazu
finden Sie unter „Encoder-
SensorValues“, [Seite 199].

DriveDeviceType Drive CoE UDINT 0x030802A0 Ermittelt den DeviceType der
CoE-Schnittstelle des Mo-
duls.
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Parameter Gruppe Typ PTCID Erläuterung
DriveDeviceName Drive CoE STRING(15) 0x030802A1 Ermittelt den DeviceName

von der CoE-Schnittstelle
des Moduls.

DriveHardwareVersion Drive CoE STRING(7) 0x030802A2 Ermittelt die Hardwareversi-
on der CoE-Schnittstelle des
Moduls.

DriveSoftwareVersion Drive CoE STRING(7) 0x030802A3 Ermittelt die Softwareversion
der CoE-Schnittstelle des
Moduls.

DriveBtn Drive CoE Btn 0x030802AF Ermittelt die BTN* der CoE-
Schnittstelle des Moduls.

* Die Beckhoff Traceability Number, kurz BTN, finden Sie auf jedem Mover und auf jedem Modul unter dem Da-
taMatrix-Code.

6.7.9.3 Data Pointer

Parameter Typ PTCID HW VariableName Size
Control UINT 0x00000005 Control 2
CurrentSetpoint-
Values[0..14]

INT 0x00000002 Current setpoint value
Ch1‑15

2

Status UINT 0x00000004 Status 2
CurrentActual-
Values[0..14]

INT 0x00000001 Current actual value Ch.1‑15 2

RawPosition-
Values[0..31]

INT 0x3F000101 Value Channel 01‑32 2
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6.7.10 ATH20x0_0xxx

6.7.10.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
AdsPort General WORD 0x03002090 Ermittelt/bestimmt den ADS-

Port.
Der Port sollte zum Lesen/
Schreiben von Parametern
über ADS verwendet wer-
den.

TaskOID General OTCID 0x03002060 Ermittelt/bestimmt die XTS-
Task, die für die Berechnun-
gen für den Mover verwen-
det wird.

MotorTerminalOID General OTCID 0x00000009 Bestimmt die Objekt ID der
entsprechenden Motorklem-
me.

SensorTerminalOID General OTCID 0x0000000A Bestimmt die Objekt ID der
entsprechenden Sen-
sorklemme.

PositionIndex General UDINT 0x00000006 Definiert die Position des
Moduls im System.
Das erste Modul hat die
Hardwareposition 0, die wei-
teren Module werden auf-
steigend gezählt.
Die Anzahl der Module mi-
nus eins ergibt die Hard-
wareposition für das letzte
Modul.

Gap General LREAL 0x0308028B Bestimmt den Abstand des
Moduls zu dem vorherigen
Modul.

Offset General LREAL 0x00000007 Bestimmt einen Versatz des
Moduls, um mechanische
Toleranzen bei der Modul-
produktion auszugleichen.

ScalingFactor General LREAL 0x00000008 Bestimmt einen Skalierungs-
faktor für das Modul, um me-
chanische Toleranzen bei
der Modulproduktion auszu-
gleichen.
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6.7.10.2 Parameter (Online)

Parameter Gruppe Typ PTCID Erläuterung
Angle Info LREAL 0x00000083 Gibt den Winkel des Moduls

zurück.
Einheit: mm

GlobalNumber Info UDINT 0x03080227 Globale Nummer, um alle
Module zu unterscheiden,
die von einer XPU verwaltet
werden.

Length Info LREAL 0x00000082 Gibt die Länge des Moduls
zurück. Die Länge wird ent-
lang der Mitte der Spulen ge-
messen.
Einheit: mm

MasterNetId Info AMSNETID 0x00000086 Gibt die Netz ID des
EtherCAT Masters zurück,
der zu der Klemme gehört.

DriveAddress Drive Info UINT 0x00000084 Gibt die Adresse der An-
triebsklemme zurück

DriveConfigIdentity Drive Info – 0x00000062 Ermittelt die Struktur der
konfigurierten Antriebsklem-
men ID.
Weitere Informationen dazu
finden Sie unter „DriveConfi-
gIdentity“, [Seite 198].

DriveOnlineIdentity Drive Info – 0x00000063 Ermittelt die Struktur der On-
line Antriebsklemmen ID.
Weitere Informationen dazu
finden Sie unter „DriveOnlin-
eIdentity“, [Seite 198].

DriveState Drive Info DriveState 0x000000A0 Gibt den Status der Antriebs-
klemme zurück.

EncoderAddress Encoder Info UINT 0x00000085 Gibt die Adresse der Enco-
derklemme (Sensor) zurück.

EncoderConfigIdentity Encoder Info – 0x00000064 Ermittelt die Struktur der
konfigurierten Encoderklem-
men ID.
Weitere Informationen dazu
finden Sie unter „Encoder-
ConfigIdentity“, [Seite 198].

EncoderOnlineIdentity Encoder Info – 0x00000065 Ermittelt die Struktur der On-
line Encoderklemmen ID.
Weitere Informationen dazu
finden Sie unter „Encode-
rOnlineIdentity“, [Seite 198].

EncoderSensorValues Encoder Info – 0x00000093 Ermittelt den Bereich der En-
codersensorwerte.
Weitere Informationen dazu
finden Sie unter „Encoder-
SensorValues“, [Seite 199].

DriveDeviceType Drive CoE UDINT 0x030802A0 Ermittelt den DeviceType
von der CoE-Schnittstelle
des Moduls.
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Parameter Gruppe Typ PTCID Erläuterung
DriveDeviceName Drive CoE STRING(15) 0x030802A1 Ermittelt den DeviceName

von der CoE-Schnittstelle
des Moduls.

DriveHardwareVersion Drive CoE STRING(7) 0x030802A2 Ermittelt die Hardwareversi-
on von der CoE-Schnittstelle
des Moduls.

DriveSoftwareVersion Drive CoE STRING(7) 0x030802A3 Ermittelt die Softwareversion
von der CoE-Schnittstelle
des Moduls.

DriveBtn Drive CoE Btn 0x030802AF Ermittelt die BTN* der CoE-
Schnittstelle des Moduls.

* Die Beckhoff Traceability Nummer, kurz BTN, finden Sie auf jedem Mover und auf jedem Modul unter dem
DataMatrix-Code.

6.7.10.3 Data Area

Decompressed Sensor Data
Parameter Typ Größe Offset Erläuterung
EncoderSensorValues ARRAY [0..53] OF

LREAL
432.0 0 64 Hallsensorwerte

Data Pointers
Parameter Typ PTCID HW VariableName Size
Control UINT 0x00000005 Control 2
CurrentSetpoint-
Values[0..14]

INT 0x00000002 Current setpoint value
Ch.1‑15

2

Status UINT 0x00000004 Status 2
CurrentActual-
Values[0..14]

INT 0x00000001 Current actual value
Ch.1‑15

2

HallSensorValues ATHCompressed-
Data64

0x000000A2 BinaryData 2
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6.7.11 Data Recorder

6.7.11.1 Parameter (Init)

Parameter Gruppe Typ PTCID Erläuterung
BufferSize General ULINT 0x00010003 Ermittelt/bestimmt die Anzahl

der Puffer Versuche.
CycleDelay General UDINT 0x00010011 Ermittelt/bestimmt die Anzahl

der Zyklen für die Verzöge-
rung der Aufzeichnung.

ImageSections General – 0x00010001 Ermittelt/bestimmt einen Be-
reich für einen Bildaus-
schnitt.
Weitere Informationen dazu
finden Sie unter „ImageSecti-
ons“, [Seite 199].

IsRingBufferModeActiva-
ted

General BOOL 0x00010009 Ermittelt/bestimmt, ob der
Ringpuffer aktiviert oder de-
aktiviert ist.
Weitere Informationen dazu
finden Sie unter „IsRingBuf-
ferModeActivated“, [Seite
 199].

WriteRecord General WriteRecord 0x00010005 Startet den Aufzeichnungs-
prozess.

TraceLevelMax Diagnostics TcTraceLevel 0x03002103 Steuert die Anzahl der Proto-
kollmeldungen.
Weitere Informationen dazu
finden Sie unter „TraceLevel-
Max“, [Seite 199].

FilePartSize Advanced UDINT 0x00010006 Ermittelt/bestimmt die Da-
teigröße.

FileOperationTimeout Advanced UDINT 0x00010007 Ermittelt/bestimmt die Zeit
nach der Aufzeichnungspro-
zess abgebrochen werden
soll.
Einheit: ms

ResetInfoArea Advanced BOOL 0x00010002 Ermittelt/bestimmt, ob der In-
fobereich nach dem Auf-
zeichnungsprozess zurück-
gesetzt werden soll.
Weitere Informationen dazu
finden Sie unter „ResetInfoA-
rea“, [Seite 199].
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6.7.11.2 Parameter (Online)

Parameter Typ PTCID Erläuterung
FrameCount ULINT 0x00010004 Ermittelt die Anzahl der Fra-

mes, die aufgezeichnet wer-
den sollen.

FrameSize UDINT 0x00010008 Ermittelt die Größe der Fra-
mes, die aufgezeichnet wer-
den sollen.

RecorderFrameCount ULINT 0x00010010 Ermittelt die Anzahl der Fra-
mes, die aktuell aufgezeich-
net werden.

6.7.11.3 Data Area

Info
Parameter Typ Größe Offset Erläuterung
UpdateTime LREAL 8.0 0 Geschätzte Aktualisierungs-

zeit
UpdateTimeMin LREAL 8.0 8 Minimale Aktualisierungszeit
UpdateTimeMax LREAL 8.0 16 Maximale Aktualisierungszeit
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6.7.12 Spezifische Datentypen

Diese Parameter liefern Ihnen zusätzliche Informationen zu den bis-
her aufgeführten Parametern. Am Ende jeder Tabelle haben Sie die
Möglichkeit zum Anfang der jeweiligen Parametergruppe zurückzu-
springen.

6.7.12.1 OperationMode

Parameter Typ Erläuterung
Normal OperationMode TwinCAT läuft mit der aktuellen Hardware.
Simulation OperationMode TwinCAT läuft im Simulationsmodus

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.2 MoverType

EnumInfo Typ Erläuterung
UserSpecific MoverType Kundenspezifischer Mover
AT9011_0050 MoverType Mover AT9011-0050
AT9011_0070 MoverType Mover AT9011-0070
AT9012_0050 MoverType Mover AT9012-0050
ATH9011_0075 MoverType Mover ATH9011-0075

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]
Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.3 MagnetPlateType

EnumInfo Typ Erläuterung
AT9001_0550 MagnetPlateType Magnetplattenset AT9001-0550
AT9001_0450 MagnetPlateType Magnetplattenset AT9001-0450
AT9002_0550 MagnetPlateType Magnetplattenset AT9002-0550
AT9001_0AA0 MagnetPlateType Magnetplattenset AT9001-0AA0
AT9001_0883 MagnetPlateType Magnetplattenset AT9001-0883
AT9001_0775 MagnetPlateType Magnetplattenset AT9001-0775
ATH9001-0550 MagnetPlateType Magnetplatenset ATH9001-0550

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]
Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.4 MoverSortOrder

Parameter Typ Erläuterung
Ascending SortOrderEnum Die Mover werden positiv gezählt, beginnend bei 1 ab der XTS

Hardware Nullposition.
Descending SortOrderEnum Die Mover werden negativ gezählt, beginnend mit der höchsten

Mover Nummer der XTS Hardware Nullposition
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]
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6.7.12.5 IdDetectionMode

Parameter Typ Erläuterung
Standard MoverIdDetectionMo-

de
Alle Mover haben ein Magnetplattenset Mover Standard. Die Mo-
ver ID-Erkennung ist ausgeschaltet.

Mover1 MoverIdDetectionMo-
de

Genau ein Mover hat das Magnetplattenset Mover 1.

MultipleMover1 MoverIdDetectionMo-
de

Mehrere Mover haben das Magnetplattenset Mover 1.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.6 MoverPositionAssignment

Parameter Typ Erläuterung
Standard MoverPositionAssi-

gnment
Alle Mover behalten ihre absolute Position.

StartAtFirstMover MoverPositionAssi-
gnment

Der erste Mover erhält die höchste oder niedrigste absolute Positi-
on, abhängig von der MoverPositionAssignment.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.7 ExpectedMoverIds

Parameter Typ Wert Erläuterung
Id STRING(3) 1 Mover ID.

„1“ für Mover mit dem dem Magnetplatten-
set Mover 1.
„-“ für Mover mit dem Magnetplattenset
Standard.

Count UDINT 2 Anzahl der erwarteten Mover.
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.8 StartStandStillTeaching

Parameter Typ Erläuterung
TeachingSelection TeachingSelection Auswahl, ob die Module vom Teaching ausgeschlossen oder in

das Teaching integriert werden.
• ExcludeSpecifiedI-

tems
– Module mit Movern. Diese Module sollen vom Teaching ausge-

schlossen werden.
• IncludeSpecifiedI-

tems
– Leere Module. Diese Module sollen ins Teaching integriert wer-

den.
selectionString STRING(1023) Nummern der Module, entsprechend des Parameters Tea-

chingSelection.
Die Modulnummern können mit den Zeichen „-“ oder „,“oder einer
Kombination aus beiden Zeichen eingegeben werden, z. B. “1‑4”,
“1,2,3,4” oder “1‑3,4”.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]
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6.7.12.9 StartMovementTeaching

Systemart beachten
Das StartMovementTeaching ist nur beim XTS Standard System an-
wendbar und nicht für das XTS Hygienic System verfügbar. Diese
Parameter werden beim XTS Hygienic System ignoriert.

Parameter Typ Erläuterung
teachingSelection TeachingSelection Auswahl, ob die Module vom Teaching ausgeschlossen oder in

das Teaching integriert werden.
• ExcludeSpecifiedI-

tems
– Module mit Movern. Diese Module sollen vom Teaching ausge-

schlossen werden.
• IncludeSpecifiedI-

tems
– Leere Module. Diese Module sollen ins Teaching integriert wer-

den.
selectionString STRING(1023) Nummern der Module, entsprechend des Parameters Tea-

chingSelection.
Die Modulnummern können mit den Zeichen „-“ oder „,“oder einer
Kombination aus beiden Zeichen eingegeben werden, z. B. “1‑4”,
“1,2,3,4” oder “1‑3,4”.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.10 IsAbortOnTeachingWarningsEnabled

Parameter Typ Erläuterung
TRUE BOOL Der Treiber bricht den Start ab, wenn Teaching Warnungen vor-

handen sind.
FALSE BOOL Der Treiber bricht den Start nicht ab, wenn Teaching Warnungen

vorhanden sind.
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.11 IsTeachingCheckSumCheckEnabled

Parameter Typ Erläuterung
TRUE BOOL Die Prüfung der Teaching Kontrollsumme wird beim Start durch-

geführt.
FALSE BOOL Die Prüfung der Teaching Kontrollsumme wird nicht beim Start

durchgeführt.
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.12 TeachingCheckSum

Parameter Typ Erläuterung
[0]…[15] BYTE Werte für die Teaching Kontrollsumme.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]
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6.7.12.13 TeachingWarningLevel

Parameter Typ Erläuterung
Level_1 TeachingWarningLe-

vel
Sehr genau

Level_2 TeachingWarningLe-
vel

Normal

Level_3 TeachingWarningLe-
vel

Gering

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.14 IsAutoDumpWritingEnabled

Parameter Typ Erläuterung
TRUE BOOL Dump-Dateien werden bei besonderen Ereignissen automatisch

geschrieben, z. B. Mover-Erkennung, Mover ID-Erkennung, Mover
verloren, …

FALSE BOOL Dump-Dateien werden nicht automatisch geschrieben.
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.15 IsInputCheckEnabled

Parameter Typ Erläuterung
TRUE BOOL Aktiviert die Plausibilitätsprüfung aller Eingangskanäle des Sys-

tems.
FALSE BOOL Deaktiviert die Plausibilitätsprüfung aller Eingangskanäle des Sys-

tems.
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.16 UsedEventLogger

Parameter Typ Erläuterung
StandardMessage-
Interface

EventMessenger Meldungen werden über die vom Benutzer gewählte Schnittstelle
ausgegeben.

EventLogger EventMessenger Meldungen werden im Visual Studio Ereignisprotokoll ausgege-
ben.

TC3EventLogger EventMessener Meldungen werden im TC3 Ereignisprotokoll ausgegeben.
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]
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6.7.12.17 IsCycleTimeWarningSuppressed

Parameter Typ Erläuterung
TRUE BOOL Es werden keine Taktzeitwarnungen ausgegeben.
FALSE BOOL Taktzeitwarnungen werden ausgegeben, wenn die XTS-Task

Taktzeit von 250us abweicht.
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.18 IsMoverFrozenErrorActivated

Parameter Typ Erläuterung
TRUE BOOL Wenn ein Mover einfriert, wird ein Fehler ausgegeben.
FALSE BOOL Wenn ein Mover einfriert, wird eine Warnung ausgegeben.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]
Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.19 IsPositionBasedErrorForwardingEnabled

Parameter Typ Erläuterung
TRUE BOOL Das DriveDeviceError-Bit der NC-Achse zeigt TRUE, wenn der

betreffende Mover auf einem Modul mit einem Fehler steht, noch
bevor die Mover-Achse freigegeben wird.

FALSE BOOL Das DriveDeviceError-Bit der NC-Achse zeigt nicht TRUE, wenn
der entsprechende Mover auf einem Modul mit einem Fehler
steht, bevor die Mover-Achse freigegeben wird. Es wird TRUE
zeigen, wenn die Mover-Achse freigegeben ist.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]
Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.20 Optimization

Parameter Typ Erläuterung
No OptimizationEnum Es wird keine Optimierung vorgenommen.
MaximizePositionAc-
curacyOP1

OptimizationEnum Das System wird hinsichtlich der Positionsgenauigkeit optimiert.

SmoothMovemen-
tOM1

OptimizationEnum Das System wird für ruckfreie Bewegungen optimiert.

CombinationOC1 OptimizationEnum Das System wird für eine Kombination aus Positionsgenauigkeit
und ruckfreien Bewegungen optimiert.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]
Zurück zu Io Driver „Parameter (Init)“, [Seite 174]



Funktionen des Treibers

Version: 1.1.1 ─── 195TF5850

6.7.12.21 PositionStartUpSimulationMode

Parameter Typ Erläuterung
UseMoverParame-
ters

PositionStartUpSimu-
lationMode

Die Mover starten in der Simulation mit ihrer vorgegebenen Start-
position.

UseOffsetAndDistan-
ce

PositionStartUpSimu-
lationMode

Die Mover starten in der Simulation auf Grundlage der konfigurier-
ten Offset-Positionsparameter und Abstands-Positionsparameter.

UseRandomDistribu-
tion

PositionStartUpSimu-
lationMode

Die Mover starten in der Simulation an einer zufälligen Position.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.22 MoverIdStartUpSimulationMode

Parameter Typ Erläuterung
UseMoverParame-
ters

MoverIdStartUpSimu-
lationMode

Die Mover starten in der Simulation mit ihrer vorgegebenen Start-
position.

UseAlternation MoverIdStartUpSimu-
lationMode

Die Mover starten in der Simulation mit einer wechselnden ID, die
auf den Einstellungen für die erwarteten Mover IDs basiert.

UseRandomDistribu-
tion

MoverIdStartUpSimu-
lationMode

Die Mover starten in der Simulation mit einer zufälligen ID, die auf
den Einstellungen für die erwarteten Mover IDs basiert.

Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.23 RandomInitMode

Parameter Typ Erläuterung
UseSystemTime RandomInitMode Die zufällige Verteilung wird auf Grundlage der Systemzeit be-

rechnet.
UseInitSeed RandomInitMode Die zufällige Verteilung wird auf Grundlage des Ausgangswertes

berechnet.
Zurück zu Processing Unit „Parameter (Init)“, [Seite 159]

6.7.12.24 IdDiagConfiguration

Parameter Typ Erläuterung
floatBufferSize UDINT Zugewiesener Pufferplatz für Position und aktuelle Werte.
intBufferSize UDINT Zugewiesener Platz für Kommunikationsdaten zwischen SoftDrive

und TcIoXts.
requiredCurrentDe-
viation

REAL Zu berücksichtigende notwendige Wechselstromdifferenz.

requiredPositionDe-
viation

REAL Zu berücksichtigende notwendige Positionsänderungsdifferenz.

Zurück zu Processing Unit „Hidden Parameter (Init)“, [Seite 164]
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6.7.12.25 CompletionCriteria

Parameter Typ Erläuterung
CheckEveryMover MoverIdDetection-

CompletionCriteria
Jeder Mover erhält einen Ruck zur Erkennung und wird auf seine
ID geprüft.

CompleteAfterMo-
ver1Found

MoverIdDetection-
CompletionCriteria

Sobald der Mover mit dem Magnetplattenset Mover 1 erkannt
wurde, wird die Erkennung beendet.

Zurück zu Processing Unit „Hidden Parameter (Init)“, [Seite 164]

6.7.12.26 IsCommutationInverted

Parameter Typ Erläuterung
TRUE OTCID Achtung! Der Parameter ist nur für Tests - wenn die Kommutie-

rung invertiert ist und das Magnetplattenset nicht übereinstimmt,
kann der Umrichter nicht sicher gesteuert werden!

FALSE OTCID Achtung! Der Parameter ist nur für Tests - wenn die Kommutie-
rung invertiert ist und das Magnetplattenset nicht übereinstimmt,
kann der Umrichter nicht sicher gesteuert werden!

Zurück zu Mover „Hidden Parameter (Init)“, [Seite 168]

6.7.12.27 ModuleSide

Parameter Typ Erläuterung
Back ModuleSide Darstellung der Modulseite mit Typenschild.
Front ModuleSide Darstellung der Modulseite mit Feedbacksystem.

Zurück zu Part „Parameter (Init)“, [Seite 171]

6.7.12.28 IsEnabled

Parameter Typ Erläuterung
TRUE BOOL Definiert, ob die Station aktiviert ist.
FALSE BOOL Definiert, ob die Station deaktiviert ist.

Zurück zu Station Info „Parameter (Init)“, [Seite 173]
Zurück zu Control Area „Parameter (Init)“, [Seite 181]

6.7.12.29 MoverIdDetectionMode

Parameter Typ Erläuterung
Standard MoverIdDetectionMo-

de
Erkennungsmodus ist deaktiviert. Es werden nur Standard Mover
verwendet.

Mover1 MoverIdDetectionMo-
de

Erkennungsmodus ist aktiviert. Ein Mover 1 wird verwendet.

MultipleMover1 MoverIdDetectionMo-
de

Erkennungsmodus ist aktiviert. Mehrere Mover 1 werden verwen-
det.

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]
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6.7.12.30 MoverPositionAssignment

Parameter Typ Erläuterung
Standard MoverPositionAssi-

gnment
Definiert die niedrigste/höchste Position.

StartAtFirstMover MoverPositionAssi-
gnment

Definiert die niedrigste/höchste Position.

Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.31 IncludeModuleAreasInRecord

Parameter Typ Erläuterung
TRUE BOOL Modulbereiche sind in der Aufzeichnung enthalten.

Achtung! Nicht ändern! Veralteter Parameter.
FALSE BOOL Modulbereiche sind in der Aufzeichnung nicht enthalten.

Achtung! Nicht ändern! Veralteter Parameter.
Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.32 IncludeMoverAreasInRecord

Parameter Typ Erläuterung
TRUE BOOL Moverbereiche sind in der Aufzeichnung enthalten.

Achtung! Nicht ändern! Veralteter Parameter.
FALSE BOOL Moverbereiche sind in der Aufzeichnung nicht enthalten.

Achtung! Nicht ändern! Veralteter Parameter.
Zurück zu Io Driver „Parameter (Init)“, [Seite 174]

6.7.12.33 IsClosed

Parameter Typ Erläuterung
TRUE BOOL Der Track ist geschlossen.
FALSE BOOL Der Track ist nicht geschlossen.

Zurück zu Track „Parameter (Init)“, [Seite 180]

6.7.12.34 IsIncludedInDetection

Parameter Typ Erläuterung
TRUE BOOL Der Track ist Teil der Mover-Erkennung und der Mover ID-Erken-

nung.
FALSE BOOL Der Track ist kein Teil der Mover-Erkennung und der Mover ID-Er-

kennung.
Zurück zu Track „Parameter (Init)“, [Seite 180]
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6.7.12.35 Polarity

Parameter Typ Erläuterung
Positive Polarity Der Track hat eine positive Zählrichtung.
Negative Polarity Der Track hat eine negative Zählrichtung.

Achtung! Derzeit noch nicht unterstützt.
Zurück zu Track „Parameter (Init)“, [Seite 180]

6.7.12.36 DriveConfigIdentity

Parameter Typ Erläuterung
vendor UDINT Hersteller ID
code UDINT Artikelnummer
revision UDINT Revisionsnummer
serial UDINT Seriennummer

Zurück zu AT20xx_0xxx „Parameter (Online)“, [Seite 183]
Zurück zu ATH20x0_0xxx „Parameter (Online)“, [Seite 186]

6.7.12.37 DriveOnlineIdentity

Parameter Typ Erläuterung
vendor UDINT Hersteller ID
code UDINT Artikelnummer
revision UDINT Revisionsnummer
serial UDINT Seriennummer

Zurück zu AT20xx_0xxx „Parameter (Online)“, [Seite 183]
Zurück zu ATH20x0_0xxx „Parameter (Online)“, [Seite 186]

6.7.12.38 EncoderConfigIdentity

Parameter Typ Erläuterung
vendor UDINT Hersteller ID
code UDINT Artikelnummer
revision UDINT Revisionsnummer
serial UDINT Seriennummer

Zurück zu AT20xx_0xxx „Parameter (Online)“, [Seite 183]
Zurück zu ATH20x0_0xxx „Parameter (Online)“, [Seite 186]

6.7.12.39 EncoderOnlineIdentity

Parameter Typ Erläuterung
vendor UDINT Hersteller ID
code UDINT Artikelnummer
revision UDINT Revisionsnummer
serial UDINT Seriennummer

Zurück zu AT20xx_0xxx „Parameter (Online)“, [Seite 183]
Zurück zu ATH20x0_0xxx „Parameter (Online)“, [Seite 186]
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6.7.12.40 EncoderSensorValues

Parameter Typ Erläuterung
[0] - [31] LREAL Encoder-Sensorwert des jeweiligen Kanals

Zurück zu AT20xx_0xxx „Parameter (Online)“, [Seite 183]
Zurück zu ATH20x0_0xxx „Parameter (Online)“, [Seite 186]

6.7.12.41 ImageSections

Parameter Typ Erläuterung
ObjectID OTCID Objekt ID
AreaNumber UDINT Bereichsnummer
StartAddress UDINT Startposition
Size UDINT Bildgröße

Zurück zu Data Recorder „Parameter (Init)“, [Seite 188]

6.7.12.42 IsRingBufferModeActivated

Parameter Typ Erläuterung
TRUE BOOL Ringpuffer ist aktiviert
FALSE BOOL Ringpuffer ist deaktiviert

Zurück zu Data Recorder „Parameter (Init)“, [Seite 188]

6.7.12.43 TraceLevelMax

Parameter Typ Erläuterung
tlAlways TcTraceLevel Steuert die Menge der Protokollmeldungen. Alle Meldungen wer-

den ausgegeben.
tlError TcTraceLevel Steuert die Menge der Protokollmeldungen. Nur Fehler werden

ausgegeben.
tlWarning TcTraceLevel Steuert die Menge der Protokollmeldungen. Fehler und Warnun-

gen werden ausgegeben.
tlInfo TcTraceLevel Steuert die Menge der Protokollmeldungen. Fehler, Warnungen

und Informationen werden ausgegeben.
tlVerbose TcTraceLevel Steuert die Menge der Protokollmeldungen. Es werden keine Mel-

dungen ausgegeben.
Zurück zu Data Recorder „Parameter (Init)“, [Seite 188]

6.7.12.44 ResetInfoArea

Parameter Typ Erläuterung
TRUE BOOL Der Infobereich wird zurückgesetzt.
FALSE BOOL Der Infobereich wird nicht zurückgesetzt.

Zurück zu Data Recorder „Parameter (Init)“, [Seite 188]
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7 Inbetriebnahme
Die ersten Schritte der Inbetriebnahme sind davon abhängig, ob Sie
über Hardware verfügen oder nicht. Wenn eine unterschiedliche
Vorgehensweise erforderlich ist, werden Ihnen zu Beginn des jewei-
ligen Kapitels entsprechende Verlinkungen dargestellt.

7.1 Projekt öffnen oder anlegen

Hardware vorhanden
Wenn Sie über Hardware verfügen, können Sie ein bereits vorhan-
denes Projekt öffnen oder ein neues Projekt anlegen. Sie können
mit einem der folgenden Kapitel fortfahren:
• „Vorhandenes Projekt öffnen“, [Seite 200]
• „Neues Projekt anlegen“, [Seite 201]

Hardware nicht vorhanden
Wenn Sie über keine Hardware verfügen, können Sie ein bereits
vorhandenes Projekt öffnen oder mit dem XTS Simulation Builder
ein neues Projekt anlegen. Beckhoff empfiehlt den XTS Simulation
Builder zu verwenden. Sie können mit einem der folgenden Kapitel
fortfahren:
• „Vorhandenes Projekt öffnen“, [Seite 200]
• „XTS Simulation Builder“, [Seite 231]

7.1.1 Vorhandenes Projekt öffnen
Nachdem Sie TwinCAT geöffnet haben, haben Sie die Möglichkeit
im Startbildschirm oder im Menü ein vorhandenes Projekt zu öffnen.

Startbildschirm In der Auflistung werden Ihnen die zuletzt geöffneten Projekte des
Vortages, der letzten Woche, des letzten Monats und der vorange-
gangenen Zeit angezeigt.

► Auf ein vorhandenes Projekt in der Liste klicken, um es zu öffnen

Menü
► Im Menü File auf den Menüpunkt Open… klicken
► Im Ausklappmenü auf Project/Solution klicken
► Auf ein vorhandenes Projekt klicken, um es zu öffnen
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7.1.2 Neues Projekt anlegen
Um ein XTS System einzurichten und mit allen Hardwarekomponen-
ten zu verbinden, müssen Sie zunächst ein TwinCAT 3-Projekt ein-
richten. Zur Inbetriebnahme müssen Sie ein neues TwinCAT XAE-
Projekt mit Solution anlegen.

► Im Menü File auf den Menüpunkt New klicken
► Im Ausklappmenü auf Project klicken

Das Dialogfenster New Project öffnet sich.
► Auf TwinCAT Projects klicken
► In das Eingabefeld Name einen Namen eingeben
► Einen Dateipfad im Dropdown-Menü Location auswählen
ODER
► Auf Browse klicken, um das Dialogfenster Project Location zu

öffnen und einen Dateipfad auszuwählen
► In das Eingabefeld Solution name einen Namen eingeben
► Mit OK bestätigen
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7.2 Hardware vorbereiten

Hardware nicht vorhanden
Wenn Sie über keine Hardware verfügen, können Sie ein System
konfigurieren. Sie können mit folgendem Kapitel fortfahren:
• „System konfigurieren“, [Seite 206]

Hardware vorhanden
Wenn Sie über Hardware verfügen, können Sie mit den folgenden
Schritten fortfahren.

7.2.1 Hardware überprüfen
► Korrekte Verbindung aller XTS Hardwarekomponenten mit dem

IPC und dem Netzanschluss prüfen
Folgende LEDs müssen an allen Modulen leuchten:
• Link / Act
• 24 V / 4 A

Wenn die LEDs nicht leuchten:
► Kabel und Steckverbindungen überprüfen
► EtherCAT-Einstellungen für die Kommunikation mit dem Ziel-PC

überprüfen

7.2.2 Ziel-PC verbinden

Dieselbe Softwareversion auf Ziel-PC und Engeneering-PC
Stellen Sie sicher, dass auf Ihrem Ziel-PC dieselbe Softwareversion
installiert ist, wie auf Ihrem Engeneering-PC.

► Solution Explorer > TwinCAT Project ausklappen
► Doppelklick auf SYSTEM

► Im Projektfenster auf den Reiter General klicken
► Auf Choose Target klicken
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Das Dialogfenster Choose Target System öffnet sich.
Im Dialogfenster Choose Target System werden alle Ziel-PCs auf-
gelistet, zu denen Routen vom Entwicklungssystem bestehen.
Wenn der gewünschte Ziel-PC noch nicht aufgelistet ist:
► Auf Search (Ethernet)… klicken
Wenn Sie lokal auf Ihrem Engeneering-PC arbeiten:
► Auf <Local> klicken
Nachdem Sie <Local> ausgewählt haben, können Sie mit folgen-
dem Kapitel fortfahren:
• „Ziel-PC überprüfen“, [Seite 204]

Das Dialogfenster Add Route Dialog öffnet sich.
► Kontrollkästchen Advanced Settings aktivieren

► Kontrollkästchen IP Address aktivieren
► Auf Broadcast Search klicken

Das Dialogfenster Select Adapter(s) öffnet sich.
► Kontrollkästchen Realtek USB GbE Family Controller deakti-

vieren
► Mit OK bestätigen

► Auf den Ziel-PC klicken
► Auf Add Route klicken
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Das Dialogfenster Add Remote Route öffnet sich.
► In das Eingabefeld Password das Passwort für den Ziel-PC ein-

geben
► Mit OK bestätigen

Die erfolgreiche Verbindung des Ziel-PCs wird durch ein geschlos-
senes Schloss in der Spalte Connected dargestellt.
► Mit Close bestätigen

Das Dialogfenster Choose Target System öffnet sich.
► Mit OK bestätigen

7.2.2.1 Ziel-PC überprüfen
► Überprüfen, ob der Ziel-PC ausgewählt ist
► Bei Bedarf den Ziel-PC im Dropdown-Menü auswählen

7.2.3 IO Devices scannen
► Darauf achten, dass sich TwinCAT im Config Mode befindet
► Bei Bedarf auf die Schaltfläche Restart TwinCAT (Config Mo-

de) klicken, um den Config Mode zu aktivieren



Inbetriebnahme

Version: 1.1.1 ─── 205TF5850

► Solution Explorer > TwinCAT Project > I/O ausklappen
► Mit der rechten Maustaste auf Devices klicken, um das Kontext-

menü aufzurufen
► Im Kontextmenü auf Scan klicken

Das Dialogfenster TcXaeShell öffnet sich.
► Mit OK bestätigen

Abhängig von den Komponenten Ihres XTS Systems stehen unter-
schiedliche Devices zur Auswahl:
• je ein RT-Ethernet Adapter für jeden angeschlossenen CU2508
• je ein EtherCAT Device für jeden Einspeisestrang des XTS Sys-

tems
• EtherCat Devices für die Busklemmen im Schaltschrank

Beckhoff empfiehlt die Devices für einen besseren Überblick eindeu-
tig zu benennen.
Das Dialogfenster 8 new I/O devices found öffnet sich.
► Kontrollkästchen der Devices aktivieren, die für die aktuelle Kon-

figuration ausgewählt werden sollen
► Mit OK bestätigen

Das Dialogfenster TcXaeShell öffnet sich.
► Mit Yes bestätigen
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7.3 System konfigurieren
Sie haben verschiedene Möglichkeiten ein XTS System zu konfigu-
rieren. Die Vorgehensweise wie Sie ein System konfigurieren kön-
nen, ist abhängig davon, ob Sie über Hardware verfügen oder nicht:

Hardware vorhanden
Wenn Sie über vorhandene Hardware verfügen, können Sie das
System mit dem XTS Configurator oder manuell anlegen. Beckhoff
empfiehlt den XTS Configurator zu verwenden. Sie können einem
der folgenden Kapitel fortfahren:
• „XTS Configurator“, [Seite 260]
• „Neues XTS System manuell anlegen“, [Seite 39]

Hardware nicht vorhanden
Wenn Sie über keine Hardware verfügen, können Sie das System
mit dem XTS Simulation Builder oder manuell anlegen. Beckhoff
empfiehlt den XTS Simulation Builder zu verwenden. Sie können mit
einem der folgenden Kapitel fortfahren:
• „XTS Simulation Builder“, [Seite 231]
• „Neues XTS System manuell anlegen“, [Seite 39]
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7.4 IO Devices überprüfen

Anschluss an das Stromnetz und 48 V erforderlich
Zur Inbetriebnahme eines realen XTS Systems muss das System an
das Stromnetz angeschlossen sein und 48 V müssen aufgeschaltet
sein.

Nachdem Sie das XTS System konfiguriert haben, können Sie die
Konfiguration in Betrieb nehmen und die Mover verfahren.

Hardware vorhanden
Um ein System in Betrieb zu nehmen, müssen die IO Devices akti-
viert sein.

Hardware nicht vorhanden
Um ein simuliertes System in Betrieb zu nehmen, müssen die IO-
Devices deaktiviert sein.

Ob die Devices aktiviert oder deaktiviert sind, können Sie an der
Darstellung der Devices im Solution Explorer erkennen:

Das Device ist aktiviert.

Das Device ist deaktiviert.

► Solution Explorer > TwinCAT Project > I/O > Devices ausklap-
pen

► Überprüfen, ob alle XTS relevanten Devices aktiviert sind
Wenn die Devices deaktiviert sind, müssen die Devices aktiviert
werden.

7.4.1 Aktivieren
► Die Taste Strg gedrückt halten, um die Devices auszuwählen
► Mit der rechten Maustaste auf die XTS relevanten Devices kli-

cken
► Im Kontextmenü auf Disable klicken
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7.5 Konfiguration aktivieren
► Auf die Schaltfläche Activate Configuration klicken, um die

Konfiguration zu aktivieren

Das Dialogfenster Activate Configuration öffnet sich.
► Darauf achten, dass in den Eingabefeldern Project und Target

das korrekte Projekt und der korrekte Ziel-PC ausgewählt sind
► Mit OK bestätigen

Sobald das System aktiviert ist, wird in der Informationsleiste und
Statusleiste ein animiertes TwinCAT-Symbol eingeblendet. Das XTS
System ist betriebsbereit. Änderungen an der aktuellen Konfigurati-
on können Sie jederzeit vornehmen, indem Sie den XTS Configura-
tor erneut öffnen.

Das XTS Tool Window lässt sich nur in den Running-Modus verset-
zen, wenn die Konfiguration aktiviert ist und sich TwinCAT im Run-
Modus befindet.

► Im XTS Tool Window die Schaltfläche Check to enable live
view aktivieren

Das XTS Tool Window befindet sich im Running-Modus und zeigt
die aktuellen Moverpositionen.

7.6 Mover ID-Erkennung
Führen Sie eine Mover ID-Erkennung durch, um Mover 1 auf dem
System zu lokalisieren. Weitere Informationen dazu finden Sie im
Kapitel „Mover 1-Funktionalität“, [Seite 93].
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7.7 NC-Achsen aktivieren
Bevor Sie einen Mover verfahren können, müssen Sie die entspre-
chende NC-Achse des Movers aktivieren.

► Solution Explorer > TwinCAT Project > MOTION > NC-Task 1 >
Axes ausklappen

► Doppelklick auf Mover Axis 1

► Im Projektfenster auf den Reiter Online klicken
► Auf Set klicken

Mit der Schaltfläche All werden die Regler Controller, Feed Fw und
Feed Bw zum Verfahren der Mover freigegeben. Wenn Sie auf die
Schaltfläche All klicken, wird das Fenster Set Enabling automatisch
geschlossen.

Das Dialogfenster Set Enabling öffnet sich.
► Auf All klicken, um alle Regler freizugeben
ODER
► Kontrollkästchen Controller, Feed Fw und Feed Bw aktivieren,

um die Regler freizugeben
► Mit OK bestätigen
Die Regler der Achse sind freigegeben und der entsprechende Mo-
ver kann verfahren werden.
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7.8 Mover verfahren
Nachdem Sie die Konfiguration und die NC-Achsen der Mover akti-
viert haben, können Sie nun einen oder mehrere Mover verfahren.
Darstellungsweise eines simulierten Systems beachten
Wenn kein reales XTS System angeschlossen ist und Sie mit einem
simulierten System arbeiten, überholen und überlagern sich die Mo-
ver in der Darstellung im XTS Tool Window. Bei einem realen Sys-
tem ist diese Überlagerung nicht möglich, stattdessen kollidieren die
Mover.
Die Mover lassen sich über die Schaltflächen in jede beliebige Posi-
tion oder über einen direkten Fahrauftrag zu einer definierten Positi-
on verfahren. Außerdem können bestimmte Funktionen zum Verfah-
ren verwendet werden, diese werden jedoch nicht über die Schalt-
flächen gesteuert.

7.8.1 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Schnell rückwärts
Fährt den Mover rückwärts mit der Geschwindigkeit, die im Eingabe-
feld Manual Velocity (Fast) eingegeben ist.
Voreingestellt: 600 [mm/s]

Langsam rückwärts
Fährt den Mover rückwärts mit der Geschwindigkeit, die im Eingabe-
feld Manual Velocity (Slow) eingegeben ist.
Voreingestellt: 100 [mm/s]

Langsam vorwärts
Fährt den Mover vorwärts mit der Geschwindigkeit, die im Eingabe-
feld Manual Velocity (Slow) eingegeben ist.
Voreingestellt: 100 [mm/s]

Schnell vorwärts
Fährt den Mover vorwärts mit der Geschwindigkeit, die im Eingabe-
feld Manual Velocity (Fast) eingegeben ist.
Voreingestellt: 600 [mm/s]

Direkten Fahrauftrag starten
Startet einen direkten Fahrauftrag zur Zielposition, die im Eingabe-
feld Target Position eingegeben wird, mit der Geschwindigkeit, die
im Eingabefeld Target Velocity eingegeben wird.

Direkten Fahrauftrag stoppen
Stoppt den direkten Fahrauftrag.

Fahrauftrag abbrechen und Reset
Stoppt den aktuellen Fahrauftrag und setzt die NC-Achse zurück.

Reglerfreigabe
Gibt die Regler zum Verfahren der Mover frei.

Eingabefeld Zielposition
Ermöglicht die Eingabe der Zielposition des Movers bei einem direk-
ten Fahrauftrag.
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Eingabefeld Geschwindigkeit
Ermöglicht die Eingabe der Geschwindigkeit für den Mover bei ei-
nem direkten Fahrauftrag.

7.8.2 Beliebige Position

Schaltfläche steuert nur den ausgewählten Mover
Die Schaltflächen zum Verfahren der Mover steuern immer nur die
ausgewählte NC-Achse mit dem dazugehörigen Mover auf dem mo-
mentan aktiven Track.
Wenn Sie mehrere Mover über die Schaltflächen verfahren möch-
ten, müssen die Mover gekoppelt werden. Weitere Informationen
dazu finden Sie im Kapitel „Mover koppeln“, [Seite 224].

Wenn die Schaltflächen inaktiv sind, ist die ausgewählte NC-Achse
des Movers nicht aktiviert oder die NC-Achse ist mit einer anderen
NC-Achse gekoppelt.

Rückwärts
► Mit der linken Maustaste die Schaltfläche F1 gedrückt halten, um

den Mover schnell rückwärts zu verfahren
ODER
► Mit der linken Maustaste die Schaltfläche F2 gedrückt halten, um

den Mover langsam rückwärts zu verfahren

Vorwärts
► Mit der linken Maustaste die Schaltfläche F3 gedrückt halten, um

den Mover langsam vorwärts zu verfahren
ODER
► Mit der linken Maustaste die Schaltfläche F4 gedrückt halten, um

den Mover schnell vorwärts zu verfahren
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7.8.3 Direkter Fahrauftrag

Die bisher zurückgelegten Strecken werden zu einer absoluten Po-
sition  [1] aufaddiert. Von dieser absoluten Position fährt der Mover
in positive oder negative Richtung, bis die Zielposition [2] mit der de-
finierten Geschwindigkeit [3] erreicht wird.
Im Gegensatz dazu werden bei der Funktion Modulo die zurückge-
legten Strecken nicht aufaddiert und die bereits zurückgelegte Stre-
cke muss nicht komplett zurückgefahren werden, um die Zielposition
zu erreichen. Weitere Informationen dazu finden Sie im Kapitel „Mo-
dulo / Modulo shortest way / Modulo plus direction / Modulo minus
direction“, [Seite 217].

► In das Eingabefeld Target Position einen Wert für die Position
eingeben, zu der der Mover verfahren werden soll

► In das Eingabefeld Target Velocity die Geschwindigkeit einge-
ben, mit der der Mover verfahren werden soll

► Auf die Schaltfläche F5 klicken, um den direkten Fahrauftrag zu
starten

Der Mover wird mit der definierten Geschwindigkeit zur Zielposition
verfahren.
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Direkten Fahrauftrag abbrechen
► Auf die Schaltfläche F6 klicken, um den direkten Fahrauftrag ab-

zubrechen

7.8.4 Funktionen
Verschiedene Fahraufträge stehen im Reiter Functions zur Verfü-
gung und können nach Eingabe einiger Werte genutzt werden.

► Im Projektfenster auf den Reiter Functions klicken
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7.8.4.1 Absolute
Mit dieser Funktion fährt der Mover zur eingegebenen Position.

Starten
► Absolute im Dropdown-Menü Start Mode auswählen

► In das Eingabefeld Target Position die Zielpositionen eingeben
► In das Eingabefeld Target Velocity einen Wert für die Geschwin-

digkeit eingeben
► Bei Bedarf das Kontrollkästchen Aceleration aktivieren, um in

das Eingabefeld einen Wert für die Beschleunigung einzugeben
► Bei Bedarf das Kontrollkästchen Deceleration aktivieren, um in

das Eingabefeld einen Wert für die Abbremsung einzugeben
► Bei Bedarf das Kontrollkästchen Jerk aktivieren, um in das Ein-

gabefeld einen Wert für den Ruck einzugeben
► Auf Start klicken, um die Funktion Absolute zu starten
Der Mover fährt zur eingegebenen Zielposition.

Stoppen

Stoppen nur während des Verfahrens
Die Funktion kann nur während der Fahrt zur Zielposition gestoppt
werden. Nach der Fahrt zur Zielposition ist die Schaltfläche Stop au-
tomatisch deaktiviert.

► Auf Stop klicken, um die Funktion Absolute zu stoppen
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7.8.4.2 Relative
Mit dieser Funktion fährt der Mover eine definierte Fahrstrecke.

Starten
► Relative im Dropdown-Menü Start Mode auswählen

► In das Eingabefeld Target Position einen Wert für die Länge der
Fahrstrecke eingeben

► In das Eingabefeld Target Velocity einen Wert für die Geschwin-
digkeit eingeben

► Bei Bedarf Kontrollkästchen Aceleration aktivieren, um in das
Eingabefeld einen Wert für die Beschleunigung einzugeben

► Bei Bedarf Kontrollkästchen Deceleration aktivieren, um in das
Eingabefeld einen Wert für die Abbremsung einzugeben

► Bei Bedarf Kontrollkästchen Jerk aktivieren, um in das Eingabe-
feld einen Wert für den Ruck einzugeben

► Auf Start klicken, um die Funktion Relative zu starten
Der Mover fährt die definierte Länge der Fahrstrecke.

Stoppen

Stoppen nur während des Verfahrens
Die Funktion kann nur während der Fahrt zur Zielposition gestoppt
werden. Nach der Fahrt zur Zielposition ist die Schaltfläche Stop au-
tomatisch deaktiviert.

► Auf Stop klicken, um die Funktion Relative zu stoppen



Inbetriebnahme

216 ─── Version: 1.1.1TF5850

7.8.4.3 Endless + / Endless -
Mit dieser Funktion fährt der Mover unendlich in positiver oder nega-
tiver Richtung.

Starten
► Endless + im Dropdown-Menü Start Mode auswählen
ODER
► Endless - im Dropdown-Menü Start Mode auswählen

► In das Eingabefeld Target Velocity einen Wert für die Geschwin-
digkeit eingeben

► Bei Bedarf Kontrollkästchen Aceleration aktivieren, um in das
Eingabefeld einen Wert für die Beschleunigung einzugeben

► Bei Bedarf Kontrollkästchen Deceleration aktivieren, um in das
Eingabefeld einen Wert für die Abbremsung einzugeben

► Bei Bedarf Kontrollkästchen Jerk aktivieren, um in das Eingabe-
feld einen Wert für den Ruck einzugeben

► Auf Start klicken, um die Funktion Endless + oder Endless - zu
starten

Der Mover fährt unendlich vorwärts oder rückwärts.

Stoppen
► Auf Stop klicken, um die Funktion Endless + oder Endless - zu

stoppen
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7.8.4.4 Modulo / Modulo shortest way / Modulo plus direction / Modulo minus direction
Mit diesen Funktionen fährt der Mover zu einer definierten Position.
Je nach ausgewählter Modulo-Funktion fährt der Mover die kürzeste
Strecke, vorwärts oder rückwärts zur Zielposition. Folgende Funktio-
nen stehen zur Auswahl:

Modulo Der Mover fährt zur Zielposition. Bei einem negativen Wert im Ein-
gabefeld Target Position fährt der Mover rückwärts zur Zielposition.

Modulo shortest way Der Mover fährt vorwärts oder rückwärts die kürzeste Strecke zur
Zielposition. Die Eingabe eines negativen Wertes im Eingabefeld
Target Position ist nicht möglich.

Modulo plus direction Der Mover fährt nur vorwärts zur Zielposition. Die Eingabe eines ne-
gativen Wertes im Eingabefeld Target Position ist nicht möglich.

Modulo minus direction Der Mover fährt nur rückwärts zur Zielposition. Die Eingabe eines
negativen Werts im Eingabefeld Target Position ist nicht möglich.

Beispiel Modulo
Die Eingabe der Werte wird beispielhaft an der Funktion Modulo ge-
zeigt.

Starten
► Modulo im Dropdown-Menü Start Mode auswählen

► In das Eingabefeld Target Position einen Wert für die Zielpositi-
on eingeben

► In das Eingabefeld Target Velocity einen Wert für die Geschwin-
digkeit eingeben

► Bei Bedarf Kontrollkästchen Aceleration aktivieren, um in das
Eingabefeld einen Wert für die Beschleunigung einzugeben

► Bei Bedarf Kontrollkästchen Deceleration aktivieren, um in das
Eingabefeld einen Wert für die Abbremsung einzugeben

► Bei Bedarf Kontrollkästchen Jerk aktivieren, um in das Eingabe-
feld einen Wert für den Ruck einzugeben

► Auf Start klicken, um die Funktion Modulo zu starten
Der Mover fährt zur eingegebenen Zielposition.
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Stoppen

Stoppen nur während des Verfahrens
Die Funktion kann nur während der Fahrt zur Zielposition gestoppt
werden. Nach der Fahrt zur Zielposition ist die Schaltfläche Stop au-
tomatisch deaktiviert.

► Auf Stop klicken, um die Funktion Modulo zu stoppen
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7.8.4.5 Reversing Sequence
Mit dieser Funktion fährt der Mover zwischen zwei Positionen hin
und her.

Starten
► Reversing Sequence im Dropdown-Menü Start Mode auswäh-

len

► In das Eingabefeld Target Position1 einen Wert für die erste Ziel-
position eingeben

► In das Eingabefeld Target Velocity einen Wert für die Geschwin-
digkeit eingeben

► In das Eingabefeld Target Position2 einen Wert für die zweite
Zielposition eingeben

► In das Eingabefeld Idle Time einen Wert für die Verweildauer am
Ziel eingeben

► Auf Start klicken, um die Funktion Reversing Sequence zu star-
ten

Der Mover fährt nun dauerhaft zwischen den beiden Zielpositionen
hin und her.

Stoppen
► Auf Stop klicken, um die Funktion Reversing Sequence zu stop-

pen
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7.8.4.6 Start/Stop Sequence
Mit dieser Funktion fährt der Mover eine definierte Strecke bis zum
nächsten Stopp und führt diese Funktion dauerhaft aus.

Starten
► Start/Stop Sequence im Dropdown-Menü Start Mode auswäh-

len

► In das Eingabefeld Target Position einen Wert für die Strecke bis
zum nächsten Stopp eingeben

► In das Eingabefeld Target Velocity einen Wert für die Geschwin-
digkeit eingeben

► In das Eingabefeld Idle Time einen Wert für die Verweildauer am
Ziel eingeben

► Auf Start klicken, um die Funktion Start/Stop Sequence zu star-
ten

Der Mover fährt nun dauerhaft die eingegebene Strecke bis zum
nächsten Stopp.

Stoppen
► Auf Stop klicken, um die Funktion Start/Stop Sequence zu stop-

pen
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7.8.4.7 Velo Step Sequence
Mit dieser Funktion fährt der Mover zwischen zwei Zielpositionen mit
zwei unterschiedlichen Geschwindigkeiten.

Starten
► Velo Step Sequence im Dropdown-Menü Start Mode auswäh-

len

Die Strecken zwischen erster und zweiter Zielposition können un-
terschiedlich lang sein, da sie äbhängig von den beiden Ge-
schwindigkeiten und der identischen Fahrtzeit sind.

► In das Eingabefelder Target Velocity1 und Target Velocity2 Wer-
te für die Geschwindigkeiten eingeben

► In das Eingabefeld Driving Time einen Wert für die Fahrzeit ein-
geben

► In das Eingabefeld Idle Time einen Wert für die Verweildauer am
Ziel eingeben

► In das Eingabefeld No of cycles einen Wert für die Anzahl der
Fahrzyklen eingeben

► Auf Start klicken, um die Funktion Velo Step Sequence zu star-
ten

Der Mover fährt nun die eingegebene Anzahl an Fahrzyklen oder
dauerhaft die zeitabhängige Strecke zu den zwei Zielpositionen.
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Stoppen

Stoppen in Abhängigkeit von No of cycles
Wenn kein Wert in das Eingabefeld No of cycles eingegeben wurde,
fährt der Mover dauerhaft. Die Funktion kann jederzeit mit der
Schaltfläche Stop beendet werden.
Wenn ein Wert in das Eingabefeld No of cycles eingegeben wurde,
stoppt der Mover nach der eingegebenen Anzahl von Fahrzyklen
automatisch und die Schaltfläche Stop wird automatisch deaktiviert.
Die Fahrzyklen können jederzeit mit der Schaltfläche Stop beendet
werden.

► Auf Stop klicken, um die Funktion Velo Step Sequence zu stop-
pen
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7.8.4.8 Sinus Sequence (Bode)
Mit dieser Funktion fährt der Mover periodisch vorwärts und rück-
wärts.

Starten
► Sinus Sequence (Bode) im Dropdown-Menü Start Mode aus-

wählen

► In die Eingabefelder Start Frequency und Stop Frequency Werte
für die Frequenzen eingeben

► In das Eingabefeld Frequency Steps einen Wert für die Anzahl
der Frequenzen eingeben

► In das Eingabefeld Sinus Base Velocity einen Wert für die Ge-
schwindigkeit eingeben

► In das Eingabefeld Feed Constant Motor einen Wert für den Vor-
schubmotor eingeben

► Auf Start klicken, um die Funktion Sinus Sequence (Bode) zu
starten

Stoppen

Stoppen nur während des Verfahrens
Die Funktion kann nur während der Fahrt zur Zielposition gestoppt
werden. Nach der Fahrt zur Zielposition ist die Schaltfläche Stop au-
tomatisch deaktiviert.

► Auf Stop klicken, um die Funktion Sinus Sequence (Bode) zu
stoppen
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7.9 Mover koppeln
Sie haben die Möglichkeit verschiedene NC-Achsen miteinander zu
koppeln und mehrere Mover gleichzeitig zu verfahren.

Mover-Positionen werden beibehalten
Bei der linearen Kopplung von Movern mit einem Kopplungsfaktor 1
werden die aktuellen Positionen der zu koppelnden Mover verwen-
det und der Abstand zwischen den Movern wird beim Verfahren der
Mover beibehalten.

Kopplungsbeispiel NC-Achse 2 mit NC-Achse 1
Das Koppeln der Mover wird beispielhaft an der NC-Achse 2 mit
NC-Achse 1 beschrieben.

► Solution Explorer > TwinCAT Project > MOTION > Axes aus-
klappen

► Auf Mover Axis 2 klicken

Die ausgewählte NC-Achse wird nicht aufgelistet, da die NC-Ach-
se nicht mit sich selbst gekoppelt werden kann.

► Im Projektfenster auf den Reiter Coupling klicken
► Die Achse im Dropdown-Menü Master Axis auswählen, mit der

die Achse gekoppelt werden soll
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► Auf Couple klicken, um die NC-Achsen zu koppeln

7.10 Mover entkoppeln
► Solution Explorer > TwinCAT Project > MOTION > Axes aus-

klappen
► Auf Mover Axis 2 klicken

► Im Projektfenster auf den Reiter Coupling klicken
► Auf Decouple klicken, um die NC-Achse zu entkoppeln
Die NC-Achse ist entkoppelt und kann mit einer anderen NC-Achse
gekoppelt werden oder einzeln verfahren werden.
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8 XTS Tools

8.1 XTS Tool Window
Das XTS Tool Window ist die Benutzeroberfläche für alle XTS bezo-
genen Komponenten Ihres TwinCAT Projekts. Es ist die Hauptseite
zur Steuerung aller XTS Systeme Ihres laufenden Projekts. Im XTS
Tool Window finden Sie hilfreiche Tools wie den XTS Configurator,
den XTS Simulation Builder und die XTS System View.

8.1.1 XTS Tool Window aktivieren
Nachdem Sie erfolgreich TF5850 TC3 XTS Extension installiert und
ein neues Projekt in TwinCAT 3 XAE (TcXaeShell oder VS 2013)
geöffnet haben, müssen Sie zunächst das XTS Tool Window akti-
vieren.

► Im Menü TwinCAT auf den Menüpunkt XTS klicken
► Im Ausklappmenü auf XTS Tool Window klicken
Das XTS Tool Window öffnet sich.
Wie alle anderen Dialogfenster können Sie das XTS Tool Window in
der Visual Studio-Umgebung platzieren.
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8.1.2 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Dropdown-Menü Projektauswahl
Zeigt das ausgewählte Projekt an und listet die verfügbaren Projekte
auf.

Aktualisieren
Aktualisiert die Inhalte des ausgewählten Projekts.

XTS Configurator öffnen
Öffnet den XTS Configurator zum Konfigurieren der Hardware.

XTS Simulation Builder öffnen
Öffnet den XTS Simulation Builder zum Konfigurieren eines simu-
lierten Systems.

XTS IO Timing Configurator öffnen
Öffnet den XTS IO Timing Configurator zum Konfigurieren der Real-
Time und Distributed Clocks.

Dropdown-Menü Theme
Zeigt das ausgewählte Thema an und listet die verfügbaren Themen
auf.

Optionen
Öffnet das Dialogfenster Options…

Zoom Fensterbreite
Skaliert die Ansicht auf die Fensterbreite.

Zoom Originalgröße
Skaliert die Ansicht auf die voreingestellte Originalgröße.

Zoom benutzerdefiniert
Skaliert die Ansicht auf die benutzerdefinierte Größe.

Reiter XTS Parts
Listet alle XTS Parts der aktuellen Konfiguration auf.
Zeigt die Eigenschaften aller XTS Parts.

Reiter XTS Tracks
Listet alle XTS Tracks der aktuellen Konfiguration auf.
Zeigt die Eigenschaften aller XTS Tracks.

Reiter XTS Mover
Listet alle XTS Mover der aktuellen Konfiguration auf.
Zeigt die Eigenschaften aller XTS Mover.

Reiter XTS Stations
Listet alle XTS Stations der aktuellen Konfiguration auf.
Zeigt die Eigenschaften aller XTS Stations.
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8.1.3 Informationslisten
Die Informationslisten der Parts, Tracks, Mover und Stations liefern
detaillierte Informationen zu den jeweiligen Objekten und deren Ei-
genschaften.

8.1.3.1 Informationsliste Parts
► Auf den Reiter Parts klicken, um die Informationsliste Parts auf-

zurufen
Die Informationsliste Parts zeigt alle Parts der aktuell ausgewählten
Processing Unit an und liefert Informationen über die Länge, die
Ausrichtung und die Position im Koordinatensystem im XTS View.
Über den Filter im oberen Bereich kann eine Processing Unit ausge-
wählt werden. Die zu der Processing Unit gehörenden Parts werden
aufgelistet.
In der unteren Liste werden alle Module eines Parts mit den wich-
tigsten Informationen aufgelistet. Ausgewählte Module werden in
der Liste und in der Ansicht hervorgehoben.

8.1.3.2 Informationsliste Tracks
► Auf den Reiter Tracks klicken, um die Informationsliste Tracks

aufzurufen
Über den Filter im oberen Bereich lässt sich eine Processing Unit
auswählen. Die Informationsliste Tracks zeigt alle Tracks der aktuell
ausgewählten Processing Unit an.
Ausgewählte Tracks werden in der Ansicht visualisiert.
In der unteren Liste werden alle Parts eines Tracks aufgelistet. Au-
ßerdem werden wichtige Informationen des Parts angezeigt.
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8.1.3.3 Informationsliste Movers
► Auf den Reiter Movers klicken, um die Informationsliste Movers

aufzurufen
Die Informationsliste Movers zeigt alle Mover der aktuell ausgewähl-
ten Processing Unit an und liefert Informationen über die NC-Ach-
sen, den SoftDrive und die Simulationseinstellungen.
Über den Filter im oberen Bereich kann eine Processing Unit ausge-
wählt werden. Die zu der Processing Unit gehörenden Mover wer-
den aufgelistet.
Ausgewählte Mover werden in der Liste und in der Ansicht hervor-
gehoben.

8.1.3.4 Informationsliste Stations
► Auf den Reiter Stations klicken, um die Informationsliste Stati-

ons aufzurufen
Die Informationsliste Stations zeigt alle Stations und deren Eigen-
schaften an. Aufgelistet werden die Startposition und die Endpositi-
on auf dem jeweiligen Part sowie alle Stopppositionen.
Die Stations werden in der Ansicht visualisiert.
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8.1.4 Dialogfenster Options… öffnen
Zur Konfiguration der XTS View stehen zahlreiche Optionen zur
Verfügung. Die Einstellungen der XTS View werden in sogenannten
Themen gespeichert. Diese Themen können bearbeitet werden und
von allen Fenstern benutzt werden, die XTS Views anzeigen kön-
nen.
► Auf die Schaltfläche Options… klicken
Das Dialogfenster Options… öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „Dialogfenster Op-
tions…“, [Seite 355].
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8.2 XTS Simulation Builder
Mit dem XTS Simulation Builder können Sie im Sandbox-Stil virtuel-
le Konstruktionen der XTS Hardware erstellen und IO Komponenten
zur Simulation in TwinCAT generieren.
Die Erstellung und Anpassung eines virtuellen XTS Systems wird
dabei komplett von der XTS View unterstützt, sodass Sie den XTS
Simulation Builder intuitiv bedienen können. Darüber hinaus werden
viele Konfigurationsoptionen der XTS Software unterstützt, sodass
Sie das Tool in vollem Umfang zur Planung und Simulation neuer
XTS Systeme nutzen können.

Beispielkonfiguration
In dieser Beispielkonfiguration wird ein geschlossenes XTS System
mit 180° Klothoiden und zehn Movern aufgebaut, entsprechend der
Konfiguration eines 3 m XTS Starterkits.

8.2.1 XTS Simulation Builder öffnen
► Das XTS Tool Window aktivieren, wie im Kapitel „XTS Tool Win-

dow“, [Seite 226] beschrieben

► Auf die Schaltfläche Start the XTS Simulation Builder… im
XTS Tool Window klicken

Der XTS Simulation Builder öffnet sich.
Wenn der XTS Simulation Builder geöffnet wird, zeigt die Startseite
einen Willkommensbildschirm mit Informationen zu den interaktiven
Nutzungsmöglichkeiten des XTS Simulation Builders.
► Bei Bedarf Fenster für bessere Bedienbarkeit vergrößern
► Bei Bedarf Kontrollkästchen Don’t show this again aktivieren,

um den Willkommensbildschirm auszublenden
Über den Menüpunkt Options… können Sie die Funktion jederzeit
wieder aktivieren.
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Unter dem Willkommensbildschirm befindet sich eine Liste mit Vor-
lagen, aus der Sie vorkonfigurierte XTS Systeme auswählen kön-
nen. Die Vorlagen können Sie mit wenigen Parametern einfach ver-
ändern, um beispielsweise die Länge des Systems oder die Art der
Kurvensegmente anzupassen.

8.2.1.1 Bedienelemente

Startseite
Die Auflistung zeigt die wichtigsten Bedienelemente:

Vorschau und Bearbeiten
Öffnet die Seite zur Vorschau und Bearbeitung der Vorlage.

System generieren
Übernimmt die Vorlage als System und öffnet die Seite Builder.

Seitenleiste öffnen
Öffnet die Seitenleiste.

Seitenleiste schließen
Schließt die Seitenleiste.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.
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8.2.2 Vorlage öffnen
Für einen schnellen Start können Sie eine der Vorlagen verwenden
und bei Bedarf an die gewünschte Größe des Systems anpassen.

► Auf die Schaltfläche Oval Template klicken
Das Dialogfenster Preview & Edit Template…öffnet sich. Die ge-
naue Konfiguration des Systems mit den eingestellten Parametern
wird angezeigt und kann angepasst und bearbeiten werden.

Das kleine Vorschaubild zeigt die Form des ausgewählten XTS Sys-
tems. In der großen Darstellung wird die genaue Systemgröße und
Modulanordnung für die eingestellten Parameter abgebildet.
► Ein XTS System im Dropdown-Menü auswählen
► In die Eingabefelder Length und Typical Feed-in Length Werte

für die genaue Systemgröße eingeben
► Kurvensegmenttyp der Module im Dropdown-Menü Curve Type

auswählen
► Auf Schaltfläche Create System from template and go to next

page. klicken, um fortzufahren
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8.2.3 XTS System simulieren

Auf den folgenden Seiten wird der Aufbau eines XTS Systems mit
dem XTS Simulation Builder ohne Verwendung einer Vorlage be-
schrieben. Die beschriebenen Funktionen stehen auch bei Verwen-
dung einer Vorlage zur Verfügung. Die Variante mit Vorlage wird da-
her nicht gesondert beschrieben.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
ODER
► Auf die Schaltfläche >> klicken, um die Seitenleiste auszuklap-

pen
Weitere Informationen zur Seitenleiste finden Sie im Kapitel „Seiten-
leiste“, [Seite 256].

Navigation mit Schaltflächen oder der Seitenleiste
Die Seiten können mit den Schaltflächen Go To Previous Step und
Go To Next Step oder mit der Seitenleiste aufgerufen werden. Beide
Varianten lassen sich jederzeit miteinander kombinieren.

Die einzelnen Schritte werden beispielhaft an der Variante mit den
Schaltflächen Go To Next Step beschrieben.

Die Seite Configure öffnet sich.
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8.2.3.1 Modules

Der Reiter Modules enthält alle Funktionen zum Hinzufügen, Entfer-
nen, Ersetzen oder Ändern von Modulen.
Vorhandene Module können durch Anklicken eines einzelnen Mo-
duls, durch Anklicken mehrerer Module mit gedrückter Strg- oder
Umschalttaste oder durch Anklicken aller Module mit gedrückter Alt-
Taste ausgewählt werden.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Add
Module

Modul hinzufügen
Fügt ein Modul vor oder hinter der Auswahl in der Modulliste hinzu
oder ersetzt ein bestehendes Modul.

Remove
Module

Modul entfernen
Entfernt ein ausgewähltes oder mehrere ausgewählte Module.

Dropdown-Menü Module
Zeigt die verfügbaren Module an. Der Modultyp kann ausgewählt
werden oder mit einem Doppelklick direkt hinzugefügt werden.

End of
Part

Einfügen am Ende des Parts
Aktiviert das Einfügen eines neuen Moduls am Ende des aktiven
Parts.

After
Selection

Einfügen nach Auswahl
Aktiviert das Einfügen eines neuen Moduls nach dem ausgewählten
Modul. Wenn mehrere Module ausgewählt sind, wird nach jedem
Modul ein neues Modul hinzugefügt.

Before
Selection

Einfügen vor Auswahl
Aktiviert das Einfügen eines neuen Moduls vor dem ausgewählten
Modul. Wenn mehrere Module ausgewählt sind, wird vor jedem Mo-
dul ein neues Modul hinzugefügt.

Replace
Selected

Auswahl ersetzen
Aktiviert das Ersetzen des ausgewählten Moduls durch ein neues
Modul. Wenn mehrere Module ausgewählt sind, wird jedes Modul
durch ein neues Modul ersetzt.

  Change
Infeed Type

Dropdown-Menü Art der Einspeisung
Zeigt die verfügbaren Arten der Einspeisung an und ändert die Art
der Einspeisung des ausgewählten Moduls. Wenn mehrere Module
ausgewählt sind, werden alle Einspeisungen geändert.
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Module hinzufügen
► Doppelklick auf AT2050-0500 klicken, um das Modul zur XTS

System View hinzuzufügen
ODER
► Auf AT2050-0500 klicken, um das Modul auszuwählen

► Auf Add Module klicken

Das Modul wird in der XTS System View dargestellt.

► Doppelklick auf AT2001-0250 klicken, um das Modul zur XTS
System View hinzuzufügen

ODER
► Auf AT2001-0250 klicken, um das Modul auszuwählen

► Auf Add Module klicken

Das Modul wird in der XTS System View dargestellt.

► Doppelklick auf AT2000-0250 klicken, um das Modul zur XTS
System View hinzuzufügen

ODER
► Auf AT2000-0250 klicken, um das Modul auszuwählen
► Drei weitere Module AT2000-0250 auf die gleiche Weise hinzu-

fügen
Die Module werden in der XTS System View dargestellt.
► In derselben Reihenfolge erneut je ein Modul AT2050-0500 und

AT2001-0250 und drei Module AT2000-0250 hinzufügen
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Das System ist geschlossen und fertiggestellt.

8.2.3.1.1 Module prüfen
Sie können die Module im Menü in der linken Spalte anklicken, um
weitere Informationen zu erhalten.

► Auf ein Modul klicken
Folgende Informationen werden unter Details angezeigt:

• Spaltmaß
• Länge des ausgewählten Moduls

Ausgewählte Module werden in der Liste und in der XTS System
View hervorgehoben.
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8.2.3.2 Parts

Der Reiter Parts enthält alle Einstellungen und Funktionen zum Er-
stellen und Entfernen von Parts.
Parts können durch Anklicken eines einzelnen Moduls, durch Ankli-
cken mehrerer Module mit gedrückter Strg- oder Umschalttaste oder
durch Anklicken aller Module eines Parts mit gedrückter Alt-Taste
ausgewählt werden.
Sie können Parts im Koordinatensystem des XTS Views verschie-
ben, während Sie die Alt-Taste und die linke Maustaste gedrückt
halten. Die X-Koordinaten und Y-Koordinaten werden dann automa-
tisch angepasst. Alternativ können Sie einen Part verschieben, in-
dem Sie die Koordinaten manuell ändern. Mit der Funktion Module-
Side können Sie zwischen der Vorderansicht und Rückansicht der
Module wählen.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Add
Part

Part hinzufügen
Fügt einen Part zur ausgewählten Processing Unit hinzu.

Template

Aus Vorlage hinzufügen
Öffnet das Dialogfenster Add part from template… zum Einfügen ei-
nes Parts aus einer Vorlage.

Remove
Part

Part entfernen
Entfernt den ausgewählten Part aus der ausgewählten Processing
Unit.

Split

Part teilen
Erstellt aus den ausgewählten Modulen eines Parts einen separaten
Part.

Keep
Position

Position beibehalten
Behält die Positionen der Module beim Teilen eines Parts bei.

Merge

Parts zusammenfügen
Fügt zwei ausgewählte Parts zu dem zuerst ausgewählten Part zu-
sammen.

Dropdown-Menü Modulseite
Zeigt die ausgewählte Modulseite an und listet die verfügbaren Mo-
dulseiten auf.

Dropdown-Menü Drehung
Ermöglicht die Auswahl eines voreingestellten Winkels zwischen
-180° und 180° oder die Eingabe eines eigenen Werts. Bezugspunkt
ist das erste Modul eines Parts.
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Eingabefeld X-Offset
Ermöglicht die Eingabe eines Versatzes für den Bezugspunkt des
ersten Moduls eines Parts auf der X-Koordinate.

Eingabefeld Y-Offset
Ermöglicht die Eingabe eines Versatzes für den Bezugspunkt des
ersten Moduls eines Parts auf der Y-Koordinate.

Show
Close Gap

Entfernung anzeigen
Zeigt die Entfernung von Startpunkt zum Endpunkt eines Parts mit
einer Linie an. Die genaue Entfernung der X-Koordinate und Y-Ko-
ordinate werden als Tooltip angezeigt, wenn der Mauszeigt über
den angezeigten Wert bewegt wird. Wenn die Schaltfläche Show
Close Gap aktiviert ist, werden alle Entfernungen ebenfalls in der
Statusleiste eingeblendet.

Part hinzufügen
Alle hinzugefügten Module werden automatisch einem Part zuge-
ordnet. Bei Bedarf kann das System in mehrere Parts unterteilt wer-
den.

Beispielkonfiguration
In dieser Beispielkonfiguration ist ein Part ausreichend. Die folgende
Beschreibung dient nur der Erläuterung.

► Auf den Reiter Parts klicken

System in Parts unterteilen
► Die Taste Strg gedrückt halten, um alle Module anzuklicken, die

zu einem neuen Part hinzugefügt werden sollen

► Auf Split klicken
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Die ausgewählten Module werden aus Part  1 entfernt. Ein neuer
Part 2 wird mit den ausgewählten Modulen hinzugefügt.

Parts prüfen
Sie können die Parts im Menü in der linken Spalte anklicken, um
weitere Informationen zu erhalten.

► Auf einen Part klicken
Folgende Informationen werden unter Details angezeigt:

• Ausrichtung im Koordinatensystem
• Position im Koordinatensystem

Ausgewählte Parts werden in der Liste und in der XTS System View
hervorgehoben.
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Eigenschaften festlegen Sie können für jeden Part auswählen, ob die Vorderseite oder die
Rückseite der XTS Module zu sehen ist und wie Position und Ein-
baulage dargestellt werden sollen. Mit diesen Eigenschaften kann
jede mögliche Ansicht eines XTS Systems getestet oder an Ihr be-
stehendes XTS System angepasst werden.

Modulseite

Vorderseite, Front Rückseite, Back

► Die Modulseite im Dropdown-Menü Front Side auswählen

► In die Eingabefelder X und Y Werte für die Position des Parts
eingeben

► In das Eingabefeld Alpha einen Wert für die Einbaulage des
Parts eingeben

Beispielkonfiguration
In dieser Beispielkonfiguration wird der Part in der Mitte der XTS
System View positioniert, als Ansicht die Vorderseite ausgewählt
und die Einbaulage bei 0° belassen.

► Die linke Maustaste und die Taste Alt gedrückt halten, um den
Part in die korrekte Position zu bringen
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8.2.3.3 Movers

Der Reiter Movers enthält alle Funktionen zum Hinzufügen, Entfer-
nen, Ersetzen oder Ändern von Movern.
Mover können durch Auswahl eines einzelnen Movers, durch Aus-
wahl mehrerer Mover mit gedrückter Strg- oder Umschalttaste oder
durch Auswahl aller Mover mit gedrückter Alt-Taste ausgewählt wer-
den.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Add
Mover

Mover hinzufügen
Fügt einen Mover hinzu.

Remove
Mover

Mover entfernen
Entfernt den ausgewählten oder die ausgewählten Mover.

Eingabefeld Moveranzahl
Ermöglicht die Eingabe der benötigten Moveranzahl.

Anzahl übernehmen
Übernimmt die Anzahl aus dem Eingabefeld.

Dropdown-Menü Moverauswahl
Zeigt die verfügbaren Movertypen an und ermöglicht die Auswahl
des Movertyps.
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Mover hinzufügen
Sie haben die Möglichkeit einen einzelnen Mover oder mehrere Mo-
ver gleichzeitig hinzuzufügen.

► Auf den Reiter Movers klicken

► Bei Bedarf das Dropdown-Menü ausklappen

Einzelnen Mover
► Doppelklick auf AT9011-0070, um den Mover zur XTS System

View hinzuzufügen
ODER
► Auf AT9011-0070 klicken, um den Mover auszuwählen

► Auf Add Mover klicken
► Weitere Mover auf die gleiche Weise hinzufügen

Mehrere Mover
► Auf AT9011-0070 klicken, um den Mover auszuwählen

► In das Eingabefeld Edit the Mover Count of the active Part. die
Anzahl an Movern eingeben

► Auf die Schaltfläche Apply klicken, um Anzahl an Movern hinzu-
zufügen

Die Mover werden zum System hinzugefügt.
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Mover prüfen
Sie können die Mover im Menü in der linken Spalte anklicken, um
nähere Informationen zu erhalten.

► Auf einen Mover klicken
Folgende Informationen werden unter Details angezeigt:

• Name des Movers
• Startposition des Movers
• Part auf dem der Mover startet

Ausgewählte Mover werden in der Liste und in der XTS System
View hervorgehoben.



XTS Tools

Version: 1.1.1 ─── 245TF5850

8.2.3.4 Tracks

Der Reiter Tracks enthält alle Funktionen zum Hinzufügen und Ent-
fernen von Tracks.
Sie können die Tracks aus der Liste auswählen. Die Parts und Mo-
dule des Tracks werden dann mit einer grünen Linie markiert.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Add
Empty

Leeren Track hinzufügen
Fügt einen leeren Track hinzu.

Remove
Track

Track entfernen
Entfernt den ausgewählten Track.

Create
from Parts

Track erzeugen
Erzeugt einen Track aus den ausgewählten Parts. Die Reihenfolge
der Parts innerhalb des Tracks wird durch die Reihenfolge bei der
Auswahl der Parts definiert

Show
Close Gap

Entfernung anzeigen
Zeigt die Entfernung von Startpunkt zum Endpunkt eines Parts mit
einer Linie an. Die genaue Entfernung der X-Koordinate und Y-Ko-
ordinate werden als Tooltip angezeigt, wenn der Mauszeigt über
den angezeigten Wert bewegt wird. Wenn die Schaltfläche Show
Close Gap aktiviert ist, werden alle Entfernungen ebenfalls in der
Statusleiste eingeblendet.

Track hinzufügen
Alle hinzugefügten Parts werden automatisch einem Track zugeord-
net. Bei Bedarf kann ein System mit mehreren Parts in mehrere
Tracks unterteilt werden.

► Auf den Reiter Tracks klicken
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System in Tracks unterteilen

Beispielkonfiguration
In dieser Beispielkonfiguration ist ein Track ausreichend. Die folgen-
de Beschreibung dient nur der Erläuterung.

► Im Menü oder in der XTS System View alle Parts anklicken, die
einem neuen Track hinzugefügt werden sollen

► Auf Create from Parts klicken

Es wird ein zweiter Track mit dem ausgewählten Part hinzugefügt.
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Tracks prüfen
Sie können die Tracks im Menü in der linken Spalte anklicken, um
nähere Informationen zu erhalten.

► Auf einen Track klicken
Folgende Informationen werden unter Details angezeigt:

• Länge des Tracks
• Geschlossenes oder offenes System
• in Mover-Erkennung einbezogen oder nicht

Die Strecke des ausgewähltenTracks wird in der XTS System View
mit einer grünen Linie dargestellt.

Eigenschaften festlegen

HINWEIS
Schäden am Produkt und Funktionsfehler vermeiden
Achten Sie auf die korrekte Angabe, ob Sie ein geschlossenes
XTS System oder ein XTS System mit definierten Endpunkten
konfigurieren.
Ist die Angabe fehlerhaft, können bei einem offenen XTS System
die Mover das XTS System verlassen. Bei einem geschlossenen
XTS System mit falscher Angabe können die Mover nicht wie ge-
wohnt im Kreis fahren.

► Kontrollkästchen Is closed aktivieren, damit die Mover umlau-
fend über die Start-End-Position des Tracks fahren können

ODER
► Kontrollkästchen Is closed deaktivieren

Bei Systemen ohne Track Management oder Systemen mit nur ei-
nem Track muss das Kontrollkästchen Is included in detection
grundsätzlich aktiviert werden.

► Kontrollkästchen Is included in detection aktivieren, damit alle
Mover von einem Modul erkannt werden, das zu dem Part die-
ses Tracks gehört

ODER
► Kontrollkästchen Is included in detection deaktivieren
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8.2.3.5 Stations

Die Registerkarte Stations enthält alle Funktionen zum Hinzufügen
und Erstellen von Stations.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Add
Station

Station hinzufügen
Fügt eine Station hinzu.

Remove
Station

Part entfernen
Entfernt die ausgewählte Station.

Station hinzufügen
► Auf den Reiter Stations klicken

► Auf Add Station klicken

Eine Station wird dem System hinzugefügt.

► Auf Add Part over which the Station should be drawn klicken,
um einen Part zur Station hinzuzufügen
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Die Station wird in der XTS System View farbig dargestellt.

Stopppositionen hinzufügen
► Auf Add stop position klicken, um eine Stoppposition hinzuzu-

fügen

► In das Eingabefeld einen Wert für die Stoppposition eingeben

Die Stoppposition wird als Raute auf der Linie der Station darge-
stellt.
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Station prüfen
Sie können die Stations im Menü in der linken Spalte anklicken, um
weitere Informationen zu erhalten.

► Auf eine Station klicken
Folgende Informationen werden unter Details angezeigt:

• Eingeblendet oder ausgeblendet
• ID der Station
• Farbe der Station
• Name der Station
• Beschreibung der Station
• Startposition
• Endposition

Unter dem Menü werden die Eigenschaften der gewählten Station
angezeigt.

Eigenschaften festlegen
► Kontrollkästchen Is enabled aktivieren, um die Station einzu-

blenden
ODER
► Kontrollkästchen Is enabled deaktivieren, um die Station auszu-

blenden
► In das Eingabefeld ID einen Wert eingeben
► Eine Farbe im Dropdown-Menü Color auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► In das Eingabefeld Name einen Namen für die Station eingeben
► Bei Bedarf in das Eingabefeld Description eine kurze Beschrei-

bung zu der Station eingeben
► In das Eingabefeld Start Position On First Part einen Wert einge-

ben
► In das Eingabefeld End Position On Last Part einen Wert einge-

ben
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8.2.3.6 Processing Unit
Der Reiter Processing Unit enthält alle Einstellungen und Funktio-
nen zum Erstellen und Entfernen der Processing Units.
Processing Units können ausgewählt werden, indem sie in der Liste
angeklickt werden. Processing Unit Einstellungen können nach der
Auswahl direkt unter der Liste bearbeitet und wichtige Informationen
entnommen werden.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Processing Unit hinzufügen
Fügt eine Processing Unit hinzu.

Processing Unit entfernen
Entfernt die ausgewählte Processing Unit.

Processing Unit hinzufügen
► Auf den Reiter Processing Unit klicken

► Auf Add klicken

Eine Processing Unit wird dem System hinzugefügt.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.2.3.7 Real-Time
Im letzten Schritt können die Real-Time-Einstellungen für das XTS
System vorgenommen werden. 

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Ziel-CPU laden
Lädt eine neue Ziel-CPU und überschreibt bereits bestehende
CPUs.

Eingabefeld Anzahl der CPUs
Ermöglicht die Eingabe der Anzahl benötigter CPUs.

Eingabefeld Anzahl isolierter CPUs
Ermöglicht die Eingabe der Anzahl isolierter CPUs.

Anzahl übernehmen
Übernimmt die Anzahl aus dem Eingabefeld.

Anzeige AUX Task
Zeigt die Konfiguration der AUX Task an.

CPU nach oben verschieben
Verschiebt die ausgewählte Task eine CPU nach oben.

CPU nach unten verschieben
Verschiebt die ausgewählte Task eine CPU nach unten.

Task entfernen
Entfernt die ausgewählte Task aus der CPU.

Schaltfläche Processing Unit und System
Schaltet zwischen der Anzeige von Processing Unit und System um.

Processing Unit oder TwinCAT System Task hinzufügen
Fügt eine Processing Unit oder eine TwinCAT System Task hinzu.

Processing Unit entfernen
Entfernt die ausgewählte Processing Unit.

Seitenleiste öffnen
Öffnet die Seitenleiste.
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Seitenleiste schließen
Schließt die Seitenleiste.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.

Real-Time-Einstellungen
Sie haben die Möglichkeit Einstellungen für die verfügbaren
TwinCAT Tasks und die Processing Units vorzunehmen.

► Einen Wert im Dropdown-Menü Base Time der CPU auswählen
Der eingestellte Wert wird für die mit der CPU verbundenen Task
übernommen und die Anzahl der Cycle Ticks entsprechend ange-
passt. Weitere Informationen dazu finden Sie im Kapitel „Real-Ti-
me“, [Seite 307].

Wenn alle Einstellungen korrekt vorgenommen wurden, können Sie
zur Seite Generation Settings wechseln.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.2.3.8 Generierungseinstellungen
Zuletzt können Sie noch allgemeine Einstellungen für die IO-Gene-
rierung vornehmen. Sie können beispielsweise wählen, ob ein neu-
es Projekt oder eine neue Projektmappe erstellt werden soll. Des
Weiteren können Sie die IO-Objekte in ein bestehendes Projekt inte-
grieren.
Die Generierungseinstellungen des XTS Simulation Builders helfen
Ihnen, die IO-Konfiguration in ein bestehendes Projekt zu überneh-
men oder ein neues TC3 XAE-Projekt und eine Lösung in Visual
Studio zu generieren.
Wenn bereits ein TC3-Projekt geöffnet ist, steht die Option Modify
TwinCAT Project zur Verfügung, um die IO-Geräte des konfigurier-
ten XTS Systems zum bestehenden Projekt hinzuzufügen.
Es gibt einige Optionen, die bei der Erstellung des neuen Projekts
ausgewählt werden können:

► In die Eingabefelder Project Name und Solution Name einen Na-
men eingeben

Standardmäßig sind die Namen XtsProject und XtsSolution vorein-
gestellt.
Project Full Path und Solution Full Path geben den genauen Pfad
an, in dem sich die Dateien nach der Erstellung befinden. Diese Pfa-
de können nicht bearbeitet werden und dienen nur zu besseren
Übersicht.
► In das Eingabefeld Location einen Dateipfad eingeben
ODER
► Auf … klicken, um das Dialogfenster Project Location zu öffnen

und einen Dateipfad auszuwählen

► Kontrollkästchen Append to Solution? aktivieren, um eine Pro-
jektmappe zu erstellen

► Kontrollkästchen Solution Directory? aktivieren, um das Projekt
zu einer bestehenden Projektmappe hinzuzufügen

Wird keine der Optionen gewählt, befinden sich das Projekt und die
Projektmappe im selben Verzeichnis.

Wenn bei der Erstellung der Projektmappe oder des Projekts mit
den vorgegebenen Einstellungen Fehler auftreten, werden die Ein-
gabefelder mit fehlerhaften Eingaben rot markiert.
In diesem Beispiel soll die Projektmappe aus dem angegebenen
Verzeichnis angehängt werden. Es erscheint eine Warnung, da es
bereits ein Projekt und eine Projektmappe mit demselben Namen
gibt. Wenn Sie mit der Erstellung fortfahren, werden die existieren-
den Dateien überschrieben.
Wenn alle Einstellungen korrekt vorgenommen wurden, können Sie
die Projektmappe oder das Projekt erstellen.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren

8.2.3.9 Konfiguration abschließen
Auf der nächsten Seite wird Ihnen angezeigt, dass alle Informatio-
nen eingegeben wurden und der XTS Simulation Builder die IO-Ob-
jekte erzeugen kann.
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► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
Wenn das Kontrollkästchen Close automatically after finished deak-
tiviert ist, wird die Seite Finished angezeigt.
► Auf x klicken, um den XTS Simulation Builder zu schließen
Der XTS Simulation Builder schließt sich. Die IO-Objekte sind er-
zeugt und das Projekt ist einsatzbereit.
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8.2.3.10 Seitenleiste
Die Seitenleiste kann auf jeder Seite des XTS Simulation Builders
ausgeklappt werden. Die Seitenleiste bietet einen Überblick über die
Seiten des XTS Simulation Builders und kann zum Navigieren zwi-
schen den Seiten genutzt werden.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Seitenleiste öffnen
Öffnet die Seitenleiste.

Seitenleiste schließen
Schließt die Seitenleiste.

Projekt geladen
Zeigt an, dass das Projekt geladen wurde. Diese Schaltfläche lässt
sich nicht anklicken.

Startseite
Zeigt die Startseite des XTS Simulation Builders an.

Schaltfläche Configure
Öffnet die Seite Configure zum Konfigurieren des gewünschten Sys-
tems.

Schaltfläche Real-Time
Öffnet die Seite Real-Time zum Bearbeiten der Real-Time Einstel-
lungen.

Schaltfläche Generation Settings
Öffnet die Seite Generation Settings zum Bearbeiten der Generie-
rungseinstellungen.

Schaltfläche Summary
Öffnet die Seite Summary. Das Kontrollkästchen Close automatical-
ly after finished kann aktiviert oder deaktiviert werden.

Schaltfläche Build
Übernimmt alle Einstellungen und erstellt die Konfiguration.
Schließt den XTS Simulation Builder.

Seite Finished
Zeigt an, dass alle Einstellungen übernommen wurden und die Kon-
figuration abgeschlossen ist. Diese Seite wird nur angezeigt, wenn
das Kontrollkästchen Close automatically after finished deaktiviert
ist.

Anzeige Seite geöffnet
Zeigt an, dass die Seite geöffnet wurde und mit einer Schaltfläche
der Seitenleiste verlassen wurde.

Anzeige Seite bearbeitet
Zeigt an, dass die Seite geöffnet wurde und mit der Schaltfläche Go
To Next Step verlassen wurde.
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Navigation
Statt mit den Schaltflächen Go To Next Step und Go To Previous
Step zu navigieren, haben Sie die Möglichkeit die Seitenleiste zu
öffnen und mit den Schaltflächen zwischen den einzelnen Seiten
des XTS Simulation Builders zu navigieren.

► Auf die Schaltfläche klicken, um die Seitenleiste zu öffnen

Die Seitenleiste öffnet sich. Sie haben die Möglichkeit mit den
Schaltflächen zwischen den Seiten des XTS Simulation Builders zu
navigieren:
► Auf eine Schaltfläche klicken, um die entsprechende Seite auf-

zurufen

Konfiguration abschließen
► Auf die Schaltfläche Build klicken, um die Konfiguration zu er-

stellen
ODER

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
Die Konfiguration wird erstellt und der XTS Simulation Builder
schließt sich.
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8.2.4 File
Der Reiter File enthält alle allgemeinen Einstellungen für den XTS
Simulation Builder, wie beispielsweise Optionen und Einstellung des
Themas.

8.2.4.1 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Optionen
Öffnet das Dialogfenster Options…

System importieren
Öffnet das Dialogfenster Import Construction… für den Import einer
bestehenden xml-Systemkonstruktion.

System exportieren
Öffnet das Dialogfenster Export Construction… für den Export der
aktuellen Systemkonstruktion als xml-Datei.

Bild exportieren
Öffnet das Dialogfenster Export Image… für den Export der System-
konstruktion als png-Datei.

Dropdown-Menü Theme
Zeigt das ausgewählte Thema an und listet die verfügbaren Themen
auf.

8.2.4.2 Dialogfenster Options… öffnen
► Auf den Reiter File klicken
► Auf Open options… klicken
Das Dialogfenster Options… öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „Dialogfenster Op-
tions…“, [Seite 355].

8.2.4.3 Systemkonstruktion importieren
► Auf den Reiter File klicken
► Auf Import Construction… klicken
Das Dialogfenster Import Construction… öffnet sich.
► Eine xml-Datei auf dem PC auswählen
► Auf Open klicken
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8.2.4.4 Systemkonstruktion exportieren
► Auf den Reiter File klicken
► Auf Export Construction… klicken
Das Dialogfenster Export Construction… öffnet sich.
► In das Eingabefeld Filename einen Namen eingeben
► Einen Dateipfad auf dem PC auswählen
► Auf Save klicken
Die aktuelle Systemkonstruktion wird als xml-Datei auf Ihrem PC ge-
speichert.

8.2.4.5 Ansicht exportieren
Sie haben die Möglichkeit, aktuelle Ansichten zu exportieren.

► Auf den Reiter File klicken
► Auf Export Image… klicken

Das Dialogfenster Export Image… öffnet sich.
► Current View im Dropdown-Menü Select the view to export aus-

wählen, um nur eine Ansicht vom System ohne Ränder zu spei-
chern

ODER
► Full View im Dropdown-Menü Select the view to export auswäh-

len, um die gesamte Ansicht zu speichern
► Bei Bedarf eine Farbe für den Hintergrund im Dropdown-Menü

Select the background color auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► Auf Copy klicken, um die Ansicht in die Zwischenablage zu ko-

pieren
ODER
► Auf Save As… klicken, um die Ansicht als png-Bild zu speichern

und den Speicherort auszuwählen
ODER
► Mit Close abbrechen
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8.3 XTS Configurator
Die Bedienoberfläche der XTS Software vereinfacht die Arbeit und
den Umgang mit den immer größeren und komplexeren Strecken-
verläufen, die mit XTS umgesetzt werden. Der einfache bildliche
Aufbau trägt entscheidend zu einer schnellen Inbetriebnahme und
einer intuitiven Arbeitsweise bei. Eine große Anzahl an XTS Syste-
men kann unabhängig von der Länge, der Form oder der Variante
sehr einfach eingerichtet werden. Der neue Konfigurator ersetzt da-
bei den XTS Manager, der in der vorherigen Softwareversion im
XTS IO Driver-Objekt integriert war.
Ein Hauptziel der XTS Software ist die Unterstützung der Track Ma-
nagement-Funktion. Mithilfe dieser Funktion können Sie das XTS
System in einzelne Abschnitte aufteilen, die Sie dann zu fortlaufen-
den Strecken zusammenfügen. Das gibt Ihnen die Möglichkeit ein-
zelne Abschnitte auf unterschiedliche Weise mechanisch auszurich-
ten und somit die Mover flexibler auf dem XTS System einzusetzen.

Beispielhafte Darstellung
In diesem Kapitel werden die einzelnen Schritte des XTS Configura-
tors gezeigt. Wenn es eine unterschiedliche Vorgehensweise zwi-
schen einem geschlossenen XTS System und einem XTS System
mit Track Management gibt, wird im Text darauf hingewiesen.

Für folgende zwei XTS Systeme werden die einzelnen Schritte des
XTS Configurators beispielhaft dargestellt:

Geschlossenes XTS System

Ein geschlossenes XTS System mit 180° Klothoiden und zehn Mo-
vern, entsprechend der Konfiguration eines 3 m XTS Starterkits.

XTS System mit Track Management

Ein XTS System mit Track Management mit vier Parts und sechs
Movern.
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Der Unterschied zwischen diesen beiden Konfigurationen eines XTS
Systems besteht darin, dass bei einem geschlossenen XTS System
die Reihenfolge der Module und Mover immer konstant bleibt. Die
Mover haben somit nur eine mögliche Strecke, auf der sie sich be-
wegen können.
Bei einem XTS System mit Track Management können die Module
ihre Position verändern und sich an anderen Modulen ausrichten.
Somit ist die Reihenfolge der Module und Mover veränderbar, da
neue Strecken gebildet werden können. Um den Überblick über die-
se Funktionen behalten zu können, wurden die Parts und Tracks
eingeführt.
Der Part ist die physische Hardwarekomponente auf der der Mover
fährt, vergleichbar mit einem Straßenabschnitt für ein Auto. Der
Track hingegen ist der tatsächliche Weg, dem der Mover folgt. Der
Weg entsteht, indem die einzelnen Hardwarekomponenten zusam-
mengefügt werden. Im Vergleich mit dem Auto wird eine mögliche
Route mit verschiedenen Straßen erschaffen. Weitere Informationen
dazu finden Sie im Kapitel „Grundlagen“, [Seite 26].
Parts und Tracks sind Objekte, die mithilfe des XTS Configurators
im TwinCAT-Projekt angelegt werden können. Ein einfaches XTS
System kann dabei mit nur einem Part und einem Track für alle Mo-
ver angelegt werden. Komplexere XTS Systeme können aus mehre-
ren Parts bestehen, die zu verschiedenen Tracks zusammengefügt
werden. So ergeben sich komplett neue Möglichkeiten im Umgang
mit den XTS Komponenten.
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8.3.1 XTS Configurator öffnen
Bevor Sie den XTS Configurator öffnen, müssen Sie ein Projekt an-
legen, Ihre Hardware überprüfen, das System mit dem Ziel-PC ver-
binden und die IO Devices scannen. Weitere Informationen dazu fin-
den Sie im Kapitel „Inbetriebnahme“, [Seite 200].
► Das XTS Tool Window aktivieren
► Weitere Informationen dazu finden Sie im Kapitel „XTS Tool

Window“, [Seite 226].

► Auf die Schaltfläche Start the XTS Configurator… klicken

Der XTS Configurator öffnet sich.
► Bei Bedarf Fenster für bessere Bedienbarkeit vergrößern
► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
ODER
► Auf die Schaltfläche >> klicken, um die Seitenleiste auszuklap-

pen
Weitere Informationen dazu finden Sie im Kapitel „Seitenleiste“,
[Seite 314].

Navigation mit Schaltflächen oder der Seitenleiste
Die Seiten können mit den Schaltflächen Go To Previous Step und
Go To Next Step oder mit der Seitenleiste aufgerufen werden. Beide
Varianten lassen sich jederzeit miteinander kombinieren.

Die einzelnen Schritte werden beispielhaft an der Variante mit den
Schaltflächen Go To Next Step beschrieben.
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8.3.2 System konfigurieren

Die Seite Processing Units öffnet sich.
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8.3.2.1 Processing Units

XTS
Auf der ersten Seite des XTS Configurators wird die Processing
Unit, die zentrale Recheneinheit des XTS Systems, angelegt. Für
einen besseren Überblick ist es möglich, die Objekte der Processing
Unit zu filtern.
Seit der Softwareversion 3.21.700 ersetzt die Processing Unit das
XTS IO Driver Objekt.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Processing Unit hinzufügen
Fügt eine Processing Unit hinzu.

Benennungsassistent
Öffnet das Dialogfenster Rename…

Optionen
Öffnet das Dialogfenster Options…

Processing Unit entfernen
Entfernt die ausgewählte Processing Unit.

Seitenleiste öffnen
Öffnet die Seitenleiste.

Seitenleiste schließen
Schließt die Seitenleiste.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.
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Processing Unit hinzufügen

► Auf die Schaltfläche + klicken, um eine weitere Processing Unit
hinzuzufügen

► Bei Bedarf auf die Schaltfläche x klicken, um eine ausgewählte
Processing Unit zu entfernen

In dieser Beispielkonfiguration ist eine Processing Unit ausreichend.
Mehrere Processing Units werden genutzt, wenn sich mehr als ein
unabhängiges System am IPC oder im Projekt befindet. Unabhängig
bedeutet, dass kein Modul oder kein Mover von einem anderen XTS
System mitbenutzt werden.

Für die Processing Unit müssen folgende Einstellungen vorgenom-
men werden:

Operationmode
► General ausklappen
► Normal im Dropdown-Menü Operation Mode auswählen, um

festzulegen, dass das System in Betrieb ist
ODER
► Simulation im Dropdown-Menü Operation Mode auswählen, um

festzulegen, dass das System in Simulation läuft
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Mover
► Mover ausklappen
► Den Movertyp im Dropdown-Menü Mover Type auswählen

► Das Magnetplattenset im Dropdown-Menü Magnet Plate Type
auswählen

► Ascending im Dropdown-Menü Mover Sort Order auswählen,
wenn die Mover aufsteigend vom System-Nullpunkt aus gezählt
werden sollen

ODER
► Descending im Dropdown-Menü Mover Sort Order auswählen,

wenn die Mover absteigend vom System-Nullpunkt aus gezählt
werden sollen

Mover ID-Erkennung
► Mover ID Detection ausklappen
► Die Anzahl der Mover 1 im Dropdown-Menü ID Detection Mode

auswählen
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Teaching

Revisionsnummer auf dem Modul beachten
Das Teaching wird nur für Module mit einem Revisionsstand kleiner
oder gleich 17 benötigt. Weitere Informationen dazu finden Sie im
Kapitel „Typenschild“ in der Original-Betriebsanleitung XTS Stan-
dard.

Teaching File Number ändern
Ändern Sie die Nummer der Teaching-Datei immer bevor Sie mit ei-
nem neuen Teaching beginnen. Wenn die Nummer der Teaching-
Datei nicht geändert wird oder die Konfiguration nicht geladen wird,
wird die alte Datei verwendet und überschrieben.
Beckhoff empfiehlt für die Nummer der Teaching-Datei das aktuelle
Datum zu verwenden. Für das erste Teaching am 03. April 2021
können beispielsweise die Ziffern 202104031 verwendet werden
und für das zweite Teaching am selben Tag die Ziffern 202104032
und so weiter.

► Teaching ausklappen
► Kontrollkästchen Is Teaching Enabled aktivieren, um das Ein-

gabefeld Teaching File Number einzublenden
ODER
► Kontrollkästchen Is Teaching Enabled deaktivieren, um das

Eingabefeld Teaching File Number auszublenden
► In das Eingabefeld Teaching File Number eine Teaching File

Number eingeben
Weitere Informationen dazu finden Sie im Kapitel „Teaching-Funk-
tionalität“, [Seite 115].

Diagnostic
► Diagnostic ausklappen
► Kontrollkästchen Auto Dump Writing aktivieren, um das auto-

matische Schreiben von Dump-Dateien einzuschalten
ODER
► Kontrollkästchen Auto Dump Writing deaktivieren, um das au-

tomatische Schreiben von Dump-Dateien auszuschalten

Wenn das Auto Dump Writing aktiviert ist, können Sie festlegen, in
welchen Fällen eine Dump-Datei geschrieben werden soll.

► Kontrollkästchen On Mover Detection Error, On Mover Lost,
On Failing ID Detection, On Module Error und On Module
Warning aktivieren, um eine Dump-Dateien zu schreiben

ODER
► Kontrollkästchen On Mover Detection Error, On Mover Lost,

On Failing ID Detection, On Module Error und On Module
Warning deaktivieren, um keine Dump-Dateien zu schreiben

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.3.2.2 Parts
Nachdem Sie die Processing Unit angelegt und eine Task hinzuge-
fügt haben, werden im nächsten Schritt Parts hinzugefügt.
Ein geschlossenes XTS System besteht in der Regel aus einem ein-
zigen Part. Für ein XTS System mit Track Management werden
mehrere Parts benötigt.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Filter Processing Unit
Filtert die Liste anhand der ausgewählten Processing Unit.

Dropdown-Menü Processing Unit
Zeigt die ausgewählte Processing Unit an und listet die verfügbaren
Processing Units auf.

Part hinzufügen
Fügt einen Part zur ausgewählten Processing Unit hinzu.

Part entfernen
Entfernt den ausgewählten Part aus der ausgewählten Processing
Unit. Der Part bleibt weiterhin in der Liste der verfügbaren Parts er-
halten.

Benennungsassistent
Öffnet das Dialogfenster Rename…

Optionen
Öffnet das Dialogfenster Options…

Dropdown-Menü Theme
Zeigt das ausgewählte Thema an und listet die verfügbaren Themen
auf.

Schaltfläche Parts und Module
Schaltet zwischen der Anzeige von Parts und Modulen um.

Zoom Fensterbreite
Skaliert die Ansicht auf die Fensterbreite.

Zoom Originalgröße
Skaliert die Ansicht auf die voreingestellte Originalgröße.

Zoom benutzerdefiniert
Skaliert die Ansicht auf die benutzerdefinierte Größe.

Seitenleiste öffnen
Öffnet die Seitenleiste.
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Seitenleiste schließen
Schließt die Seitenleiste.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.

Bedienelemente im Reiter Parts
Device hinzufügen
Öffnet das Dialogfenster Choose Devices for Part… und zeigt die
verfügbaren Einspeisestränge.

Device entfernen
Entfernt das ausgewählte Device aus dem ausgewählten Part. Das
Device bleibt weiterhin in der Liste der verfügbaren Devices verfüg-
bar.

Device nach oben verschieben
Verschiebt das ausgewählte Device eine Ebene nach oben.

Device nach unten verschieben
Verschiebt das ausgewählte Device eine Ebene nach unten.

Bedienelemente im Dialogfens-
ter Choose Devices for Part…

Filter Devices
Zeigt nur verfügbare Devices in der Liste an.

Filter Einspeisestrang
Zeigt nur verfügbare Einspeisestränge in der Liste an.

Filter Modul
Zeigt nur verfügbare Module in der Liste an.

Schaltfläche OK
Bestätigt die Eingaben und schließt das Dialogfenster.

Schaltfläche Cancel
Schließt das Dialogfenster ohne die Eingaben zu speichern.
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Part hinzufügen
► Die Processing Unit im Dropdown-Menü XTS Processing Unit

auswählen, zu der ein Part hinzugefügt werden soll
► Auf die Schaltfläche + klicken, um einen neuen Part hinzuzufü-

gen
► Bei Bedarf auf die Schaltfläche x klicken, um einen ausgewähl-

ten Part zu entfernen

Filtern
► Die Schaltfläche Filter aktivieren, um nur die Parts der ausge-

wählten Processing Unit einzublenden
ODER
► Die Schaltfläche Filter deaktivieren, um die Parts des gesamten

Projekts einzublenden

Part Eigenschaften
► Auf einen Part in der Part List klicken, um seine Eigenschaften

einzublenden
Die Eigenschaften des ausgewählten Parts werden unter Details:
Part 1 eingeblendet. Die Informationen können auch mithilfe der
XTS Utility in der PLC ausgelesen werden.
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Je nachdem ob Sie ein geschlossenes XTS System oder ein XTS
System mit Track Management konfigurieren möchten, unterschei-
den sich die folgenden Schritte voneinander.

Geschlossenes XTS System
Die folgenden Schritte sind erforderlich, wenn Sie ein geschlosse-
nes XTS System konfigurieren möchten.
Weitere Informationen zur Konfiguration eines XTS Systems mit
Track Management finden Sie im Kapitel „XTS System mit Track
Management“, [Seite 275].

Devices zuweisen
Im unteren Bereich der Detailanzeige können Sie Devices für Ihren
Part auswählen. Wählen Sie die Reihenfolge der Devices entspre-
chend ihrem Auftreten im XTS System aus.

► Auf die Schaltfläche + klicken, um Devices hinzuzufügen

Das Dialogfenster Choose Devices for Part… öffnet sich.
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Sie haben die Möglichkeit, die Devices zu filtern oder nur einzelne
Einspeisestränge oder Module zu dem ausgewählten Part hinzuzu-
fügen. Folgende Filter stehen Ihnen zur Auswahl:
• Select devices
• Select infeed lines
• Select individual modules

Select devices
► Auf die Schaltfläche Select devices klicken, um den Filter zu ak-

tivieren
► Auf ein Device klicken
ODER
► Die Taste Strg gedrückt halten, um mehrere Devices in entspre-

chender Reihenfolge auszuwählen

Select infeed lines
► Auf die Schaltfläche Select infeed lines klicken, um den Filter

zu aktivieren
► Auf einen Einspeisestrang klicken
ODER
► Die Taste Strg gedrückt halten, um mehrere Einspeisestränge in

entsprechender Reihenfolge auszuwählen

Select individual modules
► Auf die Schaltfläche Filter Modul klicken, um den Filter zu akti-

vieren
► Auf ein Modul klicken
ODER
► Die Taste Strg gedrückt halten, um mehrere Module in entspre-

chender Reihenfolge auszuwählen

► Mit OK bestätigen
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Devices prüfen
► Auf die Schaltfläche Zoom to fit klicken
Der konfigurierte Part wird angezeigt und kann auf das passende
Format skaliert werden.
► Überprüfen, ob die richtigen Devices in der passenden Reihen-

folge ausgewählt wurden

Devices sortieren
Wenn die Reihenfolge nicht korrekt ist:
► Auf ein Device klicken
► Mit den Pfeiltasten Device nach oben oder unten verschieben
ODER
► Auf die Schaltfläche x klicken, um ein Device zu entfernen
► Bei Bedarf weitere Devices hinzufügen



XTS Tools

274 ─── Version: 1.1.1TF5850

Eigenschaften festlegen Als nächstes können Sie die Eigenschaften der Parts festlegen. Da-
bei können Sie für jeden Part auswählen, ob die Vorderseite oder
die Rückseite der Module angezeigt wird und wie die Position und
Einbaulage dargestellt werden sollen. Mit diesen Eigenschaften
kann jede mögliche Ansicht Ihres XTS Systems abgebildet und an
Ihr reales XTS System angepasst werden.

Modulseite

Vorderseite, Front Rückseite, Back

Der Wert für die Länge kann in den Eigenschaften nicht verändert
werden.

► Modulseite im Dropdown-Menü Module Side auswählen
► In die Eingabefelder X und Y die Position des Parts eingeben
► In das Eingabefeld Alpha einen Wert für die Einbaulage des

Parts eingeben

Beispielkonfiguration
In dieser Beispielkonfiguration wird der Part in der Mitte der XTS
System View positioniert, als Ansicht die Vorderseite ausgewählt
und die Einbaulage bei 0° belassen.

Sie können die Werte für die Position des Parts manuell eingeben
oder den Part mit gedrückter linker Maustaste und gedrückter Taste
Alt in die richtige Position bringen.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren

Auf den folgenden Seiten werden die benötigten Schritte zur Konfi-
guration der Parts für ein XTS System mit Track Management be-
schrieben. Die weiteren Schritte für ein geschlossenes XTS System
finden Sie im Kapitel „Tracks“, [Seite 280].
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XTS System mit Track Management
Die folgenden Schritte sind erforderlich, wenn Sie ein XTS System
mit Track Management konfigurieren möchten.
Weitere Informationen zur Konfiguration eines geschlossenen XTS
Systems finden Sie im Kapitel „Geschlossenes XTS System“, [Seite
 271].

Devices zuweisen
Wählen Sie die Reihenfolge der Devices entsprechend ihrem Auftre-
ten im XTS System aus. Benötigt werden in dieser Beispielkonfigu-
ration vier Parts mit jeweils einem Device. Davon bestehen zwei
Parts aus je einem beweglichen Modul und zwei weitere Parts be-
stehen jeweils aus vier Modulen, die einen 1 m langen, feststehen-
den Modulstrang bilden.

► Auf die Schaltfläche + klicken, um Devices hinzuzufügen

Das Dialogfenster Choose Devices for Part… öffnet sich.
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Sie haben die Möglichkeit, die Devices zu filtern oder nur einzelne
Einspeisestränge oder Module zu dem ausgewählten Part hinzuzu-
fügen. Folgende Filter stehen Ihnen zur Auswahl:
• Device
• Einspeisestrang
• Modul

Select devices
► Auf die Schaltfläche Select devices klicken, um den Filter zu ak-

tivieren
► Auf ein Device klicken
ODER
► Die Taste Strg gedrückt halten, um mehrere Devices in entspre-

chender Reihenfolge auszuwählen

Select infeed lines
► Auf die Schaltfläche Select infeed lines klicken, um den Filter

zu aktivieren
► Auf einen Einspeisestrang klicken
ODER
► Die Taste Strg gedrückt halten, um mehrere Einspeisestränge in

entsprechender Reihenfolge auszuwählen
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Select individual modules
► Auf die Schaltfläche Select individual Modules klicken, um den

Filter zu aktivieren
► Auf ein Modul klicken
ODER
► Die Taste Strg gedrückt halten, um mehrere Module in entspre-

chender Reihenfolge auszuwählen

► Mit OK bestätigen
Für die Konfiguration des XTS Systems mit Track Management
müssen noch drei weitere Parts konfiguriert werden.
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Devices prüfen
► Auf die Schaltfläche Zoom to fit klicken
Die konfigurierten Parts werden angezeigt und können auf das pas-
sende Format skaliert werden.
► Überprüfen, ob die richtigen Devices in der passenden Reihen-

folge ausgewählt wurden
► Bei Bedarf die linke Maustaste und die Taste Alt gedrückt hal-

ten, um Parts in die richtige Position bringen

Devices sortieren
Wenn die Reihenfolge nicht korrekt ist:
► Auf ein Device klicken
► Mit den Pfeiltasten das Device nach oben oder unten verschie-

ben
ODER
► Auf die Schaltfläche x klicken, um ein Device zu entfernen
► Bei Bedarf weitere Devices hinzufügen
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Eigenschaften festlegen Als nächstes können Sie die Eigenschaften der Parts festlegen. Da-
bei können Sie für jeden Part auswählen, ob die Vorderseite oder
die Rückseite der Module angezeigt wird und wie die Position und
Einbaulage dargestellt werden sollen. Mit diesen Eigenschaften
kann jede mögliche Ansicht Ihres XTS Systems abgebildet und an
Ihr reales XTS System angepasst werden.

Modulseite

Vorderseite, Front Rückseite, Back

Der Wert für die Länge kann in den Eigenschaften nicht verändert
werden.

► Modulseite im Dropdown-Menü Module Side auswählen
► In die Eingabefelder X und Y die Position des Parts eingeben
► In das Eingabefeld Alpha einen Wert für die Einbaulage des

Parts eingeben

Beispielkonfiguration
In dieser Beispielkonfiguration werden die Parts in der Mitte der XTS
System View positioniert, als Ansicht die Vorderseite ausgewählt
und die Einbaulage bei 0° belassen.

Sie können die Werte für Position der Parts manuell eingeben oder
die Parts mit gedrückter linker Maustaste und gedrückter Taste Alt
in die richtige Position bringen.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.3.2.3 Tracks
Im nächsten Schritt werden Tracks hinzugefügt.
Ein geschlossenes XTS System besteht in der Regel aus einem ein-
zigen Track, der einen oder mehrere Parts beinhaltet. Für ein XTS
System mit Track Management werden mehrere Tracks benötigt,
damit die Mover zwischen verschiedenen Part-Kombinationen
wechseln können.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Filter Processing Unit
Filtert die Liste anhand der ausgewählten Processing Unit.

Dropdown-Menü Processing Unit
Zeigt die ausgewählte Processing Unit an und listet die verfügbaren
Processing Units auf.

Track hinzufügen
Fügt einen Track zur ausgewählten Processing Unit hinzu.

Track entfernen
Entfernt den ausgewählten Track aus der ausgewählten Processing
Unit.

Benennungsassistent
Öffnet das Dialogfenster Rename…

Optionen
Öffnet das Dialogfenster Options…

Dropdown-Menü Theme
Zeigt das ausgewählte Thema an und listet die verfügbaren Themen
auf.

Zoom Fensterbreite
Skaliert die Ansicht auf die Fensterbreite.

Zoom Originalgröße
Skaliert die Ansicht auf die voreingestellte Originalgröße.

Zoom benutzerdefiniert
Skaliert die Ansicht auf die benutzerdefinierte Größe.

Part hinzufügen
Fügt einen Part zur ausgewählten Processing Unit hinzu.

Part entfernen
Entfernt den ausgewählten Part aus der ausgewählten Processing
Unit. Der Part bleibt weiterhin in der Liste der verfügbaren Parts er-
halten.
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Seitenleiste schließen
Schließt die Seitenleiste.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.

Track hinzufügen
► Die Processing Unit im Dropdown-Menü XTS Processing Unit

auswählen, zu der ein Track hinzugefügt werden soll
► Auf die Schaltfläche + klicken, um einen neuen Track hinzuzufü-

gen
► Bei Bedarf auf die Schaltfläche x klicken, um einen ausgewähl-

ten Track zu entfernen

Filtern
► Die Schaltfläche Filter aktivieren, um nur die Tracks der ausge-

wählten Processing Unit einzublenden
ODER
► Die Schaltfläche Filter deaktivieren, um alle Tracks des gesam-

ten Projekts einzublenden

Track Eigenschaften
► Auf einen Track in der Track List klicken, um seine Eigenschaf-

ten einzublenden
Die Eigenschaften des ausgewählten Tracks werden unter Details:
Track 1 angezeigt. Die Informationen können auch mit Hilfe der XTS
Utility in der PLC ausgelesen werden.
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Parameter festlegen
Für jeden Track müssen die drei wichtigsten Parameter festgelegt
werden:

HINWEIS
Schäden am Produkt und Funktionsfehler vermeiden
Achten Sie auf die korrekte Angabe, ob Sie ein geschlossenes
XTS System oder ein XTS System mit definierten Endpunkten
konfigurieren.
Ist die Angabe fehlerhaft, können bei einem offenen XTS System
die Mover das XTS System verlassen. Bei einem geschlossenen
XTS System mit falscher Angabe können die Mover nicht wie ge-
wohnt im Kreis fahren.

► Kontrollkästchen Is closed aktivieren, wenn das XTS System
geschlossen ist

ODER
► Kontrollkästchen Is closed deaktivieren, wenn das XTS System

offen ist

► Kontrollkästchen Is included in detection aktivieren, wenn das
XTS System geschlossen ist oder nur einen Track hat

ODER
► Kontrollkästchen Is included in detection deaktivieren, wenn

das XTS System offen ist oder mehrere Tracks hat

Wenn das XTS System Tracks enthält, die sich Parts teilen, müssen
Sie definieren, welche Tracks die Erkennung durchführen. Dabei ist
es wichtig, dass jeder Part innerhalb einer Processing Unit nur ein-
mal im Erkennungsprozess vorkommt, da ansonsten möglicherwei-
se zu viele Mover angezeigt werden und deshalb das Aufstarten des
XTS Systems verhindert wird.
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Parts hinzufügen Wählen Sie die Reihenfolge der Parts entsprechend ihrem Auftreten
im XTS System aus. Achten Sie darauf, dass die Parts eine durch-
gängige Linie bilden, auf der sich die Mover bewegen können.

► Auf die Schaltfläche + klicken, um einen XTS Part hinzuzufügen

► Den Part im Dropdown-Menü XTS Part auswählen, der zu dem
aktuellen Track hinzugefügt werden soll

Geschlossenes XTS System

In dieser Beispielkonfiguration enthält der Track nur den zuvor konfi-
gurierten Part. So erscheint automatisch die rundumlaufende Stre-
cke des XTS Systems als farbige Linie.

Außerhalb der Tracks, die dem Part zugeordnet sind, erscheint eine
farbige Linie. Anhand dieser Linie können Sie überprüfen, ob der
gewählte Track gültig ist und ob die Parts in der richtigen Reihenfol-
ge hinzugefügt wurden.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren

XTS System mit Track Management
Außerhalb der Tracks, die dem Part zugeordnet sind, erscheint eine
grüne Linie. Anhand der grünen Linie können Sie überprüfen, ob der
gewählte Track gültig ist und ob die Parts in der richtigen Reihenfol-
ge hinzugefügt wurden.
In dieser Beispielkonfiguration gibt es zehn mögliche und sinnvolle
Konfigurationsvarianten der Tracks:
• jeder Part als einzelner Track = 4 Tracks
• beide beweglichen Module stehen jeweils neben dem oberen

oder neben dem unteren Part = 2 Tracks
• nur eine der beweglichen Module steht jeweils neben dem unte-

ren und neben dem oberen Part = 4 Tracks
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Je mehr Parts sich im XTS System befinden, desto mehr Möglich-
keiten gibt es diese mechanisch zu verbinden, um daraus Tracks zu
bilden. Oft ist es jedoch nicht sinnvoll möglichst viele Tracks zu kon-
figurieren. Jeder Part muss einem Track zugeordnet sein, damit die
Mover-Erkennung durchgeführt werden kann. Zusätzliche Tracks
können je nach erforderlichen Bewegungen der Mover auf dem XTS
System erstellt werden.
In dieser Beispielkonfiguration verfügt keiner der Tracks über eine
geschlossene Strecke, daher wird das Kontrollkästchen Is closed
bei keinem der konfigurierten Tracks aktiviert.
Da es einige Tracks gibt, die sich einzelne Parts teilen, kann das
Kontrollkästchen Is included in detection nicht für jeden Track akti-
viert werden. Das Kontrollkästchen muss für die Tracks aktiviert
werden, die mit der aktuellen Hardwarekonfiguration im Moment der
Mover-Erkennung übereinstimmen.

Wenn beide beweglichen Parts neben dem oberen Part stehen, gibt
es in der aktuellen Konfiguration zwei Tracks.
• Track 5 besteht aus Part 1, Part 2 und Part 3
• Track 4 besteht aus Part 4

Bei diesen beiden Tracks wird das Kontrollkästchen Is included in
detection aktiviert, damit die korrekte Anzahl an Movern auf dem
XTS System erkannt wird. Bei allen anderen Tracks wird das Kon-
trollkästchen nicht aktiviert.
Wenn sich bis zum Zeitpunkt der Inbetriebnahme Änderungen an
der Hardwarekonfiguration ergeben, können Sie den Parameter Is
included in detection über die PLC neu festlegen. Wenn nötig, sollte
diese Änderung während der Inbetriebnahme des XTS Systems
stattfinden.
Oftmals ist es ausreichend, den Track in den Erkennungsprozess
aufzunehmen. Das funktioniert jedoch nur, wenn sich kein Mover
auf dem Übergang zwischen zwei Parts befindet, da sonst zu viele
Mover vom XTS System erkannt werden.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.3.2.4 Stations

Die Funktion Stations befindet sich momentan noch in der Betapha-
se. Zukünftig werden noch mehr Funktionen und Informationen ver-
fügbar sein und auch das aktuelle Interface kann sich noch ändern.

Die Stations sind dafür vorgesehen, um das XTS System und dazu-
gehörige Applikationen zu visualisieren. Eine Station liefert Informa-
tionen darüber, wo einzelne Prozesse innerhalb des XTS Systems
stattfinden, um so den Aufbau der gesamten Applikation zu veran-
schaulichen.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Station hinzufügen
Fügt eine Station hinzu.

Part entfernen
Entfernt die ausgewählte Station.

Benennungsassistent
Öffnet das Dialogfenster Rename…

Optionen
Öffnet das Dialogfenster Options…

Dropdown-Menü Theme
Zeigt das ausgewählte Thema an und listet die verfügbaren Themen
auf.

Zoom Fensterbreite
Skaliert die Ansicht auf die Fensterbreite.

Zoom Originalgröße
Skaliert die Ansicht auf die voreingestellte Originalgröße.

Zoom benutzerdefiniert
Skaliert die Ansicht auf die benutzerdefinierte Größe.

Part hinzufügen
Fügt einen Part zur ausgewählten Station hinzu.

Dropdown-Menü Partauswahl
Zeigt den ausgewählten Part an und listet die verfügbaren Parts auf.

Part entfernen
Entfernt den ausgewählten Part aus der Station. Der Part bleibt wei-
terhin in der Liste der verfügbaren Parts erhalten. Diese Schaltflä-
che ist nur sichtbar, wenn ein Part zur Station hinzugefügt wurde.
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Stoppposition hinzufügen
Fügt eine Stoppposition zur ausgewählten Station hinzu.

Stoppposition entfernen
Entfernt die ausgewählte Stoppposition aus der Station. Diese
Schaltfläche ist nur sichtbar, wenn eine Stoppposition hinzugefügt
wurde.

Seitenleiste öffnen
Öffnet die Seitenleiste.

Seitenleiste schließen
Schließt die Seitenleiste.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.

Station hinzufügen
► Auf die Schaltfläche + klicken, um eine Station hinzuzufügen
► Bei Bedarf auf die Schaltfläche x klicken, um eine ausgewählte

XTS Station zu entfernen

Station Eigenschaften
► Auf eine Station in der Station List klicken, um ihre Eigenschaf-

ten einzublenden
Die Eigenschaften der ausgewählten Station werden unter Details:
Station 1 angezeigt. Die Informationen können auch mit Hilfe der
XTS Utility in der PLC ausgelesen werden.



XTS Tools

Version: 1.1.1 ─── 287TF5850

► Kontrollkästchen Is Enabled aktivieren, um die Station in der
XTS View einzublenden

ODER
► Kontrollkästchen Is Enabled deaktivieren, um die Station in der

XTS View auszublenden
► In das Eingabefeld ID einen Wert eingeben
► Eine Farbe im Dropdown-Menü Color auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► In das Eingabefeld Name einen Namen für die Station eingeben
► Bei Bedarf in das Eingabefeld Description eine kurze Beschrei-

bung zu der Station eingeben
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Startposition und Endposition
Für jede Station müssen eine Startposition und eine Endposition
festgelegt werden. Dabei ist es entscheidend, ob Sie einen einzigen
Part oder mehrere Parts in Ihrem XTS System angelegt haben.
Ein einzelner Part
Folgende Vorgaben müssen bei einem einzelnen Part beachtet wer-
den:
• Der eingegebene Wert im Eingabefeld End Position On Last Part

muss größer sein als der eingegebene Wert im Eingabefeld Start
Position On First Part

• Der eingegebene Wert im Eingabefeld End Position On Last Part
kann nur kleiner sein als der eingegebene Wert im Eingabefeld
Start Position On First Part, wenn der Part ein zweites Mal zu
den Parts hinzugefügt wird

Symbol Erläuterung
Startposition der Station, Start Position On First Part

Endposition der Station, End Position On Last Part
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Mehrere Parts
Folgende Vorgaben müssen bei mehreren Parts beachtet werden:
• Die Startposition befindet sich auf dem ersten und die Endpositi-

on auf dem letzten Part der ausgewählten Liste
• Die Reihenfolge der Parts muss entsprechend ihrem Auftreten

im XTS System ausgewählt werden. Die Parts müssen eine
durchgängige Linie bilden, auf der sich die Mover bewegen kön-
nen

Weitere Informationen dazu finden Sie im Kapitel „Part hinzufügen“,
[Seite 290].

Symbol Erläuterung
Startposition der Station, Start Position On First Part

Endposition der Station, End Position On Last Part

► In das Eingabefeld Start Position On First Part einen Wert einge-
ben

► In das Eingabefeld End Position On Last Part einen Wert einge-
ben



XTS Tools

290 ─── Version: 1.1.1TF5850

Part hinzufügen
Die Stations haben genau festgelegte Startpositionen und Endposi-
tionen. Die Startposition befindet sich auf dem ersten und die End-
position auf dem letzten Part der ausgewählten Liste. Bei allen an-
deren Parts der Liste zieht sich die Station über die volle Länge.

Wählen Sie die Reihenfolge der Parts entsprechend ihrem Auftreten
im XTS System aus. Achten Sie darauf, dass die Parts eine durch-
gängige Linie bilden, auf der sich die Mover bewegen können.

Geschlossenes XTS System

In dieser Beispielkonfiguration enthält die Station nur den zuvor kon-
figurierten Part. So wird beispielsweise eine einfache Station er-
zeugt.

► Auf die Schaltfläche + klicken, um einen Part hinzuzufügen
► Bei Bedarf auf die Schaltfläche x klicken, um einen ausgewähl-

ten Part zu entfernen

► Einen Part im Dropdown-Menü auswählen
► Bei Bedarf weitere Parts hinzufügen und auswählen

Die Station wird als Linie außerhalb des Tracks dargestellt. Wenn
die Linie nicht angezeigt wird oder die Linie nicht durchgängig ist,
überprüfen Sie die Eingaben der Startpositionen und Endpositionen
sowie die Reihenfolge der Parts.
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XTS System mit Track Management

In dieser Beispielkonfiguration wird auf dem zuvor konfigurierten
Part 3 eine einfache Zuführstation erzeugt.

► Auf die Schaltfläche + klicken, um einen Part hinzuzufügen
► Bei Bedarf auf die Schaltfläche x klicken, um einen ausgewähl-

ten Part zu entfernen

► Einen Part im Dropdown-Menü auswählen
► Bei Bedarf weitere Parts hinzufügen und auswählen

Die Station wird als Linie außerhalb des Tracks dargestellt. Wenn
die Linie nicht angezeigt wird oder die Linie nicht durchgängig ist,
überprüfen Sie die Eingaben der Startpositionen und Endpositionen
sowie die Reihenfolge der Parts.
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Stopppositionen hinzufügen
Nachdem alle Parts für die Station hinzugefügt und ausgewählt wur-
den, können Stopppositionen für die Mover definiert werden.

Stoppposition innerhalb der Station
Eine neue Stoppposition befindet sich automatisch immer am An-
fang der Station mit der Position 0 mm. Achten Sie bei der Eingabe
der Position darauf, dass Sie die Position vom Anfang der Station
verschieben und sich der Wert innerhalb der definierten Länge der
Station befinden muss.
Beispiel für eine Stoppposition

Während die dargestellte Station eine Startposition von 300 mm und
eine Endposition von 1200 mm auf dem Part hat, gelten diese Werte
für die Stoppposition nicht. Für die Stopppositionen können nur
Werte zwischen 0 mm und 900 mm vergeben werden, was der Län-
ge der Station entspricht. In diesem Beispiel entspricht ein eingege-
bener Wert von 300  mm für die Stoppposition einer Position von
600 mm auf dem Part.

► Auf die Schaltfläche + klicken, um eine Stoppposition hinzuzufü-
gen

► In das Eingabefeld einen Wert für die Stoppposition eingeben

Die Stoppposition wird als Raute auf der Linie der Station darge-
stellt.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.3.2.5 Movers
In diesem Schritt werden die Mover für das XTS System hinzuge-
fügt. Jeder Mover wird mit einer NC-Achse verbunden und kommu-
niziert über sein SoftDrive Objekt mit der NC. Jedes XTS System
benötigt mindestens einen Mover.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Filter Processing Unit
Filtert die Liste anhand der ausgewählten Processing Unit.

Mover hinzufügen
Fügt einen Mover zur ausgewählten Processing Unit hinzu.

Eingabefeld Moveranzahl
Ermöglicht die Eingabe der benötigten Moveranzahl.

Mover beibehalten
Deaktiviert überschüssige Mover, wenn die im Eingabefeld eingege-
bene Moveranzahl kleiner als die vorhandene Moveranzahl ist.

Anzahl übernehmen
Übernimmt die Anzahl aus dem Eingabefeld.

Anzeige Mover aktiviert
Zeigt an, dass der Mover im Projekt aktiviert ist.

Anzeige Mover deaktiviert
Zeigt an, dass der Mover im Projekt deaktiviert ist.

Mover entfernen
Entfernt den ausgewählten Mover.

Parameterset exportieren
Öffnet das Dialogfenster Export Parameter Set… zum Exportieren
von Parametersets.

Parameterset importieren
Öffnet das Dialogfenster Import Parameter Set… zum Importieren
von Parametersets.

Parameterset zurücksetzen
Setzt die Parametersets aller Mover auf die Standardeinstellungen
zurück.

Kopiervorlage der Parametersets aktivieren
Aktiviert oder deaktiviert die Kopiervorlage der Parametersets.

Eingabefeld Kopiervorlage Parameterset
Ermöglicht die Eingabe der Kopiervorlage der Parametersets, die
auf die Mover der ausgewählten Processing Unit angewendet wer-
den sollen.
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Anzeige der Kopiervorlage Parametersets
Zeigt die Kopiervorlagen der Parametersets an.

Benennungsassistent
Öffnet das Dialogfenster Rename…

Optionen
Öffnet das Dialogfenster Options…

Dropdown-Menü Theme
Zeigt das ausgewählte Thema an und listet die verfügbaren Themen
auf.

Zoom Fensterbreite
Skaliert die Ansicht auf die Fensterbreite.

Zoom Originalgröße
Skaliert die Ansicht auf die voreingestellte Originalgröße.

Zoom benutzerdefiniert
Skaliert die Ansicht auf die benutzerdefinierte Größe.

Seitenleiste öffnen
Öffnet die Seitenleiste.

Seitenleiste schließen
Schließt die Seitenleiste.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.
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Mover filtern
► Schaltfläche Filter aktivieren, um ausschließlich die Mover der

ausgewählten Processing Unit einzublenden
ODER
► Schaltfläche Filter deaktivieren, um alle Mover des gesamten

Projekts einzublenden

Mover hinzufügen
Sie haben die Möglichkeit vorhandene Achsen zu nutzen oder neue
Achsen anzulegen.

Vorhandene Achsen verwenden
Das folgende Dialogfenster öffnet sich, wenn Sie im Projekt bereits
NC‑Achsen mit einem SoftDrive-Objekt konfiguriert haben, die noch
nicht verlinkt sind.

► Die Processing Unit im Dropdown-Menü XTS Processing Unit
auswählen, zu der Mover hinzugefügt werden sollen

► Kontrollkästchen Yes, but only for selected axes aktivieren,
wenn nicht alle Achsen gewählt werden sollen

► Einzelne Achsen auswählen
► Mit OK bestätigen
Wenn das Dialogfenster mit Cancel abgebrochen wird, öffnet es
sich das nächste Mal erneut, wenn noch ungenutzte Achsen im Pro-
jekt vorhanden sind.

Neue Mover anlegen
► Die Processing Unit im Dropdown-Menü XTS Processing Unit

auswählen, zu der Mover hinzugefügt werden sollen

► Den verwendeten Movertyp Dropdown-Menü Mover Type aus-
wählen
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► Das verwendete Magnetplattenset des Movers im Dropdown-
Menü MagnetPlate Type auswählen

Einzelnen Mover
► Auf die Schaltfläche + klicken, um einen neuen Mover hinzuzufü-

gen

Mehrere Mover
► In das Eingabefeld Number of Movers die Anzahl benötigter Mo-

ver eingeben
► Auf die Schaltfläche Apply klicken, um die Anzahl an Movern

hinzuzufügen
Der Abstand von Movermitte zu Movermitte beträgt 80 mm.
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Mover entfernen
Sie haben die Möglichkeit einen einzelnen oder mehrere Mover
gleichzeitig zu entfernen. Beim Entfernen von mehreren Movern ste-
hen Ihnen zwei Varianten zur Verfügung.

Einzelnen Mover
► Auf einen Mover in der Mover List klicken, der entfernt werden

soll
► Auf die Schaltfläche x klicken, um den ausgewählten Mover zu

entfernen

Mehrere ausgewählte Mover
► Die Taste Strg gedrückt halten, um mehrere Mover in der Mover

List auszuwählen
► Auf die Schaltfläche x klicken, um die ausgewählten Mover zu

entfernen

Mehrere beliebige Mover
► Schaltfläche Keep existing Movers on Apply deaktivieren

► In das Eingabefeld Number of Movers die Anzahl benötigter Mo-
ver eingeben

► Auf die Schaltfläche Apply klicken
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Am Ende der Mover List werden so viele Mover gelöscht, bis die An-
zahl der Mover dem Wert im Eingabefeld Number of Movers ent-
spricht.
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Mover deaktivieren
Sie haben die Möglichkeit einen einzelnen oder mehrere Mover
gleichzeitig zu deaktivieren. Durch das Deaktivieren bleiben die Mo-
ver und ihre Eigenschaften erhalten und müssen später nicht neu
angelegt werden.

Einzelnen Mover
► Auf die Schaltfläche Enable/Disable State eines Movers kli-

cken, um den Mover zu deaktivieren
► Bei Bedarf auf die Schaltfläche Enable/Disable State eines Mo-

vers klicken, um den Mover wieder zu aktivieren

Mehrere Mover Wenn die Schaltfläche Keep existing Movers on Apply aktiviert ist,
werden die Mover nicht entfernt, sondern deaktiviert.

► Schaltfläche Keep existing Movers on Apply aktivieren

► In das Eingabefeld Number of Movers die Anzahl benötigter Mo-
ver eingeben

► Auf die Schaltfläche Apply klicken

Am Ende der Mover List werden so viele Mover deaktiviert, bis die
Anzahl der Mover dem Wert im Eingabefeld Number of Movers ent-
spricht.



XTS Tools

300 ─── Version: 1.1.1TF5850

Mover Eigenschaften

In dieser Beispielkonfiguration werden dem XTS System insgesamt
zehn Mover hinzugefügt. Diese Mover werden automatisch auf dem
ersten Part der gewählten Processing Unit aneinandergereiht. Die
Mover können angewählt werden, um ihre Eigenschaften anzuzei-
gen.

Sie können jedem Mover, jeder NC-Achse und jedem SoftDrive-Ob-
jekt einen eigenen Namen geben. Wird kein Name vergeben, wer-
den die Mover der Reihe nach durchnummeriert. Beachten Sie beim
Hinzufügen oder Entfernen von Movern, dass sich dadurch die Rei-
henfolge der Benennung verändern kann.

► Bei Bedarf in die Eingabefelder Name, Axis Name und SoftDrive
Name einen Namen eingeben

Simulation einstellen
Um das Verhalten der Mover virtuell zu testen, können Sie eine Si-
mulation erstellen. Für die Mover in dieser Simulation gibt es drei
mögliche Einstellungen:
• Auswahl eines Parts
• Festlegung einer genauen Position
• Nutzung eines Movers als Mover 1

► Einen Part im Dropdown-Menü Part auswählen, auf dem der Mo-
ver starten soll

► In das Eingabefeld Position einen Wert für die genaue Position
des Movers auf dem Part eingeben

Wenn die MoverIdDetection aktiviert ist, definiert der Wert im Einga-
befeld ID, ob der XTS Mover als Mover  1 angelegt ist. Ansonsten
bleibt das Eingabefeld ID ohne Eintrag.

► In das Eingabefeld ID eine Mover ID eingeben
► Darauf achten, dass die Anzahl der definierten IDs mit den Ein-

stellungen des Reiters Parameter (Init) unter dem Processing
Unit-Objekt übereinstimmt.
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Parameter Sets
Indem Sie Parameter Sets anlegen und wiederverwenden, können
Sie spezielle Eigenschaften, wie beispielsweise die Reglereinstel-
lungen für eine spezifische Beladung der Mover, von einem Mover
auf den anderen übertragen. Darüber hinaus haben Sie die Möglich-
keit verschiedene Standard Parameter Sets für unterschiedliche Mo-
ver zu nutzen.
Standardmäßig erhalten neue Mover das Parameter Set, das dem
festgelegten Movertyp entspricht. Sie haben jedoch die Möglichkeit
jedem Mover ein leeres Parameter Set zuzuweisen.
Bereits angelegte Mover haben kein Parameter Set und erfahren
keine Änderung beim Durchlauf des Configurators, falls sie kein an-
deres Parameter Set zugewiesen bekommen.

Die Parameter Sets sind für Mover ohne Beladung definiert. Wenn
Sie die Mover mit Beladung nutzen, müssen die Parameter Sets an-
gepasst werden. Bei Fragen kontaktieren Sie den für Ihre Region
zuständigen Produktspezialisten.

Parameter Set auswählen
► Ein Parameter Set im Dropdown-Menü Parameter Set auswäh-

len

Source Set anlegen
► Auf die Schaltfläche Source Set eines Movers klicken
Ein Source Set wird hinzugefügt. Das erste Source Set erhält den
Namen A1. Wenn es schon mehrere Source Sets gibt, wird mit dem
nächsten Buchstaben des Alphabets fortgefahren. Gibt es beispiels-
weise bereits drei Source Sets, bekommt das nächste Source Set
den Namen D1.
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Source Set auswählen
► Schaltfläche Enable or disable Parameter Copy Pattern akti-

vieren, um das Eingabefeld Edit the Parameter Copy Pattern zu
aktivieren

Das Source Set kann manuell für jeden Mover ausgewählt werden.

Source Set übertragen
Sie haben die Möglichkeit Source Sets auf einzelne oder mehrere
Mover zu übertragen. Dabei können Sie für jeden einzelnen Mover
ein Source Set auswählen oder über die Funktion Parameter Copy
Pattern ein oder mehrere Source Sets festlegen. Wenn unterschied-
liche Source Sets ausgewählt werden, wird diese Reihenfolge auf
alle Mover der ausgewählten Processing Unit übertragen.

Auf einen einzelnen Mover Sie können Source Sets über das Dropdown-Menü der Parameter
Sets auswählen und auf andere Mover übertragen.

► Ein Parameter Set im Dropdown-Menü Parameter Set auswäh-
len
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Auf mehrere Mover
► Auf Enable or disable Parameter Copy Pattern klicken, um

das Eingabefeld für die Source Sets zu aktivieren

Bestehende Source Sets verwenden
Wenn bereits Source Sets angelegt wurden, können Sie diese nun
in gewünschter Reihenfolge in das Eingabefeld eingeben. Source
Sets können dabei auch mehrmals verwendet werden.

► In das Eingabefeld Edit the Parameter Copy Pattern ein oder
mehrere Source Sets eingeben

Die eingegebenen Source Sets werden der Reihe nach auf die Mo-
ver übertragen.

Neue Source Sets verwenden
Wenn noch keine Source Sets angelegt wurden und Parameter Co-
py Pattern aktiviert ist, werden die neuen Source Sets in der Rei-
henfolge übernommen, in der diese ausgewählt werden.

► Auf die Schaltfläche Source Set eines Movers klicken
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► Auf die Schaltfläche Source Set eines weiteren Movers klicken

► Bei Bedarf auf die Schaltfläche Source Set weiterer Mover kli-
cken

Die Reihenfolge der neuen Source Sets wird im Eingabefeld Edit the
Parameter Copy Pattern übernommen.

Die Reihenfolge der neuen Source Sets wird gleichzeitig auf alle
Mover übertragen.



XTS Tools

Version: 1.1.1 ─── 305TF5850

Source Set exportieren
Source Sets können exportiert und importiert sowie auf Ihrem Com-
puter gespeichert werden. Auf diese Weise erhalten Sie einen bes-
seren Überblick über die unterschiedlichen Einstellungen der Mover.

► Auf die Schaltfläche Export a Parameter Set … klicken

Das Dialogfenster Export Parameter Set… öffnet sich.
► Ein Source Set für den Export im Dropdown-Menü Choose Para-

meter Set auswählen

Standardmäßig wird der Name des ausgewählten Source Sets ei-
nes Movertyps in die Eingabefelder Name und Comment übernom-
men. Bei Source Sets, die selbst hinzugefügt wurden, wird der Na-
me des Movers eingefügt, der die Basis für das Source Set liefert.

► In das Eingabefeld Name einen Namen für das Source Set ein-
geben

► Bei Bedarf in das Eingabefeld Comment einen Kommentar ein-
geben

► Mit Export As… bestätigen, um den Export zu starten
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Source Set importieren
► Auf die Schaltfläche Import a Parameter Set … klicken

Das Dialogfenster Import Parameter Set öffnet sich.
► Auf die Schaltfläche … klicken, um das Dialogfenster Open a

Parameter Set… zu öffnen
► Im Dialogfenster Open a Parameter Set… eine entsprechende

Datei auf dem Computer auswählen

Standardmäßig wird der Name des ausgewählten Source Sets ei-
nes Movertyps in die Eingabefelder Name und Comment übernom-
men.
► Mit Import bestätigen, um den Import zu starten
Importierte Source Sets werden am Ende der Liste Parameter Set
hinzugefügt und mit @I sowie einer fortlaufenden Ziffer gekenn-
zeichnet.

Das Source Set wird zu der Liste der Parameter Sets hinzugefügt
und kann im Dropdown-Menü Parameter Set eines Movers ausge-
wählt werden.

Source Set zurücksetzen
Sie können alle Mover gleichzeitig auf das Standard Parameter Set
zurücksetzen.

► Auf die Schaltfläche Reset to Defaults klicken

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.3.2.6 Real-Time
Im letzten Schritt werden die Real-Time-Einstellungen für das XTS
System vorgenommen.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Ziel-CPU laden
Lädt eine neue Ziel-CPU und überschreibt bereits bestehende
CPUs.

Eingabefeld Anzahl der CPUs
Ermöglicht die Eingabe der Anzahl benötigter CPUs.

Eingabefeld Anzahl isolierter CPUs
Ermöglicht die Eingabe der Anzahl isolierter CPUs.

Anzahl übernehmen
Übernimmt die Anzahl aus dem Eingabefeld.

Anzeige AUX Task
Zeigt die Konfiguration der AUX Task an.

CPU nach oben verschieben
Verschiebt die ausgewählte Task eine CPU nach oben.

CPU nach unten verschieben
Verschiebt die ausgewählte Task eine CPU nach unten.

Task entfernen
Entfernt die ausgewählte Task aus der CPU.

Schaltfläche Processing Unit und System
Schaltet zwischen der Anzeige von Processing Unit und System um.

Processing Unit oder TwinCAT System Task hinzufügen
Fügt eine Processing Unit oder eine TwinCAT System Task hinzu.

Processing Unit entfernen
Entfernt die ausgewählte Processing Unit.

Seitenleiste öffnen
Öffnet die Seitenleiste.

Seitenleiste schließen
Schließt die Seitenleiste.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.
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Schaltfläche Go To Next Step
Öffnet die nächste Seite.

Real-Time-Einstellungen
Sie haben die Möglichkeit Einstellungen für die verfügbaren
TwinCAT Tasks und die Processing Units vorzunehmen.

► Einen Wert im Dropdown-Menü Base Time der CPU auswählen
Der eingestellte Wert wird für die mit der CPU verbundenen Task
übernommen. Die Anzahl der Cycle Ticks wird entsprechend ange-
passt.

Verfügbare Kerne scannen
Wenn Sie ein reales XTS System mit einem entsprechenden IPC
verwenden, müssen die verfügbaren Kerne des IPCs gescannt wer-
den. Die Isolation der Kerne kann auch nach dem Scannen erfol-
gen.

► Auf die Schaltfläche Read target CPU klicken, um die verfügba-
ren Kerne zu scannen

Das Dialogfenster Info öffnet sich.
► Mit Yes bestätigen

Die Anzahl der verfügbaren Kerne wird nach dem Scannen im lin-
ken Feld angezeigt.
Die Anzahl der davon isolierten Kerne, die vollständig für TwinCAT
genutzt werden, wird im rechten Feld angezeigt.
Weitere Informationen zum Isolieren von Kernen finden Sie im Kapi-
tel „Kerne isolieren“, [Seite 313].
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Kerne für TwinCAT freigeben

Beispiel IPC mit 4 Kernen
Die Vorgehensweise zur Verteilung der Tasks auf die Kerne wird
beispielhaft für einen IPC mit 4 Kernen dargestellt.

► Auf die Schaltfläche + von Available TwinCAT Tasks klicken, um
die Übersicht der verfügbaren Kerne und Tasks aufzurufen

Das Dialogfenster Add TwinCAT Task öffnet sich.
In der Übersicht werden die verfügbaren Kerne und Tasks aufgelis-
tet. Die isolierten Kerne werden durch eine farbige Markierung der
jeweiligen Zeile gekennzeichnet.

Jede Task darf nur auf einem Kern laufen und muss auf 250 µs ein-
gestellt sein.

► Kontrollkästchen des Kerns CPU 3 aktivieren
► Darauf achten, dass die Base Time auf 250 µs eingestellt ist
► Bei Bedarf 250 µs im Dropdown-Menü Base Time auswählen
► Auf die Pfeiltasten Mover task CPU up und Mover task CPU

down klicken, um die XTS Task 1 auf den Kern CPU 3 zu ver-
schieben
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► Darauf achten, dass die Cycle Ticks der XTS Task 1 des Kerns
CPU 3 auf 1 eingestellt sind

► Bei Bedarf 1 im Dropdown-Menü Cycle Ticks auswählen
► Kontrollkästchen des Kerns CPU 2 aktivieren
► Darauf achten, dass die Base Time auf 1 ms eingestellt ist
► Bei Bedarf 1 ms im Dropdown-Menü Base Time auswählen
► Auf die Pfeiltasten Mover task CPU up und Mover task CPU

down klicken, um die NC-Task 1 SVB und die NC-Task 1 auf
den Kern CPU 2 zu verschieben

► Kontrollkästchen des Kerns CPU 1 aktivieren
► Darauf achten, dass die Base Time auf 1 ms eingestellt ist
► Bei Bedarf 1 ms im Dropdown-Menü Base Time auswählen
► Auf die Pfeiltasten Mover task CPU up und Mover task CPU

down klicken, um die I/O Idle Task auf den Kern CPU 1 zu ver-
schieben

► Kontrollkästchen des Kerns CPU 0 deaktivieren
► Mit OK bestätigen
Das Dialogfenster Add TwinCAT Task wird geschlossen.
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Im XTS Configurator werden die Einstellungen angezeigt und die
XTS Task 1 wird zu der XtsProcessingUnit 1 hinzugefügt.

Alternative Ansicht
Sie haben die Möglichkeit, sich die Verteilung der Kerne und Tasks
in einer alternativen Ansicht anzeigen zu lassen. Diese Ansicht ent-
spricht der Darstellung der Kerne und Tasks im Dialogfenster Add
TwinCAT Task.

► Auf den Reiter System klicken, um die alternative Ansicht anzu-
zeigen

Weitere Kerne hinzufügen
Wenn Sie weitere Kerne für Ihre Konfiguration benötigen, können
Sie diese zur XtsProcessingUnit 1 hinzufügen.

► Auf die Schaltfläche + von XtsProcessingUnit 1 klicken, um wei-
tere Kerne hinzuzufügen
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AUX Task für die Leave and Arrive-Funktionalität
Für die Leave and Arrive-Funktionalität wird eine AUX Task unter
der XtsProcessingUnit 1 benötigt.

► Auf die Schaltfläche AUX klicken, um eine XTS Aux Task zur
XtsProcessingUnit 1 hinzuzufügen

► Auf die Schaltfläche + von XTS Aux Task klicken, um eine Task
hinzuzufügen

Das Dialogfenster Assign Aux-Task to XTSProcessingUnit  1 öffnet
sich.
► Kontrollkästchen einer Task aktivieren, um sie auszuwählen
► Mit OK bestätigen
Die ausgewählte Task wird zur XTS Aux Task hinzugefügt.

► Darauf achten, dass die Base Time auf 250 µs eingestellt ist
► Bei Bedarf 250 µs im Dropdown-Menü Base Time auswählen
► Darauf achten, dass die Cycle Ticks der I/O Idle Task der XTS

Aux Task auf 1 eingestellt sind
► Bei Bedarf 1 in das Eingabefeld Cycle Ticks eingeben

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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Kerne isolieren
Die Anzahl der verfügbaren Kerne ist von dem verwendeten IPC ab-
hängig. Die meisten Systeme verfügen über 4 oder 12 Kerne, aber
auch 8 oder 64 Kerne sind möglich. Jeder Kern, der für das XTS
System verwendet wird, muss isoliert sein. Mindestens ein Kern darf
nicht isoliert werden, um ihn für Windows nutzen zu können. Für
weitere Informationen zur Verteilung der Kerne kontaktieren Sie den
für Ihre Region zuständigen Produktspezialisten.

XTS Configurator muss geschlossen sein
Das Isolieren von Kernen ist nur möglich, wenn der XTS Configura-
tor geschlossen ist.

► Solution Explorer > TwinCAT Project > SYSTEM ausklappen
► Doppelklick auf Real-Time

► Auf Read from Target klicken, um die Verteilung der Kerne auf-
zurufen

► Auf Set on Target klicken, um die Verteilung der Kerne zu än-
dern

HINWEIS
Speichern und Schließen anderer Anwendungen
Da der IPC nach der Eingabe der Kerne, die isoliert werden sol-
len, automatisch neu gestartet wird, speichern und schließen Sie
alle anderen Anwendungen, die auf dem IPC geöffnet sind.

Das Dialogfenster Change number of shared cores öffnet sich.
► Anzahl der isolierten Kerne mithilfe der Pfeiltasten eingeben
ODER
► In das Eingabefeld Aviable (Shared/Isolated) die Anzahl der iso-

lierten Kerne eingeben
► Mit Set bestätigen
Der IPC startet automatisch neu.
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8.3.2.7 Seitenleiste
Die Seitenleiste kann auf jeder Seite des Configurators ausgeklappt
werden. Die Seitenleiste bietet einen Überblick über die Seiten des
Configurators und kann zum Navigieren zwischen den Seiten ge-
nutzt werden.

Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Seitenleiste öffnen
Öffnet die Seitenleiste.

Seitenleiste schließen
Schließt die Seitenleiste.

Projekt geladen
Zeigt an, dass das Projekt geladen wurde. Diese Schaltfläche lässt
sich nicht anklicken.

Startseite
Zeigt die Startseite des XTS Configurators an.

Schaltfläche Processing Units
Öffnet die Seite Processing Units zum Bearbeiten der Processing
Units.

Schaltfläche Parts
Öffnet die Seite Parts zum Bearbeiten der Parts.

Schaltfläche Tracks
Öffnet die Seite Tracks zum Bearbeiten der Tracks.

Schaltfläche Stations
Öffnet die Seite Stations zum Bearbeiten der Stations.

Schaltfläche Movers
Öffnet die Seite Movers zum Bearbeiten der Mover.

Schaltfläche Real-Time
Öffnet die Seite Real-Time zum Bearbeiten der Real-Time Einstel-
lungen.

Schaltfläche Summary
Öffnet die Seite Summary. Das Kontrollkästchen Close automatical-
ly after finished kann aktiviert oder deaktiviert werden.

Schaltfläche Build
Übernimmt alle Einstellungen und erstellt die Konfiguration.
Schließt den XTS Configurator.
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Seite Finished
Zeigt an, dass alle Einstellungen übernommen wurden und die Kon-
figuration abgeschlossen ist. Diese Seite wird nur angezeigt, wenn
das Kontrollkästchen Close automatically after finished deaktiviert
ist.

Anzeige Seite geöffnet
Zeigt an, dass die Seite geöffnet wurde und mit einer Schaltfläche
der Seitenleiste verlassen wurde.

Anzeige Seite bearbeitet
Zeigt an, dass die Seite geöffnet wurde und mit der Schaltfläche Go
To Next Step verlassen wurde.

Navigation
Statt mit den Pfeiltasten zu navigieren, haben Sie die Möglichkeit
die Seitenleiste zu öffnen und mit den Schaltflächen zwischen den
Seiten des XTS Configurators zu navigieren.

► Auf die Schaltfläche klicken, um die Seitenleiste zu öffnen

Die Seitenleiste öffnet sich. Sie haben die Möglichkeit mit den
Schaltflächen zwischen den Seiten des XTS Configurators zu navi-
gieren:
► Auf eine Schaltfläche klicken, um die entsprechende Seite auf-

zurufen

Konfiguration abschließen
► Auf die Schaltfläche Build klicken, um die Konfiguration zu er-

stellen
ODER

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
Die Konfiguration wird erstellt und der XTS Configurator schließt
sich.
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8.3.3 Konfiguration abschließen
Nachdem alle benötigten Einstellungen vorgenommen wurden, kön-
nen Sie die Konfiguration abschließen.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
Die Änderungen werden gespeichert und der XTS Configurator
schließt sich.
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8.3.4 Konfiguration überprüfen
Alle konfigurierten TcCOM-Objekte werden im Projektbaum des So-
lution Explorers angezeigt.

Das konfigurierte XTS System können Sie sich in der XTS System
View des XTS Tool Windows ansehen. Nutzen Sie für eine bessere
Detailansicht die Funktion Zoom to fit.
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Die Einstellungen und Eigenschaften aller konfigurierten Objekte
können Sie nun in den Informationsfenstern der Parts, Tracks, Mo-
vers und Stations abrufen.
► Überprüfen, ob alle Einstellungen und Eigenschaften korrekt

sind
► Bei Bedarf Einstellungen und Eigenschaften ändern

► Die Schaltfläche Filter aktivieren, um nur die Objekte der ausge-
wählten Processing Unit einzublenden

ODER
► Die Schaltfläche Filter deaktivieren, um alle Objekte des gesam-

ten Projekts einzublenden
Wenn alle Einstellungen korrekt sind, können Sie die Konfiguration
in Betrieb nehmen. Weitere Informationen dazu finden Sie im Kapi-
tel „Inbetriebnahme“, [Seite 200].
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8.3.5 Benennungsassistent

Der Benennungsassistent ist im XTS Configurator für alle Kompo-
nenten verfügbar. Die Vorgehensweise wird beispielhaft an der Um-
benennung einer Processing Unit gezeigt.

Der Name der Schaltfläche des Benennungsassistenten ist abhän-
gig von der Komponente, die umbenannt werden soll. Das Ausse-
hen der Schaltfläche ist auf jeder Seite des XTS Configurators iden-
tisch und der Name beginnt immer mit Choose names for.

► Auf die Schaltfläche klicken, um den Benennungsassistenten zu
öffnen

Der Benennungsassistent Rename Tasks and Processing Units…
öffnet sich.
Sie haben die Möglichkeit eine Komponente oder mehrere Kompo-
nenten gleichzeitig umzubenennen.

HINWEIS
Keine doppelten Namen verwenden
Achten Sie darauf, dass Sie keine Namen eingeben, die bereits
verwendet werden. Dies kann zu Problemen bei der Konfigura-
tion führen.

8.3.5.1 Einzelne Komponente umbenennen
► In das Eingabefeld New Name einen Namen eingeben
► Mit Apply bestätigen
Die Eingabe wird gespeichert und das Dialogfenster schließt sich.

8.3.5.2 Mehrere Komponenten umbenennen
► In das Eingabefeld Base Name einen Namen eingeben
► In das Eingabefeld Starting Number eine Ziffer eingeben
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► Die Taste Strg gedrückt halten, um mehrere Processing Units in
der Liste auszuwählen

Die Anzahl der ausgewählten Processing Units wird im Feld Count
of selected renamings to which the pattern is applied angezeigt.

Zweiter Reiter für die Umbenennung der Tasks
Der Benennungsassistent der Processing Unit verfügt als Einziger
über einen zweiten Reiter. Mit diesem zweiten Reiter lassen sich
Tasks auf dieselbe Weise umbenennen.

► Auf die Schaltfläche Apply Naming Pattern klicken
Der Base Name und die Starting Number werden für die ausgewähl-
ten Processing Units übernommen. Dabei wird die Starting Number
der Reihe nach um den Wert 1 erhöht.
► Mit Apply bestätigen
Die Eingabe wird gespeichert und das Dialogfenster schließt sich.

8.3.6 Dialogfenster Options… öffnen
► Auf Schaltfläche Options… klicken
Das Dialogfenster Options… öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „Dialogfenster Op-
tions…“, [Seite 355].
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8.4 IO Timing Configurator
Der IO Timing Configurator trägt zu einer schnellen Inbetriebnahme
und einer intuitiven Arbeitsweise bei. Er unterstützt die Einstellung
der Distributed Clocks, die zur Synchronisation aller EtherCAT-Teil-
nehmer des XTS Systems benötigt werden.

8.4.1 IO-Devices überprüfen
Die IO-Devices, die nicht für das XTS System genutzt werden, müs-
sen deaktiviert sein, damit die automatischen Einstellungen für das
XTS System verwendet werden können. Ob die Devices aktiviert
oder deaktiviert sind, können Sie an der Darstellung der Devices im
Solution Explorer erkennen:

Aktiviert
Das Device ist aktiviert.

Deaktiviert
Das Device ist deaktiviert

► Solution Explorer > TwinCAT Project > I/O > Devices ausklap-
pen

► Überprüfen, ob alle XTS relevanten Devices deaktiviert sind
Wenn die Devices aktiviert sind, müssen die Devices deaktiviert
werden.

8.4.1.1 Deaktivieren
► Die Taste Strg gedrückt halten, um alle XTS relevanten Devices

auszuwählen
► Mit der rechten Maustaste auf alle XTS relevanten Devices kli-

cken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Disable klicken
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8.4.2 IO Timing Configurator öffnen
► Das XTS Tool Window aktivieren
Weitere Informationen dazu finden Sie im Kapitel „XTS Tool Window
aktivieren“, [Seite 226].

► Auf die Schaltfläche Start the IO Timing Configurator … im
XTS Tool Window klicken

Der IO Timing Configurator öffnet sich.
► Bei Bedarf Fenster für bessere Bedienbarkeit vergrößern
► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren

8.4.3 DC Settings

Die Seite DC Settings öffnet sich.
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8.4.3.1 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Schaltfläche Automatische Konfigurationseinstellungen
Übernimmt die voreingestellten Konfigurationseinstellungen für die
Devices.

Dropdown-Menü Reference Clock
Zeigt die für das Device ausgewählte Reference Clock an und listet
die verfügbaren Reference Clocks auf.

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.

Anzeige DC Master
Kennzeichnet den ausgewählten DC Master.

8.4.3.2 Device suchen
Im Menü DC Settings haben Sie die Möglichkeit nach Devices zu
suchen.

Namensteile für die Suche ausreichend
Für die Suche wird nur ein Teil des Device-Namens benötigt. Alle
Devices, die die eingegebene Buchstabenfolge an einer beliebigen
Stelle im Device-Namen enthalten, werden aufgelistet.

► Einen Begriff oder Teile des Device-Namens in das Eingabefeld
eingeben, um nach einem oder mehreren Devices zu suchen

Das Suchergebnis zu der eingegebenen Buchstabenfolge wird an-
gezeigt.
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8.4.3.3 Automatische Konfigurationseinstellungen

HINWEIS
Automatische Konfigurationseinstellungen verwenden
Beckhoff empfiehlt die automatischen Konfigurationseinstellun-
gen zu verwenden und diese Werte nicht zu verändern.

Für die Benutzung der automatischen Konfigurationseinstellungen
müssen die IO-Devices, die keine XTS Komponenten enthalten, de-
aktiviert sein. Weitere Informationen dazu finden Sie im Kapitel „IO-
Devices überprüfen“, [Seite 321].

► Auf die Schaltfläche Automatic configure settings klicken, um
die automatischen Konfigurationseinstellungen zu übernehmen

8.4.3.4 DC Master auswählen
► Einen DC Master im Dropdown-Menü Select a DC Master aus-

wählen

Der ausgewählte DC Master wird mit einer Krone gekennzeichnet.
Der DC Master ist immer der erste Einspeisestrang, der später als
Master für alle anderen CU2508 dient. Der Port-Multiplier, der die-
sen Einspeisestrang enthält, ist der Master Port-Multiplier, von dem
die Leitungen zu weiteren Port-Multipliern gezogen werden. Weitere
Informationen dazu finden Sie in den Dokumentationen Real-Time
und Distributed Clocks.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.4.4 DC Sync Cables

Sichtbarkeit in Abhängigkeit von CU2508
Die Seite DC Sync Cables wird nur angezeigt, wenn in der Konfigu-
ration ein CU2508 verwendet wird. Weitere Informationen dazu fin-
den Sie in der Dokumentation Real-Time.

8.4.4.1 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Schaltfläche Go To Previous Step
Öffnet die vorherige Seite.

Schaltfläche Go To Next Step
Öffnet die nächste Seite.

8.4.4.2 Port suchen
Im Menü DC Sync Cables haben Sie die Möglichkeit nach Ports zu
suchen.

► Eine Ziffer in das Eingabefeld eingeben, um nach einem oder
mehreren Ports zu suchen

Das Suchergebnis zu der eingegebenen Ziffer wird angezeigt.
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8.4.4.3 Port einstellen
Für jeden Port haben Sie die Möglichkeit auszuwählen, ob dieser
ungenutzt bleiben soll, als Sync-Master oder als Sync-Slave ver-
wendet werden soll.

Beispiel CU2508
Das Einstellen einer Sync-Verbindung zwischen Port  5 und Port  8
wird beispielhaft für zwei CU2508 dargestellt.

► Sync-Master im Dropdown-Menü des Ports 5 auswählen

Der untergeordnete CU2508 empfängt die Daten vom Sync-Master
und wird zu einem Sync-Slave.

► Sync-Slave im Dropdown-Menü des Ports 8 Auswählen

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
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8.4.5 Konfiguration abschließen
Nachdem alle benötigten Einstellungen vorgenommen wurden, kön-
nen Sie die Konfiguration abschließen.

► Auf die Schaltfläche Go To Next Step klicken, um fortzufahren
Die Änderungen werden gespeichert und der IO Timing Configurator
schließt sich.

8.4.6 IO-Devices aktivieren
Nachdem der IO Timing Configurator geschlossen wurde, können
alle IO-Devices wieder im Solution Explorer aktiviert werden.

► Solution Explorer > TwinCAT Project > I/O > Devices ausklap-
pen

► Die Taste Strg gedrückt halten, um die XTS relevanten Devices
auszuwählen

► Mit der rechten Maustaste auf die XTS relevanten Devices kli-
cken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Disable klicken
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8.5 XTS Viewer

8.5.1 Viewer öffnen
Nachdem Sie erfolgreich TF5850 TC3 XTS Extension installiert ha-
ben, können Sie den XTS Viewer wie jede andere Windows-Anwen-
dung öffnen.
Sie finden den XTS Viewer unter dem Dateipfad C:\TwinCAT\Functi-
ons\TF5850-TC3-XTS-Technology\TcXtsViewer oder als Icon auf
Ihrem Desktop.

► Doppelklick auf das Symbol XTS Viewer auf Ihrem Desktop
Der XTS Viewer öffnet sich.

8.5.2 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Dropdown-Menü Ziel-PC
Zeigt die Konfiguration des ausgewählten Ziel-PCs an und listet die
verfügbaren PCs auf.

Mit Ziel-PC verbinden
Ermöglicht die Verbindung mit dem Ziel-PC.

Kontinuierliche Aktualisierung
Aktualisiert kontinuierlich die Verbindung mit dem Ziel-PC.

Zusätzliche View hinzufügen
Fügt ein zusätzliches Fenster für den Ziel-PC hinzu.

Optionen
Öffnet das Dialogfenster Options…

Dropdown-Menü Modulseite
Zeigt die ausgewählte Modulseite an und listet die verfügbaren Mo-
dulseiten auf.

Dropdown-Menü Drehung
Ermöglicht die Auswahl eines voreingestellten Winkels zwischen
-180° und 180° oder die Eingabe eines eigenen Werts. Bezugspunkt
ist das erste Modul eines Parts.

Dropdown-Menü Theme
Zeigt das ausgewählte Thema an und listet die verfügbaren Themen
auf.

View konfigurieren
Öffnet das Dialogfenster Configure View.

Zoom Fensterbreite
Skaliert die Ansicht auf die Fensterbreite.
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Zoom Originalgröße
Skaliert die Ansicht auf die voreingestellte Originalgröße.

Zoom benutzerdefiniert
Skaliert die Ansicht auf die benutzerdefinierte Größe.

8.5.3 Verbinden mit dem Zielsystem
Eine XTS Viewer Anwendung kann nur mit einem Ziel-PC verbun-
den werden. Das Hauptfenster XTS Viewer und die zusätzlichen
Fenster XTS View können individuell angepasst werden, obwohl sie
dasselbe Ziel und dieselben Optionen verwenden. Um mehrere Ziel-
PCs zu verbinden, müssen weitere XTS Viewer Anwendungen ge-
öffnet werden.
Zum Verbinden einer XTS Viewer Anwendung mit einem Ziel-PC
haben Sie zwei Möglichkeiten:
• Startbildschirm
• Im Viewer

8.5.3.1 Startbildschirm
► Den Ziel-PC im Dropdown-Menü auswählen
► Auf die Schaltfläche Connect klicken

Im XTS Viewer wird das XTS System des Ziel-PCs eingeblendet,
das sich im Run Mode befindet.

Ziel auch für zusätzliche Views gültig
Der gewählte Ziel-PC gilt auch für jeden zusätzliche View, die über
die Schaltfläche Add additional View hinzugefügt wird.
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8.5.3.2 Im Viewer
► Auf die Schaltfläche Connect to selected Target klicken, um

den bisherigen Ziel-PC zu deaktivieren

► Einen Ziel-PC im Dropdown-Menü Choose Target… auswählen

► Auf die Schaltfläche Connect to selected Target klicken, um
den neuen Ziel-PC zu aktivieren

Im XTS Viewer wird das XTS System des Ziel-PCs eingeblendet,
das sich im Run Mode befindet.
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8.5.4 Kontinuierliche Aktualisierung
Durch das Deaktivieren der kontinuierlichen Aktualisierung werden
die Positionen der Mover und Module nicht mehr aktualisiert. Falls
sich die Mover zu schnell bewegen, ist es durch das Deaktivieren
der kontinuierlichen Aktualisierung möglich, eine Stillstandsansicht
zu erstellen.

Deaktivierung gilt auch für weitere XTS Views
Die Deaktivierung der kontinuierlichen Aktualisierung gilt auch für al-
le XTS Views, die über die Schaltfläche hinzugefügt wurden.

► Auf die Schaltfläche Continous Update klicken, um die kontinu-
ierliche Aktualisierung zu deaktivieren

ODER
► Auf die Schaltfläche Continous Update klicken, um die kontinu-

ierliche Aktualisierung zu aktivieren

8.5.5 View erstellen
► Auf die Schaltfläche Additional View klicken

Ein zusätzlicher XTS View öffnet sich.
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8.5.6 Dialogfenster Options… öffnen
Zur Konfiguration der XTS Views und für die grundsätzlichen Ein-
stellungen der XTS Tools stehen zahlreiche Optionen zur Verfü-
gung. Die Einstellungen der XTS Views werden in sogenannten
Themen gespeichert. Diese Themen können bearbeitet werden und
von anderen Fenstern mit XTS View Integration, wie z. B. dem XTS
Tool Window, benutzt werden.
► Auf die Schaltfläche Options… klicken
Das Dialogfenster Options… öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „Dialogfenster Op-
tions…“, [Seite 355].

8.5.7 Pop-up-Menü öffnen
► Mit der rechten Maustaste auf den Hintergrund klicken, um das

Pop-up-Menü zu öffnen
Das Pop-up-Menü öffnet sich. Weitere Informationen dazu finden
Sie im Kapitel „Pop-up-Menü“, [Seite 339].

8.5.8 ToolTips
Mit den ToolTips erhalten Sie Informationen zu den meisten Be-
dienelementen des XTS Viewers und den Komponenten.

8.5.8.1 Mover
► Den Mauszeiger über den Mover bewegen
Der ToolTip zeigt den Namen des Movers und seine Position an.
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8.5.8.2 Module
► Den Mauszeiger über das Modul bewegen
Der ToolTip zeigt den Namen und den Typ des Moduls sowie die
Zugehörigkeit zum Part.

8.5.8.3 Tracks
► Den Mauszeiger über den Track bewegen
Der ToolTip zeigt den Namen des Tracks an.

8.5.8.4 Parts
► Den Mauszeiger über den Part bewegen
Der ToolTip zeigt den Namen des Parts an.
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8.6 XTS Support Assistant, Beta
Der XTS Support Assistant sammelt Debug-Informationen des aktu-
ell auf dem TwinCAT-Zielsystem laufenden XTS Systems. Die
Desktop-Anwendung speichert die gesammelten Debug-Informatio-
nen in sogenannten Reports. Die Reports können an einen XTS
Spezialisten oder den XTS Support gesendet werden, um einen
schnelleren Überblick über das XTS System zu bekommen.
Momentan können Reports nur auf dem TwinCAT Ziel-PC generiert
werden. Das Ausführen des XTS Support Assistant auf einem Engi-
neering-PC liefert nicht alle benötigten Informationen.

Der XTS Support Assistant befindet sich momentan noch in der Be-
taphase. Zukünftig werden noch mehr Funktionen und Informationen
verfügbar sein.

8.6.1 XTS Support Assistant öffnen
Nachdem Sie erfolgreich TF5850 TC3 XTS Extensions installiert ha-
ben, können Sie den XTS Support Assistant wie jede andere Win-
dows-Anwendung öffnen.
Sie finden den XTS Support Assistant als Icon auf Ihrem Desktop
oder unter dem Dateipfad C:\TwinCAT\Functions\TF5850-TC3-XTS-
Technology\TcXtsSupportAssistant.

► Doppelklick auf das Symbol XTS Support Assistant auf Ihrem
Desktop

Der XTS Support Assistant öffnet sich.

8.6.2 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Informationsbereich
Öffnet die Eingabefelder des Informationsbereichs.

Treiber und Versionen
Öffnet die Liste der TwinCAT-Treiber und deren Versionen.

Anhänge
Öffnet die Liste der Anhänge.

Speichern
Öffnet das Dialogfenster zum Speichern des Reports.
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Bedienelemente im Bereich An-
hänge

Boot Files Schaltfläche Boot Files
Aktiviert oder deaktiviert, ob die Boot Files als Anhang versendet
werden sollen.

Target Files Schaltfläche Target Files
Aktiviert oder deaktiviert, ob die Target Files als Anhang versendet
werden sollen.

TcIoXts Dump Files Schaltfläche TcIoXts Dump Files
Aktiviert oder deaktiviert, ob die TcIoXts Files als Anhang versendet
werden sollen.

8.6.3 Informationsbereich
► In das Eingabefeld Customer den Kundennamen eingeben
► In das Eingabefeld Description eine detaillierte Beschreibung

des aufgetretenen Problems eingeben
Die Felder ID und Date Created werden automatisch ausgefüllt.

8.6.4 Treiber Versionen
► Auf die Schaltfläche Driver Versions klicken
Die Seite Drivers Versions zeigt alle installierten TwinCAT-Treiber
und deren verwendeten Versionen an.

8.6.5 Anhänge
► Auf die Schaltfläche File Attachements klicken
Die Seite File Attachements zeigt alle Dateien an, die als Anhang
versendet werden. Die Dateien sind in drei Kategorien aufgeteilt:
• Boot Files
• Target Files
• TcIoXts Dump Files
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Die Informationen, die als Anhang mit dem Report gesendet wer-
den, sind in folgende Kategorien unterteilt:

Boot Files Die Boot Files sind kundenspezifische Dateien, auf dem Projekt ba-
sieren. Sie enthalten beispielsweise die aktuelle Projektkonfiguration
ohne das SPS-Projekt und protokollierte Ereignisse aus dem An-
wendungsprotokoll.

Target Files Target Files sind projektunabhängige Basisdateien, beispielsweise
Teaching-Dateien des Systems.

TcIoXts Dump Files TcIoXts Dump Files sind Dateien, die alle relevanten Daten enthal-
ten, die mithilfe des Parameters WriteDump oder der automatischen
Dump-Funktionalität aus dem Processing Unit-Objekt oder dem
XtsIoDrv-Objekt des TcIoXts Drivers geschrieben werden

8.6.5.1 Auswählen
Beckhoff empfiehlt möglichst alle Informationen mit dem Report zu
senden, damit dem für Ihre Region zuständige Produktspezialist alle
benötigten Informationen vorliegen.
Standardmäßig sind alle Kategorien aktiviert. Deaktivierte Kategori-
en werden aus dem Report ausgeschlossen.

► Bei Bedarf auf die Schaltfläche Boot Files, Target Files oder
TcIoXts Dump Files klicken, um die Kategorie zu deaktivieren
und sie vom Report auszuschließen

ODER
► Bei Bedarf auf die Schaltfläche Boot Files, Target Files oder

TcIoXts Dump Files klicken, um die Kategorie zu aktivieren und
sie als Anhang zu versenden

Einzelne Datei ausschließen
Einzelne Dateien können nicht aus der Liste einer Kategorie entfernt
werden. Sie können einzelne Dateien nur aus dem Report aus-
schließen, indem Sie die Dateien von ihrem ursprünglichen Spei-
cherort an einen anderen Speicherort verschieben. Nach der Erstel-
lung des Reports müssen die Dateien wieder an ihrem ursprüngli-
chen Speicherort eingefügt werden.

8.6.5.2 Speichern
► Auf die Schaltfläche Speichern klicken
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Das Dialogfenster Safe report… öffnet sich.
► Einen Dateipfad auswählen
► In das Eingabefeld Dateiname einen Namen eingeben
Standardmäßig setzt sich der Dateiname aus Report, dem Datum
und der Uhrzeit zusammen, zu der der XTS Support Assistant gest-
artet wurde, beispielsweise Report-2023-10-28-09-22-40.zip
► Mit Speichern bestätigen

8.6.5.3 Dump-Dateien schreiben
Die Dump-Dateien können über die TcCom-Objekte XtsProcessing-
Unit oder XtsIoDriver geschrieben werden.

Beispiel XtsProcessingUnit
Das Schreiben der Dump-Dateien wird beispielhaft am TcCom-Ob-
jekt XtsProcessingUnit gezeigt.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects ausklappen

► Doppelklick auf XtsProcessingUnit

Manuell
► Im Projektfenster auf den Reiter Parameter (Init) klicken
► Diagnostics ausklappen
► Mit der rechten Maustaste in das Eingabefeld Write Dump kli-

cken, um das Kontextmenü aufzurufen
► Im Kontextmenü auf Download klicken

Die Dump-Dateien werden manuell geschrieben und unter C:\ auf
Ihrem Ziel-PC gespeichert.

In den Meldungsfenstern Error List und Output erscheinen Meldun-
gen, dass das Schreiben der Dump-Dateien erfolgreich war.
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Automatisch
► Diagnostics ausklappen
► TRUE im Dropdown-Menü IsAutoDumpWritingEnabled auswäh-

len

Zur Übernahme der Einstellungen muss die Konfiguration neu akti-
viert und das TwinCAT System muss neu gestartet werden.
► TwinCAT neu starten
Die Dump-Dateien werden beispielsweise bei Ereignissen wie einer
Mover-Erkennung oder einer Mover ID-Erkennung automatisch ge-
schrieben und unter C:\ auf Ihrem Ziel-PC gespeichert.
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8.7 Pop-up-Menü
Das Pop-up-Menü ist im XTS Tool Window und XTS Viewer verfüg-
bar.

Unterschiedliche Darstellungsart
Die farbliche Darstellung des Pop-up-Menüs unterscheidet sich im
XTS Tool Window und im XTS Viewer. Die Funktionsweise ist in bei-
den Tools identisch. Die Beschreibung der Funktionsweise wird bei-
spielhaft am XTS Tool Window dargestellt.

XTS Tool Window XTS Viewer

8.7.1 Parts einblenden
► Mit der rechten Maustaste auf den Hintergrund klicken, um das

Pop-up-Menü zu öffnen
► Auf Show all parts im Pop-up-Menü klicken, um alle Parts ein-

zublenden

8.7.2 Parts ausblenden
► Mit der rechten Maustaste auf den Hintergrund klicken, um das

Pop-up-Menü zu öffnen
► Auf Hide all parts im Pop-up-Menü klicken, um alle Parts auszu-

blenden
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8.7.2.1 Einen Part ausblenden
Ein Pop-up-Menü mit weniger Einstellmöglichkeiten wird eingeblen-
det, wenn Sie auf ein Modul statt auf den Hintergund klicken.

► Mit der rechten Maustaste auf ein Modul klicken, um das Pop-
up-Menü zu öffnen

► Auf Hide Part 1 im Pop-up-Menü klicken, um Part 1 auszublen-
den

8.7.2.2 Einen Part nicht ausblenden
► Mit der rechten Maustaste auf ein Modul klicken, um das Pop-

up-Menü zu öffnen
► Auf Hide all but Part 1 im Pop-up-Menü klicken, um alle Parts

bis auf den Part 1 auszublenden



XTS Tools

Version: 1.1.1 ─── 341TF5850

8.7.3 Ansicht konfigurieren
Das Dialogfenster Configure View… wird im XTS Tool Window und
im XTS Viewer auf die gleiche Weise geöffnet. Der XTS Viewer hat
zudem eine zusätzliche Schaltfläche zum Öffnen des Dialogfens-
ters.

Dialogfenster im XTS Tool Window und XTS Viewer öffnen
► Mit der rechten Maustaste auf den Hintergrund klicken, um das

Pop-up-Menü zu öffnen
► Auf Configure View… im Pop-up-Menü klicken

Das Dialogfenster Configure View öffnet sich.

► Bei Bedarf die Positionierung und die Deckkraft des Dialogfens-
ters einstellen

Weitere Informationen dazu finden Sie im Kapitel „Positionierung
und Deckkraft“, [Seite 353].

Das Dialogfenster ermöglicht Ihnen nach Komponententypen oder
nach einer bestimmten Komponente zu suchen. Sie können zudem
Komponenten filtern und einblenden oder ausblenden.

Dialogfenster im XTS Viewer öffnen
Im XTS Viewer haben Sie zudem die Möglichkeit, das Dialogfenster
Configure View mithilfe einer Schaltfläche zu öffnen:

► Auf die Schaltfläche Configure View klicken
Das Dialogfenster Configure View öffnet sich.
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8.7.3.1 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Filter Parts
Aktiviert oder deaktiviert die Parts in der Liste.

Filter Tracks
Aktiviert oder deaktiviert die Tracks in der Liste.

Filter Mover
Aktiviert oder deaktiviert die Mover in der Liste.

Filter Part Info Bars
Aktiviert oder deaktiviert die Part Info Bars und Dimensions in der
Liste.

Filter Info Bars
Aktiviert oder deaktiviert die Info Bars in der Liste.

Eingabefeld Komponentensuche
Ermöglicht die Eingabe eines Suchbegriffs. Es wird nach allen Kom-
ponenten gesucht, die diesen Begriff beinhalten.

Kontrollkästchen exakte Suche
Aktiviert oder deaktiviert die Suche nach einem exakten Suchbegriff.
Wenn das Kontrollkästchen aktiviert ist, wird nur nach der Kompo-
nente gesucht, die exakt dem Suchbegriff entspricht.

Eingaben zurücksetzen
Löscht alle Eingaben im Eingabefeld Komponentensuche.
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8.7.3.2 Komponenten suchen

Beispielsuche nach Mover 1
Die Auswirkungen der Schreibweise eines Suchbegriffs wird bei-
spielhaft an der Suche nach dem Mover 1 dargestellt.

Standardsuche
Bei der Standardsuche ist es ausreichend, wenn Sie nur einen Teil
des Suchbegriffs eingeben. Die Großschreibung oder Kleinschrei-
bung des Suchbegriffs ist irrelevant.

► Suchbegriff over 1 in das Eingabefeld Search eingeben
In der Ergebnisliste werden alle Komponenten angezeigt, die den
Teil des Suchbegriffs enthalten. Sowohl Mover 1 als auch die Mo-
ver 10 bis 19 enthalten den Suchbegriff over 1.

Exakte Suche
Bei der exakten Suche muss der Suchbegriff exakt eingegeben wer-
den. Die Großschreibung oder Kleinschreibung des Suchbegriffs ist
relevant.

► Kontrollkästchen Exact text match aktivieren

► Suchbegriff Mover 1 in das Eingabefeld Search eingeben
In der Ergebnisliste wird nur die Komponente angezeigt, die exakt
dem eingegebenen Begriff entspricht. Nur Mover 1 entspricht exakt
dem Suchbegriff. Die Mover 10 bis  19 werden nicht angezeigt, da
ihr Name noch eine weitere Ziffer enthält.
Wenn die Suche kein Ergebnis liefert, überprüfen Sie die Schreib-
weise des Suchbegriffs. Achten Sie dabei auf die Großschreibung
und Kleinschreibung sowie die korrekte Schreibweise des Suchbe-
griffs.

Wenn auch eine erneute Suche kein Ergebnis liefert:
► Kontrollkästchen Exact text match deaktivieren, um die Stan-

dardsuche zu verwenden
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8.7.3.3 Komponenten filtern
Sie können nach Komponententypen filtern und so bestimmte Kom-
ponenten in der Ansicht einblenden oder ausblenden. Standardmä-
ßig sind alle Filter aktiviert.

Abhängigkeit von Parts und Tracks
Es ist nicht möglich nur den Part oder den Track auszublenden.
Parts und Tracks sind abhängig voneinander und können nur ge-
meinsam eingeblendet oder ausgeblendet werden. Einzelne Module
können ebenfalls nicht ausgeblendet werden.

► Die Schaltfläche Filter Parts deaktivieren
Die Parts sind deaktiviert und können im Configure View nicht aus-
geklappt werden.
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8.7.3.4 Komponenten einblenden oder ausblenden
Mithilfe der Komponentenliste können einzelne Komponenten oder
ganze Komponententypen eingeblendet oder ausgeblendet werden.

Beispiel Komponenten einblenden oder ausblenden
Das Einblenden und Ausblenden der Komponenten wird beispielhaft
an den Movern dargestellt.

Einzelne Komponenten
► Mover ausklappen
► Kontrollkästchen eines Movers aktivieren, um den Mover einzu-

blenden
ODER
► Kontrollkästchen eines Movers deaktivieren, um den Mover aus-

zublenden

Komponentengruppe
► Kontrollkästchen der Komponentengruppe Mover aktivieren, um

alle Mover einzublenden
ODER
► Kontrollkästchen der Komponentengruppe Mover deaktivieren,

um alle Mover auszublenden
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8.7.4 Scope einblenden

Beispielscope für einen Mover und einen Parameter
Das Einblenden eines Scopes wird in den Grafiken beispielhaft an
dem Mover 1 und dem Parameter Hardware Position dargestellt. Die
Vorgehensweise ist für alle Mover und Parameter identisch.

► Mit der rechten Maustaste auf den Hintergrund klicken, um das
Pop-up-Menü zu öffnen

► Auf Scope… im Pop-up-Menü klicken

Das Dialogfenster Scope öffnet sich.

► Bei Bedarf die Positionierung und die Deckkraft des Dialogfens-
ters einstellen

Weitere Informationen dazu finden Sie im Kapitel „Positionierung
und Deckkraft“, [Seite 353].

► Einen Mover im Dropdown-Menü Select target mode auswählen

► Auf die Schaltfläche + klicken, um den Mover zum Scope hinzu-
zufügen

► Auf die Schaltfläche klicken
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Sie haben die Möglichkeit verschiedene Parameter aus den folgen-
den Kategorien auszuwählen:
• SoftDrive – Scope Variables
• General

Das Dialogfenster Select Parameters öffnet sich.
► Auf einen Parameter klicken
► Mit OK bestätigen

► Auf die Schaltfläche + klicken, um den Parameter hinzuzufügen

Ein Scope für den ausgewählten Mover und Parameter wird einge-
blendet.
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8.7.5 Mover Informationen
► Mit der rechten Maustaste auf den Hintergrund klicken, um das

Pop-up-Menü zu öffnen
► Auf Show mover infos im Pop-up-Menü klicken

Das Dialogfenster Movers öffnet sich.

► Bei Bedarf die Positionierung und die Deckkraft des Dialogfens-
ters einstellen

Weitere Informationen dazu finden Sie im Kapitel „Positionierung
und Deckkraft“, [Seite 353].

Die Positionen der Mover werden angezeigt.
► Bei Bedarf auf die Schaltfläche klicken, um das Dialogfenster

Select Column Values zu öffnen

Sie haben die Möglichkeit verschiedene Parameter aus den folgen-
den Kategorien auszuwählen:
• SoftDrive – Scope Variables
• General

Das Dialogfenster Select Column Values öffnet sich.
► Kontrollkästchen der Parameter aktivieren
ODER
► Kontrollkästchen der Parameter deaktivieren
► Mit OK bestätigen

Mover auswählen
► Auf einen Mover in der Ansicht klicken
ODER
► Auf einen Mover im Dialogfenster Movers klicken
Der ausgewählte Mover wird im Dialogfenster Movers und in der An-
sicht farblich hervorgehoben. Diese Funktion erleichtert die Suche
nach dem entsprechenden Mover und nach seiner Position auf dem
System.
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► Auf einen Mover in der Ansicht klicken
ODER
► Auf einen Mover im Dialogfenster Movers klicken
► Die Taste Strg gedrückt halten, um mit der linken Maustaste auf

weitere Mover zu klicken
Die ausgewählten Mover werden im Dialogfenster Movers und in
der Ansicht farblich hervorgehoben. Diese Funktion erleichtert die
Suche nach den entsprechenden Movern und nach ihrer Position
auf dem System.
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8.7.6 Module Informationen
► Mit der rechten Maustaste auf den Hintergrund klicken, um das

Pop-up-Menü zu öffnen
► Auf Show module infos im Pop-up-Menü klicken

Das Dialogfenster Modules öffnet sich.

► Bei Bedarf die Positionierung und die Deckkraft des Dialogfens-
ters einstellen

Weitere Informationen dazu finden Sie im Kapitel „Positionierung
und Deckkraft“, [Seite 353].

► Bei Bedarf auf die Schaltfläche klicken, um das Dialogfenster
Select Column Values zu öffnen

Sie haben die Möglichkeit verschiedene Parameter aus den folgen-
den Kategorien auszuwählen:
• Drive CoE – I2T Diag Data
• General
• Drive CoE – Info Data
• Drive CoE – Vendor Data
• Drive CoE – General
• Drive CoE – Amplifier Settings
• Drive Info

Das Dialogfenster Select Column Values öffnet sich.
► Kontrollkästchen der Parameter aktivieren
ODER
► Kontrollkästchen der Parameter deaktivieren
► Mit OK bestätigen

Module auswählen
► Auf ein Modul in der Ansicht klicken
ODER
► Auf ein Modul im Dialogfenster Modules klicken
Das ausgewählte Modul wird im Dialogfenster Modules und in der
Ansicht farblich hervorgehoben. Diese Funktion erleichtert die Su-
che nach dem entsprechenden Modul und nach seiner Position im
System.
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► Auf ein Modul in der Ansicht klicken
ODER
► Auf ein Modul im Dialogfenster Modules klicken
► Die Taste Strg gedrückt halten, um mit der linken Maustaste auf

weitere Module zu klicken
Die ausgewählten Module werden im Dialogfenster Modules und in
der Ansicht farblich hervorgehoben. Diese Funktion erleichtert die
Suche nach den entsprechenden Modulen und nach ihrer Position
im System.

8.7.7 Diagnoseverlauf
► Mit der rechten Maustaste auf den Hintergrund klicken, um das

Pop-up-Menü zu öffnen
► Auf Show diagnosis history im Pop-up-Menü klicken

Das Dialogfenster Diagnosis Messages öffnet sich.

► Bei Bedarf die Positionierung und die Deckkraft des Dialogfens-
ters einstellen

Weitere Informationen dazu finden Sie im Kapitel „Positionierung
und Deckkraft“, [Seite 353].

Im Dialogfenster werden Fehlermeldungen, Warnmeldungen und
Hinweise angezeigt.
► Auf ein Modul klicken, um die zugehörigen Fehlermeldungen,

Warnmeldungen und Hinweise anzuzeigen
► Bei Bedarf die Schaltflächen Errors, Warnings und Messages

aktivieren, um die entsprechenden Meldungen einzublenden
ODER
► Bei Bedarf die Schaltflächen Errors, Warnings und Messages

deaktivieren, um die entsprechenden Meldungen auszublenden
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8.7.8 Ansicht speichern
► Mit der rechten Maustaste auf den Hintergrund klicken, um das

Pop-up-Menü zu öffnen
► Auf Snapshot im Pop-up-Menü klicken

Das Dialogfenster Export Image… öffnet sich.

► Bei Bedarf die Positionierung und die Deckkraft des Dialogfens-
ters einstellen

Weitere Informationen dazu finden Sie im Kapitel „Positionierung
und Deckkraft“, [Seite 353].

► Current View im Dropdown-Menü Select the view to export aus-
wählen, um nur eine Ansicht vom System ohne Ränder zu spei-
chern

ODER
► Full View im Dropdown-Menü Select the view to export auswäh-

len, um die gesamte Ansicht zu speichern
► Bei Bedarf eine Farbe für den Hintergrund im Dropdown-Menü

Select the background color auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► Auf Copy klicken, um die Ansicht in die Zwischenablage zu ko-

pieren
ODER
► Auf Save As… klicken, um die Ansicht als png-Bild zu speichern

und den Speicherort auszuwählen
ODER
► Mit Close abbrechen
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8.7.9 Positionierung und Deckkraft
Die mit dem Pop-up-Menü geöffneten Dialogfenster können beliebig
im XTS Tool Window oder im XTS Viewer positioniert werden. Mit
den Schaltflächen des Dialogfensters Dialog Settings haben Sie zu-
dem die Möglichkeit das jeweilige Dialogfenster an den Außenkan-
ten zu positionieren und die Deckkraft einzustellen.
► Mit der rechten Maustaste auf die Kopfzeile des Dialogfensters

klicken, um das Kontextmenü aufzurufen
► Auf Dialog Settings klicken

Das Dialogfenster Dialog Settings öffnet sich.
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8.7.9.1 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Oben links
Richtet das Dialogfenster oben links im geöffneten XTS Tool aus.

Oben
Richtet das Dialogfenster oben über die gesamte Breite des geöff-
neten XTS Tools aus.

Oben rechts
Richtet das Dialogfenster oben rechts im geöffneten XTS Tool aus.

Links
Richtet das Dialogfenster links über die gesamte Höhe des geöffne-
ten XTS Tools aus.

Mittig
Richtet das Dialogfenster mittig im geöffneten XTS Tool aus.

Rechts
Richtet das Dialogfenster rechts über die gesamte Höhe des geöff-
neten XTS Tools aus.

Unten links
Richtet das Dialogfenster unten links im geöffneten XTS Tool aus.

Unten
Richtet das Dialogfenster unten über die gesamte Breite des geöff-
neten XTS Tools aus.

Unten rechts
Richtet das Dialogfenster unten rechts im geöffneten XTS Tool aus.

Regler für die Deckkraft
Stellt die Deckkraft für das Dialogfenster ein.

► Auf eine Schaltfläche klicken, um die Ausrichtung für das Dialog-
fenster einzustellen

► Mit dem Regler Opacity die Deckkraft für das Dialogfenster ein-
stellen
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8.8 Dialogfenster Options…

Das Kapitel Dialogfenster Options… ist für alle XTS Tools gültig
In diesem Kapitel werden alle Einstellungen beschrieben, die Sie in
allen XTS Tools im Dialogfenster Options… einstellen können.

Im Dialogfenster Options… können Sie mithilfe der Reiter XTS View
Themes und General die Einstellungen für die XTS Views anpas-
sen.

8.8.1 XTS View Themes
Zunächst muss ein Thema ausgewählt werden, für das die Einstel-
lungen angepasst werden sollen.

► Auf den Reiter XTS View Theme klicken
► Das Thema im Dropdown-Menü auswählen, das angepasst wer-

den soll:
• Base Theme
• XTS Viewer Theme
• Simulation Builder Theme
• Tool Window Theme
• Configurator Theme

8.8.1.1 View
► Auf View klicken
► Kontrollkästchen Textured Background aktivieren, um einen

texturierten Hintergrund einzublenden
ODER
► Kontrollkästchen Textured Background deaktivieren, um einen

einfarbigen Hintergrund einzublenden
► Eine Farbe im Dropdown-Menü XTS View Background auswäh-

len
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].

Eigenschaft Erläuterung Standardeinstellung
Textured Background Texturierter Hintergrund, Schachbrettmuster Aktiviert
XTS View Background Farbe für den Hintergrund im XTS View AliceBlue
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8.8.1.2 Module
► Module ausklappen
► Auf … von Module Dialog Columns klicken, um das Dialogfens-

ter Select Components zu öffnen

Das Dialogfenster Select Components öffnet sich.
► Kontrollkästchen des Parameters aktivieren, um den Parameter

auszuwählen
ODER

► Kontrollkästchen des Parameters deaktivieren, um den Parame-
ter aus der Auswahl zu entfernen

► Mit OK bestätigen

► Kontrollkästchen Show heat map aktivieren, um die Temperatur
einzublenden

ODER
► Kontrollkästchen Show heat map deaktivieren, um die Tempe-

ratur auszublenden
► Mit dem Regler Heat map transparency die Deckkraft einstellen
► Die Komponente im Dropdown-Menü Heat map component aus-

wählen, deren Temperatur eingeblendet werden soll

Eigenschaft Erläuterung Standardeinstellung
Show heat map Temperaturanzeige Deaktiviert
Heat map transparency Regler für die Deckkraft der Temperaturanzeige 100
Heat map component Auswahl der Komponente PCB Temperatures
• PCB Temperatures PCB Temperaturen –
• Amplifier I2T Temperatures I2T Reglertemperaturen –
• DC Link Voltage Gleichstromspannung –
• Max DC link voltage - last

500 ms
Maximale Gleichstromspannung der letzten 500 ms –

• Max overall current - last
500 ms

Maximaler Gesamtstrom der letzten 500 ms –
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Text
► Auf Text klicken
► Bei Bedarf in das Eingabefeld Text einen Parameter eingeben
ODER
► Auf Browse klicken, um das Dialogfenster Module Components

zu öffnen

Das Dialogfenster Module Components öffnet sich.

► Auf einen Parameter klicken
► Mit OK bestätigen

► Auf die Schaltflächen von Horizontal Alignment, Vertical
Alignment und Text Baseline klicken, um die Ausrichtung des
Textes auszuwählen

► Eine Farbe im Dropdown-Menü Text Brush auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► Voreingestellten Wert im Dropdown-Menü Font Size auswählen
ODER
► In das Eingabefeld Font Size einen Wert eingeben
► In die Eingabefelder Margin Werte für die Abstände des Textes

zum Rahmen eingeben
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Eigenschaft Erläuterung Standardeinstellung
Text Eingabefeld für einen Parameter, der auf den Mo-

dulen angezeigt werden.
–

Horizontal Alignment Horizontale Ausrichtung des Textes zum Modul Left
 Left Linksbündig –
 Center Zentriert –
 Right Rechtsbündig –

Vertical Alignment Vertikale Ausrichtung des Textes zum Modul Top
 Top Oben –
 Center Zentriert –
 Bottom Unten –

Text Baseline Text Grundlinie Top
 Top Oben –
 Middle Mittig –
 Bottom Unten –

Text Brush Schriftfarbe AliceBlue
Font Size Schriftgröße 16
Margin Abstand des Textes zum Rahmen –

 Left Links 0
 Right Rechts 0
 Top Oben 0
 Bottom Unten 0
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ToolTip
Mit den ToolTip Parametern legen Sie fest, welche Informationen Ih-
nen angezeigt werden, wenn Sie die Maus über die Module bewe-
gen.

► Auf ToolTip klicken
► Auf Browse klicken, um das Dialogfenster Module Components

zu öffnen

Das Dialogfenster Module Components öffnet sich.

► Auf einen Parameter klicken
► Mit OK bestätigen

ToolTip hinzufügen
► Auf die Schaltfläche + klicken, um einen neuen ToolTip hinzuzu-

fügen
Ein neuer ToolTip wird zur Liste hinzugefügt.
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ToolTip entfernen
► Auf einen ToolTip klicken, der entfernt werden soll
► Auf die Schaltfläche x klicken, um den ausgewählten ToolTip

aus der Liste zu entfernen
Der ToolTip wird aus der Liste entfernt.
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Drive Status
► Auf Drive Status klicken
► Kontrollkästchen Show Module drive warning aktivieren, um

Warnungen einzublenden
ODER
► Kontrollkästchen Show Module drive warning deaktivieren, um

Warnungen auszublenden
► Kontrollkästchen Show Module drive error aktivieren, um Feh-

lermeldungen einzublenden
ODER
► Kontrollkästchen Show Module drive error deaktivieren, um

Fehlermeldungen auszublenden
► Auf die Schaltflächen von Icon Horizontal Alignment, Icon

Vertical Alignment, Icon Horizontal Baseline und Icon Verti-
cal Baseline klicken, um die Ausrichtung des Symbols auszu-
wählen

► In die Eingabefelder Icon margin Werte für die Abstände des
Symbols zum Rahmen eingeben

Eigenschaft Erläuterung Standardeinstellung
Show Module drive warning Anzeige der Modul-Warnung Aktiviert
Show Module drive error Anzeige des Modul Fehlers Aktiviert
Icon Horizontal Alignment Horizontale Ausrichtung des Symbols Center

 Left Linksbündig –
 Center Zentriert –
 Right Rechtsbündig –

Icon Vertical Alignment Vertikale Ausrichtung des Symbols Bottom
 Top Oben –
 Center Zentriert –
 Bottom Unten –

Icon Horizontal Baseline Horizontale Symbol-Grundlinie Center
 Left Linksbündig –
 Center Zentriert –
 Right Rechtsbündig –

Icon Vertical Baseline Vertikale Symbol-Grundlinie Bottom
 Top Oben –
 Center Zentriert –
 Bottom Unten –

Icon margin Abstand Symbol zum Rahmen –
 Left Links 0
 Right Rechts 0
 Top Oben 0
 Bottom Unten 0
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8.8.1.3 Mover
► Mover ausklappen
► Eine Farbe für ausgewählte Mover im Dropdown-Menü Mover

Selection Color auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► Auf … von Mover Dialog Columns klicken, um das Dialogfenster

Select Components zu öffnen

Das Dialogfenster Select Components öffnet sich.
► Kontrollkästchen des Parameters aktivieren, um den Parameter

auszuwählen
ODER

► Kontrollkästchen des Parameters deaktivieren, um den Parame-
ter aus der Auswahl zu entfernen

► Mit OK bestätigen

Text
► Auf Text klicken
► Bei Bedarf Parameter in das Eingabefeld Text eingeben
ODER
► Auf Browse klicken, um das Dialogfenster Mover Components

zu öffnen

Das Dialogfenster Mover Components öffnet sich.

► Auf einen Parameter klicken
► Mit OK bestätigen
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► Auf die Schaltflächen von Horizontal Alignment, Vertical
Alignment und Text Baseline klicken, um die Ausrichtung des
Textes auszuwählen

► Eine Farbe im Dropdown-Menü Text Brush auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► Voreingestellten Wert im Dropdown-Menü Font Size auswählen
ODER
► In das Eingabefeld Font Size einen Wert eingeben
► In die Eingabefelder Margin Werte für die Abstände des Textes

zum Rahmen eingeben

Eigenschaft Erläuterung Standardeinstellung
Text Eingabefeld für Parameter, die auf den Movern an-

gezeigt werden
–

Horizontal Alignment Horizontale Ausrichtung des Textes zum Modul Left
 Left Linksbündig –
 Center Zentriert –
 Right Rechtsbündig –

Vertical Alignment Vertikale Ausrichtung des Textes zum Mover Top
 Top Oben –
 Center Zentriert –
 Bottom Unten –

Text Baseline Text Grundlinie Top
 Top Oben –
 Middle Mittig –
 Bottom Unten –

Text Brush Schriftfarbe AliceBlue
Font Size Schriftgröße 16
Margin Abstand des Textes zum Rahmen –

 Left Links 0
 Right Rechts 0
 Top Oben 0
 Bottom Unten 0
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ID
► Auf ID klicken
► Kontrollkästchen Shade Mover IDs aktivieren, um die Mover IDs

hervorzuheben
ODER
► Kontrollkästchen Shade Mover IDs deaktivieren, um die Mover

IDs nicht hervorzuheben
► Eine Farbe für die farbliche Hervorhebung der Mover 1 im Drop-

down-Menü ID 1 Color auswählen
► Eine Farbe für die farbliche Hervorhebung der Mover im Drop-

down-Menü Other Color auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].

Eigenschaft Erläuterung Standardeinstellung
Shade Mover IDs Farbliche Hervorhebung der Mover IDs Aktiviert
ID 1 Color Farbe für die farbliche Hervorhebung der ausge-

wählten Mover 1
PaleGreen

Other Color Farbe für die farbliche Hervorhebung der ausge-
wählten Mover

Steelblue
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ToopTip
► Auf ToolTip klicken
► Auf Browse klicken, um das Dialogfenster Mover Components

zu öffnen

Das Dialogfenster Mover Components öffnet sich.

► Auf einen Parameter klicken
► Mit OK bestätigen

ToolTip hinzufügen
► Auf die Schaltfläche + klicken, um einen neuen ToolTip hinzuzu-

fügen
Ein neuer ToolTip wird zur Liste hinzugefügt.

ToolTip entfernen
► Auf einen ToolTip klicken, der entfernt werden soll
► Auf die Schaltfläche x klicken, um den ausgewählten ToolTip

aus der Liste zu entfernen
Der ToolTip wird aus der Liste entfernt.
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8.8.1.4 Track
► Kontrollkästchen Enabled, Show Name und Show name on

each segment aktivieren
ODER
► Kontrollkästchen Enabled, Show Name und Show name on

each segment deaktivieren 
► Bei Bedarf den Wert im Eingabefeld Thickness ändern
► Auf die Schaltflächen von Text Baseline und Text Alignment

klicken, um die Ausrichtung des Textes auszuwählen
► Voreingestellten Wert im Dropdown-Menü Text Font Size aus-

wählen
ODER
► In das Eingabefeld Text Font Size einen Wert eingeben
► In die Eingabefelder Text Margin Werte für die Abstände des

Textes zum Rahmen eingeben

Eigenschaft Erläuterung Standardeinstellung
Enabled Anzeige der Track Informationen Aktiviert
Show Name Name des Tracks Aktiviert
Show name on each segment Name des Tracks für jedes Segment Aktiviert
Thickness Linienstärke 8
Text Baseline Text Grundlinie Top

 Top Oben –
 Middle Mittig –
 Bottom Unten –

Text Alignment Textausrichtung Left
 Left Linksbündig –
 Center Zentriert –
 Right Rechtsbündig –

Text Font Size Schriftgröße 48
Text Margin Abstand des Textes zum Rahmen –

 Left Links 0
 Right Rechts 0
 Top Oben 0
 Bottom Unten 0
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8.8.1.5 Close-Gap
► Auf Close-Gap klicken
► Kontrollkästchen Track Close-Gap Info aktivieren, um die Ent-

fernung vom Startpunkt bis zum Endpunkt des Tracks einzublen-
den

ODER
► Kontrollkästchen Track Close-Gap Info deaktivieren, um die

Entfernung vom Startpunkt bis zum Endpunkt des Tracks auszu-
blenden

► Bei Bedarf den Wert im Eingabefeld Thickness ändern
► Eine Farbe im Dropdown-Menü Brush auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► Kontrollkästchen Show Text aktivieren, um den Text einzublen-

den
ODER
► Kontrollkästchen Show Text deaktivieren, um den Text auszu-

blenden
► Auf die Schaltflächen von Text Baseline und Text Alignment

klicken, um die Ausrichtung des Textes auszuwählen
► Voreingestellten Wert im Dropdown-Menü Text Font Size aus-

wählen
ODER
► In das Eingabefeld Text Font Size einen Wert eingeben

Eigenschaft Erläuterung Standardeinstellung
Track Close-Gap Info Anzeige der Entfernung vom Startpunkt bis zum

Endpunkt des Tracks
Aktiviert

Thickness Linienstärke 8
Brush Schriftfarbe LightSkyBlue
Show Text Anzeige des Textes Aktiviert
Text Baseline Text Grundlinie Bottom

 Top Oben –
 Middle Mittig –
 Bottom Unten –

Text Alignment Textausrichtung Center
 Left Linksbündig –
 Center Zentriert –
 Right Rechtsbündig –

Text Font Size Schriftgröße 48
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8.8.1.6 Station
► Auf Station klicken
► Kontrollkästchen Show Name aktivieren, um den Namen der

Station einzublenden
ODER
► Kontrollkästchen Show Name deaktivieren, um den Namen der

Station auszublenden
► Kontrollkästchen Show name on each segment aktivieren, um

den Namen der Station an jedem Segment einzublenden
ODER
► Kontrollkästchen Show name on each segment deaktivieren,

um den Namen an jeder Station auszublenden
► Bei Bedarf den Wert im Eingabefeld Thickness ändern
► Auf die Schaltflächen von Text Baseline und Text Alignment

klicken, um die Ausrichtung des Textes auszuwählen
► Voreingestellten Wert im Dropdown-Menü Text Font Size aus-

wählen
ODER
► In das Eingabefeld Text Font Size einen Wert eingeben
► In die Eingabefelder Text Margin Werte für die Abstände des

Textes zum Rahmen eingeben

Eigenschaft Erläuterung Standardeinstellung
Show Name Anzeige des Namens der Station Aktiviert
Show name on each segment Anzeige des Namens der Station an jedem Seg-

ment
Deaktiviert

Thickness Linienstärke 8
Text Baseline Text Grundlinie Top

 Top Oben –
 Middle Mittig –
 Bottom Unten –

Text Alignment Textausrichtung Left
 Left Linksbündig –
 Center Zentriert –
 Right Rechtsbündig –

Text Font Size Schriftgröße 48
Text Margin Abstand des Textes zum Rahmen –

 Left Links 0
 Right Rechts 0
 Top Oben 0
 Bottom Unten 0
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8.8.1.7 Part
► Auf Part klicken
► Kontrollkästchen Dimensions Enabled aktivieren, um die Ab-

messungen des Parts einzublenden
ODER
► Kontrollkästchen Dimensions Enabled deaktivieren, um die Ab-

messungen des Parts auszublenden
► Eine Farbe im Dropdown-Menü Dimensions Brush auswählen
Weitere Informationen dazu finden Sie im Kapitel „Dropdown-Menü
Brush | Color“, [Seite 376].
► Voreingestellten Wert im Dropdown-Menü Dimensions Marker

Font Size auswählen
ODER
► In das Eingabefeld Dimensions Marker Font Size einen Wert ein-

geben
► Bei Bedarf die Werte in den Eingabefeldern Part Dimensions

Marker Label Modulo, Dimensions Marker Size und Dimensions
Thickness ändern

Eigenschaft Erläuterung Standardeinstellung
Dimensions Enabled Anzeige der Abmessungen des Parts Aktiviert
Dimensions Brush Farbe der Abmessungen AliceBlue
Dimensions Marker Font Size Schriftgröße für die Abmessungen an der Markie-

rung
26

Part Dimensions Marker Label
Modulo

Intervall für die Anzeige der Beschriftung der Part
Abmessungen an der Markierung

2

Dimensions Marker Size Länge der Markierung der Abmessungen 30
Dimensions Thickness Breite der Markierung der Abmessungen 8
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8.8.2 General
Im Reiter General können Sie allgemeine Einstellungen vornehmen.

8.8.2.1 Common

HINWEIS
Parameter Common nicht verändern
Die Parameter Common sollten nicht geändert werden, um Kom-
munikationsfehler zu vermeiden.

Wenn die Parameter Common doch geändert werden müssen, ge-
hen Sie wie folgt vor:

► Auf den Reiter General klicken
► Auf Common klicken
► Bei Bedarf den Wert im Eingabefeld CoE Update Intervall [ms]

ändern
► Kontrollkästchen Cycle Update Info Server aktivieren
ODER
► Kontrollkästchen Cycle Update Info Server deaktivieren
► In das Eingabefeld Snapshot Default Path einen Speicherort für

die Momentaufnahmen eingeben
ODER
► Auf Browse klicken, um das Dialogfenster Browse For Folder zu

öffnen und einen Speicherort für die Momentaufnahmen aus-
wählen

Eigenschaft Erläuterung Standardeinstellung
CoE Update Intervall [ms] CoE Aktualisierungsintervall 50
Cycle Update Info Server Zyklusaktualisierung-Infoserver Deaktiviert

EtherCAT Description hinzufügen
► Auf die Schaltfläche + klicken, um einen Dateipfad hinzuzufügen
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EtherCAT Description entfernen
► Auf einen Dateipfad klicken, der entfernt werden soll
► Auf die Schaltfläche x klicken, um den ausgewählten Dateipfad

zu entfernen
Der Dateipfad wird aus der Liste entfernt.
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8.8.2.2 Configurator
Die Default Configuration legt standardmäßig einen Part und einen
Track mit allen notwendigen Einstellungen an. Diese Einstellung ist
hilfreich, wenn Sie ein geschlossenes XTS System mit dem XTS
Configurator konfigurieren möchten. Wenn Sie überwiegend mit
Track Management arbeiten, sollte diese Einstellung deaktiviert wer-
den.

► Auf Configurator klicken
► Kontrollkästchen Default Configuration aktivieren, um ein ge-

schlossenes System zu konfigurieren
ODER
► Kontrollkästchen Default Configuration deaktivieren, um ein

System mit Track Management zu konfigurieren
► Kontrollkästchen Show Advanced Settings aktivieren, um er-

weiterte Einstellungen einzublenden
ODER
► Kontrollkästchen Show Advanced Settings deaktivieren, um er-

weiterte Einstellungen auszublenden

Eigenschaft Erläuterung Standardeinstellung
Default Configuration Vereinfacht die Konfiguration von Parts und Tracks

in einem geschlossenem XTS System mit dem
XTS Configurator

Aktiviert

Show Advanced Settings Anzeige der erweiterten Einstellungen Deaktiviert
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8.8.2.3 Simulation Builder
Die Default Configuration legt standardmäßig einen Part und einen
Track mit allen notwendigen Einstellungen an. Diese Einstellung ist
hilfreich, wenn Sie ein geschlossenes XTS System mit dem XTS Si-
mulation Builder konfigurieren möchten. Wenn Sie überwiegend mit
Track Management arbeiten, sollte diese Einstellung deaktiviert wer-
den.

► Auf Simulation Builder klicken
► Kontrollkästchen Default Configuration aktivieren, um ein ge-

schlossenes System zu konfigurieren
ODER
► Kontrollkästchen Default Configuration deaktivieren, um ein

System mit Track Management zu konfigurieren
► Kontrollkästchen Show Introduction aktivieren, um den Will-

kommensbildschirm einzublenden
ODER
► Kontrollkästchen Show Introduction deaktivieren, um den Will-

kommensbildschirm auszublenden

Eigenschaft Erläuterung Standardeinstellung
• Default Configuration Vereinfacht die Konfiguration von Parts und Tracks

in einem geschlossenen XTS System mit dem XTS
Simulation Builder

Aktiviert

Show Introduction Anzeige des Willkommensbildschirms im Simulati-
on Builder

Aktiviert
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8.8.3 Dialogfenster Options… schließen
Das Dialogfenster Options… lässt sich auf drei unterschiedliche
Weisen schließen.

8.8.3.1 Save & Close
Mit Save & Close werden alle Einstellungen dauerhaft gespeichert.

Sofortige Verwendung im XTS Tool Window
Die Einstellungen werden nach dem Speichern im XTS Tool Win-
dow übernommen. In anderen Tools werden die Einstellungen erst
nach einem Neustart übernommen.

► Auf Save & Close klicken, um die Einstellungen dauerhaft zu
speichern

Das Dialogfenster Options… schließt sich.

8.8.3.2 Close
Mit Close werden die aktualisierten Einstellungen im Dialogfenster
Options… temporär gespeichert. Bei einem erneuten Öffnen des
Dialogfensters Options… sind diese Einstellungen noch vorhanden.

HINWEIS
Einstellungen sicher speichern
Achten Sie darauf, dass Ihre Einstellungen nicht versehentlich
gelöscht oder gespeichert werden.
Nutzen Sie zum Speichern der aktuellen Einstellungen die
Schaltfläche Save  & Close, um ein versehentliches Löschen
durch das Beenden von TwinCAT zu vermeiden.
Nutzen Sie zum Löschen der aktualisierten Einstellungen die
Schaltfläche Cancel, um ein versehentliches Speichern zu ver-
meiden.

► Auf Close klicken, um das Dialogfenster Options… zu schließen
ODER
► Auf x klicken, um das Dialogfenster Options… zu schließen
Die Einstellungen werden temporär gespeichert und sind so lange
verfügbar bis TwinCAT beendet wird.
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8.8.3.3 Cancel
Mit Cancel werden alle aktualisierten und bisher noch nicht mit Sa-
ve & Close gespeicherten Einstellungen gelöscht.

► Mit Cancel abbrechen
Alle bisher noch nicht mit Save & Close gespeicherten Einstellungen
werden gelöscht und sind bei einem erneuten Öffnen des Dialog-
fensters Options… nicht mehr verfügbar.
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8.8.4 Dropdown-Menü Brush | Color
Im Dropdown-Menü Brush | Color haben Sie zwei Möglichkeiten ei-
ne Farbe einzustellen:
• eine vordefinierte Farbe im Reiter System auswählen
• eine Farbe im Reiter Custom definieren

8.8.4.1 System
Im Bereich System stehen Ihnen 141 vordefinierte Farben zur Aus-
wahl. 

Den Namen der Farbe einblenden
Wenn Sie den Mauszeiger über die Farbe bewegen, wird Ihnen der
Name der Farbe eingeblendet.

► Das Dropdown-Menü öffnen

► Auf den Reiter System klicken
► Farbe im Dropdown-Menü System auswählen
Nach Auswahl der gewünschten Farbe schließt sich das Dropdown-
Menü automatisch.
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8.8.4.2 Custom
Im Bereich Custom haben Sie die Möglichkeit eine Farbe zu definie-
ren. 

► Das Dropdown-Menü öffnen

► Auf den Reiter Custom klicken, um den Einstellbereich Custom
einzublenden

Position Erläuterung
1 Auswahlwerkzeug im Auswahlbereich
2 Auswahlbereich
3 Farbregler
4 Eingabefelder und Regler für RGB-Farbwerte
5 Eingabefeld und Regler für die Deckkraft
6 Eingabefeld für HEX-Farbcode
7 Anzeigebereich der definierten Farbe

Der Einstellbereich Custom wird eingeblendet.
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Volltonfarbe einstellen
► Farbe mit dem Auswahlwerkzeug [1] im Auswahlbereich [2] und

dem Farbregler [3] definieren
► In die Eingabefelder R, G und B [4] Werte eingeben, um die Far-

be zu definieren
ODER
► Mit den Reglern R, G und B [4] Werte für die Farbe einstellen
► In das Eingabefeld A [5] einen Wert für die Deckkraft eingeben
ODER
► Mit dem Regler A [5] die Deckkraft einstellen

HEX-Farbcode eingeben
► In das Eingabefeld [6] einen Code für die HEX-Farbe eingeben

► Außerhalb des Einstellbereichs klicken, um das Dropdown-Menü
zu schließen
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8.8.5 Positionierung und Deckkraft
Standardmäßig öffnet sich das Dialogfenster Options… in der Mitte
des XTS Tools. Sie haben die Möglichkeit das Dialogfenster mit
Schaltflächen an verschiedenen Stellen zu platzieren und die Deck-
kraft des Dialogfensters einzustellen.
► Mit der rechten Maustaste auf die Kopfzeile des Dialogfensters

klicken, um das Kontextmenü aufzurufen
► Auf Dialog Settings klicken

Das Dialogfenster Dialog Settings öffnet sich.

8.8.5.1 Bedienelemente
Die Auflistung zeigt die wichtigsten Bedienelemente:

Oben links
Richtet das Dialogfenster oben links im geöffneten XTS Tool aus.

Oben
Richtet das Dialogfenster oben über die gesamte Breite des geöff-
neten XTS Tools aus.

Oben rechts
Richtet das Dialogfenster oben rechts im geöffneten XTS Tool aus.

Links
Richtet das Dialogfenster links über die gesamte Höhe des geöffne-
ten XTS Tools aus.

Mittig
Richtet das Dialogfenster mittig im geöffneten XTS Tool aus.

Rechts
Richtet das Dialogfenster rechts über die gesamte Höhe des geöff-
neten XTS Tools aus.

Unten links
Richtet das Dialogfenster unten links im geöffneten XTS Tool aus.

Unten
Richtet das Dialogfenster unten über die gesamte Breite des geöff-
neten XTS Tools aus.

Unten rechts
Richtet das Dialogfenster unten rechts im geöffneten XTS Tool aus.
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Regler für die Deckkraft
Stellt die Deckkraft für das Dialogfenster ein.

► Auf eine Schaltfläche klicken, um die Ausrichtung für das Dialog-
fenster einzustellen

► Mit dem Regler Opacity die Deckkraft für das Dialogfenster ein-
stellen
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9 XTS HMI Controls
Zur Installation und Verwendung der XTS HMI Controls benötigen
Sie die folgenden Softwarepakete:

Software Version
TE2000 HMI Engineering 1.12.748 oder höher
TF2000 HMI Server 1.12.748 oder höher
Beckhoff.TwinCAT.HMI.XTS.Controls 3.2107.1 oder höher
Beckhoff.TwinCAT.HMI.XTS 3.2107.1 oder höher
TF5850 TC3 XTS Extension 3.21.700.0 oder höher
TwinCAT 3.1 3.1.4024.0 oder höher

Systemvoraussetzungen für die XTS HMI Controls
Betriebssystem Version
Windows 10 oder höher

9.1 Installation des NuGet-Packages
Nachdem Sie erfolgreich TF5850 TC3 XTS Extension und TE2000
HMI Engineering installiert und ein neues HMI-Projekt geöffnet ha-
ben, können Sie die XTS HMI Controls zu Ihrem Projekt hinzufügen.
Um die HMI Steuerelemente hinzuzufügen, müssen Sie die erfor-
derlichen NuGet-Pakete hinzufügen und konfigurieren.

► Im Solution Explorer mit der rechten Maustaste auf TcHmiPro-
ject klicken, um das Kontextmenü aufzurufen

► Im Kontextmenü auf Manage NuGet Packages … klicken

Im Projektfenster öffnet sich der Reiter NuGet: TcHmiProject.
► TwinCAT XTS Technology im Dropdown-Menü Package sour-

ce auswählen
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► Auf Browse klicken
► Auf Beckhoff.TwinCAT.HMI.XTS.Controls klicken

Sie finden das HMI XTS Paket und das HMI XTS Controls Paket
auch in Ihrem Explorer unter folgendem Dateipfad:
C:\TwinCAT\Functions\TF5850-TC3-XTS-Technology\TcXts-
HmiControl.

► Mit Install bestätigen, um das Beckhoff.TwinCAT.HMI.XTS.Con-
trols Paket zu installieren

Mit der Installation des Beckhoff.TwinCAT.HMI.XTS.Controls Pakets
wird automatisch auch das Beckhoff.TwinCAT.HMI.XTS Paket in-
stalliert.

Das Dialogfenster Preview Changes öffnet sich.
► Mit OK bestätigen

Nach der Installation ist der XTS View unter XTS Controls in der
Toolbox verfügbar.
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9.2 Server Extension Konfiguration
Um ein XTS System in der XTS View zu sehen, müssen Sie eine
Verbindung zum Ziel-PC konfigurieren. Auf dem Ziel-PC muss sich
ein XTS Projekt im Run Mode befinden. Eine lokale Verbindung ist
vorkonfiguriert.

► Solution Explorer > TcHmiProject > Server ausklappen
► Doppelklick auf TcXtsHmiServerExtension

Im Projektfenster öffnet sich der Reiter TwinCAT HMI Server Confi-
guration.
► Auf TcXtsHmiServerExtension klicken
► TARGET_SYSTEMS ausklappen
► Auf + Add klicken

Namen zur besseren Übersicht vergeben
Der Name für die Verbindung hat keine Funktion. Beckhoff empfiehlt
die Vergabe eines Namens, um den Ziel-PC zu identifizieren.

Das Dialogfenster Add öffnet sich.
► In das Eingabefeld Name einen Namen für die Verbindung ein-

geben
► In das Eingabefeld NETID die AMS Net Id des Ziel-PCs einge-

ben, mit dem die Verbindung aufgebaut werden soll
► Bei Bedarf den Wert im Eingabefeld UPDATE_RATE anpassen,

um die Aktualisierungszeit einzustellen
► Mit Add bestätigen
► Weitere Verbindungen auf die gleiche Weise hinzufügen

► Mit Accept bestätigen, um die Konfiguration abzuschließen
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9.2.1 Eingaben bearbeiten
Sie haben die Möglichkeit, Ihre Eingaben zu entfernen oder zu bear-
beiten:

► Auf den Namen der Verbindung klicken, um die Eingabefelder
auszuklappen

► Auf die Schaltfläche x klicken, um die Verbindung zu entfernen
ODER
► In die Eingabefelder von NETID und UPDATE_RATE klicken,

um die Eingaben zu bearbeiten

► Auf die Schaltfläche zum Bearbeiten klicken
Das Dialogfenster Rename öffnet sich.
► In das Eingabefeld New name einen neuen Namen eingeben
► Mit Rename bestätigen
ODER
► Auf die Schaltfläche x klicken, um den Vorgang abzubrechen

und um das Dialogfenster zu schließen
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9.3 XTS View Konfiguration
Nach der Installation des NuGet-Packages und der Server Extensi-
on-Konfiguration kann nun eine XTS View Control-Instanz hinzuge-
fügt werden und anschließend eingestellt werden.

9.3.1 XTS View hinzufügen

► Toolbox > XTS Controls ausklappen
► Die Taste Strg gedrückt halten, um XTS View aus der Toolbox

in die Desktop View zu ziehen

Wenn sich das XTS System im Run-Modus befindet, wird das Sys-
tem sofort im gleichen Layout wie im XTS Viewer angezeigt. Befin-
det sich das XTS System nicht im Run Mode, bleibt die Desktop
View leer.
Wenn Sie eine Verbindung zu einem anderen Ziel-PC haben, wird
das System des Ziel-PCs angezeigt, nachdem der TargetName des
Controls geändert wurde. Befindet sich das XTS System auf dem
Ziel-PC nicht im Run Mode, bleibt die Desktop View leer.
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9.3.2 XTS View-Eigenschaften
Zusätzlich zu den üblichen Layout-Eigenschaften wie Rahmen, Lay-
out und Hintergrundbild unterstützt der Kontroller einige spezifische
Eigenschaften.

► Im Menü View auf den Menüpunkt Properties Window klicken

XtsView muss ausgewählt sein
Das XtsView-Element muss ausgewählt sein, um die XTS HMI
View-Eigenschaften zu ändern. Das Fenster Properties bleibt leer,
wenn das XtsView-Element nicht ausgewählt ist.

Das Properties Window öffnet sich.
► Im Projektfenster auf das XtsView-Element klicken
Im Fenster Properties werden die verfügbaren Eigenschaften ange-
zeigt und können nach Bedarf angepasst werden.
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9.3.2.1 Einstellungen zurücksetzen
Bei dem XTS HMI Controller haben Sie die Möglichkeit, geänderte
Einstellungen auf die voreingestellten Einstellungen zurückzuset-
zen.

Beispiel anhand der Einstellungen unter System Layout
An den Einstellungen unter System Layout wird beispielhaft gezeigt,
woran Sie erkennen können, bei welchen Parametern Sie Werte ge-
ändert haben.

Nachdem Sie Einstellungen in einem Dropdown-Menü ausgewählt
oder Werte in die Eingabefelder eingeben haben, ändert sich die
Schriftstärke des Parameters und das Kontrollkästchen hinter dem
Eingabefeld wird aktiviert.

Standardeinstellungen Einstellungen geändert

• Schrift normal
• kein Element hinzugefügt
• Kontrollkästchen deaktiviert

• Schrift fett
• ein Element hinzugefügt
• Kontrollkästchen aktiviert

► Properties > System Layout ausklappen
► Auf das aktivierte Kontrollkästchen PartTransformations kli-

cken

► Im Pop-up-Menü auf Reset klicken
Die bisherigen Einstellungen werden gelöscht und auf die voreinge-
stellten Werte zurückgesetzt.
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9.3.2.2 Formel verknüpfen
Bei dem XTS HMI Controller haben Sie die Möglichkeit, Eingabefel-
der umzuwandeln, um Formeln einzugeben.

Beispiel anhand der Einstellungen unter System Layout
An den Einstellungen unter System Layout wird beispielhaft gezeigt,
wie Sie das Eingabefeld umwandeln können.

Nachdem Sie Einstellungen in einem Dropdown-Menü ausgewählt
oder Werte eingeben haben, verändert sich die Schriftstärke des
Parameters und das Kontrollkästchen hinter dem Eingabefeld wird
aktiviert.

Standardeinstellungen Einstellungen geändert

• Eingabefeld Standard • Eingabefeld umgewandelt

► Auf das deaktivierte Kontrollkästchen klicken

► Im Pop-up-Menü auf Create function binding klicken
Das bisherige Eingabefeld wird umgewandelt und ein Eingabefeld
für eine Funktion wird eingefügt.

► In das Eingabefeld PartTransformations eine Funktion eingeben
ODER
► Auf die Schaltfläche klicken, um den Multiline editor zu öffnen

Das Dialogfenster Multiline editor öffnet sich, wenn Sie auf die
Schaltfläche geklickt haben.
► Eine Funktion in das Eingabefeld eingeben
► Mit OK bestätigen
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9.3.2.3 Colors
► Properties > Colors ausklappen
► In das Eingabefeld ModuleSelectionColor klicken, um die Farbe

für die Modulauswahl einzustellen
► In das Eingabefeld MoverSelectionColor klicken, um die Farbe

für die Moverauswahl einzustellen
Der Einstellbereich wird eingeblendet.
Weitere Informationen dazu finden Sie im Kapitel „Colors“, [Seite
 426].

► In das Eingabefeld BackgroundColor klicken, um die Farbe für
den Hintergrund einzustellen

► In das Eingabefeld BorderColor klicken, um die Farbe für den
Rahmen einzustellen

Der Einstellbereich wird eingeblendet.
Weitere Informationen dazu finden Sie im Kapitel „Colors“, [Seite
 426].

Die Tabelle zeigt die Standardeinstellungen der Parameter für die
Colors-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
ModuleSelectionColor Farbe der Modulauswahl Solid Color
• None Keine Farbe –
• Theme Grafik –
• Solid Color Volltonfarbe #FF000000
MoverSelectionColor Farbe der Moverauswahl Solid Color
• None Keine Farbe –
• Theme Grafik –
• Solid Color Volltonfarbe #FF000000
BackgroundColor Hintergrundfarbe Theme
• None Keine Farbe –
• Theme Grafik –
• Solid Color Volltonfarbe –
• Gradient Color Farbverlauf –
BorderColor Rahmenfarbe Theme
• None Keine Farbe –
• Theme Grafik –
• Solid Volltonfarbe –
• Gradient Color Farbverlauf –
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9.3.2.4 Connection
► Properties > Connection ausklappen
► In das Eingabefeld TargetName den Ziel-PC eingeben
ODER
► Auf die Schaltfläche klicken, um den Multiline editor zu öffnen
► Bei Bedarf den Wert im Eingabefeld RefreshRate anpassen, um

die Aktualisierungsrate einzustellen

Die Tabelle zeigt die Standardeinstellungen der Parameter für die
Connection-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
TargetName Name des Ziel-PCs, spezifizierte Verbindung zum

XTS System
Local

RefreshRate Aktualisierungsrate zur Anpassung an Endgeräte 16
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9.3.2.5 System Layout
Mit dieser Einstellung legen Sie fest, wie Ihr XTS System im HMI
angezeigt wird.

► Properties > SystemLayout ausklappen
► Die Darstellungsoption im Dropdown-Menü Layout auswählen

► Auf … von InfoImages klicken

XtsInfoImages können in den Kontroller eingesetzt werden und sind
mit dem XTS System zoombar und verschiebbar. XtsInfoImages
werden als Array eingesetzt.
Das Dialogfenster XtsView | InfoImages öffnet sich.
► Auf Add klicken
Ein XtsInfoImage wird hinzugefügt. Die Eigenschaften des XtsInfo-
Images können im Bereich Properties eingestellt werden.

► General ausklappen
► Auf die Schaltfläche Image klicken, um einen Dateipfad für die

Grafik auszuwählen
► Die Darstellung im Dropdown-Menü View auswählen
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Referenzpunkt und Ursprung
Referenzpunkt für die Grafik ist die linke obere Ecke. Der Ur-
sprung bezieht sich auf das zuerst hinzugefügte Modul im XTS
Configurator.

► Layout ausklappen
► In die Eingabefelder PositionX und PositionY Werte für die Posi-

tion eingeben
► In die Eingabefelder Width und Height Werte für die Größe ein-

geben
► In das Eingabefeld Rotation einen Drehwinkel eingeben
► Kontrollkästchen Visible aktivieren, um die Grafik einzublenden
ODER
► Kontrollkästchen Visible deaktivieren, um die Grafik auszublen-

den
► In das Eingabefeld zIndex einen Wert eingeben
Weitere Informationen dazu finden Sie im Kapitel „Allgemeine Ein-
stellungen“, [Seite 424].

► Mit OK bestätigen
Das Dialogfenster XtsView | InfoImages schließt sich.

► Auf … von PartTransformations klicken

Part Transformations können in den Kontroller eingesetzt werden
und bestimmen das XTS Layout. Sie können das Layout für jeden
XTS Part festlegen. Part Transformations werden als Array einge-
setzt.
Das Dialogfenster XtsView | PartTransformations öffnet sich.
► Auf Add klicken
Eine Part Transformation wird hinzugefügt. Die Eigenschaften der
Part Transformation können im Bereich Properties eingestellt wer-
den.
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► General ausklappen
► In die Eingabefelder PartIndex und Rotation Werte eingeben
► Die Darstellungsoption im Dropdown-Menü PartSide auswählen

► X-Transformation ausklappen
► In die Eingabefelder Offset, ValueScale und AxisBinding Werte

eingeben
► Y-Transformation ausklappen
► In die Eingabefelder Offset, ValueScale und AxisBinding Werte

eingeben

► Mit OK bestätigen
Das Dialogfenster XtsView | PartTransformations schließt sich.
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Die Tabelle zeigt die Standardeinstellungen der Parameter für die
System Layout-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
Layout Ansicht des Systems SystemView
• SystemView Ansicht des Systems, wie zuvor im XTS Configurator

konfiguriert
–

• InvertedSystemView Ansicht des Systems, wie zuvor im XTS Configurator
konfiguriert, jedoch von der anderen Systemseite

–

• Custom Ansicht des Systems, die manuell in den PartTranfor-
mation-Eigenschaften konfiguriert wird

–

InfoImages …
 General

• Image Dateipfad für die Grafik –
• View Ansicht des Systems SystemView
  • SystemView Ansicht des Systems, wie zuvor im XTS Configurator

konfiguriert
–

  • InvertedSystemView Ansicht des Systems, wie zuvor im XTS Configurator
konfiguriert, jedoch von der anderen Systemseite

–

  • Custom Ansicht des Systems, die manuell in den PartTranfor-
mation-Eigenschaften konfiguriert wird

–

 Layout
• PositionX X-Position der Grafik

Referenzpunkt ist der globale Nullpunkt
0

• PositionY Y-Position der Grafik
Referenzpunkt ist der globale Nullpunkt

0

• Width Breite der Grafik
Standardmäßig wird die Breite der Grafik in px über-
nommen. Durch Eingabe eines Wertes wird die Brei-
te verändert, proportional dazu verändert sich die
Höhe der Grafik. Die Eingabe von Werten bei Width
und Height kann dazu führen, dass die Grafik ver-
zerrt wird.
Einheit: mm, bezogen auf die reale Systemgröße

–

• Height Höhe der Grafik.
Standardmäßig wird die Höhe der Grafik in px über-
nommen. Durch Eingabe eines Wertes wird die Höhe
verändert, proportional dazu verändert sich die Breite
der Grafik. Die Eingabe von Werten bei Width und
Height kann dazu führen, dass die Grafik verzerrt
wird.
Einheit: mm, bezogen auf die reale Systemgröße

–

• Rotation Drehwinkel der Grafik.
Einheit: Grad

0

• Visible Sichtbarkeit des Werkzeugs  True
  •  True Kontrollkästchen aktiviert –
  •  False Kontrollkästchen deaktiviert –
• zIndex Z-Position der Grafik. Liefert Informationen über die

Aktualisierung der Grafik.
1000
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Eigenschaft Erläuterung Standardeinstellung
PartTransformations

 General
• PartIndex Index des konfigurierten Parts 0
• Rotation Drehwinkel des Parts.

Einheit: Grad
0

• PartSide Darstellungsseite des Parts Default
  • Default Standardmäßige Verwendung der Ansicht, die in den

Layout-Eigenschaften definiert ist
–

  • Front Vorderseite –
  • Back Rückseite –

 X-Transformation
• Offset Konfiguration des X-Versatzes des Parts.

Einheit: mm, bezogen auf die reale Systemgröße
0

• ValueScale X-Skalierung des Achsen-Offsets, wenn eine X-Ach-
sen-Bindung verwendet wird.

1

• AxisBinding Einbindung eines TwinCAT-NCs zur Transformation
eines X-Versatzes, beispielsweise um eine Schal-
tachse darzustellen.
Einheit: mm, bezogen auf die reale Systemgröße

–

 Y-Transformation
• Offset Konfiguration des Y-Versatzes des Parts.

Einheit: mm, bezogen auf die reale Systemgröße
0

• ValueScale Y-Skalierung des Achsen-Offsets, wenn eine Y-Ach-
sen-Bindung verwendet wird

1

• AxisBinding Einbindung eines TwinCAT-NCs zur Transformation
eines Y-Versatzes, beispielsweise um eine Schal-
tachse darzustellen.
Einheit: mm, bezogen auf die reale Systemgröße

–
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9.3.2.6 Mover Layout
Mit dem Mover Layout können Sie sich personalisierte Werkzeuge
in Form von Bildern oder Text auf einem Mover anzeigen lassen.
Das Mover Layout wird als Array eingesetzt.

► Properties > Mover Layout ausklappen
► Auf … von Tools klicken

Das Dialogfenster XtsView | Tools öffnet sich.
► Auf Add klicken
Ein XTS Tool wird hinzugefügt. Die Eigenschaften des XTS Tools
können im Bereich Properties eingestellt werden.

► General ausklappen
► Die Darstellungsoption im Dropdown-Menü Tooltype auswählen

► Die Darstellungsoption im Dropdown-Menü MoverSide auswäh-
len

► Image ausklappen
► Auf die Schaltfläche ImageSource klicken, um einen Dateipfad

für die Grafik auszuwählen
► In die Eingabefelder ImageWidth und ImageHeight Werte einge-

ben
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► Mover Identification ausklappen
► Die Darstellungsoption im Dropdown-Menü MoverIdentification-

Mode auswählen

► In das Eingabefeld MoverIdentification die Mover ID oder den
MoverIndex eingeben

ODER
► Auf die Schaltfläche klicken, um den Multiline editor zu öffnen

► Text ausklappen
► Den Texttyp im Dropdown-Menü TextType auswählen

► In das Eingabefeld CustomText einen Text eingeben
ODER
► Auf die Schaltfläche klicken, um den Multiline editor zu öffnen
► Auf … von TextOptions klicken
Das Dialogfenster TextOptions öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „TextOptions“,
[Seite 424]„Allgemeine Einstellungen“, [Seite 424].

► Transformation ausklappen
► In die Eingabefelder Position X, Position Y, Width, Height und

Rotation Werte eingeben
► Kontrollkästchen Visible aktivieren, um den Text einzublenden
ODER
► Kontrollkästchen Visible deaktivieren, um den Text auszublen-

den
► In das Eingabefeld zIndex einen Wert eingeben
Weitere Informationen dazu finden Sie im Kapitel „Allgemeine Ein-
stellungen“, [Seite 424].
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► Mit OK bestätigen
Das Dialogfenster TextOptions schließt sich.

Die Tabelle zeigt die Standardeinstellungen der Parameter für die
Mover Layout-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
Tools …

 General
• ToolType Art des Werkzeugs Image
   • Image Grafik –
   • Text Text –
• MoverSide Seite des Movers, auf der das Werkzeug dargestellt

wird
Front

   • Front Vorderseite –
   • Back Rückseite –

 Image
• ImageSource Dateipfad der Grafik, falls der ToolType Image aus-

gewählt ist
–

• ImageWidth Breite der Grafik, falls der ToolType Image ausge-
wählt ist
Standardmäßig wird die Breite der Grafik in px über-
nommen. Durch Eingabe eines Wertes wird die Brei-
te verändert, proportional dazu verändert sich die
Höhe der Grafik. Die Eingabe von Werten bei Width
und Height kann dazu führen, dass die Grafik ge-
staucht wird.
Einheit: mm, bezogen auf die reale Systemgröße

–

• ImageHeight Höhe der Grafik, falls der ToolType Image ausge-
wählt ist
Standardmäßig wird die Höhe der Grafik in px über-
nommen. Durch Eingabe eines Wertes wird die Höhe
verändert, proportional dazu verändert sich die Breite
der Grafik. Die Eingabe von Werten bei Width und
Height kann dazu führen, dass die Grafik gestaucht
wird.
Einheit: mm, bezogen auf die reale Systemgröße

–

 MoverIdentification
• MoverIdentificationMode Festlegung, wie ein Mover oder eine Mover-Gruppe

definiert wird
All

   • All Alle Mover auf dem System –
   • MoverId Erfordert eine Eingabe der Mover ID im Eingabefeld

von MoverIdentification
–

   • MoverIndex Erfordert eine Eingabe des Mover Index im Eingabe-
feld von MoverIdentification

–

• MoverIdentification Eingabefeld für die MoverId oder den MoverIndex,
entsprechend der ausgewählten Eigenschaft bei Mo-
verIdentificationMode

–
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Eigenschaft Erläuterung Standardeinstellung
 Text

• TextType Eigenschaften des Textes, falls der ToolType Text
ausgewählt ist
Art des Textknotens, wenn der ToolType Text ausge-
wählt ist.

Custom

   • Custom Benutzerdefiniert –
   • MoverId Mover ID –
   • MoverIndex Mover Index –
   • MoverPosition Mover Position –
• CustomText Eingabefeld für Text, falls der ToolType Text und der

TextType Custom ausgewählt sind
–

• TextOptions Eigenschaften für die Textgestaltung …
 Transformation

• OffsetX X-Versatz
Einheit: mm, bezogen auf die reale Systemgröße

0

• OffsetY Y-Versatz
Einheit: mm, bezogen auf die reale Systemgröße

0

• Rotation Drehwinkel
Einheit: Grad

0

• Visible Sichtbarkeit  True
   •  True Kontrollkästchen aktiviert –
   •  False Kontrollkästchen deaktiviert –
• zIndex Z-Position der Grafik, Informationen über die Aktuali-

sierung der Grafik.
11000
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9.3.2.7 Pan & Zoom
► Properties > Pan & Zoom ausklappen
► Kontrollkästchen LockZoomGesture aktivieren, um die Zoom-

funktion einzuschalten
ODER
► Kontrolkästchen LockZoomGesture deaktivieren, um die Zoom-

funktion auszuschalten
► Kontrollkästchen LockPanGesture aktivieren, um die Schwenk-

funktion einzuschalten
ODER
► Kontrollkästchen LockPanGesture deaktivieren, um die

Schwenkfunktion auszuschalten
► In die Eingabefelder Padding Werte eingeben

Die Tabelle zeigt die Standardeinstellungen der Parameter für die
Pan & Zoom-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
LockZoomGesture Zoomfunktion False
LockPanGesture Schwenkfunktion False
Padding Abstand zwischen dem angezeigten XTS System

und dem Rand des Controllers. Standard-Zoom beim
Laden des Controls.
Einheit: px oder %

px

• Linker Abstand 0
• Rechter Abstand 0
• Oberer Abstand 0
• Unterer Abstand 0
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9.3.2.8 Selections
Mit den Selection-Eigenschaften wird definiert, wie Sie die Mover
und Module im Kontroller auswählen können.

► Properties > Selections ausklappen
► Den Auswahlmodus im Dropdown-Menü SelectionMode wählen

► Auf … von MoverSelection klicken

Das Dialogfenster XtsView | MoverSelection öffnet sich.
► Auf Add klicken
Ein XTS Mover wird hinzugefügt. Die Eigenschaften des XTS Mo-
vers können im Bereich Properties eingestellt werden.
Wenn der SelectionMode SingleSelection oder MultiSelection aus-
gewählt ist und durch Anklicken die Liste der ausgewählten Mover
bearbeitet wird, wird das Ereignis onSelectedMoverChanged ausge-
löst.
Der Mover wird in der Farbe dargestellt, die Sie unter MoverSelec-
tionColor eingestellt haben. Weitere Informationen dazu finden Sie
im Kapitel „Colors“, [Seite 389].
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► General ausklappen
► In das Eingabefeld MoverIndex einen Wert eingeben

► Mit OK bestätigen

► Auf … von ModuleSelection klicken

Das Dialogfenster XtsView | ModuleSelection öffnet sich.
► Auf Add klicken
Ein XTS Module wird hinzugefügt. Die Eigenschaften des XTS Mo-
dules können im Bereich Properties eingestellt werden.
Wenn der SelectionMode SingleSelection oder MultiSelection aus-
gewählt ist und durch Anklicken die Liste der ausgewählten Module
bearbeitet wird, wird das Ereignis onSelectedModuleChanged aus-
gelöst.
Das Modul wird in der Farbe dargestellt, die Sie unter ModuleSelec-
tionColor eingestellt haben. Weitere Informationen dazu finden Sie
im Kapitel „Colors“, [Seite 389].

► General ausklappen
► In die Eingabefelder PartIndex und ModuleIndex Werte eingeben
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► Mit OK bestätigen

Die Tabelle zeigt die Standardeinstellungen der Parameter für die
Selections-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
SelectionMode Off
• Off Auswahl eines Moduls oder eines Movers durch

Anklicken nicht möglich
–

• SingleSelection Auswahl eines Moduls oder eines Movers durch
Anklicken. Die Auswahl des zuvor ausgewählten Mo-
duls oder des zuvor ausgewählten Movers wird auf-
gehoben.
Anklicken einer leeren Stelle hebt die Auswahl von
Modulen und Movern auf.
Auslösen des Ereignisses onSelectedMoverChan-
ged.

–

• MultiSelection Auswahl weiterer Module oder Mover durch Ankli-
cken. Bereits ausgewählte Module und Mover wer-
den durch erneutes Anklicken aus der Auswahl ent-
fernt.
Anklicken einer leeren Stelle hebt die Auswahl von
Modulen und Movern auf.
Auslösen des Ereignisses onSelectedMoverChan-
ged.

–

MoverSelection …
 General

• MoverIndex Identifikation des ausgewählten Movers 0
ModuleSelection …

 General
• PartIndex Identifikation des ausgewählten Parts 0
• ModuleIndex Identifikation des ausgewählten Moduls 0
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9.3.2.9 Station Layout
► Properties > StationLayout ausklappen
► Kontrollkästchen DisplayStations aktivieren, um die Station ein-

zublenden
ODER
► Kontrollkästchen DisplayStations deaktivieren, um die Station

auszublenden
► Auf … von StationOptions klicken

Das Dialogfenster StationOptions öffnet sich.
► Layout ausklappen
► In die Eingabefelder Displacement, Thickness und zIndex Werte

eingeben

► Text ausklappen
► Den Text für die Station im Dropdown-Menü Text auswählen

► Auf eine Schaltfläche von TextInfoBarPlacement klicken, um
die Ausrichtung des Textes auszuwählen

► In das Eingabefeld TextDisplacement einen Wert eingeben
► Auf … von TextOptions klicken
Das Dialogfenster TextOptions öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „TextOptions“,
[Seite 424]„Allgemeine Einstellungen“, [Seite 424].
► Mit OK bestätigen
Das Dialogfenster StationOptions schließt sich.
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► Auf … von StationMarkerOptions klicken

Das Dialogfenster StationMarkerOptions öffnet sich.
► Layout ausklappen
► Die Darstellung der Station Endpunkte im Dropdown-Menü Mar-

kerType auswählen

► In die Eingabefelder Size, Thickness und zIndex Werte eingeben
Weitere Informationen dazu finden Sie im Kapitel „Allgemeine Ein-
stellungen“, [Seite 424].

► Text ausklappen
► None im Dropdown-Menü Text auswählen, wenn kein Text an-

gezeigt werden soll
ODER
► StopPosition im Dropdown-Menü Text auswählen, wenn die

Stoppposition angezeigt werden soll
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► In das Eingabefeld TextDisplacement einen Wert eingeben
► Auf … von TextOptions klicken
Das Dialogfenster TextOptions öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „TextOptions“,
[Seite 424]„Allgemeine Einstellungen“, [Seite 424].

► Mit OK bestätigen
Das Dialogfenster StationMarkerOptions schließt sich.
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Die Tabelle zeigt die Standardeinstellungen der Parameter für die
Station Layout-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
DisplayStations Darstellung der Abmessungen True
StationOptions …

 Layout
• Displacement Versatz zwischen InfoBar und der Mitte des Stators 150
• Thickness Dicke der InfoBar 8
• zIndex Z‑Position, Position des visuellen Elements und In-

formationen über die Aktualisierung des visuellen
Elements

1000

 Text
• Text Text für die Station None
   • None Kein Text –
   • StationDescription Beschreibung der Station –
   • StationId Id der Station –
• TextInfoBarPlacement Ausrichtung der InfoBar  left-justified
   •  left-justified Linksbündig –
   •  centered Zentriert –
   •  right-justified Rechtsbündig –
• TextDisplacement Versatz des Textes 10
• TextOptions Eigenschaften für die Textgestaltung …
StationMarkerOptions …

 Layout
• MarkerType Darstellung der Station Endpunkte None
   • None Keine Endpunkte –
   • Diamond Diamant Endpunkte –
   • Tick Haken Endpunkte –
• Size Größe des Endpunkts 20
• Thickness Dicke des Endpunkts 8
• zIndex Z‑Position, Position des visuellen Elements und In-

formationen über die Aktualisierung des visuellen
Elements

Select Type…

 Text
• Text Text für die Station None
   • None Kein Text –
   • StopPosition Stoppposition –
• TextDisplacement Versatz des Textes 20
• TextOptions Eigenschaften für die Textgestaltung …
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9.3.2.10 Dimensions
► Dimensions ausklappen
► Kontrollkästchen DisplayDimensions aktivieren, um die Abmes-

sungen einzublenden
ODER
► Kontrollkästchen DisplayDimensions deaktivieren, um die Ab-

messungen auszublenden
► Kontrollkästchen InvertDimensions aktivieren
ODER
► Kontrollkästchen InvertDimensions deaktivieren
► Auf … von DimensionOptions klicken

Das Dialogfenster DimensionOptions öffnet sich.
► Colors ausklappen
► Auf InfoBarColor oder MarkerColor klicken, um die Farbe ein-

zustellen
Der Einstellbereich wird eingeblendet.
Weitere Informationen dazu finden Sie im Kapitel „Colors“, [Seite
 426].

► Layout ausklappen
► In die Eingabefelder Displacement, Thickness, MarkerThickness

und MarkerSize Werte eingeben
► Auf Select Type… von zIndex klicken
Weitere Informationen dazu finden Sie im Kapitel „zIndex“, [Seite
 428].

► Den Markierungstyp im Dropdown-Menü MarkerType auswählen
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► Text ausklappen
► In die Eingabefelder TextPattern und TextDisplacement Werte

eingeben
► Auf … von TextOptions klicken
Das Fenster TextOptions öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „TextOptions“,
[Seite 424]„Allgemeine Einstellungen“, [Seite 424].

► Mit OK bestätigen
Das Dialogfenster DimensionsOptions schließt sich.
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Die Tabelle zeigt die Standardeinstellungen der Parameter für die
Dimensions-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
DisplayDimensions Darstellung der Abmessungen False
DimensionOptions …

 Colors
• InfoBarColor Farbe, die für die InfoBar definiert

werden kann
#FF000000

• MarkerColor Farbe, die für die Markierung defi-
niert werden kann

#FF000000

 Layout
• Displacement Versatz der Abmessungen 100
• Thickness Dicke der Abmessungen 8
• MarkerType Auswahl des Markierungstyps Tick
   • None Keine Markierung –
   • Diamond Diamant –
   • Tick Haken –
• MarkerThickness Dicke der Markierung 5
• MarkerSize Größe der Markierung 25
• zIndex Z‑Position, Position des visuellen

Elements und Informationen über
die Aktualisierung des visuellen Ele-
ments

1200

 Text
• TextPattern Textmuster für die Beschreibung der

Skalierung des Systems. Bei 1 er-
folgt die Skalierung in 250er Schrit-
ten

2

• TextDisplacement Versatz des Textes 10
• TextOptions Eigenschaften für die Textgestal-

tung
…

InvertDimensions False
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9.3.2.11 InfoBars
► InfoBars ausklappen
► Auf … von InfoBars klicken

Das Dialogfenster XtsView | InfoBars öffnet sich.
► Auf Add klicken
Eine XtsInfoBar wird hinzugefügt. Die Eigenschaften der XtsInfoBar
können im Bereich Properties eingestellt werden.

► Colors ausklappen
Der Einstellbereich wird eingeblendet.
Weitere Informationen dazu finden Sie im Kapitel „Colors“, [Seite
 426].

► General ausklappen
► In die Eingabefelder PartIndex, PartStartPosition und Part-

EndPosition Werte eingeben
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► Layout ausklappen
► In die Eingabefelder InfoBarThickness und InfoBarDisplacement

Werte eingeben
► Kontrollkästchen Visible aktivieren, um die InfoBar einzublenden
ODER
► Kontrollkästchen Visible deaktivieren, um die InfoBar auszu-

blenden
► In das Eingabefeld zIndex einen Wert eingeben

► Marker ausklappen
► Auf … von Marker klicken

Das Dialogfenster Marker öffnet sich.
► Auf Add klicken
Ein XtsInfoBarMarker wird hinzugefügt. Die Eigenschaften des Xts-
InfoBarMarkers können im Bereich Properties eingestellt werden.

► Colors ausklappen
Der Einstellbereich wird eingeblendet.
Weitere Informationen dazu finden Sie im Kapitel „Colors“, [Seite
 426].
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► General ausklappen
► In das Eingabefeld InfoBarPosition einen Wert eingeben

► Layout ausklappen
► Den Markierungstyp im Dropdown-Menü MarkerType auswählen

► In die Eingabefelder MarkerThickness, MarkerSize und zIndex
Werte eingeben

Weitere Informationen dazu finden Sie im Kapitel „zIndex“, [Seite
 428].

► Text ausklappen
► In das Eingabefeld MarkerText einen Text eingeben
ODER
► Auf die Schaltfläche klicken, um den Multiline editor zu öffnen
Weitere Informationen dazu finden Sie im Kapitel „Formel verknüp-
fen“, [Seite 388].
► In das Eingabefeld TextDisplacement einen Wert eingeben
► Auf … von TextOptions klicken
Das Dialogfenster TextOptions öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „TextOptions“,
[Seite 424]„Allgemeine Einstellungen“, [Seite 424].

► Mit OK bestätigen
Das Dialogfenster Marker schließt sich.
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► Text ausklappen
► In das Eingabefeld InfoBarText einen Text eingeben
ODER
► Auf die Schaltfläche klicken, um den Multiline editor zu öffnen
► Auf eine Schaltfläche von TextPlacement klicken, um die Aus-

richtung des Textes auszuwählen
► In das Eingabefeld TextDisplacement einen Wert eingeben
► Auf … von TextOptions klicken
Das Dialogfenster TextOptions öffnet sich.
Weitere Informationen dazu finden Sie im Kapitel „TextOptions“,
[Seite 424]„Allgemeine Einstellungen“, [Seite 424].

► Mit OK bestätigen
Das Dialogfenster XtsInfoBars schließt sich.
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Die Tabelle zeigt die Standardeinstellungen der Parameter für die
InfoBars-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
InfoBars …

 Colors
• InfoBarColor Farbe, die für die InfoBar definiert werden kann #FF00000

 General
• PartIndex 0
• PartStartPosition Punkt, an dem der Part beginnt 10
• PartEndPosition Punkt, an dem der Part endet 200

 Layout
• InfoBarThickness Dicke der InfoBar 8
• InfoBarDisplacement Versatz des Textes 100
• Visible Sichtbarkeit des Werkzeugs True
• zIndex Z‑Position, Position des visuellen Elements und In-

formationen über die Aktualisierung des visuellen
Elements

1000

 Marker
Marker …
• MarkerColor Farbe, die für die Markierung definiert werden kann #FF000000
• InfoBarPosition Position der InfoBar 100
• MarkerType Auswahl des Markierungstyps Diamond
   • None Keine Markierung –
   • Diamond Diamant –
   • Tick Haken –
• MarkerThickness Dicke der Markierung 5
• MarkerSize Größe der Markierung 25
• zIndex Z‑Position, Position des visuellen Elements und In-

formationen über die Aktualisierung des visuellen
Elements

1001

• MarkerText Text, der mit der Markierung angezeigt wird –
• TextDisplacement Versatz des Textes 15
• TextOptions Eigenschaften der Textgestaltung …

 Text
• InfoBarText Text, der in der InfoBar dargestellt wird –
• TextPlacement Textausrichtung Left-justified
   •  left-justified Linksbündig –
   •  centered Zentriert –
   •  right-justified Rechtsbündig –
• TextDisplacement Versatz des Textes 15
• TextOptions Eigenschaften der Textgestaltung …
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9.3.2.12 Layout
► Layout ausklappen
► In die Eingabefelder Left, Top, Right, Bottom, Width und Height

Werte eingeben
► Bei Bedarf die Einheit im Dropdown-Menü ändern

► Auf die Schaltfläche klicken, um das Menü zu erweitern

► In das Eingabefeld Opacity einen Wert für die Deckkraft einge-
ben

► Die Sichtbarkeit im Dropdown-Menü Visibility auswählen

► Value im Dropdown-Menü WidthMode auswählen
ODER
► Parent im Dropdown-Menü WidthMode auswählen
► Value im Dropdown-Menü HeightMode auswählen
ODER
► Parent im Dropdown-Menü HeightMode auswählen
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► Auf … von Transform klicken

Sie können dem XtsView  |  Transform verschiedene Transformati-
onsarten hinzufügen. Beim Öffnen des Fensters ist standardmäßig
Rotate ausgewählt. Folgende Transformationen stehen zur Aus-
wahl:
• Rotate
• Scale
• Translate
• Skew
• Origin
• Perspective

Das Dialogfenster XtsView | Transform öffnet sich.
► Die Transformationsart im Dropdown-Menü auswählen, die hin-

zugefügt werden soll
► Auf Add klicken
Die ausgewählte Transformation wird hinzugefügt.
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Die unterschiedlichen Eigenschaften der Transformationen können
im Bereich Properties eingestellt werden.

Rotate
► General ausklappen
► In das Eingabefeld Angle einen Drehwinkel eingeben
► Bei Bedarf die Einheit im Dropdown-Menü ändern
► In die Eingabefelder VectorX, VectorY und VectorZ Werte einge-

ben

Scale
► General ausklappen
► In die Eingabefelder X, Y und Z Werte eingeben

Translate
► General ausklappen
► In die Eingabefelder X, Y und Z Werte eingeben
► Bei Bedarf die Einheit im Dropdown-Menü ändern

Skew
► General ausklappen
► In das Eingabefeld XAngle einen Wert für den horizontalen Nei-

gungswinkel eingeben
► In das Eingabefeld YAngle einen Wert für den vertikalen Nei-

gungswinkel eingeben
► Bei Bedarf die Einheit im Dropdown-Menü ändern

Origin
► General ausklappen
► In die Eingabefelder X, Y und Z Werte eingeben
► Bei Bedarf die Einheit im Dropdown-Menü ändern
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Perspective
► General ausklappen
► In die Eingabefelder Distance, OriginX und OriginY Werte einge-

ben
► Bei Bedarf die Einheit im Dropdown-Menü ändern

Transformation entfernen oder
ändern

Sie haben die Möglichkeit einzelne Transformationen zu entfernen
oder die Reihenfolge der Transformationen zu ändern.

► Die Transformation auswählen, die verschoben oder entfernt
werden soll

► Auf x klicken, um die Transformation zu entfernen
ODER
► Auf die Schaltflächen klicken, um die Transformation schrittwei-

se nach oben oder nach unten zu verschieben

► Mit OK bestätigen
Das Dialogfenster XtsView | Transform schließt sich.
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► In die Eingabefelder MaxWidth, MaxHeight, MinWidth und Min-
Height Werte eingeben

► Bei Bedarf die Einheit im Dropdown-Menü ändern

► In die Eingabefelder GridColumnIndex, GridRowIndex und Zin-
dex Werte eingeben

Weitere Informationen dazu finden Sie im Kapitel „zIndex“, [Seite
 428].

► Auf … von BoxShadow klicken
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Das Dialogfenster XtsView | BoxShadow öffnet sich.
► Auf Add klicken
Eine BoxShadow definition wird hinzugefügt. Die Eigenschaften des
Schattens können im Bereich Properties eingestellt werden.

► Colors ausklappen
Der Einstellbereich wird eingeblendet.
Weitere Informationen dazu finden Sie im Kapitel „Colors“, [Seite
 426].

► General ausklappen
► In das Eingabefeld OffsetX einen Wert für den Abstand des

Schattens in X-Richtung eingeben
► In das Eingabefeld OffsetY Werte einen Wert für den Abstand

des Schattens in Y-Richtung eingeben
► Kontrollkästchen Inset aktivieren
ODER
► Kontrollkästchen Inset deaktivieren
► In das Eingabefeld Blur einen Wert für die Unschärfe des Schat-

tens eingeben
► In das Eingabefeld Spread einen Wert für die Streuweite des

Schattens eingeben
► Bei Bedarf die Einheit im Dropdown-Menü ändern

► Mit OK bestätigen
Das Dialogfenster XtsView | BoxShadow schließt sich.
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Die Tabelle zeigt die Standardeinstellungen der Parameter für die
Layout-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
Left Linker Abstand.

Einheit: px oder %
448

Top Oberer Abstand.
Einheit: px oder %

298

Right Rechter Abstand.
Einheit: px oder %

-

Bottom Unterer Abstand.
Einheit: px oder %

-

Width Breite.
Einheit: px oder %

329

Height Höhe.
Einheit: px oder %

280

Opacity Wert für die Deckkraft 1
Visibility Dropdown-Menü für die Sichtbarkeit Visible
• Visible Sichtbar
• Hidden Versteckt
• Collapsed Eingeklappt
WidthMode Value
• Value Wert -
• Parent Übergeordnet -
HeightMode Value
• Value Wert -
• Parent Übergeordnet -
Transform Transformationsart …
Rotate Rotatorische Verschiebung

 General
• Angle Drehwinkel -
• VectorX Vektor X-Achse -
• VectorY Vektor Y-Achse -
• VectorZ Vektor Z-Achse -
Scale Skalierung

 General
• X Wert für Breite 1
• Y Wert für die Höhe 1
• Z Wert für die Tiefe 1
Translate Translatorische Verschiebung

 General
• X Wert für die Verschiebung in X-Richtung.

Einheit: px oder %
-

• Y Wert für die Verschiebung in Y-Richtung.
Einheit: px oder %

-

• Z Wert für die Verschiebung in Z-Richtung.
Einheit: px oder %

-



XTS HMI Controls

Version: 1.1.1 ─── 423TF5850

Eigenschaft Erläuterung Standardeinstellung
Skew Neigung

 General
• XAngle Winkel für die horizontale Neigung -
• YAngle Winkel für die vertikale Neigung -
Origin Ursprung

 General
• X Wert in X-Richtung -
• Y Wert in Y-Richtung -
• Z Wert in Z-Richtung -
Perspective Perspektivische Verzerrung

 General
• Distance Abstand -
• OriginX Ursprung in X-Richtung -
• OriginY Ursprung in Y-Richtung -
MaxWidth Maximale Breite -
MaxHeight Maximale Höhe -
MinWidth Minimale Breite -
MinHeight Minimale Höhe -
GridColumnIndex Wert für die Gitterspaltenbreite 0
GridRowIndex Wert für die Gitterzeilenhöhe 0
Zindex -
BoxShadow Wert für den Schatten …

 Colors
• Color Farbe des Schattens ##FF000000

 General
• OffsetX Versatz des Schattens in X-Richtung.

Einheit: px oder %
0

• OffsetY Versatz des Schattens in Y-Richtung.
Einheit: px oder %

0

• Inset Einschub False
• Blur Unschärfe des Schattens.

Einheit: px oder %
0

• Spread Streuweite des Schattens.
Einheit: px oder %

0
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Allgemeine Einstellungen
In diesem Kapitel finden Sie weitere Informationen zu den Einstel-
lungen Colors, TextOptions und zIndex.

TextOptions
► Colors ausklappen
Der Einstellbereich wird eingeblendet.
Weitere Informationen dazu finden Sie im Kapitel „Colors“, [Seite
 426].
► Farbe über den Einstellbereich definieren

General
► General ausklappen
► Den Schriftstil im Dropdown-Menü FontStyle auswählen

► Die Schriftstärke im Dropdown-Menü FontWeight auswählen

► In das Eingabefeld FontFamily die Schriftfamilie eingeben
ODER
► Auf die Schaltfläche klicken, um den Multiline editor zu öffnen
► Textausrichtung unter HorizontalAlignment und Vertical-

Alignment auswählen
► In das Eingabefeld FontSize einen Wert für die Schriftgröße ein-

geben
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► Mit OK bestätigen
Das Dialogfenster TextOptions schließt sich.

Die Tabelle zeigt die Standardeinstellungen der Parameter für die
TextOptions-Eigenschaften:

Eigenschaft Erläuterung Standardeinstellung
 Colors

• Color Farbe des Textes Solid Color
   • None Keine Farbe –
   • Theme Grafik –
   • Solid Color Volltonfarbe, RGBA #FF000000

 General
• FontStyle Schriftart Normal
   • Normal Normal –
   • Italic Kursive Schrift –
   • Oblique Schräggestellte Schrift –
   • Auto Automatisch –
• FontWeight Schriftstärke Normal
   • Normal Normal –
   • Bold Fett –
   • Auto Automatisch –
• FontFamily Schriftfamilie –
• HorizontalAlignment Horizontale Textausrichtung Left-justified
   •  Left-justified Linksbündig –
   •  Centered Zentriert –
   •  Right-justified Rechtsbündig –
• VerticalAlignment Vertikale Textausrichtung Bottom
   •  Top Oben –
   •  Middle Zentriert –
   •  Bottom Unten –
• FontSize Schriftgröße 20
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Colors
Einige Einstellbereiche bieten zusätzlich zur Definition einer Vollton-
farbe die Möglichkeit einen Farbverlauf zu definieren. Für die Defini-
tion des Farbverlaufs steht dann ein zusätzlicher Reiter zur Verfü-
gung.

Unterschiedliche Einstellbereiche
Das Einstellen der Farben wird beispielhaft an einem Einstellbereich
mit Farbverlauf dargestellt.

Position Erläuterung
1 Keine Farbe
2 Grafik
3 Volltonfarbe
4* Farbverlauf
5** Eingabefeld für RGB-Farbwerte
6** Eingabefeld für die Deckkraft
7** Farbregler
8** Eingabefeld für HEX-Farbcode
9** Pipette
10*** Farbe 1 des Farbverlaufs
11*** Position von Farbwert 1 des Farbverlaufs [%]
12*** Drehwinkels des Farbverlaufs [°]
13*** Anzeigebereich der definierten Farbe 1 des Farbverlaufs
14*** Anzeigebereich der definierten Farbe 2 des Farbverlaufs
15*** Regler für den Drehwinkel des Farbverlaufs
16*** Farbe 2 des Farbverlaufs
17** Anzeigebereich der zuletzt verwendeten Farben
18** Auswahlbereich
19** Auswahlwerkzeug im Auswahlbereich

* nicht in jedem Einstellbereich vorhanden
** nur im Reiter Volltonfarbe [3] oder im Reiter Farbverlauf [4]

sichtbar
*** nur im Reiter Farbverlauf [4] sichtbar
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Sie haben verschiedene Möglichkeiten eine Farbe für den Hinter-
grund und den Rahmen einzustellen.

Keine Farbe
► Auf die Schaltfläche [1] klicken, um keine Farbe auszuwählen

Grafik verwenden
► Auf die Schaltfläche [2] klicken, um eine Grafik zu verwenden

Volltonfarbe einstellen
► Auf die Schaltfläche [3] klicken, um eine Volltonfarbe einzustel-

len
► Farbe mit dem Auswahlwerkzeug [19] im Auswahlbereich [18]

und dem Farbregler [7] definieren
ODER
► In die Eingabefelder R, G und B [5] Werte eingeben, um die Far-

be zu definieren
► In das Eingabefeld A [6] einen Wert für die Deckkraft eingeben
ODER
► In das Eingabefeld [8] einen Code für die HEX-Farbe eingeben
ODER
► Mit der Pipette [9] eine Farbe auswählen

Farbverlauf einstellen
► Auf die Schaltfläche [4] klicken, um einen Farbverlauf einzustel-

len
► Auf Farbe 1 [17] klicken, um die erste Farbe des Farbverlaufs

einzustellen
► Volltonfarbe einstellen, um die erste Farbe des Farbverlaufs ein-

zustellen
► Auf Farbe 2 [16] klicken, um die zweite Farbe des Farbverlaufs

einzustellen
► Volltonfarbe einstellen, um die zweite Farbe des Farbverlaufs

einzustellen

Die definierten Farben werden im Anzeigebereich angezeigt.
► Mit der linken Maustaste außerhalb des Einstellbereichs klicken,

um den Einstellbereich zu schließen
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zIndex
Der zIndex gibt die Z-Position an, an der sich das visuelle Element
befindet.
Die erste Ebene hat einen zIndex bis 5000, darin sind beispielswei-
se Module mit einem zIndex von 0 enthalten. Sobald eine Interakti-
on stattfindet, beispielsweise wenn das Padding verändert wird, wird
die erste Ebene aktualisiert. Auf diese erste Ebene kann ein InfoI-
mage platziert werden.
Die nächste Ebene hat einen zIndex von 5000-15000, darin sind die
Mover mit einem zIndex von 10000 enthalten. Auf dieser Ebene
kann ein InfoImage platziert werden, da dieses mit den Movern ak-
tualisiert wird.
Sobald der zIndex einen Wert von 15000 überschritten hat, werden
die visuellen Elemente in dieser Ebene aktualisiert. Auf dieser Ebe-
ne kann ein InfoImage platziert werden, das nicht mit den Movern
aktualisiert wird.
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10 Tc3 XTS Utility
Die Tc3 XTS Utility wird zusammen mit dem TF5850 Software Paket
installiert. Die Tc3 XTS Utility ist eine PLC-Bibliothek und wird zum
Lesen oder Setzen von Parametern des XTS Systems verwendet.
Die folgende Grafik zeigt den Aufbau der Tc3 XTS Utility:



Tc3 XTS Utility

430 ─── Version: 1.1.1TF5850

10.1 Bibliothek hinzufügen
Um die Visualisierung nutzen zu können, muss eine Tc3 XTS Utility-
Bibliothek zur PLC hinzugefügt werden.

10.1.1 Standard PLC-Projekt hinzufügen
► Solution Explorer > TwinCAT Project ausklappen
► Mit der rechten Maustaste auf PLC klicken, um das Kontextme-

nü aufzurufen
► Im Kontextmenü auf Add New Item… klicken

Das Dialogfenster Add New Item öffnet sich.
► Auf Standard PLC Project klicken
► In das Eingabefeld Name einen Namen eingeben
► Auf Add klicken, um ein SPS-Projekt hinzuzufügen

10.1.2 Tc3 XTS Utility-Bibliothek hinzufügen
► Solution Explorer > TwinCAT Project > PLC > Untitled > Untitled

Project ausklappen
► Mit der rechten Maustaste auf References klicken, um das Kon-

textmenü aufzurufen
► Im Kontextmenü auf Add library… klicken

Das Dialogfenster Add Library öffnet sich.
► (Miscellaneous) ausklappen
► Auf Tc3_XTS_Utility klicken
► Mit OK bestätigen
Die Tc3_XTS_Utility-Bibliothek wird hinzugefügt.
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10.2 Initialisierung
Der Funktionsbaustein FB_TcIoXtsEnvironment muss einmal für
das XTS Projekt eingerichtet werden, damit auf alle Parameter der
Processing Unit zugegriffen werden kann. Wenn im Projekt XTS Ob-
jekte verwendet werden sollen, muss zusätzlich der Funktionsbau-
stein FB_XtsEnvironment eingerichtet werden.
Die Funktionsbausteine für den Zugriff auf die Parameter des Info-
Servers und der CA-Gruppe sind in der Tc3  XTS  Utility integriert.
Sie müssen die Funktionsbausteine für die Initialisierung aktivieren,
damit die Funktionsbausteine im weiteren Verlauf über den
FB_TcIo-XtsEnvironment genutzt werden können.
Der Funktionsbaustein FB_TcIoXtsEnvironment muss einmal beim
Starten oder bei einer Online-Änderung initialisiert werden, um Infor-
mationen über alle Objekte zu erhalten. Nach der Initialisierung sind
alle Parameter über den FB_TcIoXtsEnvironment verfügbar. Durch
den Aufruf der entsprechenden Methoden kann auf alle Parameter
zugegriffen werden. Es findet keine automatische zyklische Aktuali-
sierung der Daten statt.

10.2.1 Beispiel-Code

// Declaration Part
PROGRAM MAIN
VAR
     fbXtsEnvironment                 : FB_TcIoXtsEnvironment;
     stXtsEnvironmentConfiguration    : ST_XtsEnvironmentConfiguration;
     nEnvironmentState                : INT:=1;
END_VAR

//----------------------------------------------------------------------------------------------------

// Programm Part
CASE nEnvironmentState OF

     1: //Enable init items
            //Enable init Info Server if needed
            stXtsEnvironmentConfiguration.bEnableInitInfoServer := TRUE;

            //Enable init CA Group if needed
            stXtsEnvironmentConfiguration.bEnableInitCaGroup := TRUE;

            //Set configuration of XtsUtility init
            fbXtsEnvironment.P_XtsEnvironmentConfiguration := stXtsEnvironmentConfiguration;

            //Next Step
            nEnvironmentState:=2;

     2://Init
           //Start init
           IF fbXtsEnvironment.Init(TRUE) THEN
                 //Stop init 
                 fbXtsEnvironment.Init(FALSE);

                 //Next Step
                 nEnvironmentState:=3;
           END_IF

     3: //Check if init succeeded
           //Check IsInitialized property
           IF fbXtsEnvironment.P_IsInitialized THEN

                 //Next Step 
                 nEnvironmentState:=4;
          END_IF

     4: //Init done
          ;

END_CASE
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10.3 PLC-Zugriff

10.3.1 Call Chain
Mit der folgenden Call Chain haben Sie die Möglichkeit auf die we-
sentlichen Parameter der XTS Objekte zuzugreifen. Eine Übersicht
zu den Parametern finden Sie im Kapitel „Parameter“, [Seite 445].

10.3.2 Zugriff auf die TcIo-Parameter
In der SPS kann grundsätzlich auf alle TcIo-Parameter zugegriffen
werden. Der Zugriff erfolgt über die TcCom-Objekte im Solution Ex-
plorer.

Beispiel Anzahl erkannter Mover
Der Zugriff auf TcIo-Parameter wird beispielhaft an dem Auslesen
der Anzahl erkannter Mover dargestellt. Das Aufrufen der Onli-
ne‑Parameter erfolgt für alle TcIo-Parameter auf die gleiche Weise.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects ausklappen

► Doppelklick auf XtsProcessingUnit

► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Mover Detection ausklappen
► Anzahl der erkannten Mover bei DetectedMoverCount ausle-

sen
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10.3.3 Zugriff auf die Parameter in der SPS
Für den Zugriff auf verschiedene Parameter in der SPS benötigen
Sie diese Aufrufe:

Auslesen der Anzahlt erkannter Mover

nDetectedMoverCount :=      fbXtsEnvironment.XpuTcIo(1).GetDetectedMoverCount();

Auslesen des DriveState von XPU1

//read the DriveState of XPU1

eDrive:=fbXtsEnvironment.XpuTcIo(1).GetDriveState();

Auslesen der Modulanzahl von XPU1

//read the ModuleCount of XPU1-Part2

nModuleCount:=fbXtsTcIo(1)-.PartTcIo(2).GetModuleCount();

Auslesen der Länge von XPU1

//read the Length of XPU1-Part2-Module3

fLength:=fbXtsEnvironment.XpuTcIo(1).PartTcIo(2).ModuleTcIo(3).GetLength();

Auslesen der ID der Achse von XPU1

//read the AxisId of XPU1-Mover3

nAxisId:=fbXtsEnvironment.XpuTcIo(1).MoverTcIo(3).GetAxisId();

Auslesen der Länge des Tracks von XPU1

//read the Length of XPU1-Track2

fLength:=fbXtsEnvironment.XpuTcIo(1).TrackTcIo(2).GetLength();

Auslesen der Startposition des InfoStation

//read the StartPositionOnPart of Infostation2

fPosition:=fbXtsEnvironment.InfoServerTcIo(1).InfoStationTcIo(2). GetStartPositionOnPart();

Auslesen des GabControl-Modus des CA-Gruppe

//read the GapControlMode of CaGroup1

GapControlMode:=fbXtsEnvironment.Mc2CaGroup(1).GetDefaultGapControlMode();
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10.3.4 Zugriff auf die SoftDrive-Parameter
Für den Zugriff auf die SoftDrive-Parameter benötigen Sie diese
Aufrufe:

Auslesen des KP von VelocityControlLoop

//read Kp of velocity control loop

fbXtsEnvironment.XpuTcIo(1).MoverTcIo(1).SoftDrive.VelocityControl.GetKp();

Einstellen des KP von VelocityControlLoop

//set kp of velocity control loop

fbXtsEnvironment.XpuTcIo(1).MoverTcIo(1).SoftDrive.VelocityControl.SetKp(1.5);
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10.3.5 Zugriff auf die CoE-Daten
Der Zugriff auf die CoE-Daten erfolgt entweder über das Modulob-
jekt oder über das Lesen des CoE-Registers.

10.3.5.1 Modulobjekt
Der Treiber bietet die Möglichkeit, die CoE-Daten direkt über das
Modulobjekt auszulesen.

Treiber-Intervall beeinflusst Aktualität der CoE-Daten
Der Treiber aktualisiert die CoE-Daten in einem selbstbestimmten
Intervall. Es kann daher vorkommen, dass die ausgegebenen Infor-
mationen nicht aktuell sind.

Beispiel
Der Zugriff auf die CoE-Daten wird beispielhaft an dem Auslesen
der DC Link Voltage dargestellt. Das Aufrufen der CoE-Daten erfolgt
für alle CoE-Daten auf die gleiche Weise.

► Solution Explorer > TwinCAT Project > SYSTEM > TcCOM Ob-
jects > XtsProcessingUnit > Part ausklappen

► Doppelklick auf Module

► Im Projektfenster auf den Reiter Parameter (Online) klicken
► Auf + von Drive CoE - Info Data klicken
► Wert bei DC Link Voltage auslesen
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Update der CoE-Daten über das TcIo-Modul
Mit der CoE-Lesefunktion über das TcIo-Modul können Sie gleich-
zeitig auf verschiedene CoE-Daten zugreifen. Der Zugriff erfolgt
über folgenden Aufruf:

fDcLink:=fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).GetDCLinkVoltage();

aI2T REF=fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).GetI2TTemperatures();

10.3.5.2 Update der CoE-Daten über direktes Lesen der CoE-Register

Die Tc3  XTS  Utility organisiert den Zugriff auf die CoE-Daten, um
Kommunikationsfehler zu vermeiden. Sie können nur über eine Up-
date-Methode aktualisieren und nur auf ein Modul eines Einspeise-
strangs gleichzeitig zugreifen. Zusätzlich bietet die Tc3  XTS  Utility
die CoE-Daten über das IO-Modul auszulesen.

► Solution Explorer > TwinCAT Project > I/O > Devices > Device 1
ausklappen

► Doppelklick auf Term 1

► Im Projektfenster auf den Reiter CoE - Online klicken
► Auf CC I2T Diag Data klicken
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Aufruf zum Auslesen der Register nur mit angeschlossener
Hardware
Das Auslesen der CoE-Daten über die Aufrufe ist nur mit ange-
schlossener Hardware und nur im Run-Modus möglich.
Wenn keine Hardware angeschlossen ist oder das System in der Si-
mulation betrieben wird, können die Aufrufe Fehlermeldungen her-
vorrufen.

Mit folgendem Aufruf wird ein Auslesen der Register vermieden,
wenn keine Hardware angeschlossen ist und das System in Simula-
tion betrieben wird:

IF NOT fbXtsEnvironment.XpuTcIo(1).GetOperationMode() = OperationMode.Simulation THEN
       "Methode, die genutzt werden soll"
END_IF

Mit folgenden Aufrufen lassen sich die Register auslesen, wenn
Hardware angeschlossen ist und das System im Run-Modus betrie-
ben wird:

IF fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.I2TDiagData.Update() THEN
     aI2T:=fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.I2TDiagData.TemperatureCoilCh;
END_IF

IF fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.InfoData.Update() THEN
     nDcLink:=fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.InfoData.DcLinkVoltage;
END_IF

10.3.5.3 Zugriff auf alle Daten eines CoE-Objekts
Wenn Sie beispielsweise Zugriff auf alle I2T-Werte benötigen, kön-
nen Sie das gesamte Objekt über die Eigenschaft all verfügbar ma-
chen. Folgende Aufrufe sind dafür erforderlich:

pCoEI2TDiagData   : POINTER TO ST_AT2xxxI2TDiagData;

IF fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.I2TDiagData.Update() THEN
   pCoeI2TDiagData:=fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.I2TDiagData.all;
END_IF

10.3.5.4 Aktualisierung und Zugriff auf alle CoE-Objekte
Die Tc3 XTS Utility ermöglicht es Ihnen, alle CoE-Objekte mit nur ei-
nem Aufruf zu aktualisieren und darauf zuzugreifen. Folgende Auf-
rufe sind dafür erforderlich:

stAllCoEData   : ST_AT2xxxI2TDiagData;

IF fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.AllCoE.UpdateAllCoEData() THEN
   stAllCoEData:=fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.AllCoE.AllCoEData;
END_IF



Tc3 XTS Utility

438 ─── Version: 1.1.1TF5850

10.3.6 Zugriff auf den Diagnoseverlauf
Sie können direkt auf den Diagnoseverlauf vom IO-Modul sowie auf
andere CoE-Daten zugreifen. Folgender Aufruf ist dafür erforderlich:

  IF fbXtsEnvironment.XpuTcIo(1)PartTcIo(1).ModuleTcIo(1).CoE.DiagHistoryData.UpdateDiagHistory() THEN
     stAT2xxxI2TDiagHistory:= fbXtsEnvironment.XpuTcIo(1).PartTcIo(1).ModuleTcIo(1).CoE.DiagHistory-
     Data.DiagHistory;
  END_IF

10.3.7 Mover ID-Erkennung einstellen
Folgender Aufruf ist für die Mover ID-Erkennung erforderlich:

  IF fbXtsEnvironment.XpuTcIo(1).SetMoverIdDetectionMode(MoverIdDetectionMode.Mover1) THEN
     nEnvironmentState:=8;
  END_IF

10.3.8 Mover-Befehle abspeichern
Mit der Befehlsverlauf-Funktion können bis zu 25 Befehle für einen
Mover gespeichert werden. Jeder Befehl enthält den Befehlstyp, die
Station, einen Text und einen Zeitstempel.

Wird kein eigener Zeitstempel eingetragen, fügt die Funktion auto-
matisch einen Zeitstempel hinzu.

Folgende Aufrufe sind für das Verwalten des Befehlsverlaufs erfor-
derlich:

stCommand         : ST_TcIoXtsMoverCommand;

refCommandHistory : REFERNCE TO ARRAY[1..TcIoXtsEnvironmentParameterList.MaxMessageCommandHistory] OF
ST_TcIoXtsMoverCommand;

//preparing the message to store in command history
//if there is no time stamp in the message, the program will add one automatically
stCommand.sCommandType   := ‘MoverAbsoluteCA‘;
stCommand.sStation       := ‚Station2’;
stCommand.sText          := ‚Pos:1000,Acc/Dec:10000‘;

//adding message int command history
fbXtsEnvironment.XpuTcIo(1).MoverTcIo(1).AddCommand(stCommand);

//read command history
refCommandHistry REF= fbXtsEnvironment.XpuTcIo(1).MoverTcIo(1).P_CommandHistory;

//clear all messages in command history
fbXtsEnvironment.XpuTcIo(1).MoverTcIo(1).ClearCommandHistory();
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10.4 Visualisierung
Der Funktionsbaustein FB_XtsEnvironmentVisu nutzt einen Inter-
face Pointer als Eingang, der auf den Funktionsbaustein
FB_TcIoXtsEnvironment verweisen muss, um auf die Parameter der
XTS Objekte zugreifen zu können. Die Methode Cycle von FB_Xts-
EnvironmentVisu muss zur zyklischen Aktualisierung aller Parame-
ter aufgerufen werden.

HINWEIS
Visualisierung nur zur Unterstützung während des Program-
mierens
Die Visualisierung dient nur zur Unterstützung während des Pro-
grammierens eines XTS Systems und kann nicht zur Visualisie-
rung in der Anlagenbedienoberfläche genutzt werden.
• Weitere Informationen dazu finden Sie im Kapitel „XTS HMI

Controls“, [Seite 381].

10.4.1 Beispiel-Code

// Declaration Part
PROGRAM MAIN

VAR
     fbXtsEnvironment                 : FB_TcIoXtsEnvironment;
     nEnvironmentState                : INT:=1;
END_VAR

//----------------------------------------------------------------------------------------------------

// Programm Part
CASE nEnvironmentVisuState OF

     1: //Link data pointer
     fbXtsEnvironmentVisu(ipTcIoXtsEnvironment:=fbXtsEnvironment);

     Next Step
     nEnvironmentVisuState:=2;

     2: //Cyclic update of Visu information
     fbXtsEnvironmentVisu.Cycle();

END_CASE

► Solution Explorer > TwinCAT Project > PLC > Untitled > Untitled
Project ausklappen

► Mit der rechten Maustaste auf VISUs klicken, um das Kontext-
menü aufzurufen

► Im Kontextmenü auf Add klicken, um ein weiteres Kontextmenü
aufzurufen

► Im Kontextmenü auf Visualization… klicken
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Das Dialogfenster Add Visualization öffnet sich.
► Kontrollkästchen VisuSymbols (System) aktivieren
► Auf Open klicken
Die Visualization wird zu VISUs hinzugefügt.

► Solution Explorer > TwinCAT Project > PLC > Untitled > Untitled
Project > VISUs ausklappen

► Doppelklick auf Visualization
Im Projektfenster öffnet sich der Reiter Visualization.
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10.4.2 Standard-Visualisierung
► Toolbox > Tc3_XTS_Utility ausklappen
► Mit gedrückter linker Maustaste VI_Xts_EnvironmentVisu in

das Projektfenster Visualization ziehen

Die Visualisierung wird im Projektfenster Visualization dargestellt.
► Bei Bedarf die Visualisierung für bessere Bedienbarkeit vergrö-

ßern
► Bei Bedarf die Visualisierung im Projektfenster positionieren
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10.4.3 Zyklus Daten aktualisieren

Für die Verwendung der Visualisierung muss vorher die
Tc3 XTS Utility initialisiert werden.

Nach der Übergabe des DataPointers muss die Methode Cycle des
Funktionsbausteins FB_XtsEnvironmentVisu im SPS-Programm zy-
klisch aufgerufen werden, um die Parameter aller XTS Objekte zu
aktualisieren:

//Link data pointer
fbXtsEnvironmentVisu(ipTcIoXtsEnvironment:=fbXtsEnvironment);

//Cyclic update of Visu information
fbXtsEnvironmentVisu.Cycle();

10.4.4 Visualisierung steuern
Neben der Startseite gibt es fünf weitere Reiter zur Anzeige von Pa-
rametern:
• Xpu
• Part
• Module
• Mover
• Track

Anzeige Beispiel
Die Anzeige der Parameter wird beispielhaft an dem Reiter Mover
dargestellt.

► Auf den Reiter Mover klicken

► Auf einen Mover klicken, um detaillierte Informationen des Mo-
vers aufzurufen
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► Auf + oder – klicken, um zwischen den Movern zu wechseln
ODER
► In das Eingabefeld die Nummer des Movers eingeben

10.4.4.1 Einzelne Seite der Visualisierung
Neben der Verwendung der Standardvisualisierung VI_XtsEnviron-
mentVisu ist es auch möglich, eine Visualisierung als eigenständige
Seite zu verwenden. Sie können die gewünschte Seite mit gedrück-
ter linker Maustaste in die Visualisierung ziehen und anschließend
die entsprechende Methode im SPS-Programm aufrufen, um die
Daten zu aktualisieren.

Im folgenden Beispiel wird die Seite VI_XtsMover zur Visualisierung
hinzugefügt, um weitere Detailinformationen des Movers anzuzei-
gen.

► Toolbox >Tc3_XTS_Utility ausklappen
► Mit gedrückter linker Maustaste VI_XtsMover in das Projektfens-

ter Visualization ziehen
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Die Visualisierung der Mover wird im Projektfenster Visualization
dargestellt.
► Bei Bedarf die Visualisierung für bessere Bedienbarkeit vergrö-

ßern
► Bei Bedarf die Visualisierung im Projektfenster positionieren
Nach der Übergabe des DataPointers muss zur Aktualisierung der
Daten die Methode CatMover in der SPS zyklisch aufgerufen wer-
den:

//Link data pointer
fbXtsEnvironmentVisu(ipTcIoXtsEnvironment:=fbXtsEnvironment);

//cyclic update of Mover Visu information
fbXtsEnvironmentVisu.CatMover ();
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10.5 Parameter

10.5.1 FB_TcIoXtsEnvironment – I_TcIoXtsEnvironment

10.5.1.1 Methode

Parameter Gruppe Return Type Input Type Erläuterung
Init – BOOL BOOL Initialisierung
GetXpuCount – BOOL BOOL Aktualisiert die Gesamt-

zahl der Processing Units,
die über P_XpuCount oder
P_XpuCountUnit abgeru-
fen werden kann.

GetXpuOids – BOOL BOOL Aktualisiert die Objekt ID-
Liste der Processing Units,
die über P_XpuOids abge-
rufen werden kann.

GetInfoServerCount – BOOL BOOL Aktualisiert die Gesamt-
zahl der InfoServer, die
über die P_InfoServer-
Count abgerufen werden
kann.

GetInfoServerOids – BOOL BOOL Aktualisiert die Objekt ID-
Liste der InfoServer, die
über P_InfoServerOids ab-
gerufen werden kann.

GetCaGroupCount – BOOL BOOL Aktualisiert die Gesamt-
zahl der CA-Gruppen, die
über P_CaGroupCount ab-
gerufen werden kann.

GetCaGroupOids – BOOL BOOL Aktualisiert die Objekt ID-
Liste der CA-Gruppen, die
über P_CaGroupOids ab-
gerufen werden kann.

Subitem
XpuTcIo – I_TcIoXtsProcessing-

Unit
UINT Die Eingabe der Proces-

sing Unit Nummer wählt
diese Processing Unit für
den weiteren Betrieb aus.

InfoServerTcIo – I_TcIoXtsInfoServer UINT Die Eingabe der InfoSer-
ver-Nummer wählt diesen
Server für den weiteren
Betrieb aus.

Mc2CaGroup – I_Mc2CaGroup UINT Die Eingabe der CA-Grup-
pen Nummer wählt diese
CA-Gruppe für den weite-
ren Betrieb aus.
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Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_XpuCount – UDINT – Gibt die Gesamtzahl der

Processing Units zurück.
P_XpuCountUnit – UINT – Gibt die Gesamtzahl der

Processing Units in UINT
zurück.

P_XpuOids – REFERENCE TO
ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxXtsProces
singUnits] OF OTCID

– Gibt die Objekt ID-Liste der
XPUs zurück.

P_InoServerCount – UINT – Gibt die Gesamtzahl der
InfoServer zurück.

P_InfoServerCount-
Oids

– REFERENCE TO
ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxXtsInfoSer
ver] OF OTCID

– Gibt die Objekt ID-Liste der
InfoServer zurück.

P_CaGroupCount – UINT – Gibt die Gesamtzahl der
CA-Gruppe zurück.

P_CaGroupCount-
Oids

– REFERENCE TO
ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxXtsCaGrou
p] OF OTCID

– Gibt die Objekt ID-Liste der
CA-Gruppe zurück.

P_IsInitialised – BOOL – Gibt den Status der Initiali-
sierung zurück.

P_XtsEnvironment-
Configuration

– ST_XtsEnvironment-
Configuration

– Gibt die Konfiguration der
XTS Umgebung zurück.
Dieser Parameter wird be-
nutzt, um die Initialisierung
der XTS Umgebung, wie
beispielsweise die Initiali-
sierung des InfoServers
oder CA-Gruppe, auszu-
wählen.
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10.5.2 FB_TcIoXtsProcessingUnit – I_ TcIoXtsProcessingUnit

10.5.2.1 Methode - Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetOperationMode General OperationMode – Gibt den ausgewählten

Operation Mode zurück.
GetEtherCatMaster-
SyncTaskObjectId

General OTCID – Gibt die EtherCAT Master
Synchro Task Object ID
zurück.

GetMoverType Mover MoverType – Gibt den ausgewählten
Movertyp zurück.

GetMagnetPlateType Mover MagnetPlateType – Gibt den ausgewählten
Magnetplattentyp zurück.

GetMoverSortOrder Mover SortOrderEnum – Gibt die ausgewählte Sor-
tierreihenfolge der Mover
zurück.

GetMoverWidth Mover LREAL – Gibt den minimalen Ab-
stand zwischen den Mo-
vern zurück.

GetConfiguredDetec-
tionCount

MoverDetection UDINT – Gibt die festgelegte Erken-
nungsanzahl zurück.

SetConfiguredDetec-
tionCount

MoverDetection BOOL UDINT Definiert die Erkennungs-
anzahl.

TriggerDetection MoverDetection BOOL – Löst eine Mover Erken-
nung aus.

TriggerRedetection MoverDetection BOOL – Löst eine Mover Wiederer-
kennung aus.

GetExpectedMover-
Ids

MoverIdDetection ARRAY[1..2] OF
ST_ExpectedMover-
Ids

– Gibt die erwarteten Mover
IDs bei der ID-Erkennung
mit mehreren Mover 1 zu-
rück.

GetMoverIdDetec-
tionMode

MoverIdDetection MoverIdDetectionMo-
de

– Gibt den festgelegten Mo-
ver ID-Erkennungsmodus
zurück

GetMoverPositionAs-
signment

MoverIdDetection MoverPositionAssi-
gnment

– Gibt die Mover Positions-
zuweisung zurück.

TriggerMoverIdDe-
tection

MoverIdDetection BOOL – Löst eine Mover ID-Erken-
nung aus.

SetExpectedMover-
Ids

MoverIdDetection BOOL ExpectedMove-
rIds : AR-
RAY[1..2] OF
ST_Expected-
MoverIds

Legt die erwarteten Mover
IDs bei der ID-Erkennung
mit mehreren Movern 1
fest.

SetMoverIdDetec-
tionMode

MoverIdDetection BOOL MoverIdDetec-
tionMode

Legt den Mover ID-Erken-
nungsmodus fest.

SetMoverPositionAs-
signment

MoverIdDetection BOOL MoverPositio-
nAssignment

Legt die Zuordnung der
Mover Position fest.

GetTeachingFile-
Number

Teaching UDINT – Gibt die Nummerierung/
den Namen der Teaching-
Datei zurück.

GetIsAbortOnTea-
chingWarningEnab-
led

Teaching BOOL – Gibt die Einstellung der
Teaching-Warnung zurück.
Wenn TRUE, kann der
Start des Systems wegen
der Warnung abgebrochen
werden.
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Parameter Gruppe Return Type Input Type Erläuterung
GetIsTeachingCheck-
SumCheckEnabled

Teaching BOOL – Gibt die Einstellung der
Lernkontrollsummenprü-
fung zurück. Gibt TRUE
zurück, wenn die angege-
bene Prüfsumme verwen-
det wird, um zu überprü-
fen, ob die richtige Tea-
ching-Datei geladen und
nicht beschädigt ist.

SetTeachingFile-
Number

Teaching BOOL UDINT Legt die Nummerierung/
den Namen der angewen-
deten Teaching-Datei fest

GetIsAutoDumpWri-
teEnabled

Diagnostics BOOL – Gibt die Einstellung des
automatischen Schreibens
der Dump-Datei zurück.
Wenn TRUE, schreibt der
Treiber in bestimmten Si-
tuationen wie beim Start
oder im Fehlerfall automa-
tisch eine Dump-Datei.

GetIsInputCheck-
Enabled

Diagnostics BOOL – Gibt die Einstellungen der
Eingabeprüfung zurück.
Wenn TRUE, sind alle
Plausibilitätsprüfungen al-
ler Eingangskanäle im
System aktiviert.

GetUsedEventLog-
ger

Diagnostics EventMessenger – Gibt ausgewählte Spezifi-
kationen zurück, wie Ereig-
nisse und Nachrichten vom
Treiber übermittelt werden

WriteDump Diagnostics BOOL – Schreibt eine Dump-Datei.
SetIsInputCheckEna-
bled

Diagnostics BOOL BOOL Legt die Aktivierung/Deak-
tivierung der Eingangsprü-
fung fest

GetIsCycleTimeWar-
ningSuppressed

Advanced BOOL – Gibt die Einstellung der un-
terdrückten Zykluszeitwar-
nung zurück. Wenn akti-
viert, wird die Warnung,
dass der Treiber bei einer
Zykluszeit von 250us nicht
läuft, deaktiviert.
ACHTUNG: Nur im Simu-
lationsmodus verfügbar.

GetIsMoverFrozen-
ErrorActivated

Advanced BOOL – Gibt die Einstellung des
Fehlers eines eingefrore-
nen Movers zurück. Wenn
aktiviert, gibt der Treiber
eine Fehlermeldung an-
stelle einer Warnung aus,
wenn eine Position des
Mover eingefroren ist.

GetIsPositionBased-
ErrorForwardingEnab
led

Advanced BOOL – Gibt die Einstellung der po-
sitionsbezogenen Fehler-
weiterleitung zurück. Wenn
aktiviert, wird ein Hardwa-
re-Fehler positionsbasiert
an Mover weitergeleitet,
die sich auf den fehlerhaf-
ten Modulen befinden.
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Parameter Gruppe Return Type Input Type Erläuterung
GetOptimization Advanced OptimizationEnum – Gibt die ausgewählte Opti-

mierung zurück.
GetIsPositionNoi-
seEnabled

Simulation BOOL – Gibt Positionsrauschen in
der Simulation zurück.

GetIsRandomStart-
UpEnabled

Simulation BOOL – Gibt die Einstellung der zu-
fälligen Startposition von
Movern zurück.

GetMoverDistance Simulation LREAL – Gibt den Moverabstand
beim Starten zurück

GetPositionOffset Simulation LREAL – Gibt den Positionsoffset
der Mover beim Starten
zurück

GetPositionNoise-
Bandwidth

Simulation LREAL – Gibt die Bandbreite des
Positionsrauschens zurück

GetRandomStartUp-
Bandwidth

Simulation LREAL – Gibt die Bandbreite des
zufälligen Starts zurück

GetPositionStartUp-
SimulationMode

Simulation PositionStartUpSimu-
lationMode

– Gibt den ausgewählten
Modus für die Startposition
zurück

GetMoverIdStartUp-
SimulationMode

Simulation MoverIdStartUpSi-
mulationMode

– Gibt den gewählten Modus
für die Generierung der
Mover-ID zurück

GetRandomInitMode Simulation RandomInitMode – Gibt den gewählten Modus
für die Initialisierung der
Zufallsauswahl zurück

GetRandomInitSeed Simulation DINT – Gibt den Startwert zurück,
der für die Zufallsgenerie-
rung von Moverposition
und Mover ID verwendet
wird.
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10.5.2.2 Methode - Parameter (Online)

Parameter Gruppe Return Type Input Type Erläuterung
GetAreAllPositions-
Valid

MoverDetection BOOL – Gibt den Zustand zurück,
wenn alle Moverpositionen
gültig sind.

GetDetectionCycle-
Count

MoverDetection UDINT – Gibt die Anzahl der Erken-
nungszyklen zurück.

GetDetectedMover-
Count

MoverDetection UDINT – Gibt die Anzahl der Mover
zurück, die während des
letzten Erkennungsprozes-
ses erkannt wurden.

GetExpectedMover-
Count

MoverDetection UDINT – Gibt die Anzahl der auf
dem System erwarteten
Mover zurück.

GetScannedModule-
Count

MoverDetection UDINT – Gibt die Anzahl der Module
zurück, die während der
letzten Erkennung
gescannt wurden.

GetMoverPositions MoverDetection BOOL – Aktualisiert die aktuelle Po-
sition aller Mover.

GetActiveMover-
Count

MoverDetection UDINT – Gibt die Anzahl aktiver Mo-
ver zurück.

GetHasMoverIdDe-
tectionError

MoverIdDetection BOOL – Gibt den Status der Mover
ID-Erkennung zurück.
Wenn TRUE, ist ein Fehler
während der Mover ID-Er-
kennung aufgetreten.

GetIsMoverIdDetec-
tionValid

MoverIdDetection BOOL – Gibt den Status der Mover
ID-Erkennung zurück.
Wenn TRUE, wurde die
Mover ID erkannt.

GetIsMoverIdDetec-
tionActive

MoverIdDetection BOOL – Gibt den Status der Mover
ID-Erkennung zurück.
Wenn TRUE, läuft die Mo-
ver ID-Erkennung.

GetMoverIds MoverIdDetection ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxXtsMovers
PerXpu] OF
STRING(3);

– Gibt eine Liste der Mover
IDs zurück.

GetIsTeachingChan-
ged

Teaching BOOL – Gibt den Status des Tea-
chings zurück. Wenn
TRUE, läuft das Teaching.

GetIsTeachingValid Teaching BOOL – Gibt den Status des Tea-
chings zurück. Wenn
TRUE, ist das Teaching
gültig.

GetDriveState Info DriveState – Gibt den Status des An-
triebssystems zurück.

GetMoverCount Structure UDINT – Gibt die Gesamtzahl der
Mover zurück.

GetMoverOids Structure BOOL – Aktualisiert die Objekt ID
aller Mover.

GetPartCount Structure UDINT – Gibt die Gesamtzahl aller
Parts zurück.

GetPartOids Structure BOOL – Aktualisiert die Objekt ID
aller Parts.
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Parameter Gruppe Return Type Input Type Erläuterung
GetTaskCount Structure UDINT – Gibt die Gesamtzahl aller

Tasks zurück.
GetTaskOids Structure BOOL – Aktualisiert die Objekt ID

aller Tasks.
GetTrackCount Structure UDINT – Gibt die Gesamtzahl aller

Tracks zurück.
GetTrackOids Structure BOOL – Aktualisiert die Objekt ID

aller Tracks.
Subitems
MoverTcIo – I_TcIoXtsXpuMover UINT Wählt einen Mover für den

weiteren Betrieb durch Ein-
gabe der Nummer des
ausgewählten Mover.

PartTcIo – I_TcIoXtsXpuPart UINT Wählt einen Part für den
weiteren Betrieb durch Ein-
gabe der Nummer des
ausgewählten Parts.

TrackTcIo – I_TcIoXtsXpuTrack UINT Wählt einen Track für den
weiteren Betrieb durch Ein-
gabe der Nummer des
ausgewählten Tracks.

10.5.2.3 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_MoverPositions – REFERENCE TO

ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxXtsMovers
PerXpu] OF ST_Xpu-
MoverPositions

– Gibt die Position des Parts,
die Objekt ID des Parts
und die Objekt ID des
Tracks zurück, auf dem
sich der Mover befindet.

P_MoverOids – REFERENCE TO
ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxXtsMovers
PerXpu] OF OTCID

– Gibt die Objekt ID aller Mo-
ver zurück.

P_PartOids – REFERENCE TO
ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxXtsPartsP
erXpu] OF OTCID

– Gibt die Objekt ID aller
Parts zurück.

P_TaskOids – REFERENCE TO
ARRAY [1..12] OF
OTCID

– Gibt die Objekt ID aller
Tasks zurück.

P_TrackOids – REFERENCE TO
ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxXtsTracks
PerXpu] OF OTCID

– Gibt die Objekt ID aller
Tracks zurück.

P_IsInitialised – BOOL – Gibt den Status der Initiali-
sierung zurück.
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10.5.3 FB_TcIoXtsXpuPart - I_TcIoXtsXpuPart

10.5.3.1 Methode - Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetTaskOid General OTCID – Gibt die Objekt ID der Task

zurück.
GetModuleSide General ModuleSide – Gibt die Seite des Moduls

zurück, die im XTS Tool
Window und im XTS View-
er angezeigt wird. Auswahl
zwischen Front und Back.

GetOriginTransform General ST_OriginTransform – Gibt die Ausgangstransfor-
mation für den Part, die im
XTS Tool Window und
XTS Viewer angezeigt
wird, zurück.

SetIsClosed General BOOL BOOL Legt den Part als ge-
schlossene Form fest.

SetModuleSide General BOOL ModuleSide Legt die Modulseite des
Parts fest, der im XTS Tool
Window und im XTS View-
er angezeigt wird.

SetOriginTransform General ST_originTransform – Legt die Ausgangstransfor-
mation fest, die im XTS
Tool Window und XTS
Viewer angezeigt wird.
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10.5.3.2 Methode - Parameter (Online)

Parameter Gruppe Return Type Input Type Erläuterung
GetDriveState Info DriveState – Gibt den Status des An-

triebssystems zurück.
GetGlobalNumber Info UDINT – Gibt die globale Nummer

eines Parts zurück. Die
globale Nummer wird ver-
wendet, um alle Parts zu
unterscheiden, die von der
Processing Unit verwaltet
werden.

GetLength Info LREAL – Gibt die Länge des ausge-
wählten Parts zurück.

GetAreaCount Structure UDINT – Gibt die Gesamtzahl der
Areas auf dem Part zu-
rück.

GetAreaOids Structure BOOL – Aktualisiert die Objekt ID
der Areas auf dem Part.

GetModuleCount Structure UDINT – Gibt die Gesamtzahl der
Module auf dem Part zu-
rück.

GetModuleOids Structure BOOL – Aktualisiert die Objekt ID
der Module auf dem Part.

Subitems
ModuleCoE – I_AT2xxxXtsMotor UINT Wählt ein Modul für das

weitere Lesen des CoE
durch Eingabe der Num-
mer des ausgewählten Mo-
duls aus.

ModuleTcIo – I_TcIoXtsPartModule UINT Wählt ein Modul für den
weiteren Betrieb durch Ein-
gabe der Nummer des
ausgewählten Moduls aus.

10.5.3.3 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_AreaOids – REFERENCE TO

ARRAY [1..100] OF
OTCID

– Gibt die Objekt ID der Are-
as auf dem Part zurück.

P_ModuleOids – REFERENCE TO
ARRAY [1..TcIoXts-
EnvironmentParamet
erList.MaxModulesP
erPart] OF OTCID

– Gibt die Objekt ID der Mo-
dule auf dem Part zurück.

P_IsInitialised – BOOL – Gibt den Status der Initiali-
sierung zurück.
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10.5.4 FB_TcIoXtsPartControlArea – I__TcIoXtsPartControlArea

10.5.4.1 Methode - Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetName General STRING(1023) – Gibt den Namen der Con-

trol Area zurück.
GetDescription General STRING(1023) – Gibt die Beschreibung der

Control Area zurück.
GetStartPosition General LREAL – Gibt die Startposition der

Control Area auf dem Part
zurück.

GetEndPosition General LREAL – Gibt die Endposition der
Control Area auf dem Part
zurück.

GetBlendInLength General LREAL – Gibt die Länge vom Start
der Control Area bis zu der
Position, an der die Con-
trol-Parameter komplett
genutzt werden, zurück.

GetBlendOutLength General LREAL – Gibt die Länge, ab der die
Control Parameter nicht
mehr komplett genutzt
werden, bis zum Ende der
Control Area, zurück.

GetIsEnabled General BOOL – Gibt den Aktivierungssta-
tus der Control Area zu-
rück.

SetName General BOOL STRING(1023) Legt den Namen für die
Control Area fest.

SetDescription General BOOL STRING(1023) Legt die Beschreibung der
Control Area fest.

SetStartPosition General BOOL LREAL Legt die Startposition der
Control Area fest.

SetEndPosition General BOOL LREAL Legt die Endposition der
Control Area fest.

SetBlendInLength General BOOL LREAL Legt die BlendInLength
fest.

SetBlendOutLength General BOOL LREAL Legt die BlendOutLength
fest.

SetIsEnabled General BOOL BOOL Legt die Aktivierung/Deak-
tivierung der Control Area
fest.
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10.5.4.2 Methode - Parameter (Online)
Parameter Gruppe Return Type Input Type Erläuterung
GetLength Info LREAL – Gibt die Länge der Control

Area zurück.
GetIsValid Info BOOL – Gibt TRUE zurück, wenn

alle Einstellungen der Con-
trol Area gültig sind.

10.5.4.3 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.5 FB_TcIoXtsPartModule – I_TcIoXtsPartModule

10.5.5.1 Methode - Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetAdsPort General WORD – Gibt den Ads Port zurück.
GetTaskOid General OTCID – Gibt die Objekt ID der Task

zurück.
GetMotorTerminalO-
id

General OTCID – Gibt die Objekt ID der zu-
gehörigen Motorklemme
zurück.

GetSensorTerminal General OTCID – Gibt die Objekt ID der zu-
gehörigen Sensorklemme
zurück.

GetPositionIndex General UDINT – Gibt den Index des Moduls
im XTS System zurück.
Das erste Modul hat den
Index 0.

GetOffset General LREAL – Gibt den Offset des Mo-
duls zurück, um mechani-
sche Toleranzen auszu-
gleichen.

GetScalingFactor General LREAL – Gibt den Skalierungsfaktor
zurück, um mechanische
Toleranzen auszugleichen.

SetAdsPort General BOOL WORD Legt den ADS Port fest.
SetTaskOid General BOOL OTCID Legt die Task für einen

Part, durch Eingabe der
Task Objekt ID, fest.

SetMotorTerminalOid General BOOL OTCID Legt die Objekt ID der Mo-
torklemme fest.

SetSensorTerminal-
Oid

General BOOL OTCID Legt die Objekt ID der
Sensorklemme fest.

SetPositionIndex General BOOL UDINT Legt den Index des Moduls
im XTS System fest.

SetOffset General BOOL LREAL Legt den Offset des Mo-
duls fest.

SetScalingFactor General BOOL LREAL Legt den Skalierungsfaktor
des Moduls fest.
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10.5.5.2 Methode - Parameter (Online)

Parameter Gruppe Return Type Input Type Erläuterung
GetAngle Info LREAL – Gibt den Winkel des Mo-

duls zurück.
GetGlobalNumber Info UDINT – Gibt die globale Nummer

des Moduls zurück. Die
globale Nummer wird ver-
wendet, um alle Module zu
unterscheiden, die von der
Processing Unit verwaltet
werden.

GetLength Info LREAL – Gibt die Länge des Moduls
zurück.

GetMasterNetId Info AMSNETID – Aktualisiert die Net-ID des
EtherCAT Masters.

GetDriveAddress DriveInfo UINT – Gibt die Adresse des Drive
Terminals zurück.

GetDriveConfigIden-
tity

DriveInfo ST_DriveConfigIden-
tity

– Gibt die Struktur der konfi-
gurierten Antriebs-Identität
mit der Hersteller-ID, dem
Code, der Revision und
der Seriennummer zurück.

GetDriveOnlineIden-
tity

DriveInfo ST_DriveOnlineIden-
tity

– Gibt die Struktur der online
Antriebs-Identität mit Her-
steller-ID, dem Code, der
Revision und der Serien-
nummer zurück.

GetDriveState DriveInfo DriveState – Gibt den Status des An-
triebs-Terminals zurück.

GetEncoderAddress EncoderInfo UINT – Gibt die Adresse des En-
coder Terminals zurück.

GetEncoderConfig-
Identity

EncoderInfo ST_EncoderConfig-
Identity

– Gibt die Struktur der konfi-
gurierten Encoder-Identität
mit der Hersteller-ID, dem
Code, der Revision und
der Seriennummer zurück.

GetEncoderOnline-
Identity

EncoderInfo ST_EncoderOnline-
Identity

– Gibt die Struktur der online
Encoder-Identität mit Her-
steller-ID, dem Code, der
Revision und der Serien-
nummer zurück.

GetEncoderSensor-
Values

EncoderInfo ARRAY[1..32] OF
ST_EncoderSensor-
Values

– Gibt die Werte des Enco-
der-Sensors zurück.

GetDriveBTN General BTN – Gibt die Beckhoff Tracea-
bility Number (BTN) zu-
rück.

GetDriveDeviceNa-
me

General STRING(15) – Gibt den Device-Namen
zurück.

GetDriveDeviceType General UDINT – Gibt den Device-Typ zu-
rück.

GetDriveHardware-
Version

General STRING(15) – Gibt die Hardwareversion
zurück.

GetDriveSoftware-
Version

General STRING(15) – Gibt die Softwareversion
zurück.

GetI2TWarnLevel AmplifierSettings USINT – Gibt das I2T-Warnlevel zu-
rück.
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Parameter Gruppe Return Type Input Type Erläuterung
GetI2TErrorLevel AmplifierSettings USINT – Gibt das I2T-Fehlerlevel

zurück.
GetTemperature-
WarnLevel

AmplifierSettings UINT – Gibt das Temperatur-
Warnlevel zurück.

GetTemperatureEr-
rorLevel

AmplifierSettings UINT – Gibt das Temperatur-Feh-
lerlevel zurück.

GetMaxDcLinkVolta-
ge

AmplifierSettings UDINT – Gibt das Maximum der
DC-Link-Spannung zurück.

GetMinDcLinkVolta-
ge

AmplifierSettings UDINT – Gibt das Minimum der DC-
Link-Spannung zurück

GetEnabledBrake-
Chopper

AmplifierSettings BOOL – Gibt die Einstellungen des
Bremskraftreglers zurück.

GetBreakAfterBridge-
Disable

AmplifierSettings BOOL – Gibt die Einstellung der
Unterbrechung nach der
Deaktivierung der Daten-
übertragung zurück.

GetI2TTemperatures I2T REFERENCE TO
ARRAY [1..15] OF
REAL

– Gibt den I2T-Wert zurück.

GetAuxiliaryVolta-
ge5V

InfoData REAL – Gibt die Betriebsspannung
von 5 V zurück.

GetAuxiliaryVolta-
ge10V

InfoData REAL – Gibt die Betriebsspannung
von 10 V zurück.

GetAuxiliaryVolta-
ge24V

InfoData REAL – Gibt die Betriebsspannung
von 24 V zurück.

GetDCLinkVoltage InfoData REAL – Gibt die DC-Link-Span-
nung zurück.

GetCurrentScaling InfoData REAL – Gibt die Skalierung der
Stromstärke zurück.

GetChipID InfoData ULINT – Gibt die Chip-ID zurück.
GetDeviceInfo InfoData UDINT – Gibt die Device-Informatio-

nen zurück.
GetMaxDCLinkVolta-
geLast500ms

InfoData REAL – Gibt die maximale DC-
Link-Spannung der letzten
500 ms zurück.

GetMaxOverallCurr-
entLast500ms

InfoData REAL – Gibt den Gesamtstrom der
letzten 500 ms zurück

GetOverallCurrent InfoData REAL – Gibt den Gesamtstrom zu-
rück.

GetPCBTemperatu-
res

InfoData REFERNCE TO AR-
RAY [1..4] OF REAL

– Gibt die Temperatur von
PCB zurück.

GetCode VendorData ULINT – Gibt den Code zurück.
GetCoilOvercurrent-
Threshold

VendorData UDINT – Gibt die Überstromgrenze
der Spule zurück.

GetCoilPeakCurrent VendorData UDINT – Gibt die Stromspitzen der
Spule zurück.

GetCoilRatedCurrent VendorData UDINT – Gibt den Nennstrom der
Spule zurück.

GetCoilThermalTime-
Constant

VendorData UINT – Gibt die thermische Zeit-
konstante der Spule zu-
rück.

GetEnableOverall-
CurrentPeakDetecti-
on

VendorData BOOL – Gibt die Einstellung der
Spitzenstromerkennung
zurück.
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Parameter Gruppe Return Type Input Type Erläuterung
GetEnableOverallNe-
gativeCurrentChan-
geError

VendorData BOOL – Gibt die Einstellung des
Fehlers für die negative
Gesamtstromänderung zu-
rück.

GetEnableOverallNe-
gativepowerError

VendorData BOOL – Gibt die Einstellung des
negativen Gesamtfehlers
zurück.

GetOverallCurrentFil-
ter

VendorData UINT – Gibt den Gesamtstromfilter
zurück.

GetOverallCurrent-
Gain

VendorData UINT – Gibt Zunahme des Ge-
samtstroms zurück.

GetOverallCurrent-
Offset

VendorData DINT – Gibt das Offset des Ge-
samtstroms zurück.

GetOverallOvercur-
rentThreshold

VendorData UDINT – Gibt die Gesamtüberstrom-
grenze zurück.

GetPolarity VendorData UDINT – Gibt die Polarität zurück.

10.5.5.3 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
Subitems
CoE – I_AT2xxxXtsMotor – Wählt die CoE-Lesefunkti-

on für den weiteren Betrieb
aus.

P_IsInitialised – BOOL – Gibt den Status der Initiali-
sierung zurück.
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10.5.6 FB_AT2xxxXtsMotor (ModuleCoE/CoE) - I_AT2xxxXtsMotor (ModuleCoE/CoE)

10.5.6.1 Methode

Parameter Gruppe Return Type Input Type Erläuterung
Update – BOOL – Aktualisiert die ausgewähl-

ten CoE-Daten.
UpdateDiagHistory – BOOL – Aktualisiert die Diagnose

Verlaufsdaten. (Beta Versi-
on)

UpdateAllCoEData – BOOL – Aktualisiert die Daten aller
CoE-Objekte. Die Daten
können über die Eigen-
schaft UpdateAllCoEData
aufgerufen werden.
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10.5.6.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
AllCoE UpdateAllCoEData I_AT2xxxAllCoEData – Wählt alle CoE-Objekte

aus.
UpdateAllCoEData UpdateAllCoEData ST_AT2xxxAllCoE-

Data
– Gibt die Daten aller CoE-

Objekte zurück.
AmplifierSettingsDa-
ta

AmplifierSetting I_AT2xxxAmplifier-
Settings

– Wählt die Verstärkerein-
stellungen aus.

BrakeAfterBridgeDi-
sable

AmplifierSetting BOOL – Gibt den Zustand der
Bremse zurück, nachdem
die Überbrückung deakti-
viert wurde.

EnableBrakeChopper AmplifierSetting BOOL – Gibt den Status der Akti-
vierung des Bremskraftbe-
grenzers zurück.

I2TErrorLevel AmplifierSetting USINT – Gibt den Fehlerlevel von
I2T zurück.

I2TWarnLevel AmplifierSetting USINT – Gibt den Warnlevel von
I2T zurück.

MaxDcLinkVoltage AmplifierSetting UDINT – Gibt das Maximum der
DC-Link-Spannung zurück.

MinDcLinkVoltage AmplifierSetting UDINT – Gibt das Minimum der DC-
Link-Spannung zurück.

TemperatureErrorLe-
vel

AmplifierSetting UINT – Gibt das Fehlerlevel der
Temperatur zurück.

TemperatureWarnLe-
vel

AmplifierSetting UINT – Gibt das Warnlevel der
Temperatur zurück.

BtnData BTN I_AT2xxxBtn – Wählt die Beckhoff Tracea-
bility Number (BTN) aus

Btn BTN STRING(13) – Gibt die Beckhoff Tracea-
bility Number (BTN) zu-
rück.

DeviceNameData DeviceName I_AT2xxxDeviceNa-
me

– Wählt den Device-Namen
aus.

DeviceName DeviceName STRING(17) – Gibt den Device-Namen
zurück.

DeviceTypeData DeviceType I_AT2xxxDeviceType – Wählt den Device-Typ aus.
DeviceType DeviceType UDINT – Gibt den Device-Typ zu-

rück.
DiagData DiagData I_AT2xxxDiagData – Wählt die Diagnosedaten

aus.
WarningActual DiagData UINT – Gibt die Diagnosedaten

zurück.
ErrorLatch DiagData UINT – Gibt den Speicherfehler

zurück.
ErrorActual DiagData UINT – Gibt den aktuellen Fehler

zurück.
DiagHistoryData DiagHistory I_AT2xxxDiagHistory – Wählt den Diagnoseverlauf

aus.
DiagHistory DiagHistory ST_AT2xxxDiagHis-

tory
– Gibt den Diagnoseverlauf

zurück.
AmsNetId Ethercat T_AMSNETID – Gibt die Net-ID zurück.
DriveAdr Ethercat UINT – Gibt Adresse des Treibers

zurück.
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Parameter Gruppe Return Type Input Type Erläuterung
HardwareVersionDa-
ta

HardwareVersion I_AT2xxxHardware-
Version

– Wählt die Hardwareversion
aus.

HardwareVersion HardwareVersion STRING(2) – Gibt die Hardwareversion
zurück.

I2TDiagData I2TDiagData I_AT2xxxI2TDiagDa-
ta

– Wählt die I2T-Diagnose
aus.

TemperatureCoilCh I2TDiagData ARRAY[1..15] OF
USINT

– Gibt die I2T-Werte der
Spulen zurück.

IdentityData IdentityData I_AT2xxxIdentity – Wählt die ID aus.
ProductCode IdentityData UDINT – Gibt den Produktcode zu-

rück.
Revision IdentityData UDINT – Gibt den Revisionsstand

zurück.
SerialNumber IdentityData UDINT – Gibt die Seriennummer zu-

rück.
VendorId IdentityData UDINT – Gibt die ID des Herstellers

zurück.
InfoData InfoData I_AT2xxxInfoData – Wählt die Informationsda-

ten aus.
AuxiliaryVoltage10V InfoData UINT – Gibt die gemessene Hilfs-

spannung von 10 V zu-
rück.

AuxiliaryVoltage24V InfoData UINT – Gibt die gemessene Hilfs-
spannung von 24 V zu-
rück.

AuxiliaryVoltage5V InfoData UINT – Gibt die gemessene Hilfs-
spannung von 5 V zurück.

ChipId InfoData ARRAY [1..16] OF
BYTE

– Gibt die ID des Chips zu-
rück.

CurrentScaling InfoData INT – Gibt die Skalierung des
Stroms zurück.

DcLinkVoltage InfoData UINT – Gibt die DC-Link-Span-
nung zurück.

DeviceInfo InfoData UDINT – Gibt die Device-Informatio-
nen zurück.

MaxDCLinkVoltage-
Last500ms

InfoData UDINT – Gibt die maximale DC-
Link-Spannung der letzten
500 ms zurück.

MaxOverallCurrent-
Last500ms

InfoData DINT – Gibt den Gesamtstrom der
letzten 500 ms zurück.

OverallCurrent InfoData DINT – Gibt den Gesamtstrom zu-
rück.

PcbTemp InfoData ARRAY[1..4] OF
UINT

– Gibt die Temperatur im
Modul zurück.

SoftwareVersionData SoftwareVersion I_AT2xxxSoftware-
Version

– Wählt die Softwareversion
aus.

SoftwareVersion SoftwareVersion STRING(2) – Gibt die Softwareversion
zurück.

VendorData VendorData I_AT2xxxVendorData – Gibt die Herstellerdaten
zurück.

Code VendorData ARRAY [1..16] OF
BYTE

– Gibt die Softwareversion
zurück.

CoilOvercurrent-
Threshold

VendorData UDINT – Gibt die Überstromgrenze
der Spule zurück.
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Parameter Gruppe Return Type Input Type Erläuterung
CoilPeakCurrent VendorData UDINT – Gibt die Stromspitzen der

Spule zurück.
CoilRatedCurrent VendorData UDINT – Gibt den Nennstrom der

Spule zurück.
CoilThermalTime-
Const

VendorData UINT – Gibt die thermische Zeit-
konstante der Spule zu-
rück.

EnableOverallCur-
rentPeakDetection

VendorData BOOL – Gibt die Einstellung der
Spitzenstromerkennung
zurück.

EnableOverallNega-
tivCurrentChangeEr-
ror

VendorData BOOL – Gibt die Einstellung des
Fehlers für die negative
Gesamtstromänderung zu-
rück.

EnableOverallNegati-
vePowerError

VendorData BOOL – Gibt die Einstellung des
negativen Gesamtfehlers
zurück.

OverallCurrentFilter VendorData UINT – Gibt den Gesamtstromfilter
zurück.

OverallCurrentGain VendorData UINT – Gibt Zunahme des Ge-
samtstroms zurück.

OverallCurrentOffset VendorData DINT – Gibt das Offset des Ge-
samtstroms zurück.

OverallCurrentThres-
hold

VendorData UDINT – Gibt die Gesamtüberstrom-
grenze zurück.

Polarity VendorData UDINT – Gibt die Polarität zurück.
All All PVOID – Gibt alle Daten eines Un-

terbereichs zurück, bei-
spielsweise VendorData
und SoftwareVersion.
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10.5.7 FB_TcIoXtsModuleMotorTerminal - I_TcIoXtsModuleMotorTerminal

10.5.7.1 Methode

Parameter Gruppe Return Type Input Type Erläuterung
GetObjectName – STRING(21) – Gibt den Namen der Mo-

torklemme zurück.

10.5.7.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.

10.5.8 FB_TcIoXtsModuleSensorTerminal – I_TcIoXtsModuleSensorTerminal

10.5.8.1 Methode

Parameter Gruppe Return Type Input Type Erläuterung
GetObjectName – STRING(20) – Gibt den Namen der Sen-

sorklemme zurück.

10.5.8.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.9 FB_TcIoXtsXpuTrack – I_TcIoXtsXpuTrack

10.5.9.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetTaskOid General OTCID – Gibt die Objekt ID der Task

für den Track zurück.
GetIsClosed General BOOL – Gibt den Status zurück, ob

der Track geschlossen ist.
GetIsIncludedInDe-
tection

General BOOL – Gibt den Status zurück, ob
der Track in den Erken-
nungsmodus integriert ist.

GetPolarity General Polarity – Gibt die Polarität zurück.
GetOffset General LREAL – Gibt das Offset zurück.
GetPartConfigItems General ARRAY[1..TcIoXts-

EnvironmentParamet
erList.MaxPartsPerTr
ack] OF ST_Part-
ConfigItems

– Gibt die Informationen des
Parts in diesem Track zu-
rück.

SetIsClosed General BOOL BOOL Legt den Status fest, ob
der Track geschlossen ist.

SetIsIncludedInDe-
tection

General BOOL BOOL Legt den Status fest, ob
der Track in den Erken-
nungsmodus integriert ist.

SetPolarity General BOOL Polarity Legt die Polarität fest.
SetOffset General BOOL LREAL Legt das Offset fest.
SetTaskOid General BOOL OTCID Legt die Task für den

Track durch Eingabe der
Objekt ID fest.

10.5.9.2 Methode – Parameter (Online)

Parameter Gruppe Return Type Input Type Erläuterung
GetLength Info LREAL – Gibt die Länge des Tracks

zurück.
GetModuleCount Info UDINT – Gibt die Anzahl an Modu-

len zurück.
GetPartCount Info UDINT – Gibt die Anzahl an Parts

zurück.
GetPartInfoItems Info ARRAY[1..TcIoXts-

EnvironmentParamet
erList.MaxPartsPer-
Track] OF ST_PartIn-
foItems

– Gibt ein Array von Part In-
formationen zurück, das
die Part Objekt ID, die Po-
larität des Parts, das Offset
des Parts im Track und die
aktuelle Länge des Parts
enthält.

10.5.9.3 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.10 FB_TcIoXtsXpuMover – I_TcIoXtsXpuMover

10.5.10.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetAdsPort General WORD – Gibt den ADS Port zurück.
GetActiveTrackOb-
jectId

General OTCID – Gibt die Objekt ID des akti-
ven Tracks zurück.

GetTaskOid General OTCID – Gibt die Objekt ID der Task
zurück.

SetActiveTrackOb-
jectId

General BOOL OTCID Legt den aktiven Track
durch Eingabe der Objekt
ID des Tracks fest.

GetIsActivated General BOOL – Gibt den aktivierten Status
des Movers zurück.

SetIsActivated General BOOL BOOL Legt den aktivierten Status
des Movers fest.

GetSimulatedStart-
UpPart

Simulation OTCID – Gibt die Objekt ID des
Startparts in der Simulation
zurück.

GetSimulatedStart-
UpPosition

Simulation LREAL – Gibt die Position beim
Start zurück.

GetSimulatedStart-
UpId

Simulation STRING(3) – Gibt die ID des Movers zu-
rück.

SetSimulatedStart-
UpPart

Simulation BOOL OTCID Legt den Startpart durch
Eingabe der Objekt ID des
Parts fest.

SetSimulatedStart-
UpPosition

Simulation BOOL LREAL Legt die Startposition fest.

SetSimulatedStart-
UpId

Simulation BOOL STRING(3) Legt die ID des Movers
fest.



Tc3 XTS Utility

Version: 1.1.1 ─── 467TF5850

10.5.10.2 Methode – Parameter (Online)

Parameter Gruppe Return Type Input Type Erläuterung
GetMoverId MoverIdDetection STRING(3) – Gibt die Mover ID zurück.
GetAxisId Info UDINT – Gibt die ID der Achse zu-

rück.
GetAxisObjectId Info OTCID – Gibt die Objekt ID der Ach-

se zurück.
GetDistanceDriven Info LREAL – Gibt den Wert der absolu-

ten Fahrstrecke zurück.
Einheit: mm

GetDistanceDrive-
nInKm

Info LREAL – Gibt den Wert der absolu-
ten Fahrstrecke zurück.
Einheit: km

GetDriveAddress Info UINT – Gibt die Adresse des Mo-
duls zurück, auf der sich
der Mover befindet.

GetDriveModule-
Number

Info UDINT – Gibt die Nummer des Mo-
duls zurück, auf der sich
der Mover befindet.

GetDriveTerminalOid Info OTCID – Gibt die Objekt ID des Mo-
duls zurück, auf der sich
der Mover befindet.

GetEncoderAddress Info UINT – Gibt die Adresse der Enco-
derklemme zurück, auf der
sich der Mover befindet.

GetEncoderModule-
Number

Info UDINT – Gibt die Nummer der En-
coderklemme zurück, auf
der sich der Mover befin-
det.

GetEncoderTerminal-
Oid

Info OTCID – Gibt die Objekt ID der En-
coderklemme zurück, auf
der sich der Mover befin-
det.

GetHasDriveError Info BOOL32 – Gibt den Fehlerstatus des
Antriebs zurück.

GetHasEncoderError Info BOOL32 – Gibt den Fehlerstatus der
Encoderklemme zurück.

GetMasterNetId Info AmsNetId – Gibt die Net-ID des Moduls
zurück.

GetPositionInfo Info REFERENCE TO
ST_PositionInfo

– Gibt die Positionsinforma-
tionen des Parts und des
Tracks zurück

GetSoftdriveOid Info OTCID – Gibt die Objekt ID des
SoftDrives zurück.



Tc3 XTS Utility

468 ─── Version: 1.1.1TF5850

10.5.10.3 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_AxisOid Info REFERNCE TO

OTCID
– Gibt die Objekt ID der Ach-

se zurück.
P_SoftdriveOid Info REFERENCE TO

OTCID
– Gibt die Objekt ID des

SoftDrives zurück.
P_IsInitialised Info BOOL – Gibt den Status der Initiali-

sierung zurück.
Softdrive Softdrive I_McXtsMoverSoft-

drive
– Wählt den SoftDrive für

den weiteren Betrieb aus.
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10.5.11 FB_McXtsMoverSoftdrive – I_McXtsMoverSoftdrive

10.5.11.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetAdsPort General WORD – Gibt den ADS Port des

SoftDrives zurück.
GetHardwareModulo General LREAL – Gibt den Hardware Modulo

Faktor zurück.
GetOperationMode General UDINT – Gibt den Betriebsmodus

zurück.
GetMaxCurrentOut-
put

General LREAL – Gibt den maximalen Aus-
gangsstrom zurück.

GetEmergencyRamp General LREAL – Gibt die Notbremsfunktion
zurück.

GetEmergencyTime-
Out

General LREAL – Gibt die gesamte Notfall-
ausfallzeit zurück.

GetStandstillSwitch-
Time

General LREAL – Gibt die Schaltzeit zurück,
die der Mover benötigt, um
in den Stillstand zu wech-
seln.
Kontrollparameter nach
dem Stillstand.

GetStandstillSwitch-
Mode

General TcSdStandStill-
SwitchMode

– Gibt den Modus zurück, in
dem der Mover in den Still-
stand schaltet.

GetControlAreas ControlAreas REFERENCE TO
ARRAY[1..TcIoXts-
EnvironmentParamet
erList.MaxAreasPerP
art] OF ST_ControlA-
reas

– Gibt die Einstellungen für
die Control Areas zurück.

GetAreaOwner ExternalIO OTCID – –
GetIoChildAreaLoca-
tion

ExternalIO REFERNCE TO AR-
RAY[1..2] OF ST_Io-
ChildAReaLocation

– –



Tc3 XTS Utility

470 ─── Version: 1.1.1TF5850

10.5.11.2 Methode – Parameter (Online)

Parameter Gruppe Return Type Input Type Erläuterung
GetEncoderOid General OTCID – Gibt die Objekt ID des En-

coders zurück.
GetFeedForwardOid General OTCID – Gibt die Objekt ID der Vor-

steuerung zurück.
GetFilter1Oid General OTCID – Gibt die Objekt ID von Fil-

ter 1 zurück.
GetFilter2Oid General OTCID – Gibt die Objekt ID von Fil-

ter 2 zurück.
GetInterpolatorOid General OTCID – Gibt die Objekt ID des In-

terpolators zurück.
GetMoverOid General OTCID – Gibt die Objekt ID des Mo-

vers zurück.
GetPositionControl-
Oid

General OTCID – Gibt die Objekt ID der Po-
sitionskontrolle zurück.

GetSoftdriveOid General OTCID –– Gibt die Objekt ID des
SoftDrives zurück.

GetTcNc3ActData General REFERENCE TO
ST_TcNc3ActData

– Obsoleter Parameter.

GetTuningAssistOid General OTCID – Gibt die Objekt ID des Tu-
ning Assistenten zurück.

GetVelocityControl-
Oid

General OTCID – Gibt die Objekt ID der Ge-
schwindigkeitsregelung zu-
rück

10.5.11.3 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
Encoder – I_SoftdriveEncoder – Wählt den Encoder für den

weiteren Betrieb aus.
FeedForward – I_SoftdriveFeedFor-

ward
– Wählt die Vorsteuerung für

den weiteren Betrieb aus.
Filter1 – I_SoftdriveFilter1 – Wählt den Filter 1 für den

weiteren Betrieb aus.
Filter2 – I_SoftdriveFilter2 – Wählt den Filter 2 für den

weiteren Betrieb aus.
Interpolator – I_SoftdriveInterpola-

tor
– Wählt den Interpolator für

den weiteren Betrieb aus.
PositionControl – I_Softdriveposition-

Control
– Wählt die Positionskontrol-

le für den weiteren Betrieb
aus.

VelocityControl – I_SoftdriveVelocity-
Control

– Wählt die Geschwindig-
keitskontrolle für den wei-
teren Betrieb aus.

P_IsInitialised – BOOL – Gibt den Status der Initiali-
sierung zurück.
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10.5.12 FB_SoftdriveEncoder – I_SoftdriveEncoder

10.5.12.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetVelocityFeed-
backMode

General TcSdVelocityFeed-
backMode

– Gibt den Feedback-Modus
der Geschwindigkeit zu-
rück.

GetPositionFeed-
backMode

General TcSdPositionFeed-
backMode

– Gibt den Feedback-Modus
der Position zurück.

GetPositionLowPass-
Filter

General LREAL – Gibt die Frequenz des Po-
sitions-Tiefpassfilters zu-
rück.

GetVelocityFilter-
Bandwidth

General LREAL – Gibt die Bandbreite der
Geschwindigkeitsfilter zu-
rück.

GetStartUpPosition General TcSdStartUpPositi-
onType

– Gibt den Typ der Startposi-
tion zurück.

SetVelocityFeed-
backMode

General BOOL TcSdVelocity-
FeedbackMode

Legt den Feedback-Modus
der Geschwindigkeit fest.

SetPositionLowPass-
Filter

General BOOL LREAL Legt die Frequenz des Po-
sitions-Tiefpassfilters fest.

SetVelocityFilter-
Bandwidth

General BOOL LREAL Legt die Bandbreite des
Geschwindigkeitsfilters
fest.

GetCorrectionFactor Advanced LREAL – Gibt den Korrekturfaktor
des Beobachtungs modells
zurück.

GetSimulationOffset Advanced LREAL – Gibt das Offset der Start-
position in der Simulation
zurück.

GetCommutationEr-
rorVelocity

Advanced LREAL – Gibt den Schwellenwert
der Kommunikationsfehler-
Geschwindigkeit zurück.

SetCorrectionFactor Advanced BOOL – Legt den Korrekturfaktor
fest.

SetSimulationOffset Advanced BOOL – Legt das Offset der Start-
position in der Simulation
fest.

SetCommutationEr-
rorVelocity

Advanced BOOL – Legt den Schwellenwert
der Kommunikationsfehler-
Geschwindigkeit fest.

10.5.12.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.13 FB_SoftdriveFeedForward – I_SoftdriveEncoder

10.5.13.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetFeedForwardTy-
pe

General TcSdFeedForward-
Type

– Gibt den Typ der Vorsteue-
rung zurück.

GetKpAccFFT General LREAL – Gibt die Verstärkung der
Beschleunigungsvorsteue-
rung zurück.

GetKpAccFFTArea General LREAL – Gibt die Verstärkung der
Beschleunigungsvorsteue-
rung der Area zurück.

GetFrictionCompen-
sation

General LREAL – Gibt die Vorsteuerung des
Stroms zur zur Kompensa-
tion der Haftreibung zu-
rück.

GetFrictionCompen-
sationArea

General LREAL – Gibt die Vorsteuerung des
Stroms zur zur Kompensa-
tion der Haftreibung der
Area zurück.

GetAreaCurrentLimit General LREAL – Gibt das Stromlimit der
Area zurück.

SetFeedForwardTy-
pe

General BOOL TcSdFeedFor-
wardType

Legt den Typ der Vor-
steuerung fest.

SetKpAccFFT General BOOL LREAL Legt die Verstärkung der
Beschleunigungsvorsteue-
rung fest.

SetKpAccFFTArea General BOOL LREAL Legt die Verstärkung der
Beschleunigungsvorsteue-
rung der Area fest.

SetFrictionCompen-
sation

General BOOL LREAL Legt die Vorsteuerung des
Stroms zur Kompensation
der Haftreibung fest.

SetFrictionCompen-
sationArea

General BOOL LREAL Legt die Vorsteuerung des
Stroms zur Kompensation
der Haftreibung der Area
fest.

SetAreaCurrentLimit General BOOL LREAL Legt das Stromlimit der
Area fest.

GetDetectionMinMo-
vement

MoverIdDetection LREAL – Gibt die minimale Bewe-
gung des Mover 1 wäh-
rend der Mover 1-Erken-
nung zurück.

GetDetectionFilter MoverIdDetection LREAL – Gibt den Lowpass-Filter
der Mover 1-Erkennung
zurück.

GetDetectionCurrent-
Ramp

MoverIdDetection LREAL – Gibt den Stromanstieg der
Mover 1-Erkennung zu-
rück.

GetDetectionMax-
Current

MoverIdDetection LREAL – Gibt den Maximalstrom für
die Mover 1.Erkennung zu-
rück.

SetDetectionMinMo-
vement

MoverIdDetection BOOL LREAL Legt die minimale Bewe-
gung für Mover 1 während
der Mover 1-Erkennung
fest.
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Parameter Gruppe Return Type Input Type Erläuterung
SetDetectionFilter MoverIdDetection BOOL LREAL Legt den Lowpass-Filter

der Mover 1-Erkennung
fest.

SetDetectionCurrent-
Ramp

MoverIdDetection BOOL LREAL Legt den Stromanstieg der
Mover 1-Erkennung fest.

SetDetectionMaxCur-
rent

MoverIdDetection BOOL LREAL Legt den Maximalstrom
der Mover 1-Erkennung
fest.

GetOpenloopMove-
Current

Advanced LREAL – Gibt den Bewegungsstrom
der offenen Strecke zu-
rück.

SetOpenloopMove-
Current

Advanced BOOL LREAL Legt den Bewegungsstrom
der offenen Strecke fest.

10.5.13.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.

10.5.14 FB_SoftdriveFilter1/ FB_SoftdriveFilter2 - I_SoftdriveFilter1/ I_SoftdriveFilter2

10.5.14.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetConfigurationFil-
ter

General REFERENCE TO
ST_ConfigurationFil-
ter

– Gibt die Konfiguration des
Filters zurück.

SetConfigurationFil-
ter

General BOOL ST_Configura-
tionFilter

Legt die Konfiguration des
Filters fest.

10.5.14.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.15 FB_SoftdriveInterpolator – I_SoftdriveInterpolator

10.5.15.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetInterpolatorType General TcSdInterpolatorTy-

pe
– Gibt den Typ der Zwi-

schensteuerung zurück.
SetInterpolatorType General BOOL TcSdInterpola-

torType
Legt den Typ der Zwi-
schensteuerung fest.

10.5.15.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.16 FB_SoftdrivePositionControl – I_SoftdrivePositionControl

10.5.16.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetPositionLoopTy-
pe

General TcSdPositionLoop-
Type

– Gibt die Regelungsart des
Regelkreises zurück.

GetKp General LREAL – Gibt die proportionale Ver-
stärkung der Positionskon-
trolle zurück.

GetKpStandstill General LREAL – Gibt die proportionale Ver-
stärkung der Positionskon-
trolle im Stillstand zurück.

GetKpArea General LREAL – Gibt die proportionale Ver-
stärkung der Positionskon-
trolle in der Area zurück.

GetKpAreaStandstill General LREAL – Gibt die proportionale Ver-
stärkung der Positionskon-
trolle in der Area im Still-
stand zurück.

SetpositionLoopType General BOOL TcSdPosition-
LoopType

Legt die Regelungsart des
Regelkreises fest.

SetKp General BOOL LREAL Legt die proportionale Ver-
stärkung der Positionskon-
trolle fest.

SetKpStandstill General BOOL LREAL Legt die proportionale Ver-
stärkung der Positionskon-
trolle im Stillstand fest.

SetKpArea General BOOL LREAL Legt die proportionale Ver-
stärkung der Positionskon-
trolle in der Area fest.

SetKpAreaStandstill General BOOL LREAL Legt die proportionale Ver-
stärkung der Positionskon-
trolle in der Area im Still-
stand fest.

GetPosLoopFilter Advanced LREAL – Gibt die Einstellung der
Lowpass-Frequenz des
Positionsfilters zurück.

SetPosLoopFilter Advanced BOOL LREAL Legt die Lowpass-Fre-
quenz des Positionsfilters
fest.

10.5.16.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.17 FB_SoftdriveVelocityControl – I_SoftdriveVelocityControl

10.5.17.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetVelocityLoopType General TcSdVelocityLoop-

Type
– Gibt die Regelungsart der

Geschwindigkeitsregelung
zurück.

GetKp General LREAL – Gibt die proportionale Ver-
stärkung der Geschwindig-
keitskontrolle zurück.

GetKpStandstill General LREAL – Gibt die proportionale Ver-
stärkung der Geschwindig-
keitskontrolle im Stillstand
zurück.

GetKpArea General LREAL – Gibt die proportionale Ver-
stärkung der Geschwindig-
keitskontrolle in der Area
zurück.

GetKpAreaStandstill General LREAL – Gibt die proportionale Ver-
stärkung der Geschwindig-
keitskontrolle in der Area
im Stillstand zurück.

GetTn General LREAL – Gibt die ganzzahlige Zeit-
konstante der Geschwin-
digkeitskontrolle zurück.

GetTnStandstill General LREAL – Gibt die ganzzahlige Zeit-
konstante der Geschwin-
digkeitskontrolle im Still-
stand zurück.

GetTnArea General LREAL – Gibt die ganzzahlige Zeit-
konstante der Geschwin-
digkeitskontrolle in der
Area zurück.

GetTnAreaStandstill General LREAL – Gibt die ganzzahlige Zeit-
konstante der Geschwin-
digkeitskontrolle in der
Area im Stillstand zurück

SetVelocityLoopType General BOOL TcSdVelocity-
LoopType

Legt die Regelungsart des
Geschwindigkeitsregelkrei-
ses fest.

SetKp General BOOL LREAL Legt die proportionale Ver-
stärkung der Geschwindig-
keitskontrolle fest.

SetKpStandstill General BOOL LREAL Legt die proportionale Ver-
stärkung der Geschwindig-
keitskontrolle im Stillstand
fest.

SetKpArea General BOOL LREAL Legt die proportionale Ver-
stärkung der Geschwindig-
keitskontrolle in der Area
fest.

SetKpAreaStandstill General BOOL LREAL Legt die proportionale Ver-
stärkung der Geschwindig-
keitskontrolle in der Area
im Stillstand fest.
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Parameter Gruppe Return Type Input Type Erläuterung
SetTn General BOOL LREAL Legt die ganzzahlige Zeit-

konstante der Geschwin-
digkeitskontrolle fest.

SetTnStandstill General BOOL LREAL Legt die ganzzahlige Zeit-
konstante der Geschwin-
digkeitskontrolle im Still-
stand fest.

SetTnArea General BOOL LREAL Legt die ganzzahlige Zeit-
konstante der Geschwin-
digkeitskontrolle in der
Area fest.

SetTnAreaStandstill General BOOL LREAL Legt die ganzzahlige Zeit-
konstante der Geschwin-
digkeitskontrolle in der
Area im Stillstand fest.

GetMaxVelocity Advanced LREAL – Gibt die Einstellung für die
maximale Geschwindigkeit
zurück.

SetMaxVelocity Advanced BOOL LREAL Legt die maximale Ge-
schwindigkeit fest.

10.5.17.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.18 FB_TcIoXtsInfoServer – I_TcIoXtsInfoServer

10.5.18.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetAdsPort General WORD – Gibt den ADS Port des In-

foServers zurück.

10.5.18.2 Methode – Parameter (Online)

Parameter Gruppe Return Type Input Type Erläuterung
GetInfoStationCount Info UDINT – Aktualisiert und gibt die

Gesamtzahl der InfoStati-
ons zurück.

GetInfoStationOids Info BOOL – Aktualisiert die Objekt IDs
aller InfoStations.

Subitems
InfoStationTcIo – – – Wählt die InfoStation für

den weiteren Betrieb,
durch die Eingabe der
Nummer der InfoStation,
aus.

10.5.18.3 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_InfoStationCount – UINT – Gibt die Gesamtzahl der

InfoStations zurück.
P_InfoStationOids – REFERENCE TO

ARRAY[1..TcIoXts-
EnvironmentParamet
erList.MaxXtsInfoStat
ion] OF OTCID

– Gibt alle Objekt IDs zu-
rück.

P_IsInitialised – BOOL – Gibt den Status der Initiali-
sierung zurück.
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10.5.19 FB_TcIoXtsInfoServerInfoStation – I_TcIoXtsInfoServerInfoStation

10.5.19.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetAdsPort General WORD – Gibt den ADS Port der Sta-

tion zurück.
GetStationId General UDINT – Gibt die ID der Station zu-

rück.
GetStationColor General UDINT – Gibt die Farbe der Station

zurück.
Einheit: ARGB

GetStartPositionOn-
Part

General LREAL – Gibt die Startposition der
Station auf dem Part zu-
rück.

GetEndPositionOn-
Part

General LREAL – Gibt die Endposition der
Station auf dem Part zu-
rück.

GetStopPosition General LREAL – Gibt die Stoppposition auf
dem Part zurück.

GetStopPositions General ARRAY[1..TcIoXts-
EnvironmentParamet
erList.MaxXtsStopPo
sitionPerStation] OF
LREAL

– Gibt die Stopppositionen
auf dem Part zurück.

GetPartObjectIds General ARRAY[1..TcIoXts-
EnvironmentParamet
erList.MaxXtsStopPo
sitionPerStation] OF
OTCID

– Gibt alle Part Informatio-
nen der Station zurück.

GetIsEnabled General BOOL – Gibt den Status der Station
zurück.

GetDescription General STRING(1023) – Gibt die Beschreibung der
Station zurück.

10.5.19.2 Methode – Parameter (Online)

Parameter Gruppe Return Type Input Type Erläuterung
GetPartCount Structure UDINT – Gibt die Anzahl der Parts

zurück, die zu dieser Stati-
on gehören.

GetStopPositions-
Count

Structure UDINT – Gibt die Gesamtzahl der
Stopppositionen zurück.

10.5.19.3 Eigenschaften

Name Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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10.5.20 FB_Mc2CaGroup – I_Mc2CaGroup

10.5.20.1 Methode – Parameter (Init)

Parameter Gruppe Return Type Input Type Erläuterung
GetRailLength Geometry LREAL – Gibt die Länge der Füh-

rungsschienen zurück.
GetRailsRing Geometry BOOL – Gibt zurück, dass die Füh-

rungsschienen geschlos-
sen sind.

SetRailLength Geometry BOOL LREAL Legt die Länge der Füh-
rungsschienen fest.

SetRailsRing Geometry BOOL BOOL Legt fest, dass die Füh-
rungsschienen geschlos-
sen sind.

GetDefaultGapCon-
trolMode

Gap Control MC_DEFAULT_GAP
_CONTROL_MODE

– Gibt den Modus der Ab-
standskontrolle zurück.

GetGapControlDirec-
tion

Gap Control MC_GAP_CON-
TROL_DIRECTION

– Gibt die Richtung der Ab-
standskontrolle zurück.

GetStandbyGapCon-
trol

Gap Control BOOL – Gibt den Standby-Status
der Abstandskontrolle zu-
rück.

GetDefaultGap Gap Control LREAL – Gibt den Standardwert des
Abstands zurück.

GetDefaultVelocity Gap Control LREAL – Gibt die Standardge-
schwindigkeit der Ab-
standskontrolle zurück.

GetDefaultAccelerati-
on

Gap Control LREAL – Gibt die Standardbe-
schleunigung der Ab-
standskontrolle zurück.

GetDefaultDecelera-
tion

Gap Control LREAL – Gibt die Standardverzöge-
rung der Abstandskontrolle
zurück.

GetDefaultJerk Gap Control LREAL – Gibt den Standardruck der
Abstandskontrolle zurück.

SetDefaultGapCon-
trolMode

Gap Control BOOL MC_DEFAULT
_GAP_CON-
TROL_MODE

Legt den Modus der Ab-
standskontrolle fest.

SetGapControlDirec-
tion

Gap Control BOOL MC_GAP_CON-
TROL_DIREK-
TION

Legt die Richtung der Ab-
standskontrolle fest.

SetStandbyGapCon-
trol

Gap Control BOOL BOOL Legt den Standby-Status
der Abstandskontrolle fest.

SetDefaultGap Gap Control BOOL LREAL Legt den Standardwert des
Abstands fest.

SetDefaultVelocity Gap Control BOOL LREAL Legt die Standardge-
schwindigkeit der Ab-
standskontrolle fest.

SetDefaultAccelerati-
on

Gap Control BOOL LREAL Legt die Standardbe-
schleunigung der Ab-
standskontrolle fest.

SetDefaultDecelerati-
on

Gap Control BOOL LREAL Legt die Standardverzöge-
rung der Abstandskontrolle
fest.

SetDefaultJerk Gap Control BOOL LREAL Legt den Standardruck der
Abstandskontrolle fest.
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10.5.20.2 Eigenschaften

Parameter Gruppe Return Type Input Type Erläuterung
P_IsInitialised – BOOL – Gibt den Status der Initiali-

sierung zurück.
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